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Value-Added Reseller (VAR) Language 

Oracle Retail VAR Applications 
The following restrictions and provisions only apply to the programs referred to in this 
section and licensed to you. You acknowledge that the programs may contain third party 
software (VAR applications) licensed to Oracle. Depending upon your product and its 
version number, the VAR applications may include: 

(i) the MicroStrategy Components developed and licensed by MicroStrategy Services 
Corporation (MicroStrategy) of McLean, Virginia to Oracle and imbedded in the 
MicroStrategy for Oracle Retail Data Warehouse and MicroStrategy for Oracle Retail 
Planning & Optimization applications. 

(ii) the Wavelink component developed and licensed by Wavelink Corporation 
(Wavelink) of Kirkland, Washington, to Oracle and imbedded in Oracle Retail Mobile 
Store Inventory Management. 
(iii) the software component known as Access Via™ licensed by Access Via of Seattle, 
Washington, and imbedded in Oracle Retail Signs and Oracle Retail Labels and Tags. 

(iv) the software component known as Adobe Flex™ licensed by Adobe Systems 
Incorporated of San Jose, California, and imbedded in Oracle Retail Promotion Planning 
& Optimization application. 

You acknowledge and confirm that Oracle grants you use of only the object code of the 
VAR Applications. Oracle will not deliver source code to the VAR Applications to you. 
Notwithstanding any other term or condition of the agreement and this ordering 
document, you shall not cause or permit alteration of any VAR Applications. For 
purposes of this section, "alteration" refers to all alterations, translations, upgrades, 
enhancements, customizations or modifications of all or any portion of the VAR 
Applications including all reconfigurations, reassembly or reverse assembly, re-
engineering or reverse engineering and recompilations or reverse compilations of the 
VAR Applications or any derivatives of the VAR Applications. You acknowledge that it 
shall be a breach of the agreement to utilize the relationship, and/or confidential 
information of the VAR Applications for purposes of competitive discovery. 

The VAR Applications contain trade secrets of Oracle and Oracle's licensors and 
Customer shall not attempt, cause, or permit the alteration, decompilation, reverse 
engineering, disassembly or other reduction of the VAR Applications to a human 
perceivable form. Oracle reserves the right to replace, with functional equivalent 
software, any of the VAR Applications in future releases of the applicable program. 
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Overview of Macro Space Planning 

Overview of Macro Space Planning 
The Macro Space Planning Application (which includes the Planner and Merchandiser 
modules) is described in the diagram below. 

 

Macro Space Planning 
Macro Space Planning consists of two applications sharing a common database: Macro 
Space Management and In-Store Space Collaboration. Macro Space Management is 
intended for use at headquarters and has functionality not replicated in In-Store Space 
Collaboration. In-Store Space Collaboration is designed to be portable and can be used 
(via the Internet) at stores within a retail organization. 

Macro Space Management 
Macro Space Management consists of two sorts of modules: store planning modules and 
support modules. 

1. Store Planning Modules 

Store Planning can be carried out in Planner (AutoCAD environment) or 
Merchandiser (Virtual Reality environment). Store Manager, used to administer the 
store hierarchy, can be accessed from either Planner or Merchandiser. 

2. Support Modules 

The support modules are used for three main purposes: to configure Macro Space 
Management, to configure the varying libraries of information and to operate batch 
processes.   

 Configuring Macro Space Management is carried out using the Administration 
module for global changes and the Configuration module for local, user specific 
changes. 
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 Libraries of information maintained include the fixture and gondola libraries 
(Fixture Studio), product library (Product Studio) and the planogram library 
(planogram design within the Merchandiser module). 

 Batch tools include Data importer (for bulk import of data) and Report Designer 
(configuring planogram reports for bulk output) 

In-Store Space Collaboration 
In-Store Space Collaboration uses a common database with Macro Space Management. 
ISSC is more portable than MSM and is often deployed to stores to allow store managers 
to be come involved in the store planning process. It can also be used to ensure 
compliance with store plans. 

Differences between Planner and Merchandiser Modules 
Although the Planner and Merchandiser modules can both be used to develop floor 
plans, they have different capabilities. In general Planner is used for 'Macro' planning, 
while Merchandiser can be used for 'Micro' planning. The differences between the 
modules are briefly outlined below. 

  Planner Merchandiser 

Zones • Can be added, edited and 
deleted. 

• Can be viewed 'read only' 

Fixtures and 
Gondolas 

• Can be accurately 
positioned using standard 
AutoCAD functionality. 

• Shelves generally not 
shown 

• Position of signage shown, 
but no text/images 
available. 

• Can be positioned 
accurately, but not as easily 
as in Planner. 

• Can work with additional 
detail for equipment - 
shelves and pegs for 
instance. 

• Can see writing/images on 
signage 

Products • Can only be displayed as 
placeholders - no 
information on quantity or 
position given. 

• Can be shown as display 
styles on fixtures or shelves 
- giving full information on 
quantity and position. 

• Can be associated with 
images - giving a photo-
realisitic appearance. 

Planograms • Can only be seen as 
placeholders - with no 
information available on 
quantity or position of 
shelves or merchandise. 

• Planograms can be seen 
with full detail including 
position and quantity of 
shelves and merchandise. 

Key Performance 
Indicators 

• Can be used for zones and 
fixtures. 

• Can be used for zones, 
fixtures, shelves and 
products. 

Annotation • Fully configurable 
annotation. 

• Basic text labelling. 



Overview of Macro Space Planning 

Retail Operations and the Planner and Merchandiser Modules  3 

  Planner Merchandiser 

Floor Plans 

  
• Can be prepared for 

printing with fixtures 
toggled to 2D form, 
specified annotation and 
title blocks. 

• Snapshots can be taken, but 
no formal way of 
outputting floor plans 
exists. 

Retail Operations and the Planner and Merchandiser Modules 
Note: The information below is intended for general 
guidance and should not be interpreted as being a 
recommended solution. 

This section of help gives a high level overview of store planning and how it integrates 
into the rest of the retail planning process. 

 

Note: Boxes coded in blue are Macro Space Planning 
operations. 

The stages in the retail planning process are broadly as follows: 
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Range and Resource Planning 
This is strategic planning and would include such items as identifying the ranges of 
products to be placed in the store, staff and service levels, etc. As a general procedure, 
this would have retail chain wide implications and not be restricted to a single store. 

Category and Assortment Planning 
Again done at a strategic level, this is the process of braking down the product ranges 
into more specific categories then optimizing the products to be offered in each category. 

Store Planning Criteria 
Following on from the Category and Assortment Planning is the need to set criteria for 
how the store is to be planned. This may well be a guidance document based on 
information from sources such as: 

 Business Intelligence - for example from syndicated data, market basket analysis 
or loyalty card programs. 

 Financial Planning - criteria on the product mix required to meet profitability 
criteria. 

 Space Allocation - sub-dividing the available space in the store into areas for each 
department and category.   

Planogram Design 
Planogram design will also have been carried out, often based on information from 
category management combined with guidelines on visual merchandising. 

Store Planning 
Store planning (more generally called floor planning) can then commence based on the 
supplied criteria. The planograms placed should meet those criteria. 

Store Plan Validation 
Once planned, the store plan must be validated against a number of criteria. These 
include: 

 Whether planograms have been placed on appropriate fixtures 

 Whether the planogram adjacencies will maximise (for example) impulse buying 

 Whether financial performance criteria will be met. 

If failures occur during validation, the validation process must be halted and the store 
plan revised. 

Store and Planogram Publishing 
After the store plan has been validated, the store plan and its associated planograms can 
be published. This is the signal for the execution processes to commence. 

Supply Chain Execution 
In order to execute the store plan, equipment, merchandise, signage and promotional 
material will be required. These requirements must be put into the supply chain in time 
for the goods to be delivered to site. 
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Store Plan Execution  
At an appropriate date, the store plan has to be put into effect. Using store labor or sub 
contractors, equipment, merchandise and signage must be placed or changed as 
appropriate. 

Performance Measurement 
At an appropriate time, the performance of the store should be examined by means of 
reports and KPIs. This information can be fed back into the Range and Resource Planning 
and Category and Assortment Planning in time for the next cycle of store planning. 

Overview of Store Planning 
Note: The information below is intended for general 
guidance and should not be interpreted as being a 
recommended solution. 

This section of help gives a high level overview of the store planning process. 
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Store Planning Criteria 
The process starts with store planning criteria for other parts of the retail organization. 
These may include: 

 Business Intelligence - for example from syndicated data, market basket analysis 
or loyalty card programs. 

 Financial Planning - criteria on the product mix required to meet profitability 
criteria. 

 Space Allocation - sub-dividing the available space in the store into areas for each 
department and category.   

This information serves as a set of criteria and constraints that a floor plan must meet 
before it is released for service. 



Overview of Macro Space Planning 

Overview of Store Planning  7 

Store Manager 
Store Manager is used for the administration of the store planning process. These 
include: 

• Maintaining the Store Hierarchy 

Maintaining the store hierarchy includes adding, editing and deleting stores, floors, 
revision and floor plans as required. 

• Associating Architectural Plans 

Architectural plans are used as underlays for floor plans in order to show the 
position of walls, doors, windows, lighting and services. Associating architectural 
plans is a two-part process, with the second step required when a floor plan is open. 

• Managing Business Processes 

Stores, Floors, Revision and floor plans all go through different stages in their 
business life cycle. For example a store may be at the design stage, in service, closed 
for refurbishment or sold and out of service. 

Floor Planning 
If a new floor plan is to be created, the general stages are as follows: 

Note: Precise details of departmental areas, number and 
types of fixtures and products, performance targets, etc will 
often be specified in the store planning criteria.  

• Assign Architectural Plan 

An architectural plan should already have been associated with the parent floor for 
the floor plan in Store Manager. This can now be assigned to this specific floor plan.   

• Lay Out Zones 

The next stage is to lay out the zones within the floor plan. These can be used to 
indicate the positions and areas of departments, sub-departments, aisles, etc. This can 
only be done in the Planner module. Zones come in several broad types: 

– Internal Area: There is only one zone of this type in a floor plan. It is used to 
indicate the maximum extents and area used for retail purposes. 

– Department: This type is used to indicate the departments within a retail 
outlet. Any floor plan that is to be viewed in In-Store Space Collaboration 
must have zones of this type for it to open. 

– Other: This type is often used to indicate sub-departments within a main 
department, aisles, etc.  

Place Fixtures 

The fixturing can then be laid out. Fixtures can either be placed individually or a 
gondola runs. Fixture placement is generally done in the Planner module because of 
the ability to place the fixtures with great accuracy. After the fixturing has been 
placed, it is often Bay Numbered - this makes it easier for users to identify a specific 
fixture within a floor plan.   

• Place Aisles 

The next stage is to draw the aisles. These can only be placed in the Planner model 
and allow the aisle to be identified. The direction the aisle is drawn also serves to 
identify the predominant traffic direction. This can be used when placing multibay 
planograms that have been designed to be viewed in a specific sequence. 

• Place Products 
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After the fixtures and aisles are in place, products can be placed. 'Big ticket' items can 
be placed as individual products, but the majority of merchandise is placed in the 
form of planograms.  

• Validate Floor Plan 

After the floor plan has been created, it is next validated to see the layout is 
optimum. Validation can be done using reports and KPIs. Because of the visual 
nature of KPIs these often allow validation to be completed in the least possible time. 
Validation can include: 

 Whether planograms have been placed on appropriate fixtures. 

 Whether the planogram adjacencies will maximise (for example) impulse buying. 

 Whether financial performance criteria will be met. 

If necessary amendments can be made to the floor plan and the new arrangement 
revalidated. 

• Approve for Service 

The final stage is to approve the floor plan for service. This is done in Store Manager 
by setting the status to Authorized. This enables the Publish and Effective (Current) 
dates to be set. Macro Space Management batch tools can then be used to 
automatically change the floor plan status and publish the floor plan and its 
associated planograms. 

Information Distribution 
When the floor plan has been approved for service, the next stage is to distribute the 
information at the pertinent time. 

• Set Dates 

When the floor plan has been approved and set to Authorized status, the Publish and 
Effective Dates are set. 

– The Publish Date is when information is distributed in preparation for 
putting the floor plan into service. This date is set far enough in advance of 
the implementation date that all preparations for putting the floor plan into 
service (including ordering equipment and merchandise) can be put in hand. 

– The Effective Date is when the floor plan will be put into service (made 
current). This date will usually be integrated with the retailers strategic 
planning so that the change is made in coordination with promotional and 
advertising campaigns, etc. 

 Run Update Status 

UpdateStatus.exe is a small Macro Space Management utility that can automatically 
change the status of floor plan. It is generally set to run as a batch process on a 
nightly schedule. When the Publish Date has been met or exceeded, Update Status 
will change the status of the floor plan from Authorized to Published. In most 
implementations this also sets the floor plan to read only status. This prevents 
further changes to the floor plan unless an administrator deliberately overrides this. 

• Auto-Publish Floor Plan 

Another Macro Space Management application can be scheduled to publish the floor 
plan on the Publish Date. This results in a copy of the floor plan (typically in DWF or 
PDF format) being placed in a specified location. From there the retail chain can 
make arrangements to distribute the information to the store - typically by e-mail.  

• Auto-Publish Planograms 
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A further Macro Space Management application can be scheduled to publish the 
planograms on the Publish Date. This results in a copy (typically in Word document 
or PDF format) being placed in a specified location. From there the retail chain can 
make arrangements to distribute the information to the store - typically by e-mail.  

• Distribute to Supply Chain 

In parallel with publishing the information, information needs to be sent to the 
supply chain for the equipment, merchandise, signage and promotional material 
needed. This is generally achieved by running reports on the floor plan to identify 
the types and quantities required, then creating the appropriate purchase orders. 

• Run Update Status 

UpdateStatus.exe executes as a batch process on a nightly schedule. When the 
Effective Date has been met or exceeded, Update Status will change the status of the 
floor plan from Published to Current. In most implementations this also maintains 
the floor plan at read only status. This prevents further changes to the floor plan 
unless an administrator deliberately overrides this. 

Simultaneously with update status changing the status of this floor plan to Current, 
any pre-existing Current floor plan for this specific floor will have its status changed 
to Historical. This indicates it has been superseded by a more recent version. 

• Implementing the Floor Plan 

On the Effective Date, the store will know to put the changes into effect. This means 
setting out the fixturing, populating it with merchandise and setting up the signage 
and promotional material. This will require careful planning and allocation of labor. 

Floor Plan Updating 
Once a floor plan has been put into service, it will probably be subject to a series of 
updates. These may vary from changing a number of the planograms on the end caps 
through to remodelling a substantial part of the store. A typical procedure is described 
below: 

• Modify Fixtures 

The fixtures are modified as required. Typical examples include adding or removing 
display bins from an aisle or changing the widths of several aisles. 

• Manually Update Planograms 

If the fixturing has been changed, it may be necessary to manually populate the 
modified fixtures with the appropriate planograms. 

• Run Planogram Substitutions 

Planogram substitutions are an automated way of changing the specified planograms 
in one or more stores. This can be done in several forms including: 

– One to One Substitutions: A planogram is swapped out for one of identical 
size. 

– One to Many Substitutions: A large planogram is swapped out for several 
smaller ones. 

– Many to One Substitutions: Several smaller planograms are swapped out 
and replaced by a single large one. 

There are a number of reasons for planogram substitutions. The more common ones 
include: 

– Space Trading: Reducing the space assigned to a poorly performing 
category and increasing the space available to a better performing one. 
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– Seasonal Changes: Swapping out seasonal goods; for example changing 
Halloween products for Christmas ones. 

– Special Offers: Swapping out standard planograms for planograms 
containing products in modified packaging for the special offer. 

 Validate Floor Plan 

After the floor plan has been created, it is next validated to see the layout is 
optimum. Validation can be done using reports and KPIs and would be similar to the 
exercise carried out when the floor pan was first created. 

Information Distribution 
When the revised floor plan has been approved for service, the next stage is to distribute 
the information at the pertinent time. This follows the same procedure as implementing 
the original floor plan. 

Using Prototype Stores 
Overview of Prototype stores 

One useful concept in Macro Space Management is that of Prototype Stores.  

 

Prototype Stores are exemplars of a store that has an idealized layout. They may be 
actual stores that are performing better than average. Alternatively they may be 'paper' 
stores that have been designed as guidance for real store layouts. The process is as 
follows: 
1. Store Planning Criteria 

Store planning criteria are received in tabular for. This will be information on 
departmental areas, numbers and types of fixtures and products, suggested product 
adjacencies, etc. 

3. Create and Design Prototype Store 

The planning criteria are then used to design the prototype store. This results in the 
tabular information in the planning criteria being transformed into a series of spatial 
relationships where departments, equipment and merchandise are placed relative to 
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each other. After the store plan has been optimized by means of reports and KPIs, it 
is ready for use as a reference. 

4. Set Store as a Prototype 

The store can then be designated as a prototype by checking the Set as Prototype 
check box in the General tab of the Add/Edit Store dialog box in Store Manager.  

5. Select Prototype Store and Create Floor Plan 

The child store is then associated with its prototype store by selecting the  prototype 
store from the list of those available in the Add/Edit Store dialog box in Store 
Manager. This information is now set in the File Properties dialog box. Any floor 
plans now created can potentially reference the information held on the prototype 
store in the database. This information is: 

 Information in the Properties Window of the Object Browser: The Custom SQL 
supplied with Macro space Planning can be modified to show the quantities in 
the Prototype and Child stores for comparison purposes. 

 Information in the Object Grid: The information supplied in the object grid can be 
customized (Custom SQL) to show only equipment and merchandise in the 
Prototype Store.  

 The Store Comparison tool: This compares the quantities of equipment, 
merchandise categories and planograms in the prototype and its child and 
specifies differences between the two. 

 KPI's and Reports: These can be customized to the client's requirements and can 
be used to look at specific aspects of the floor plan. 

6. Design Floor Plan 

Using the Prototype Store, the child floor plan can then be designed. A typical use of 
the functionality would be to take a prototype store of 30,000 ft2 and create a child 
plan of similar area but different physical layout containing broadly similar 
department sizes and equipment/merchandise placements.   

Note: Information in the Object Browser and Object Grid is 
controlled by SQL statements in the AVTTB_CUSTOM_SQL 
table in the database. Modifying this SQL can change the 
information appearing to customer specific requirements. The 
code in the application has the ability to use specific tags in the 
Custom SQL such as {FIL_ID}. This allows the code to execute 
the SQL statement with the File ID (FIL_ID) of the currently open 
floor plan in the 'where' clause. 

MSM Batch Processes 
There are certain processes in the store planning process that can be automated and run 
on a regular schedule using a scheduling tool. These are: 

 Data Importer 

 ODI Planogram Importer 
 Automated Calculations 

 Update Status 

 Floor Plan Publishing 

 Planogram Publishing 
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Data Importer 

 

Data Importer is a Macro Space Management (MSM) module that allows imports of data 
into the MSM database to be configured and executed. In principle any table (including 
custom information) can be imported into the database and used for reporting purposes. 

ODI Planogram Importer 

 

Oracle Data Integrator (ODI) is another Oracle application. It can be configured to import 
planogram definitions. This requires an XML file to be configured by the retailer in a 
very specific format. This XML file can then be imported into the MSM database by ODI. 

Automated Calculations 
MSM provided a series of automated calculations that can be used to ensure the 
information in the database is current before reports are generated. These calculations 
are: 

 Allocated Areas: Allocating floor area to fixture to take into account the aisles 
around them when generating performance data. 

 Aisle Adjacency: Identifying which fixtures are associated with an aisle. 



Overview of Macro Space Planning 

Custom SQL  13 

 Fixture Adjacency: Identifying which fixtures are to the left, right above or below 
each other. 

 Product Adjacency: Identifying which products are to the left right or on the 
same fixture. 

 Face Planes: Calculating the frontal area of each product for performance 
metrics. 

 Space Measurement: Calculating the volume of each product for performance 
metrics. 

Update Status 
Update Status is a small MSM utility that is capable of changing the status of a store or 
floor plan. This allows dates for actions to be pre-set then automatically executed. This 
utility is typically used by retailers to trigger ordering of the equipment and merchandise 
required to execute a store plan change. 

Floor Plan Publishing 
Floor Plan Publishing enables the user to automatically generate an electronic copy of the 
floor plan and deposit it in a specified directory. From there the retailer can disseminate 
the information to the store. 

Planogram Publishing 
Planogram Publishing enables the user to automatically generate an electronic copy of 
the planograms that will be changed during a reset of a floor plan and deposit it them a 
specified directory. From there the retailer can disseminate the information to the store. 

Custom SQL 
Note: this information is for DBAs and Administrators only. 
Standard users cannot access the database and modify the 
requisite tables. 

Definition of Custom SQL 
The code used in Macro Space Planning has the ability to update SQL statements so they 
are specific to the currently active floor plan, etc, when it executes them. This is an 
addition to Standard SQL and is done by the use of placeholders such as {FIL_ID} for File 
ID.  

• In Standard SQL, a simple statement would be Select PRODUCT_NAME from 
PRODUCT where FIL_ID = 123 

• Custom SQL is of the form Select PRODUCT_NAME from PRODUCT where 
FIL_ID = {FIL_ID} 

When the code references the Custom SQL it identifies the placeholder and substitutes 
the File ID of 123 from the currently active floor plan for {FIL_ID}. This enables the 
application to return a specific sub-set of results for the currently active floor plan, etc. 
In the screen shot below, a Quick Report is being used in a floor plan to identify the 
planograms that can be placed. The fields that appear can all be customized by a DBA or 
Administrator with the correct permissions in the database. For example, if the 
planograms have User Defined Attributes (UDAs) associated with them, key UDA's 
could be displayed in the Quick Report. Similarly, if this floor plan is associated with a 
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prototype store, quantities of planograms in the currently active floor plan could be 
compared with those in the prototype store. 

 

Where Custom SQL Can Be Used 
Custom SQL can be used in the following ways: 

 To populate data into the Properties and Summary Windows in the Object 
Browser. 

 To populate data into the Object Grid and to specify the filters and sort criteria 
available. 

 To populate data into some of the Find dialog boxes. 
 To specify some of the data for annotation in Planner. 

 To specify data that can be referenced by Title Blocks. 

 To specify the data that will appear in Quick Reports. 

Where Custom SQL is Stored 
The primary repository for Custom SQL is in the AVTTB_CUSTOM_SQL in the database; 
although other tables come into use. The Custom SQL itself is stored in the CSQ_SQL 
field. This can be edited to change the table referenced and fields displayed. 

Note: See the Macro Space Planning Data Model for more 
information. 

Overview of Other MSM Modules 
A number of other modules affect the behavior of equipment and merchandise in the 
Planner and Merchandiser modules. These are described briefly below - for more 
information see the help files for the respective modules. 

Note: Users will need the appropriate privileges to access 
these modules. 
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Administration Module 
Access to the Administration module is generally carefully restricted. The settings made 
have a global effect for all users of the Planner and Merchandiser modules. Examples 
include: 

Option Description Planner Merch 

Floor Plan 
Publishing 

How floor plans are published (made 
available to stores for implementation) 

X X 

Planogram 
Publishing 

How planograms are published (made 
available to stores for implementation) 

X X 

Statuses The statuses available to show how far a 
store, item of equipment, item of 
merchandise, etc, is through its business 
life cycle. 

X X 

Annotation (Text 
Styles) 

How annotation for zones, fixtures, 
products and planograms draws 

X   

Zones The hierarchy of available zones to 
place in a floor plan 

X   

Ranges The list of temperature ranges that can 
be assigned to equipment and 
merchandise. This affects equipment 
and merchandise when display styles 
are used. 

  X 

Styles The list of styles that can be assigned to 
equipment and merchandise. This 
affects equipment and merchandise 
when display styles are used. 

  X 

Planogram 
Substitution 

How to automatically substitute one 
planogram for another in floor plans 

X X 
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Option Description Planner Merch 

Data Security What access rights users have for 
specific objects such as stores or 
planograms. 

X X 

Title Blocks How a 'frame' of information is added 
to the floor plan before it is published. 
Information in the title block can 
include store name, floor plan 
designers's name, date of 
implementation, etc. 

X   

Configuration Module 
The Configuration Module can be called from the file menu of either the Planner or 
Merchandiser modules. Only four tabs will be available (the full range only being 
available if called from the Administration module). These four tabs affect the behavior 
of the Planner and Merchandiser modules on a user by user basis - the settings do not 
have a global effect. Examples include: 

Option Description Planner Merch 

Zones Tab • How zones are drawn when being 
added to the floor plan. 

• How zones are highlighted in the 
floor plan. 

X 

X 

  

Fixturing tab • How the Add Fixture dialog box 
functions 

• How Connection Points function 

• Highlighting of Fixtures 

X 

X 

X 

  

X 

Merchandising 
Tab 

• Selection Method for Fixtures 

• Highlighting of Products 

• Checking Planogram Placement 
Validity 

X 

X 

X 

  

  

X 

Merchandiser tab • Appearance of buildings, 
equipment and merchandise 

  X 

Fixture Studio 
Fixture Studio is another Macro Space Planning module. It is used to configure the 
Fixture and Gondola Hierarchies, together with Fixtures and Gondolas themselves. 
Settings in Fixture Studio affect the behavior of Equipment in the Planner and 
Merchandiser modules. Examples include: 
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Option Description Planner Merch 

Insertion height The height at which equipment is 
inserted in the floor plan - a fixture 
will generally be inserted at floor level, 
a hanging sign 10 feet above it. 

X X 

Connection Points Datums by which one item of 
equipment aligns itself with another. 
In Planner, this is only Fixtures; in 
Merchandiser it is fixtures and shelves. 

X X 

Associated 
Equipment 

This is used to specify whether one 
item of equipment can accept another - 
for example whether a fixture will 
accept shelves. 

  X 

Temperature 
Range 

Compared to the temperature range on 
the display style being placed to 
determine if it is compatible with the 
equipment it is being placed on. 

  X 

Style Compared to the style of the display 
style to determine if the display style 
can be placed on a specific fixture or 
shelf. 

  X 

Merchandisable 
Areas 

Determines the volume that 
merchandise can take up on a fixture 
or shelf. 

  X 

Product Studio 
Product Studio is another Macro Space Planning module. It is used to hold information 
on the products available for placement in floor plans. This product information can 
either be imported from another database or entered manually. Settings in Product 
Studio affect the behavior of merchandise in the Planner and Merchandiser modules. 
Examples include: 

Option Description Planner Merch 

Product Colors The colors products for merchandiser at 
different levels in the hierarchy can be 
configured 

X X 

Publish, 
Effective and 
Expiry Dates 

These specify the dates an item of 
merchandise is available between and 
what date information will be published 
to users. 

X X 

Temperature 
Range 

Compared to the temperature range on 
the parent fixture or shelf to determine if 
the display style can be placed. 

  X 
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Option Description Planner Merch 

Style Compared to the style on the parent 
fixture or shelf to determine if the 
display style can be placed. 

  X 

Product 
Dimensions 

The size of a specific display style - this 
will determine the number of items that 
can be inserted on a fixture or shelf. 

  X 

Peg Holes Specifies the datum point by which a 
display style hangs from a product or 
rail. 

  X 

Images Associates an image with a display style 
that can subsequently be displayed in a 
floor plan. 

  X 

About Synchronization and Adjacencies 
When fixtures, fittings and gondolas are placed on the drawing using MSM tools, they 
are also sent as data to the Macro Space Management central database. 

If fixtures in the drawing are modified with AutoCAD tools, this will change the 
drawing, but not the central database. 

The process of making sure the AutoCAD drawing and the Macro Space Management 
Central database hold the same information is known as synchronization. 
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After the drawing has been synchronized with the central database, the Adjacency 
calculations can be run. 

Fixture Adjacency calculations establish the physical relationship of one fixture to 
another. 

These relationships are used for both bay numbering and as the basis for subsequent 
Product Adjacency calculations. 

Product Adjacency calculations establish the relationship of one type of product to 
another. They cannot be run until the Fixture Adjacencies have been calculated. 
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2 
Logging In 

How Passwords and Privileges are Configured 
Passwords and Privileges are configured in Macro Space Management's Administration 
module. 

Note: Access to the Administration Module is normally 
restricted to a limited number of users. This is because the 
Administration Module can be used to set a wide variety of 
parameters affecting how Macro Space Management 
operates.   

Access rights to the Macro Space Management modules are set using the Functional 
Security option. 

 

Users are assigned to User Groups in the User Groups Tab. Which modules a User Group 
can access is specified in the Group Relationships tab. User's privileges thus depend on 
what user groups they are assigned to. 
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In the above example, User 1 is only a member of the Equipment Planner user group. 
Accordingly, their access is restricted to the Fixture Studio and Planner modules. User 2 
is a member of the Equipment Planner and Merchandiser Planner user groups. They 
have wider access and can use the Fixture Studio, Planner, Product Studio and 
Merchandiser modules. 

Logging in to Macro Space Management Modules 
When a user first attempts to access a Macro Space Management module, the Log In 
dialog box will appear. 

 

This requires the user to enter a User Name and Password. If these are correct, the user 
will be able to access the desired module. After the initial log in, information will be held 
in Security Server. Users will therefore be able to access all other Macro Space 
Management modules they have permissions for without the need to log in again. 

If the user attempts to log into a module for which they do not have permissions for, a 
warning will appear and the log in attempt will be terminated. 

 

Note: The permissions for which modules can be accessed 
are configured in the Administration module. 

Password Changes 
Macro Space Management can be configured to require password changes at specified 
intervals. If one of these intervals has been exceeded, the user will be asked to change 
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their password the next time they log in. This can be done by means of the Change 
Password >>> option on the Log In dialog box. This will reveal another part of the 
dialog box where the changed password can be entered and confirmed. 

 

Security Server 
Security Server is a Macro Space Management application that runs in the background 
and is normally not visible to users. When running, it can be seen in Windows Task 
Manager. 

 

How Security Server operates is shown in the following flowchart. 
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1. The user opens a Macro Space Management module from a shortcut or the Windows 
start menu. 

2. Security server starts but remains in the background. 

3. The Log In dialog box appears. 
4. The user types their user name and password into the Log In dialog box. 

5. Security Server validates the user name and password against the information held 
in the database. If they are correct and the user has sufficient privileges, the Macro 
Space Management module opens. 

6. Security Server holds information on what other privileges the user has in Macro 
Space Management. 

7. If the user attempts to access other modules, Security Server will check the 
information it holds and allow or deny access as required. This means that a user 
only has to log into Macro Space Management once per session. 

8. When the user exits the last Macro Space Management module, Security Server also 
closes. 

Security Server and Application Errors 
On occasion a Macro Space Management module might encounter a significant error and 
automatically close. Because the closure was not user initiated, Security Server does not 
close but remains open in the background. If the module that unexpectedly closed is 
reopened, Security Server will contain information incompatible with the restart and 
further application errors will result. 

In the event of a Macro Space Management module failing unexpectedly, carry out the 
following actions: 

1. Save the information in any other Macro Space Management modules that are open 
and close those modules. 

2. Open Windows Task Manager, highlight Security Server and click End Task. 

3. When Security Server has closed, the required Macro Space Management modules 
can be restarted. 
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3 
Store Manager – Business Processes 

Store Manager Business Processes 
Store Manager enables Equipment Layout Managers, Merchandise Managers and Store 
Planners to control the business process flows relating to planning and maintaining the 
'bricks and mortar' stores within a retail organization. It can perform the following 
general functions: 

Grouping Together Stores of Common Purpose in the Hierarchy 
Stores can be assigned to multiple clusters in the Store Hierarchy. This enables stores 
with similar characteristics to be grouped together for reporting of control purposes. For 
example the New York Store could be a member of The North America, Large store and 
Regional Manager 1 clusters. This enables groups of stores to be selected - for example all 
stores in North America, or all stores of size over 50,000 square feet.  

 

It also allows stores sharing (for example) similar demographic characteristics to be 
grouped together. For example clusters could be created according to the ethnic mix of 
the store catchment area. If a 'Hispanic' cluster was created, that would enable all stores 
with a predominantly Hispanic shopper base to be grouped together. This would allow 
the product mix going into the stores to be optimized to suit that specific customer base. 
For example, the stores might have a higher proportion of burritos, enchiladas and fajitas 
than a store catering to a predominately Asian or Caucasian clientele. 

Similarly, stores could be characterized according to the average wealth of the shoppers 
using them - for example 'Low Income', Middle Income' and 'High Income' clusters could 
be created an stores assigned accordingly. Stores in the 'High Income' cluster would then 
be selected for planograms containing a higher proportion of 'premium' products than 
average. Similarly, stores in the 'Low Income' cluster would have planograms with more 
'value' products. 
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Controlling Business Life Cycle 
The planning process for any new floor plan can go through a number of stages, several 
of which will require approval before the floor plan is put into service. 

 

In the above example, it can be seen that the floor plan goes through a number of statuses 
during the creation process. For example the fixturing is placed then approved by a 
manager, before the merchandise is placed and approved. It is also possible to use In-
Store Space Collaboration (ISSC) to control business flows. ISSC users have the option to 
Accept or Reject a floor plan. These options will advance or reverse the current status of 
the floor plan. 
The floor will eventually reach Authorised status where dates can be specified for when 
preparations should be started for putting the floor plan into service (Publishing) and 
when the floor plan will be put into service (made Current). The floor plan will normally 
be automatically changed to Published and Current status by a Macro Space 
Management utility called Update Status. (This utility should be set to run at regular 
intervals by a scheduling tool).The software will also automatically change the status of 
the floor plan to Historical when it is superseded by a more recent plan. 

Batch processes can be used when the floor plan reaches Publish status to auto-generate 
the pertinent floor plan and planograms. 

Communicating Information 
Store Manager can also be used as a medium for communicating information. This is 
done in several ways. 

• File Notes 

It is possible to attach notes (short lines of text information) to floor plans. This enables 
store planners in Macro Space Management and In-Store Space Collaboration (who may 
be based in very different locations) to communicate requests and information to each 
other. This information can be seen in the Notes tab of the floor plan Properties dialog 
box. 
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• Publishing a Floor Plan 

When a floor plan is Published, a hard or electronic copy can be generated via a batch 
process. The retailer must the use their own systems to disseminate this copy of the floor 
plan to the store in preparation for putting it into effect. Simultaneously, the retailer must 
generate a report specifying the equipment, merchandise and signage required to put the 
floor plan into effect. Orders will then need to be placed so that these items are available 
when required. 

Batch processes can be used when the floor plan reaches Publish status to auto-generate 
the pertinent planograms. 

• Making a floor Plan Effective (Current) 

When a floor plan is made effective (current), that is the signal for it to be put into 
service. The retailer should create a report identifying which store plans have achieved 
Current status and notify the stores accordingly.  

Reports and the Macro Space Planning Database 
Information generated in Store Manager is stored in the Macro Space Planning database. 
It will generally require custom reports to disseminate this information to other 
departments and stores within a retail organization. Example of reports could include: 

 Floor plans that have reached a stage in their business life cycle that requires 
approval before the next stage is commenced. 

 Floor plans that have reached published status. 
 Bills of material for the equipment in a floor plan 

 Lists of products and planograms in a floor plan 

 Lists of floor plans that have reach current status and need to be put into service. 

 KPIs for the performance of merchandise in a floor plan. 

These reports are not supplied with the application. It is the responsibility of the retailer 
to develop appropriate reports that suit their specific business processes. 
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Integrating Store Manager into Retail Processes 
Every retailer will have their own business processes. This section of the user guide can 
only cover basic principles in brief detail. It is intended to give new users of the 
application some insights into how store manager could be used within the existing 
processes. Users will have to adapt the general principles to suit their specific case. 

Identify Need for Floor Plan Change 
Typically the need for producing a new floor plan will originate from an external system. 
For example, a specific category in category management might have seasonal 
components that require updating. An instance of this might be in the meat department, 
where the 'Bacon and Sausage' category might be allocated more space in the summer 
season than in winter due to increased sales because of barbecues in the summer months. 

The retailer will have to have some form of system integrating Category Management 
and Macro Space Planning so that requirements to update floor plans can be 
communicated from one system to another. 

Floor Plan Created in Store Manager 
As a result of the identified need, instructions would be given to a store planning 
manager to create a revised floor plan. The manager in turn would give instructions to a 
specific floor planner to create a new floor plan (or modify an existing one). 

Floor Plan Ready for Approval 
When the floor planner has completed the floor plan, a retailer's internal systems would 
probably require approval. This could be done in many ways - for example a senior 
manager could be given In-Store Space Collaboration enabling them to view the reports 
and KPIs before deciding whether to approve or reject the proposed floor plan. 

Floor Plan Set to Authorised Status 
On the floor plan getting approved, it can be set to Authorised status. This allows two 
dates to be set: 

1. The Publish Date 

The Publish Date specifies the date at which the floor plan is to be to be sent to the 
store in preparation for implementation. It is also the date at which information on 
the equipment and merchandise required for the changes need to be sent to supply 
chain management so that they can be placed on order.  

7. The Effective Date 

The Effective Date schedules the date at which the floor plan will come into service 
(becomes Current). It can also serve as advance information for a Workforce 
Management System as to the amount of labor, etc., required for the changes. This 
would allow the retailer to plan for labor utilisation within the store or arrange for an 
external merchandise change management organization to come in on the scheduled 
date.  

Update Status Changes Floor Plan Status to Published 
Update Status is a small Macro Space Management utility that is typically run every 
night by means of a scheduling tool. At the appropriate date it will change the status of 
the floor plan to Published.  
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Publishing Planogram Designs and Floor Plan 
At the same time as the status is changed, other batch tools can be used to publish any 
pertinent planogram designs in the floor plan and publish the floor plan itself. This 
information will be put in specified folders on a specific server. The retailer will have to 
use their reporting systems to identify the quantities of equipment, merchandise and 
signage needed to make the change. This information will then need to be communicated 
to the supply chain systems and orders placed. 

The retailer will also need to use their systems to distribute the planogram designs and 
the floor plan to the store, together with information on when the changes are intended 
to come into effect. 

Note: As well as ordering the equipment, merchandise and 
signage, other preparatory work may be required - for 
example in ensuring the labor is available to make the 
changes on the specified date. 

Update Status Changes Floor Plan Status to Current 
Update Status (run by the scheduling tool) changes the status of the floor plan to current. 
Retailers can develop a reporting tool to identify all floor plans scheduled to become 
current within a specified period and confirm that the store has made the necessary 
preparations to put the changes into effect.  

Financial KPIs and Reports 
Macro Space Management allows retailers to understand how efficiently they are using 
space within their bricks and mortar outlets. Running KPIs and reports enables retailers 
to optimize future floor plans. It also allows information to be fed back into Category 
Management to optimize future categories and their associated assortments. 

Importing Data and Setting up Store Manager 
Before commencing use of Store Manager, though needs to be given as to what data is 
imported and how data is to be structured within Store Manager. 

Importing Data 
Macro Space Management has a Data Import module. This enables data to be taken from 
external databases and imported into the Macro Space Planning central database. 
Activating this module brings up the MSM Data Importer dialogue box. 

 

This allows the classes of data to be imported to be selected. Data Importer is fully 
configurable 
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Oracle’s consultants can configure the exact nature of the data import so that specified 
data is selected from the designated databases and imported into the required fields 
within Macro Space Management’s central database. 

Configuring the Store Manager Hierarchy 

General 
Before Macro Space Management can be used, it is necessary to set up a Hierarchical Tree 
within Store Manager. This structure enables the stores to be arranged in logical 
groupings by means of Clusters and Sub-clusters. 

The performance of individual Stores can be compared against selected Prototype Stores, 
while the performance of one cluster of stores can be compared against another cluster. 

The structure of this hierarchical tree should be carefully considered as it will affect the 
quality of information that can be produced using Macro Space Management, and hence 
determine the effectiveness of Macro Space Management as a tool for improving the 
profitability of a business. 

Planning the Structure 
Typical information needed to plan how individual stores should be assigned within the 
structure includes: 

 Store Size 

 Store Turnover 

 Store Location 

 Store Demographics 

Criteria can then be developed as to cluster types, and hence whether individual stores 
should be assigned to single or multiple clusters. 

For example, a store could be associated with three separate and distinctive clusters. One 
cluster would enable the store to be compared against those in other regions, one against 
stores of similar turnover, and the third against stores of similar size. 

Consideration should also be given to which stores can be designated as Prototypes for 
comparison purposes. Correctly assigned prototype stores will also allow swift and 
effective comparison of individual store performance against an exemplar. 

A correctly planned structure can significantly improve the performance of a retail 
organization – a poorly planned structure could prevent the full power of Macro Space 
Management being used. 
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4 
Store Manager - Overview 

Overview of Store Manager Module 

Accessing the Store Manager Module 
Store Manager can be accessed from either the Planner or Merchandiser modules. 

In Planner, Store Manager is accessed by clicking on the Open File option in the standard 
toolbar. Alternatively, the Open File option can be selected from the File menu. 

  

In Merchandiser, Store Manager is also accessed by clicking on the Open File option in 
the standard toolbar. Alternatively, the Open File option can be selected from the File 
menu. 

 

Overview of Module 
Oracle’s Macro Space Management software combines the traditional merchandising 
approach with store planning, construction, operation and inventory management. It is 
designed to maximize profitability and returns by enabling the optimum layout and mix 
of products to be efficiently planned right across an organizations’s range of retail 
outlets. 

Macro Space Management contains large amounts of information. This can be as specific 
as the current contents of a shelf in a single store or as general as the floor plans to be 
implemented business wide in 6 months time. This mass of information has to be 
organized and administered. Within Macro Space Management this is achieved by the 
Store Manager module. 

Store Manager operates in a similar way to Windows Explorer. It has been designed to be 
easy to use and allows information to be grouped in a way that reflects the structure of 
the organizations. 
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The menu and tool bars can be seen to the top left of the window. 

A frame showing the hierarchical tree of Clusters, Stores, Floors and Revisions can be 
seen to the left of the window. 

The files associated with a particular Revision can be seen in the frame to the upper right. 

A preview of the drawing to be selected can be seen towards the lower right. 

Using Store Manager you can: 

 Assign your retail outlets to logical groupings, allowing comparisons and 
analysis of sales to be made between individual stores or groups of stores. 

 Assign or change floor plans for stores, allowing the effects of differing store 
layouts or merchandising mixes to be evaluated. 

 Carry out routine administration on the files used within Macro Space 
Management. 

 Get reports on the data used within Macro Space Management. 

 Interface with external programs allowing import and export of data to and from 
those programs. 

Note: Macro Space Management's sister program, In-Store 
Space Collaboration, can be used to access and edit drawings 
held in the central Macro Space Management database. 

The Store Manager Menu Bar 
The Store Manager Menu bar contains several options: 
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File activates a pull down menu with options primarily concerned with operations on 
files. 

 

Some of these may be grayed out depending on what Store Manager function is being 
used. 
This menu can be used to add, edit and delete files and to associate files and architectural 
plans. 

Edit activates a pull down menu with options to cut, copy and paste files. 

 

Some of these may be grayed out depending on what Store Manager function is being 
used. 

View activates a pull down menu with various options controlling the way Store 
Manager appears. 

 

These can be used to change the way Store Manger displays information. 
The Tools option is only available to administrators and is toggled on and off by means 
of <Ctrl + A>. 
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It contains a series of options used to check in files, check directory integrity, import files 
and create hierarchies. 

The Store Manager Toolbar 

 

 The Store Manager toolbar contains a series of options for administering the objects and 
files in Macro Space Management. Depending on which operation is being carried out, 
one or more options may be greyed out (unavailable). 

  

Icon Description 

 

 Close Store 
Manager 

 

 Open a 
Drawing 

 

 Add an Item 

 

 Edit an Item 

 

 Delete an Item 

 

 Create reports 

 

 Associate File 

 

 Associate 
Architectural 
Plan 

 

 Search 

 

  

Cut 
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Icon Description 

 

 Copy 

 

 Paste 

 

 Properties 

 

 Large icons 
for files 

 

 Small Icons 
for files 

 

 List of files 

 

 Details of files 

Basic Concepts 
This section of help covers some basic concepts helpful to new users. 

Hierarchical Structures 
A Hierarchical structure is one where objects are organized in the form of a tree. The 
more fundamental data is close to the trunk, while the more dependent data is further 
out on the branches. The most fundamental part of the hierarchical structure is the root. 

 

Hierarchical structures are used to allow objects to be set out in a logical relationship to 
each other. 

The Prototype stores cluster contains prototype stores of different sizes. These stores each 
have floors associated with them - and the floors have revisions associated with them. 
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Parent-Child Relationships 
Some objects within Store Manager are linked together in such a manner that changes to 
one object may result in changes to other objects linked to it. Such objects are described as 
being in a parent-child relationship. The object that has dependent objects associated 
with it is known as the parent, while the objects that are associated with the parent object 
are known as the children. 

In a hierarchical structure, children of one parent can be parents of their own children in 
turn. 

When the status of a parent object is changed; it can often result in changes to the status 
of child objects. Similarly, the status of parent objects can sometimes only be changed 
when the status of the appropriate child object is correct. 

When a parent object is deleted, it affects all the associated child objects. Conversely, a 
child object can often be deleted without affecting the parent. 

 

In the above example, the Ground Floor is a child of the Small Prototype store, but is a 
parent several Revisions - including 'Store with Fixtures'. 

Status 
Status defines the current standing of an object within the business life cycle. 
For example, Stores generally have three statuses. 
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At the beginning of the process, the Store has a Proposed status as it is only at the design 
stage. When the store has been built, its status will change to Open. Finally, if the store 
has reached the end of its useful life, it will be assigned Closed status. 

The status of an object thus changes as Macro Space Management users move through 
the business cycle. 

Publish and Effective Dates 
Publish and Effective dates are associated with the status of a floor plan. 

The Publish date is the date at which the floor plan is issued to the stores. Floor plans are 
typically published a number of days or weeks in advance of the time the changes are 
required. 

The Effective date is the date at which the published drawing becomes current. 

Publish and Effective dates can be turned on of off by making changes to the 
ENABLE_FILE_TRIGGER_DATES system variable in the Administration Module. 

Note: It is STRONGLY recommended that users discuss this 
with Oracle’s Technical Support team before making the 
changes. 

Once enabled, Publish and Effective dates can be used to automatically change the status 
of revisions and drawings by making use of the UpdateStaus.exe file in the Macro Space 
Management/Tools sub-directory. 

Note: UpdateStatus.exe can be set to run on a daily or 
weekly basis by the Windows task manager, allowing some 
degree of automation of common tasks. However, for full 
automation of common tasks, it is recommended that Macro 
Space Management users use the Enterprise version of 
Macro Space Management. 
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RFBin 
The RFBin is Macro Space Management’s equivalent of the Recycle Bin. Files marked for 
deletion are sent to the RFBin, but will not be permanently deleted until the Purge option 
is used in the Tools menu. Its location is specified in the Directories tab of the 
Configuration module. 

 

The path to this directory can only be changed by users with rights to the Administration 
module. 

Overview of Objects 
This section of help describes the objects found in the Store Manager hierarchy. 

Store Root 

  

The Store Root is the origin of the hierarchical tree. All other data emanates from the 
root. 

Normally, stores are grouped in clusters and sub-clusters. However, it is possible to add 
stores directly at the root level without them being associated with a cluster or sub-
cluster. 

Clusters 
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A Cluster is a logical grouping of stores that meet specified criteria. Examples of possible 
groupings for Clusters include stores that are: 

 In the same country. 

 In the same region. 
 Of the same size. 

 Of the same turnover. 

 Of the same internal layout. 

Clusters of a specific type can be further divided into sub-clusters. 

Sub-Clusters 

 

A Sub-cluster is a sub-division of a Cluster. Sub-clusters are used to allow a finer level of 
detail when analyzing the performance of groups of stores. 

For example the cluster of stores labelled England might be further sub-divided into sub-
clusters called north, central and south. 

Stores 

 

A Store is the unique description of a specific retail outlet. Stores are made up of one or 
more floors. 

Stores are normally associated with one or more clusters; although they can, (less 
usually), be directly associated with the Store Root. 

Floor 

 

A Floor is a distinct physical level within a store. 

A Floor can contain one or more revisions, (arrangements of fixtures and fittings), 
associated with it. 

Revision 

 

Revision is the name given to a version of the arrangement of fixtures and fittings on a 
floor. Floors can have many revisions. For example, a floor could have Spring, Summer, 
Autumn and Winter revisions, each representing a planning arrangement to be used at 
the appropriate time. 
Revisions are often color coded to show their status. Floors can also have different 
revisions showing different marketing mixes, fixture arrangements, etc. 
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Files 
A File is a general description for a category of records. Floor plans are files, as are 
Architectural Plans. 
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The Store Manager Hierarchy 

General Note on Adding, Editing and Deleting Objects 
There are three broad ways of invoking the Add, Edit or Delete options. 

File Menu 
Objects can be added to, edited in or deleted from the hierarchy by highlighting an 
appropriate object and selecting the pertinent option from the File menu. 

 

Toolbar 
Objects can be added to, edited in or deleted from the hierarchy by highlighting an 
appropriate object and selecting the pertinent option from the Toolbar menu. 

 

Right Click Menu 
Objects can be added to, edited in or deleted from the hierarchy by highlighting an 
appropriate object right clicking to bring up the Right Click Menu. 

 

Deleted Objects 
Whether objects are visible after deletion depends on whether the Show Files Marked 
for Deletion option has been selected in the Options dialog box accessed from the View 
menu. If selected, objects marked for deletion will show with a black cross. 



The Store Manager Hierarchy 

Adding, Editing and Deleting Clusters  41 

 

If not selected, the objects marked for deletion will be hidden from view until purged. 

Adding, Editing and Deleting Clusters 

Add and Edit Dialog Boxes 
The Add and Edit dialog boxes are identical but for the title. Only the Add dialog box 
will be shown in this section, but the descriptions of the fields equally apply to the Edit 
dialog boxes.  

Adding (and Editing) Clusters 
To add a Cluster, highlight the Store Root or another cluster and select Add from the File 
Menu, Toolbar or Right Click Menu. The Add Cluster dialog box will appear. 

 

Cluster ID: once the dialog box is saved, this field will populate with the ID that is the 
primary key in the database. 

Cluster Name: This is the name assigned to the cluster. 

Cluster Type: This is assigned from a drop down list. It is normally used as a filter for 
reporting purposes. 
Cluster Code: This is the unique identifying code assigned to the cluster. 

Deleting Clusters 

To delete a cluster, highlight it and select Delete from the File Menu, Toolbar or Right 
Click Menu. The cluster is now marked for deletion but will not be permanently 
removed until purged using the Purge option from the Tools menu. 

Adding, Editing and Deleting Stores 

Add and Edit Dialog Boxes 
The Add and Edit dialog boxes are identical but for the title. Only the Add dialog box 
will be shown in this section, but the descriptions of the fields equally apply to the Edit 
dialog boxes.  

Adding (and Editing) Stores 
To add a store, highlight the parent cluster and select Add from the File Menu, Toolbar 
or Right Click Menu. The Add Store dialog box will appear. There are four tabs. 

1. General Tab 
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In the General Tab: 

Store ID: Once the dialog box is saved, this field will populate with the ID that is the 
primary key in the database. 

Store Code: This is the unique code used to identify the store.  

Store Name: this is the name of the store. 

Directory Name: This is the name of the directory that will be automatically created 
to hold the files associated with the store. It will be created below the Store Root 
specified in the Directories Tab of the Configuration Module.  
Latitude: This can be entered to identify the position of the store. 

Longitude: This can be entered to identify the position of the store. 

Status: This is set from a drop down list. It specifies where the store is in its business 
life cycle. 

Opened Date: This is the date the store is scheduled to open. If the store is not at 
Open status when this date is reached, Update Status will automatically change the 
status to Open. 

Closed Date: This is the date the store is scheduled to close. If the store is not at 
Closed status when this date is reached, Update Status will automatically change the 
status to closed. 

Store Prototype: This enables the user to specify another store to be used as a 
prototype for comparison purposes. Available prototypes are set by selecting the Set 
as Prototype check box. 

Set as Prototype: This check box designates the store as a Prototype. If set as a 
prototype, it cannot have a prototype store assigned to it. 

2. Units Tab 
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• Input Units 

Length: These are the default length units used for the floor plan. 

Area: These are the default area units used for the floor plan. 

8. Display/Output Units 

Length: These are the default length units used for displaying information the floor 
plan. 

Alternative Length: These are the alternative length units used for displaying 
information for the floor plan. 

Area: These are the default area units used for displaying information the floor plan. 

Alternative Area: These are the alternative area units used for displaying 
information for the floor plan. 

9. Address Tab 
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Address: There are 4 lines available to enter the address of the store. 

Post Code: This field holds the post code of the store. This might be used in the UK. 
Area Code: This field holds the area code of the store. This might be used in the US. 

Telephone: This field holds the telephone number of the store. 

10. Attributes Tab 

 

The attributes tab contains the name and value of the User Defined Attributes 
assigned to the store. These are configured in the Administration Module and will 
vary from retailer to retailer. 



The Store Manager Hierarchy 

Adding Stores to Multiple Clusters  45 

Deleting Stores 
To delete a store, highlight it and select Delete from the File Menu, Toolbar or Right 
Click Menu. The store is now marked for deletion but will not be permanently removed 
until purged using the Purge option from the Tools menu. 

Adding Stores to Multiple Clusters 
Stores can belong to more than one cluster. This enables stores sharing a common 
characteristic to be grouped together for reporting, control or planning purposes. 

 

In the above example, the New York store is in the following clusters: 

 North America 

 Large Stores 

 Regional Manager 1 

This enables New York to be selected along with all stores in North America, all Large 
Stores or all stores supervised by Regional Manager 1. 

Note: Copying a store merely associates it with multiple 
clusters - it does not duplicate the floor plans associated with 
the store. 

Adding Stores to Multiple Clusters 
To add a stope to a multiple cluster, highlight the store and chose the Copy option from 
the Edit menu, Toolbar or right click menu. Select the required cluster to copy the store 
to and use the Paste option from the Edit menu, Toolbar or right click menu. 

Removing Stores from Multiple Clusters 
To remove a store from a cluster, highlight the store then select the Delete Link option 
from the right click menu. This will remove the database link between the store and that 
specific cluster, but it will remain associated with any other clusters it has been copied 
into. 

  



Adding, Editing and Deleting Floors  

46 Oracle Retail Store Planner's User Guide 

Adding, Editing and Deleting Floors 

Add and Edit Dialog Boxes 
The Add and Edit dialog boxes are identical but for the title. Only the Add dialog box 
will be shown in this section, but the descriptions of the fields equally apply to the Edit 
dialog boxes.  

Adding (and Editing) Floors 
To add a floor, highlight the parent store and select Add from the File Menu, Toolbar or 
Right Click Menu. The Add Floor dialog box will appear. 

 

Floor ID: Once the dialog box is saved, this field will populate with the ID that is the 
primary key in the database. 
Floor Type: This is the type of floor. It is set from a drop down list which is pre-
populated with names like Basement, ground floor, etc. 

Description: This is the name given to the floor. 

Directory: This is the name of the directory that will be automatically created to hold the 
files associated with the floor. It will be created below the directory for the parent store. 

Status: This is set from a drop down list. It specifies where the floor is in its business life 
cycle. 

Allocated Area Tolerance: This is a value that can be entered for reporting purposes. It 
allows the actual area allocated for retail purposes to be compared with some theoretical 
value. 

Elevation: This field can be used to specify the height above ground level for reporting 
purposes. 
Edit Levels: This button can be used to edit the default levels for items of equipment that 
are to be placed at levels other than floor level. Examples would be posters and banners. 
If not activated during the creation of the floor, these levels cannot be edited later. 
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Adding, Editing and Deleting Revisions 

Add and Edit Dialog Boxes 
The Add and Edit dialog boxes are identical but for the title. Only the Add dialog box 
will be shown in this section, but the descriptions of the fields equally apply to the Edit 
dialog boxes.  

Adding (and Editing) Revisions 
To add a floor, highlight the parent floor and select Add from the File Menu, Toolbar or 
Right Click Menu. The Add Revision dialog box will appear. 

 

Revision ID: Once the dialog box is saved, this field will populate with the ID that is the 
primary key in the database. 

Revision Number: This is a number that can be assigned to the revision. 

Revision Description: This is the name of the revision. 

Directory: This is the name of the directory that will be automatically created to hold the 
files associated with the floor. It will be created below the directory for the parent floor. 

Status: This is set from a drop down list. It specifies where the revision is in its business 
life cycle. 

Season Description: This drop down list allows the user to select a season from a list of 
predefined seasons. If set, this can be used (in conjunction with the Custom SQL) to filter 
data in the Object Grid. 
Birth Date: This is the date the revision was created. 

Death Date: This is the date the revision went out of service. 

Adding, Editing and Deleting Floor Plans 

Adding Floor Plans 
If the Add Proposal Drawing check box is selected when a new revision is created, a new 
floor plan will be automatically created in the new revision. To add a new or additional 
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floor plan, go to the right hand pane in Store Manager and bring up the right click menu. 
Select New Drawing. A new floor plan will be created. 

 

When the floor plan is first created, it will be auto-assigned a name - in this example 
Proposal290. 

 

This name can be changed by highlighting it and selecting Rename from the right click 
menu. 

Editing Floor Plans 
When a floor plan has been added, it can be edited by highlighting it and selecting the 
Properties option on the Right click menu. This will bring up the Properties dialog box. 

Details Tab 
The Details tab contains information of the floor plan. 
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File Name is the name assigned to the file - this will typically be the name of the floor 
plan. 

Location is the path to where the physical copy of the DWG file is held. This will be 
below the Store Root specified in the Directories Tab of the Configuration Module. 
(This tab is only accessible if the configuration module is opened via the Administration 
module). 

File Predecessor is the name of the file this file was derived from. This will be populated 
if the file was created automatically as a result of the Planogram Substitution process.  

Type shows the extension of the file - and hence its type. The DWG extension indicates it 
is an AutoCAD file. 

Size is the physical size of the file. 
File Status is where the floor plan is in its business life cycle. See the section on statuses 
for more information. 

Prototype Store is the name of another store which can be used for comparison purposes. 
After being set up through the Custom SQL, it is possible to compare the selected floor 
plan with the floor plan at Current status in the prototype store. This enables differences 
to be compared for reporting purposes. 
Active Date is the date at which the floor plan is scheduled to come into service. This 
date can be used as a filter to determine whether equipment of merchandise will be 
available for placement at the time which the floor plan will be made current (active). 

Publish Date will be grayed out and unavailable until the floor plan is at Authorised 
status. Once set, the publish date is the date at which Update Status will automatically 
change the status of the floor plan to Published. A copy of the floor plan will then be 
placed in the designated export directory for onward transmission to the store in 
preparation for putting the floor plan into service. When the Publish Date first appears, it 
will be set to a default value by the software. 

Effective Date will be grayed out and unavailable until the floor plan is at Authorised 
status. Once set, the effective date is the date at which Update Status will automatically 
change the status of the floor plan to Current. This is the signal (via an appropriate 
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reporting system) for the store to put the floor plan into effect. When the Effective Date 
first appears, it will be set to a default value by the software. 

Created is the date the floor plan was originally created in Store Manager. Alternatively, 
if the floor plan was imported, this will be the date it was originally created in raw 
AutoCAD.  

File Modified is the date the floor plan was originally created in Store Manager. 
Alternatively, if the floor plan was imported, this will be the date it was last modified in 
raw AutoCAD. Once the file has been saved in Planner, the database will hold the date of 
that save but the File Modified field will continue to show the date it was last modified in 
raw AutoCAD. 
Last Modified is the date the file was last saved by a user in the Planner or Merchandiser 
modules or in In-Store Space Collaboration. 

Modified by Automation is the date the file was last modified by a batch process such as 
planogram substitution. 

Last Modified By is the individual or process that last modified the file.  

Note: The Created, File Modified, Last Modified and 
Modified by Automation dates can be used to decide on 
how to manually synchronize the floor plan if Auto-
Synchronization is not enabled: see the section on 
synchronisation.  

File Last Published is the date the file was last published as a result of Update Status 
being run. 

File Made Current is the date the file was made current - typically as a result of Update 
Status being run. 

File Made Historical is the date the floor plan was superseded as a current file by 
another floor plan. This change is made automatically by the software and the date set 
accordingly. 

ID is the value of the FIL_ID field in the AVTTB_FILE table in the database. This 
information is provided to assist support personnel in problem solving.  
Checked Out indicates whether the file is in use or not. 

Notes Tab 
The Notes tab holds details of notes created in both Macro Space Management and In-
Store Space Collaboration. These notes are visible in both applications and serve both to 
record and communicate data.   
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 Macro Space Management 

Notes can entered by typing them into any vacant line. Existing notes can be edited 
by selecting them then typing a revised entry. Notes in MSM only apply to the floor 
plan itself and cannot be applied to objects within that floor plan. 

 In-Store Space Collaboration 

ISSC users can add notes to the floor plan. They can also add notes to objects in the 
floor plan such as zones and fixtures. These notes can be read in MSM.  

UDA Option 
Clicking the UDA button will bring up the Floor Plan User Defined Attributes dialog 
box. This holds retailer specific information for the floor plan. In the example below, it 
has been configured to hold information on why the floor plan is being updated.  
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The list of available fields can be configured using the User Defined Attributes option 
from the General Menu in the Administration module. Users in Store Manager can then 
set the values for each floor plan. Depending on how each field has been configured in 
the Administration module, users can enter numeric, text or currency values, select from 
a drop down list, enter a date from a calendar or tick or untick a check box. 

Some values can be defined as mandatory when they are configured in the 
Administration module. These are indicated by a blue asterisk. If a mandatory value is 
not filled in this will be indicated by a red cross; as can be seen for the Responsible 
Planner field in the screen shot below. 

 

 If the user attempts to close the User Defined Attributes dialog box without setting a 
mandatory attribute, a warning will result. 

 

• Accessing the File UDA dialog box directly 

If required, the File UDA dialog box can be accessed directly from the right click 
menu in the list pane store Manager. 

 

If multiple floor plans have been selected, the File UDA dialog box will display the 
attributes for the last floor plan selected. 

Importing, Exporting and Copying Floor Plans 
Floor plans can be either imported or copied. 
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Importing Floor Plans 
Floor plans can be imported into Store Manager. This is done by highlighting an existing 
floor plan (this can be a blank) and then selecting the Import New Version of Drawing 
option from the right click menu. 

 
This will bring up the Import Drawing dialog box.  

 
This enables uses to browse to the Windows folder holding the floor plan and select it. 
On clicking the Open button, the Import New Version of File dialog box will appear. 
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Users can select whether to keep the existing file name or use that of the file to be 
imported. 

Important Note: objects in the imported floor plan will not 
be written to the MSP database until the file has been 
synchronised 'Match the Drawing'. Blocks in the imported 
floor plan that also exist in Fixture Studio will then be 
written to the database. 

Exporting Floor Plans 
Floor plans can be exported from Store Manager by highlighting the pertinent floor plan 
then selecting Export from the right click menu. This will bring up the Export Drawing 
dialog box. 

 
The filename will be a composite of the form: Store Name_Floor Name_Revision 
Name_File Name. After selecting an appropriate directory, the file can be exported by 
clicking the Save button. 

Copying Floor Plans 
Floor plans can be copied within a revision or from one revision to another. Copying is 
done by highlighting the required floor plan then selecting the Copy option from the 
right click menu. After navigating to the required location, the Paste option can be used 
from the right click menu to place a copy of the file. At the same time and exact copy of 
all existing information in the database for the original file is created for the copied file. 

Note: If copying from one floor to another, any architectural 
plans associated with the original should be temporarily 
unchecked. Once the floor plan has been pasted to the 
revision in the new floor, it can be associated with any 
architectural plans associated with that floor. The 
architectural plans can also be re-associated with the old 
floor plan. 
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Associating Architectural Plans 

Overview of Architectural Plans 
Architectural Plans can only be associated with Floors. They contain information on the 
structure and fabric of the building including the position of walls, doors, electrical 
systems and other services. 

 

The above screen shot shows a DWG type architectural plan in isometric view. Its 
outlines show fainter than other objects in the floor plan because it effectively servers as 
an underlay to the floor plan. This architectural plan shows the structure of the store and 
allows the zones to be correctly drawn and the fixtures correctly positioned with respect 
to the walls, doors and windows. 

Architectural plans are used in two stages: 

1. They must first be associated with a parent floor in Store Manager. 

2. After the architectural plan has been associated with a specific floor, it can then be 
associated with any child floor plan. This is done from the Insert menu in the 
Planner module once the floor plan has been opened in Planner. 

Types of Architectural Plans 
Macro Space Planning recognizes two forms of architectural plans:   

 DWG files can only be used within the Planner module. 

 DWF files can be used both within the Planner module and in In-Store Space 
Collaboration (ISSC). 

Because of a current limitation of the software, if a DWF file is to be used for ISSC, it 
must be associated before any DWG files are associated for use in Planner. If this is not 
done, the DWF file will fail to appear in ISSC. 

Associating an Architectural Plan 
Architectural plans can only be associated with floors. Once associated this makes them 
available for use within any floor plan associated with the parent floor. Architectural 
Plans can be associated by highlighting the required floor then selecting the Associate 
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Architectural Plan command from the File menu, the Toolbar or the right click menu. 
This will bring up the Architectural Plan Association dialog box. 

 

1. Browse to the required file 

2. Click OK 

3. The file will be copied to the specified folder and will become available for use 
within individual floor plans. 

Note: The architectural plan will not appear in an individual 
floor plan unless it is associated with it using the Insert 
menu in the Planner module once the floor plan has been 
opened in Planner. 

Associating Files 
Files can be associated with any level of the store hierarchy except clusters. Any form of 
file can be associated including: 

 Word documents 
 Excel spreadsheets 

 PDF Files 

These files can be used for many purposes including: 
 Performance reports at store, floor and floor plan level 

 Store specific information on suggested improvements to merchandise 

 Non-MSP information that will be useful for store planners. 

How to Associate Files 
Files can be associated by selecting the Associate File command from the File menu, the 
Toolbar or the right click menu. This will bring up the File Association dialog box. 
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1. Browse to the required file. 

2. Specify whether the file is to be copied into Store Manager or whether a link is to be 
created to an external file. 

3. Click OK. 

4. If the file is copied, a copy will be imported into the appropriate folder in Store 
Manager. 

 
5. If a file is linked, MSP will hold a copy of the path to the file. 

Note: If linking to a file, ensure it is available on a network 
resource or it might not be available to all users.  

The advantage of linked files is that the latest version will be available if they are 
updated by an external program. Copied files will need to be re-imported in order that 
the latest version is available in Store Manager. 

Deleting Associated Files  
Deleting associated files may be carried out by highlighting them then selecting the 
Delete command from the File menu, the Toolbar or the right click menu. The file will 
not be permanently deleted until the Purge option is used from the Tool menu. 
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Status 

Overview of Statuses 

Concept of Statuses 
Statuses are used to indicate where an object is in its business life cycle. For example a 
store will go through a design stage, be built, be opened, be closed for refurbishment, 
reopen for business and finally be closed as its structure wears out or it is sold. By being 
able to set statuses in the store hierarchy, store planners can indicate where stores, floors, 
revision and floor plans are in their business life cycle - and hence control activities based 
on that information. The example below shows example statuses for a store.  

 

For example, a floor plan may go through a series of stages during the planning 
processes - these would include laying out the equipment, receiving approval for that 
layout, laying out the merchandise, receiving approval for that merchandise, authorizing 
that floor plan to go into service, publishing the floor plan, putting it into service and 
finally retiring it from service. 

Because a large retail organization may have several thousand stores and an even large 
number of floor plans, it is standard practice to set up a report identifying which objects 
have had their statuses changed recently and what actions are required. 

Configuring Statuses 
Macro Space Planning has a set of default statuses configured. The list of available 
statuses can be modified using the Status dialog box in the Administration module. This 
also allows the order statuses are displayed, whether they are reversible, whether files 
become read only when the status is selected, etc. 
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Note: See the Administration Module User Guide for more 
information. 

 

Users and In-Store Space Collaboration 
Users in In-Store Space Collaboration have the ability to indirectly change the status of a 
floor plan. When closing and saving a floor plan, some users have the option to Accept or 
Reject that floor plan. This will result in the present status of that floor plan being 
changed to a predefined alternative. 

Non-Reversible Statuses 
Some statuses are set to be non-reversible - users can select that status, but having 
selected it cannot then manually reset that status to an earlier one.  

Non-Selectable Statuses 
Some statuses can be set to not be selectable manually. An example of this is Current 
status as floor plans are normally automatically changed to that status by the Update 
Status functionality. 

Example of Controlling Business Flows with Statuses 
The following is a simple example of how statuses can be used to control business flows: 
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1. The process flow starts with a floor plan at Proposal status. 

2. After laying out the fixturing, the store planner changes the status to Fixturing ready 
for Approval. This alerts his manager. 

3. The manager reviews the layout of the fixturing. If they disagree with it, they set the 
status back to Proposal - causing the store planner to rework the fixturing. If the 
manager agrees with the layout of the equipment they change the status to Fixturing 
Accepted. 

4. Once the status has been changed to Fixturing Accepted, the store planner places the 
merchandise. When this is complete, the store planner sets the status to Merchandise 
ready for Approval. 

5. The manager reviews the layout of the merchandise. If they disagree with it, they set 
the status back to Fixturing Accepted - causing the store planner to rework the 
products and planograms. If the manager agrees with the layout of the equipment 
they change the status to Merchandise Accepted. 

6. At an appropriate time, the manager then changes the status to Layout Verified and 
Ready for Store Approval. This makes the floor plan visible in In-Store Space 
Collaboration. 

7. The store manager opens the floor plan in ISSC. They have two choices when saving 
it. Clicking Reject will change the status back to Proposal, starting the whole 
planning process again. Clicking Accept will change the status to Authorised. The 
Publishing and Effective dates will then be set.  

8. When the Publish date is reached, the Update Status tool will change the status to 
Published, causing a copy of the floor plan to be sent to the store in preparation for 
its implementation.  

9. When the Effective date is reached, the Update Status tool will change the status to 
Current. The store will then be notified to put the plan into effect. 

10. When another floor plan for that store becomes current, the existing store plan will 
be superseded and will be set to Historical status. 
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Changing the Status of Objects 

Changing Statuses 
Statuses can be changed by selecting the required store, floor, revision or floor plan in the 
store hierarchy. It can then be opened for edit using the right click menu or the edit 
option from the Edit menu on the menu bar or the edit option from the toolbar.  

Clusters 
Clusters and sub-clusters are administrative devices for arranging stores in logical 
groupings. As such they do not have a status. 

Stores 
Statuses for stores are set using the Status drop down list in the Store dialog box. 

 

If a store is set to Closed, all associated floor plans will be set to Read Only status. Any 
attempt to open those files for editing will result in the appearance of a warning dialog 
box. 

 

Floors 
Statuses for floors are set using the Status drop down list in the Floor dialog box. 
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If a floor is set to Closed, all associated floor plans will be set to Read Only status. Any 
attempt to open those files for editing will result in the appearance of a warning dialog 
box. 

 

Revisions 
Statuses for revisions are set using the Status drop down list in the Revision dialog box. 

 

If a revision is set to Closed, all associated floor plans will be set to Read Only status. 
Any attempt to open those files for editing will result in the appearance of a warning 
dialog box. 
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Files 
Statuses for revisions are set using the Status drop down list in the File Properties dialog 
box. 

 

Some statuses for floor plans may not be reversible - for example, if the status is set 
manually to Published, it may not be possible to set it back to an earlier date. Other 
statuses are not selectable - for example it is not generally possible to set the status to 
Current manually as this is normally done automatically when Update Status is run. 

When the floor plan status is set to Authorised, it becomes possible to set up Publish 
Date and Effective Date. 

 When the Publish Date is reached, Update Status will change the status to 
Published. 

 When the Effective Date is reached, Update Status will change the status to 
Current. 
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Advanced Administration 

Customizing Display Options 
The appearance of some aspects of the Store Manager module can be customized via the 
Options option on the View pull down menu. This brings up the Options dialogue box. 

 

Show Files Marked for Deletion  
The Show Files Marked for Deletion option is used to specify whether files marked for 
deletion are to remain visible or are to be hidden. If the Show files option is chosen, files 
marked for deletion will be shown with the deleted icon. 

 

Note: Files marked for deletion are not permanently 
removed from the database until the Purge option has been 
used from the Tools menu. 

Show Store Codes 
This option allows users to specify whether on not the Store Code will be displayed 
before the Store Name in the store hierarchy. 
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Show Grid  
If active, this option adds a grid to the list of objects displayed in the list view pane on the 
right hand side of Store Manager. 

Show Large Icons  
This check box changes the icon size. 

Show Tooltips for Tree View  
If active, this option displays the store, floor or revision code when the mouse pointer is 
held over the object within the Store Manager hierarchy. 

Show Tooltips for List View  
If active, displays the full path when the mouse pointer is held over a file in the list view 
pane on the right hand side of Store Manager. 

Show Document Preview  
If active, this option puts a preview of the document at the bottom of the Store Manager 
Window 

Date Format  
This option uses a drop down list to select the form the date is displayed in. 

Enable Drag and Drop 
If enabled, this allows the Store hierarchy to be rearranged by dragging and dropping. 

Enable Automatic File Renaming 
This option is not currently active. 

Enable Column Reordering 
If active, this allows the columns in the list view pane on the right hand side of Store 
Manager to be dragged and dropped to a different order. 

Enable Editing 
This option is not currently active. 

Enable Multiple File Selection 
If active, this option allows the user to multi-select files for further operations. 

Populate on Demand 
The Populate on Demand Option does not load full information for the store hierarchy 
until the users opens a specific branch. That branch is then populated with full data as 
the user opens it. If this option is not selected, all branches of the hierarchy populate as 
Store Manager is opened. 
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Windows Folders and the Store Hierarchy 
Store Manager has a specified structure: 

1. Clusters 
2. Stores 

3. floors 

4. Revisions 

5. Files 

Specific files associated with specific levels on the hierarchy will be in the appropriate 
folders. For example Architectural plans will be in folders associated with floors and 
floor plans in folders associated with revisions. 

 

Clusters only exist in the Macro Space Planning database. For Stores, Floors and 
Revisions, Windows folders are created below the Store Root specified in the Directories 
tab of the Configuration module - this tab can only be accessed if the Configuration 
module is accessed via the Administration module. 
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Any physical files associated with specific levels on the hierarchy will be in the 
appropriate folders. For example Architectural plans will be in folders associated with 
floors and floor plans in folders associated with revisions. 

Searching the Store Hierarchy 
The search facility can be activated by clicking the search icon on the toolbar. 

 

This brings up a dialogue box with a dialogue box with a series of options. Select the 
required options and click on OK. 

  

The search function in Store Manager performs an in-string search and does not support 
wild-cards. It will thus only return exact matches. 

The search starts from any selected node, and can be set to search up or down from that 
node. 

Significance of Dates in File Properties Dialog Box 
The File Properties dialog box that can be accessed from Store Manager contains a series 
of dates that give information on how and when the file was last modified or processed. 
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These dates have the following significance: 

 Created: This is the date the floor plan was originally created in Store Manager. 
Alternatively, if the floor plan was imported, this will be the date it was 
originally created in raw AutoCAD. 

 File Modified: This is the date the floor plan was last modified in raw AutoCAD. 

 Last Modified: This is the date the file was last saved by a user in the Planner or 
Merchandiser modules or in In-Store Space Collaboration. 

 Modified by Automation: This is the date the file was last modified by a batch 
process such as planogram substitution. 

These dates are often used to decide on the correct actions when manually or 
automatically synchronizing the floor plan. 

Note: See the section on synchronization for more 
information. 

List Checked Out Files 
Checked out files are files that the database has flagged as being in use for some reason. 
These include: 

 File is checked out to a user in either Macro Space Management or In-Store Space 
Collaboration. 

 File is checked out to a batch process. 
 File has remained checked out due to a software problem. 

In these instances, users with access to Store Manager can manually check the files back 
in. 

Note: If the file is manually checked back in, all changes 
since the previous save will be lost. 

 

Selecting All Checked Out Files lists every file checked out from Store Manager. 

Selecting My Checked Out Files lists the files checked out by that particular log in 
identity. (This can also be accessed by <Ctrl + O>). 
After the option has been selected, the user has the option to check files back in by 
highlighting them then clicking Check In. 
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Purging from Store Manager 
The Purge option allows users to permanently delete several types of object: 

 Objects in the Store Manager hierarchy such as clusters, stores, floors, revisions 
and floor plans. 

 Back-up files for AutoCAD (files with a BAK extension) 

 Text log files created for Store Manager. 

Removing Objects from the Store Manager Hierarchy 
Permanent removal of objects from the Store Manager hierarchy is done in two stages. 

1. The required object is marked for deletion in the store hierarchy. If the selected object 
is a DWG file, it will be moved to the RFBin. The location of this folder is specified in 
the Directories tab of the Configuration Module. (This tab is only accessible when the 
Configuration module is accessible via the Administration module). 

2. The objects are permanently deleted using the Purge option from the Tools menu. 

Deleting Objects 
Depending on settings in the Options dialog box (View menu), objects marked for 
deletion will either be hidden from view or denoted with the Deleted icon. 
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Purging Objects 
Purging objects results in their permanent removal from the Macro Space Planning 
database. In the case of the DWG files used for floor plans, these will also be physically 
deleted from the RFBin - where they were move to when marked for deletion.  

Note: Purged DWG floor plans files cannot be recovered, so 
care should be taken to ensure they are no longer required. 

To purge objects, select the Purge option from the Tools menu. 

 

This will bring up the Items Marked for Deletion dialog box 

 

Items marked for deletion are highlighted and then removed by clicking Destroy. 

Note: The right click menu gives the option to Select All 
Files, Deselect All Files, Destroy or Undelete files. 

Objects cannot be deleted if they have child objects associated with them. The most 
common example of this occurring is when an architectural plan is in the list of files to be 
deleted. All floor plans associated with the architectural plan should be deleted before 
the architectural plan itself is deleted. 

Purging .BAK files 
When Planner modifies a file, some settings in Planner can cause it to save a back-up 
version. This is saved with the file extension .BAK. Because floor plans can be large, these 
.BAK files can occupy a considerable amount of server or hard disc space. Purging the 
files frees up this space and may improve performance. 
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Purging Log Files 
Store Manager writes a series of log files when any errors occur. These files accumulate 
over time. The "purge log files" allows the option of deleting these files; either between a 
date range, or on the user’s computer. 

 

Importing directories 
The Import Directory option allows files to be imported into the Store Manager file 
structure and corresponding entries to be made in the database. The import process is as 
follows: 

Preparation 
The files to be imported must have a data structure compatible with Store Manager – the 
files should be in the store/floor/revision/file hierarchy. If there are multiple stores to 
import, these files should under a common directory. 

Importing  
A parent cluster should be selected within the Store Manager hierarchy, (or created if 
required). This parent cluster will be the target for the files to be imported. 

1. The Import Directory option should then be selected from the Administrator menu. 
This will bring up a dialogue box called Directory Structure Import. This has three 
options called Preview, Options and Results. 
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11. In the Preview tab, use the Browse button to navigate to the require source for the 
directories to be imported. 

12. In the Options tab specify the file extensions to be excluded from the import. 

13. Click the Import button to import the information. 

14. The results can be seen in the Result tab. 

Store/Cluster view 
Selecting the Store/Cluster view option brings up a window allowing an alternative way 
of viewing the information held within the hierarchical data structure within Store 
Manager. Stores are listed in the sequence determined by their unique identification 
code. The cluster to which the store has been allocated is displayed immediately below 
the store. 

 

Where stores are assigned to multiple clusters, this will be shown. For example the Berlin 
store belongs to both the Europe and Large Store clusters. 
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Integrity Check 
The Integrity Check compares the store directory structure shown in the current display 
window with that registered in the database. Any errors found are displayed and should 
be brought to the attention of the Systems Administrator for rectification. 

 

 The ID column contains a list of the File ID’s used by Macro Space Management as 
references for the files. If a File ID is missing, this means a problem with the directory 
structure. 

The Type is the type of object. It can be a Store, Floor or Revision. Clusters and sub-
clusters will not appear as they are folders for holding files, not files themselves. 

The Description is the name given to the object. 
The Path is the path in the directory structure to the designated object. 

Log Files 
Log files are files recording events and problems during operation of Macro Space 
Management. This enables problems to be investigated at a later date. 

They can be found at the location specified in the Directories tab of the Configuration 
Module - this tab is only available if the configuration module is open via the 
Administration module. 
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Double clicking on a specific file will bring up a log of that aspect of Macro Space 
Management’s operations. 

Note: In many cases, log files have been superseded by 
information written back to tables in the Macro Space 
Planning database. 
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Overview of UpdateStatus.exe 
UpdateStatus.exe is a small Macro Space Management tool that can be used to change the 
status of floor plans.  

 

1. The initial stage is to set the Publish and Effective dates when a floor plan reaches 
Authorized status 

2. Update status is set to execute every night by means of a scheduling tool. 

3. When the Publish date is met or exceeded, the status of the floor plan is changed to 
Published. 

4. When the Effective Data is met of exceeded, the status of the floor plan is changed to 
current. 

5. At the same time as the status of the floor plan is changed to current any pre-existing 
current file for that floor is changed to Historical status. 

Running Update Status 
There are three ways of running UpdateStatus.exe; directly, using Windows Scheduler or 
using another batch scheduling tool. It is normal to install a copy of Macro Space 
Management on the batch server - UpdateStatus would generally be run from there. 

1. Running Directly 

To run UpdateStatus.exe directly, navigate to the C:\Program Files\Oracle 
Retail\MSM\Common directory on the batch server. 
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Click on AVT5UpdateStatus.exe to run the file. 

2. Through Windows Scheduler 

Windows Scheduler gives the option of running UpdateStatus.exe automatically at 
set intervals. 

3. Through other Batch Scheduling Tools 

UpdateStatus.exe can also be run though more advanced batch scheduling tools. 

Using UpdateStatus.exe 
To use UpdateStatus.exe the following actions are required. 

 

The process is carried out as follows: 

1. Open the file Properties dialog box 

This is done by highlighting the required file within the right hand pane of Store 
Manager then right clicking to bring up the pop-up menu. Selecting Properties from 
this menu will bring up the Properties dialogue box. 
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Note: setting the varying values required for Update Status 
is carried out by clicking the down arrow on the pertinent 
field. In the above screenshot, the effective date is being set.  

1. Set File status to Authorized 

This is done by highlighting the required file within the right hand pane of Store 
Manager then right clicking to bring up the pop-up menu. Selecting Properties from 
this menu will bring up the Properties dialogue box. 
2. Set the Publish Date 

The Publish Date is the date at which the floor plan will be set to Publish status by 
Update Status. This will allow the requisite store to begin preparations for 
implementing the changed floor plan. The default Publish Date is set a specific 
number of days ahead of date the value is being set - this time period is set by the 
PUBLISH_DATE_LEAD_PERIOD system variable in the Administration module.  

The Publish Date can be set using the drop down calendar. 

3. Set the Effective Date 

The Effective Date is the date at which the floor plan will be set to Current status by 
Update Status. This is the date at which the requisite store will carry out the changes 
required for the floor plan. The default Effective Date is set a specific number of days 
ahead of date the value is being set - this time period is set by the 
EFFECTIVE_DATE_LEAD_PERIOD system variable in the Administration module.  

The Effective Date can be set using the drop down calendar. 

4. Run UpdateStatus.exe 

Update status can be run manually. However, it is more normal to run it using a 
scheduling tool.  
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 When the Publish Date is met or exceeded, the status of the file will be changed 
to Published. 

 When the Effective Date is met or exceeded, the status of the file will be changed 
to Current. 

Note: If a floor contains several files of Authorized status 
with Effective dates before the date Update Status.exe is run, 
only the latest file will have Current status - all other files 
will have Historical Status.   

  If run directly, a small pop-up window will report the results.  

 

Note: UpdateStatus.exe will not actually publish the file or 
notify the store that Publish or Current status has been 
reached. This has to be done via MSMs Automated Floor 
Plan Publishing functionality and the retail organizations 
own reporting tools. 

Potential difficulties with UpdateStatus.exe 

Multiple Authorized Files within a Floor 
If there are multiple Authorized files within a floor, when UpdateStatus.exe is run, it will 
sequentially change them to Current status based on the Effective Date. As each file is 
changed to Current status, it will change the preceding file to Historical Status. 

Note: Each Revision can only contain one Authorized file. 
Therefore, if a floor is to have multiple Authorized files, 
multiple Revisions must be created for that floor. If a floor 
only has a single Revision then this can only contain a single 
Current file and a single Authorized file. (It can contain 
multiple Proposed and Historical files. If a floor has multiple 
revisions, then care must be taken to keep track of which 
Revision contains the Current version of the drawing. 

Files with an Effective Date greater than the date UpdateStatus.exe is run will not have 
their status changed. 

All Effective Dates set to a date before the date UpdateStatus.exe is run will be changed 
to Current status in the sequence based on the date and time they were authorized. This 
will result in all but the last file set to Authorized being set first to current, and then to 
historical status. 

This means that only the last file to be set to Authorized will retain Current status. 

Status of Revisions 
UpdateStatus.exe does not currently change the status of Revisions when floor plans 
within the Revision have their status changed. 
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It is therefore currently possible to have a Current file in a Revision that is not of Current 
status. 

Dates  
UpdateStatus will change the status of a floor plan depending on whether the Publish 
Date or Effective Date has been met or exceeded. Running Update status at 23.30 on 12th 
June will have a different date to running it at 00.15 on 13th June, although the two 
instances are only 45 minutes apart. 
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Object Browser 

About the Object Browser 
The Object Browser offers Macro Space Management users a single point of access to the 
Zone, Fixture, Product, and Planogram libraries and the Key Performance Indicators 
(KPI’s).   It is found in both the Planner and Merchandiser environments and is used to 
control the various activities within those environments. 

 

The Object Browser can be turned off by clicking on the ‘x’ in the upper right corner. It 
can be opened by selecting the Show Object Browser option on the View drop down 
menu. 
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The Object Browser has a series of parts. These are described below. 

 

Tabs allow the Object Browser to be switched from one function to another. 

At present, the Object Browser can be used to added, edit, and delete Zones, Fixtures, 
and Merchandise. 

Each tab has the same general components. 

A Toolbar at the top allows various functions to be accessed. These typically allow 
adding, editing, and deleting of the required objects, together with searching, filtering 
and refreshing options. 

The Fixturing and Merchandising Tabs have Sub-Tabs. 

In Fixturing, the user can click on one or other button to select Fixturing or Gondola 
operations. 
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In Merchandising, the user can use the buttons to switch between planograms and 
products. 

Each tab has a series of Information Windows. These vary from tab to tab but can 
include: 
 Hierarchical trees: These give information on what objects can be added, edited, 

or deleted in the drawing. In the Zones Tab for example, the hierarchical tree 
allows the user to select different types of zones. 

 The Properties window: This gives details of the selected object. 

 The Summary window: This gives totals of types of objects placed in the 
drawing. 

 The Preview window: This shows a low resolution image of the selected object. 
In the fixturing tab for example, this would be an image of the selected fixture. 

The Information windows can be opened or closed by clicking on the Splitter Bars. 

The Refresh Option 
All toolbars have a Refresh option. 

 

Clicking Refresh will update the application with the latest information from the 
database. This means that if information has been updated in another module (for 
example the Administration module) since the application was opened Planner (or 
Merchandiser) will be updated to match. 

For example, if the zone definitions have been updated in the Administration Module 
after Planner was opened, clicking Refresh will bring the updated information into 
Planner. 

The Zones Tab 

Overview of the Zones Tab 
Macro Space Management uses Zones to assign space to different departments and non-
sales areas.  The zone types available to your business are customized within the 
Administration Module.  Zones can also be used to help user’s select fixtures or 
merchandise. 

The Zones tab is divided into four sections: 

 The Toolbar – provides controls to add, modify, and delete zones from a store 
plan. 

 The Zones Window – shows a hierarchy of available zones. 

 The Properties Window – when a Zone is selected from the hierarchy, its 
properties are visible in this window. 
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  The Summary Window – shows details of the zones based on the open store 
plan. 

Note: Zones are ‘read only’ in the Merchandiser 
environment. Accordingly, the majority of the functionality 
that is present when the Object Browser is used in the 
Planner module is not operative. 

Toolbar 

Planner 

 

Icon Description 

 

Add Zone 

 

Add Hole 

 

Delete all Zones of 
that type 

 

Delete selected Zone 
or Hole 

 

Highlight Zone in Store 
Plan 

 

Highlight Selected zone 
in Tree 

 

Detect Clashes 

 

Options 

 

Refresh 

 

Hatch 

 

Remove Hatch 

Merchandiser 
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Icon Description 

 

Options 

 

Refresh 

The Hierarchy Window 
The hierarchy window displays the zone hierarchy. This hierarchy is defined in the 
Administration module and shows all the zones that can be added to a store plan. 

 

The hierarchy can be expanded using the plus control next to each item on the hierarchy. 
It can also collapsed by using the minus control next to each item. 

The Properties Window 
The Properties window displays information for the zone that has been selected in the 
zone hierarchy. The content of this window is customizable. 

 

The Summary Window 
The Summary window displays information on the zones placed in the open store plan. 
The content of this window is customizable by an Oracle Retail consultant. If set up to do 
so, this window can also show the zones drawn in the prototype store plan and their 
areas. This allows the user to see what zones should be added to the new store plan and 
the target areas. 
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The Fixturing Tab 

Overview of the Fixturing Tab 
The Fixturing tab allows users to add fixtures, fittings, gondolas and other equipment to 
the store plan. It is divided in to five parts as follows: 

 The toolbar – provides controls that allow users to add, edit, and delete fixtures 
and gondolas 

 The Fixtures window – shows a hierarchy of available blocks and gondolas 

 The Properties window – after selecting a block from the hierarchy, this window 
shows the details for the selected block.  The content of this window is 
customizable by an Oracle Retail consultant 

 The Summary window – shows details of equipment placed based on the active 
store plan. The content of this window is customizable by an Oracle Retail 
consultant 

 The Preview window – shows an image of the object selected in the fixture 
hierarchy. 

Note: In Merchandiser, fixtures can only be added by 
dragging and dropping from the hierarchy. The Add icon is 
not active. 

The Fixturing Tab Toolbar in the Object Browser enables the user to control all aspects of 
adding, editing and deleting fixtures and gondolas within the Planner and Merchandiser 
environments. 

Clicking on the Switch Buttons will determine whether the Fixturing or Gondola options 
are active. 

Fixturing Toolbar 

 

Icon Action 

 

Add Fixture 

 

Edit Fixture in Fixture 
Studio 

 

Delete Fixture 

 

Highlight Fixture in 
drawing 

 

Highlight selected item 
in tree 

 

Find 
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Icon Action 

 

Options 

 

Refresh 

 

Show Attributes 

 

Promotional Fixtures 

  

Note: When Fixtures are added, the Add Fixture dialogue 
box (present in the Planner Environment) does not appear in 
Merchandiser. 

Gondola Toolbar 

 

Icon Action 

 

Add Gondola 

 

Edit Gondola in Fixture 
Studio 

  Delete gondola option not 
available 

  Highlight Gondola  in 
drawing option not available 

  Highlight selected item in tree 
option not available 

  Find Option not available 

  Options not available 

 

Refresh 

 

Show Attributes 

 

Promotional Fixtures 

The Hierarchy Window 
The Hierarchy window displays both the block and the gondola hierarchies.  To toggle 
between the hierarchies use the Blocks or Gondolas buttons respectively. The hierarchies 
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are defined in the Fixture Studio environment and show all the fixtures and gondolas 
that can be added to a store plan. 

The hierarchy can be expanded using the plus control next to each item on the hierarchy. 
It can also collapsed by using the minus control next to each item. 
An item in the hierarchy can be highlighted by clicking on the name of the block or 
gondola. 

 

The Properties Window 
The Properties window displays information for the block that has been selected in the 
blocks hierarchy.  The content of this window is customizable. 

 

The Summary Window 
The Summary window displays information on the blocks placed in the open store plan. 
The content of this window is customizable. 

 

The Preview Window 
The Preview window shows a sample picture of the block selected in the block hierarchy. 
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The preview is not updated when the Gondola hierarchy is displayed. 

Placing Fixtures and Gondolas 

Placing Fixtures - Planner Module 
To add a block to the store plan, highlight the required block in the hierarchy. You can 
then either press the Add Fixture button on the tool bar, or drag and drop the fixture to 
the store plan drawing. When a block is added the Insert fixture dialog opens. 

 

These controls allow blocks to be positioned accurately in the store plan. Pressing the left 
mouse button places the block in an initial position. Pressing the right mouse button or 
the <Esc> key finishes placing the block. 

Placing Fixtures - Merchandiser Module 
To add a block to the store plan, highlight the required block in the hierarchy then drag 
and drop the fixture to the store plan drawing. 

(The Insert Fixture dialogue box will not appear in Merchandiser). 

Placing Gondolas 
To add a gondola to the store plan, highlight the required gondola in the 
hierarchy.  Press the Add Gondola button on the toolbar or drag and drop the gondola to 
the store plan drawing. 
The user is prompted to select a start point for the gondola. Pressing the left mouse 
button opens the Gondola Run dialog box. 
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The Gondola Run dialog box allows the user to select the dimensions of the blocks to use 
in the gondola.  It also allows the number of bays or length of the gondola to be set.  Once 
the desired options have been set, pressing the OK button closes the dialog and places all 
the blocks required for the gondola run in to the store plan. 

The Merchandising Tab 
The Merchandising tab allows users to add product placeholders (products), and 
planogram placeholders (planograms) to the store plan. A product is any category, sub-
category, or SKU that is included in the product hierarchy, i.e. any level in the hierarchy. 
Planograms are also organized in to a hierarchy of planogram groups. However, you can 
only place planograms in to the store plan. Planogram groups cannot be placed. 
Placeholders are markers that can be placed on to fixtures to indicate the product 
category, sub-category or planogram that will be used. 

The Merchandising tab is divided in to 5 parts: 

 The toolbar – provides controls that allow products and planograms to be added, 
edited, and deleted 

 The Merchandise window – shows a hierarchy of available products and 
planograms 

 The Properties window – shows details for the product that has been selected in 
the product hierarchy. Similarly, it will show details of a planogram that has been 
selected in the planogram hierarchy. The content of this window is customizable 
by an Oracle Retail consultant. 

 The Summary window – shows details of products and planograms placed based 
on the active store plan. The content of this window is customizable by an Oracle 
Retail consultant 

 The Preview window – shows a sample picture of product display styles selected 
in the product hierarchy 
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Note: Product display styles are only available in 
Merchandiser. In Merchandiser, products and planograms 
can only be added by dragging and dropping from the 
hierarchy. The Add icon is not active 

The Merchandising Tab Toolbar in the Object Browser enables the user to control all 
aspects of adding, editing and deleting products and planograms within the Planner and 
Merchandiser environments. 

Clicking on the Switch Buttons will determine whether the Product or Planogram options 
are active. 

Products Toolbar 

 

Icon Action 

 

Add Product 

 

Edit Definition 

 

Delete Product 

  Reverse Product 
Placement Direction (not 
active) 

 

Highlight in Store 

 

Highlight in Tree 

 

Find 

 

Options 

 

Refresh 

  

Planogram Toolbar 
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Icon Action 

 

Add Planogram 

 

Edit Definition 

 

Delete Planogram 

 

Reverse Planogram 
Placement Direction 

 

Highlight in Store 

 

Highlight in Tree 

 

Find 

 

Properties 

 

Refresh 

The Hierarchy Window 
The hierarchy window displays both the product and the planogram hierarchies. To 
toggle between the hierarchies use the Products or Planograms buttons respectively. 
The Product hierarchy is defined in the Product Studio module and shows all the 
products that can be added to a store plan. The Planogram hierarchy can be configured in 
Merchandiser and shows all the planograms that can be added to a store plan. 

The hierarchy can be expanded using the plus control next to each item on the hierarchy. 
It can also collapsed by using the minus control next to each item. 

 

An item in the hierarchy can be highlighted by clicking on the name of the product or 
planogram. 
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The Properties Window 
The Properties window displays information for the merchandise that has been selected 
in the products or planograms hierarchy. The content of this window is customizable by 
an Oracle Retail consultant. 

 

The Summary Window 
The Summary window displays information on the merchandise placed in the open store 
plan. The content of this window is customizable by an Oracle Retail consultant. The 
window can show the merchandise allocated per zone in the prototype store plan. This 
allows the user to see what merchandise should be added to the new store plan. 

 

The Preview Window 
The Preview Window will be blank for products unless an image has been associated 
with that product in Product studio. It will always be blank for Planograms. 

The KPI Tab 
The KPI’s tab of the Object Browser allows users to see performance of a store plan at a 
glance. The available KPI’s are customizable and more can be added either by an Oracle 
Retail consultant or a trained Macro Space Management super user. 

The KPI tab is divided in to 4 parts: 
 The toolbar – provides controls that allow KPI’s to be run and modified 

 The Indicators window – shows a hierarchy of available KPI’s 

  The Layers window – shows a list of KPI’s that have been run against the store 
plan 

 The Legend window – shows the color bands associated with a KPI that has been 
run 

When the tab is first opened the Layers and Legend windows are blank. These windows 
are populated when a KPI is run. 
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Note: Some KPIs require information such as financial data 
to be imported into the Macro Space Planning database 
before they will work correctly. 

The KPI Tab Toolbars in the Object Browser are used to Add and Edit KPI’s. They are 
also used to Edit and Delete the list of KPI’s selected for display in the ViewPorts 

Upper Toolbar 

 

Icon Description 

 

Edit Indicator 

 

Edit Themes 

 

Add KPI 

 

Synchronize Views 

The Synchronize Views Icon allows the user to choose whether the ViewPorts are 
synchronized or not. One application of this is when ViewPorts are synchronized and 
three different KPI’s are opened in different windows. The ViewPorts will then show 
identical perspectives on the Virtual Reality environment with the information from 
different KPI’s overlaid. 

Lower Toolbar 

 

Icon Description 

 

View Data 

 

Edit KPI in list of 
those displaying 

 

Delete KPI from list of 
those displaying 

 

Refresh All 

These commands are user to alter the list of those KPI’s current displayed in the 
ViewPorts. 
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Running a KPI 
In order to run a KPI the user must highlight the KPI that is to be run from the hierarchy 
of Indicators that are shown on the Object Browser. 

Details Tab 
Pressing the Add KPI button opens the Key Performance Indicator dialog for the 
highlighted KPI with the Details tab active. Slightly different versions of the Details tab 
will appear in Planner and Merchandiser. Merchandiser has more options because it can 
show up to four views of the floor plan simultaneously. 

 

The Details tab shows the name of the selected KPI in the Name field. The user can edit 
this if they wish. This will only change the name that is shown in the Layers section of 
the KPI tab on the Object Browser and not the name of the KPI definition saved in the 
database. 

The Group By field is automatically populated with the KPI Type that was saved in the 
KPI definition. 

Stores Tab 
The Stores tab enables users to specify whether the KPI should be run against the current 
floor plan or a floor plan in an equivalent store. The latter option is useful when a new 
store is being planned and there is no operational data available for it. However, the store 
data is being taken from must be an exact clone of the new store or data will not map 
across directly. Using a store specific KPI also requires a KPI to be developed for the 
purpose. 
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Date Tab 
The Data tab has several options selectable by radio button. These can be used to specify 
the date range for the data where data is time sensitive. The initial action is to set the 
Data type. This can be set to any time period from a specific day to a year.  

 

The next stage is to set the specified date for the date. 

 Effective Date will use the Effective Date specified in the File Properties dialog 
box in Store Manager. This can only be used if the floor plan has not yet reached 
Current status and the Effective Date has been set. 

 Current Date will use the Current Date specified in the File Properties dialog box 
in Store Manager. This can only be used if the floor plan is at Current status. 

 Other Date can be manually set by the user using the Calendar control  

 Active Date will use the Active Date specified at the top of the Object Browser. 

When the OK button is clicked, the software will use the date and the data type to 
identify the correct calendar period. For example, if the date has been set to 21st June 
2013 and the Data Type has been set to Month, the software will select the data 
associated with the calendar period June 2013. 



The KPI Tab  

96 Oracle Retail Store Planner's User Guide 

Note: When selecting date specific data, that data must first 
exist in the database for the KPI to display correctly. 

Running the KPI 
Pressing the OK button will close the dialog and apply the KPI to the store plan drawing. 
The Layers frame will show the KPI that has just been run and the legend will be 
updated with the Color Theme for the KPI. 

 

KPI’s can be turned off in the store plan view by un-ticking the tick box next to the KPI 
name in the Layers pane on the Object Browser. If no KPI’s are ticked the store plan view 
returns to the normal view mode. 

Deleting the KPI 
The Delete KPI button removes the highlighted KPI from the list in the Layers pane. If 
this is the KPI being displayed in the store plan view, then the results will be cleared and 
the view returns to normal, i.e. with no KPI applied. 

Note: The Delete KPI option only removes the KPI from the 
current floor plan. The KPI definition is still saved in the 
database.  If the KPI needs to be run again, this can be done 
by selecting it within the KPI hierarchy again and clicking 
the Add KPI button. 
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10 
Object Grid 

About the Object Grid 
The Object Grid provides an alternative to selecting lower level objects in the Object 
Browser, including Zones, Fixtures, Products and Planograms. 

 

It is used in conjunction with the Object Browser and is available in both the Planner and 
the Merchandiser environments. 

Note: The OBJECT_GRID_DATALIMIT system variable is 
used to set the maximum number of limits that will be 
returned in the Object Grid. The optimum value for this 
system variable will vary from system to system depending 
on the performance of that system. The value set will have to 
be a compromise between execution speed of the query and 
whether the result set returned is sufficient for the user's 
needs. 

The Object Grid has the following major parts: 
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Tabs and Options 
There are three tabs: 

 The Data Tab contains a list of all returned results up to the limit set in the 
OBJECT_GRID_DATALIMIT system variable. Results are also constrained by the 
filters in use. 

 The Sort Tab allows the user to select the fields the data will be ordered by and 
whether the data will be in ascending or descending order. 

 The Filter Tab allows the raw data sent to the Object Grid to be filtered to a 
smaller sub-set before it is displayed in the Object Grid.  

For the settings in the filter and sort tabs to be active; the appropriate check boxes (just to 
the right of the tabs) must be selected. 

Search Options 
Once a result set has been returned, it is possible to search for any value in the results by 
entering that value into the text box and clicking the Find icon to the right. The results 
can be stepped through by repeatedly clicking the find icon. 

Refresh and Add Buttons 
For data to be added to the Object Grid, the refresh button must be toggled on 
(depressed). Clicking on a node in the appropriate hierarchy will return the results 
associated with that note. Highlighting a result and clicking the Add button will result in 
that object being added to the floor plan in Planner. Objects must be 'dragged and 
dropped' in order to add them to a Merchandiser floor plan. 

Columns 
The columns can be hidden or displayed by right clicking in them. 
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The order can be changed by 'dragging and dropping' them to a different order. 

Determining the Data that Appears in the Object Grid 
The data that appears in the Object Grid is determined by the Custom SQL in the 
AVTTB_CUSTOM_SQL table. System DBAs with access to the database can modify this 
Custom SQL to change the information that appears. 

Note: If the custom SQL includes a column named RGB, 
then the row will be colored using the value in the column. 
This will allow certain rows to be highlighted, which could 
be used indicate high performing products or planograms, 
or simply indicate which products have already been placed. 

Turning Object Grid Display On or Off 
The Object Grid Display can be turned off by clicking the close button in the upper right 
corner. It can be turned back on by using the Object Grid option on the View pull down 
menu in both the Planner and Merchandiser environments. 
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Note: The Object Grid can be ''dragged and dropped' to 
different sides of the screen if the Allow Docking option is 
selected from the right click menu. If Allow Docking is not 
on, the Object Grid can be positioned at any point on the 
screen. 

The Object Grid Sort and Filtering Tabs 

The Sort Tab 
The Sort tab allows the user to determine which columns will be used to sort the data 
and the priority with which they will be used. Settings will not take effect unless the Use 
Sort check box is ticked. 

 

The selected fields determine both the fields that will be used for sorting. The sequence 
they are selected in specifies the priority that will be used. The available fields for sorting 
will match the fields in the Data tab. The order specifies whether data will be shown 
ascending (A -->Z) or descending (Z-->A). 

Note: Data can also be sorted by clicking on the column 
headers in the Data tab. 

The Filter Tab  
The Filter Tab can be used to filter the full list of results down to a more restricted set 
pertinent to the fixtures being merchandised. Settings will not take effect unless the Use 
Filter check box is ticked. 
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 The Field specifies the field that is to be used to filter the data. The sequence they 
are selected in specifies the priority that will be used. 

 The Operator specifies how the value will be used. For example the = sign 
requires and exact match, the LIKE option uses implied wild cards to match all or 
part of the value being searched for. 

 The Value is the numeric or text value that is to be matched. 
 The Combination can be set to AND or OR. If set to AND, all conditions must be 

met. If set to OR, multiple conditions can be met. 

Note: The OR condition applies to all field set. If four AND 
fields and one OR field is specified, the OR field will return a 
set of results independent of the AND fields. 

Using the Object Grid 
The Object Grid will behave in different ways depending on which tab of the Object 
Browser is selected. The results returned can be customized by modifying the 
information in the AVTTB_CUSTOM_SQL table. (This table is only accessible by 
Administrators with access rights to the database). 

Zones Tab 
The Zones Tab gives the opportunity to return lists of products or planograms associated 
with specific zones. This can serve as a pre-filtering process - for example by returning all 
planograms associated with the Frozen Food zone. In the example below, highlighting 
the Tinned Goods zone in the Object Browser then clicking the Refresh button in the 
Object Grid has returned all planograms associated with that zone. 

Note: The Object Browser has been configured to show 
placed planograms in red and unplaced planograms in 
black. 
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This is controlled by Custom SQL using the following logic. 

 

When a planogram is created or imported, the planogram tables in the database will 
contain the Product ID for each planogram that identifies the node in the Product 
Hierarchy that is a common source for all products in the planogram. This product node 
can in turn be manually associated with a specific zone in the database, allowing that 
product node to be associated with that zone. 

When the Custom SQL (AVTTB_CUSTOM_SQL table in the database) is being set up to 
populate the Object Grid, it can reference that product ID, allowing the Object Grid to 
populate with merchandise associated with that zone. 
There are two ways this functionality can be used: 

 In an open floor plan in the Planner and Merchandiser modules 

 In an open planogram design in the Merchandiser module. 

In each option, only one form of merchandise (either products or planograms) can be 
selected on the basis of the zone it is associated with. Retails may configure this as they 
require, but the usual way is to configure the planograms associated with a specific zone 
to be selected in the floor plan, and the products in the planogram design window. 

Fixturing Tab 
The Fixturing Tab allows users to select fixtures based on their parent fixture group in 
the Object Browser. In the example below, the Basic Shelves Fixture Group has been 
selected in the Object Browser. Clicking the Refresh button on the Object Grid then 
returns all shelves associated with that fixture group and its child fixture groups. 

 



Object Grid 

Using the Object Grid  103 

Note: Gondolas cannot be selected using the Object Grid. 

Merchandising Tab 
The Merchandising Tab allows users to select products or planograms based on their 
parent group in the Object Browser. Clicking the Refresh button on the Object Grid then 
returns all results associated with that group and its children. 

Products 
Products can be selected at Department, Class or Sub-Class level by clicking at that level 
in the product hierarchy and then clicking the Refresh button on the Object Grid. 
Clicking at other levels in the hierarchy (for example Item) will result in an error 
message. 

 

Note: In the above example, more results have been 
returned than permitted by the maximum limit. This limit is 
set using the OBJECT_GRID_DATALIMIT system variable 
accessed using the System Variable option from the General 
menu in the Administration module. 

Planograms 
Planograms can be selected by clicking on the parent planogram group in the Object 
Browser, then clicking the Refresh button on the Object Grid. If the planogram group has 
child planogram groups, any planograms associated with those child groups will also be 
displayed. 

 

Key Performance Indicators 
The Object Grid cannot carry out any actions associated with KPIs. 
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Adding Objects 
The method of adding an object varies slightly depending on whether the user is in the 
Planner or Merchandiser modules. 

Planner  
Objects can be added from the Object grid into the drawing in two ways; by 'dragging 
and dropping' or by clicking on the Add button in the Data Tab. The Add button will 
only be enabled if an object is selected by clicking on it. Only a single object can be added 
to the drawing at one time. 

Merchandiser 
Objects can only be added by 'dragging and dropping' as the Add button is disabled in 
this environment. Only a single object can be added to the drawing at one time. 
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Calculations 

Overview of Calculations 
Macro Space Management has many capabilities. One of these is to understand space. 
After creating a floor plan, it is then possible to run a number of calculations that give 
information on how well (or how badly) the floor plan has been laid out. This 
information can then be used to further optimize the floor plan, enabling a retailer to 
maximise the sales and profit from the available area.  

One example is area calculations: this apportions the floor area in a specific floor between 
the fixtures in that floor. This data then allows the amount of aisle space allocated to a 
fixture to be taken into account. In the screen shot below, the red areas show points 
where customers can stand in a floor plan and see a lot of fixtures - including end caps. 
This enables a retailer to identify prime areas to place high margin merchandise.  

 

Custom Reports and KPIs 
The results of the varying calculations write back to tables within the database. The 
template database supplied does not contain any specific reports or KPI's that can make 
use of that information. However, one of the aims of Macro Space Planning is to allow 
users to understand the use of space within their bricks and mortar retail outlets. It is 
possible to produce custom reports or KPI's that will enable them to optimize that space. 
Some of the reports/KPIs that can be created are detailed for each type of calculation 
within this section of the user guide.  

Example of Use of Calculations 
Consider a number of categories associated with snacks and convenience buys. 
Users not using Macro Space Management will have information in tabulated form. 
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Category Base Linear (feet) Profit  Profit per foot Base Linear 

Crackers and Savory Biscuits 12 $3,600 $300 

Chocolate 16 $6,400 $400 

Crisps and Snacks 12 $3,000 $250 

Sweet Biscuits 8 $2,400 $300 

Sweets, Mints and Gums 4 $1,400 $350 

If users use the Allocated Area calculation, it is possible to extend this information to take 
into account the aisle space associated with the fixtures the products are on. For example, 
it is now possible to see that chocolate is showing a good profit when related to base 
linear, but a poor one when the about of floor space assigned to it is taken into account. 

Category 
Base 
Linear 
(feet) 

Profit  
Profit per 
foot Base 
Linear 

Allocated 
Area (Square 
Feet) 

Profit per 
Square 
Foot 

Crackers and 
Savory Biscuits 12 $3,600 $300 720 $5 

Chocolate 16 $6,400 $400 1,600 $4 

Crisps and Snacks 12 $3,000 $250 600 $5 

Sweet Biscuits 8 $2,400 $300 400 $6 

Sweets, Mints and 
Gums 

4 $1,400 $350 280 $5 

If used in conjunction with EPOS data, a KPI could be created that shows fixtures 
containing these products and whether they are on target for budgeted profit.  

 

Here a store planner (or store manager) can see at a glance which fixtures contain 
products that are performing well or badly. In this case it is possible to see an end cap is 
performing below expectations and further investigation is required to identify the 
reasons. 

Calculations and the Business Process 
Calculations - providing the necessary reports and KPI's are available - can be used at 
any stage of the store planning process. 
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The initial stage would be for a floor plan to be created or modified. Calculations would 
then be run on that store plan, leading to information on how effectively the space within 
the store was being used. This information would allow a store planner to keep returning 
to his floor plan and optimizing it.  Once optimized, the floor plan would be published 
and put into service. Once operational in a real life store, EPOS and other data from the 
'live store' could be used to determine what improvements to make in the next iteration 
of the floor plan. 

The necessary reports and KPIs resulting from the calculations are likely to be retailer 
specific - every retail chain has its own ideas and theories about how best to utilise the 
space within its retail outlets. These reports and KPIs can be developed from a thorough 
knowledge of the technicalities of retail and careful study of how data is stored within 
the Macro Space Planning database.  

General Technicalities for Calculations 

Initiating Calculations 
Calculations are initiated from the Calculations menu in Planner. 

 

Alternatively, they can be initiated from the Calculations menu in Merchandiser. 
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Imploded and Exploded Planograms 
Planograms can exist in two forms: 2D (imploded) and 3D (exploded). 

 

The example planogram on the left is imploded (2D) and takes the form of a product 
block occupying the volume of the planogram. There is no information on the shelves 
and individual products present. The planogram on the right has been exploded to 3D 
form and contains information on both shelves and individual products.  

Planograms can be changed between the imploded and exploded form in the 
Merchandiser module. The Face Plane and Space Measurement calculations will only 
return meaningful results for planograms in 3D (exploded) form that contain Display 
Styles. 

Information on Database Tables 
Information is provided in the following sections on the database tables associated with 
the calculations. These are not generally accessible to normal users, but only to those 
with the correct privileges for accessing the database. This information has primarily 
been provided as an aid to anyone intending to produce custom reports. 

 Allocated Areas 

Principles of Allocated Areas 
The Allocated Area calculation is used to apportion areas of floor space to specific 
fixtures. This allows reports on performance to take into account the way the floor has 
been laid out. 
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In the above simplified example, fixtures are shown with a solid outline and the resulting 
allocated area with a dotted outline. It can be seen that an end cap will receive a greater 
allocated area than a standard fixture, while a fixture at an aisle end could have an 
allocated area intermediate between the two. The result can be seen in the following 
table.  

Fixture Footprint Sales Sales 
ft2 

Allocated 
Area 

Sales 
ft2 

Standard 
Fixture 8 ft2 $1,200 $150 16 ft2 $75 

Aisle 
Fixture 

8 ft2 $1,800 $225 40 ft2 $45 

End Cap 8 ft2 $54000 $375 60 ft2 $90 

  

If performance figures were looked at purely on the basis of fixture area (footprint), it 
would appear that the aisle end fixture was performing well.  However, when the floor 
area allocated to it is taken into account, it can be seen that the sales per square foot are 
disappointing.  

This form of analysis allows a number of facets of floor layout to be explored: 

 Wider aisles may mean fewer fixtures in a store, but will increased product 
visibility lead to higher sales? 

 Are products performing badly because visibility for their parent fixture is poor 
and customers can't see them? 

 How significantly does fixture position (end of aisle, centre of aisle) impact on 
sales? 

Space Measurements 
The Allocated Area result is also used in the Space Measurement calculation. 

 Allocated Area Calculation Technicalities 
System Variables Affecting Allocated Areas 

The following system variables affect the allocated areas calculation: 

 AREA_LARGE_INCREMENT 

 AREA_MEDIUM_INCREMENT 
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 AREA_SMALL_INCREMENT 

 AREA_MAX_DISTANCE 

 AREA_UNIT_OF_MEASURE 

These system variables are set in the Administration Module - see the Administration 
Module User Guide for more information. 

Area Calculation Directions 
The directions for which the calculations apply for a specific type of fixture are set in the 
Block Details dialog box in Fixture Studio. 

 

Fixtures such as spinners or bins that can be seen from all directions might have all four 
area calculation directions set. Conversely, fixtures such as slatwalls will not have the 
products visible from the back and will have their directions set to left, right and 
forward. See the Fixture Studio User Guide for more information. 

Internal Area Zone and AREA_MAX_DISTANCE_SYSTEM_VARIABLE 
Two factors affect the maximum area that can be allocated to a fixture: the Internal Area 
zone and the AREA_MAX_DISTANCE system variable. 
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Individual fixtures feel out' in the specified directions until: 

1. They reach another fixture. 

2. They reach the boundary of the Internal Area zone.  

3. They reach the distance specified in the AREA_MAX_DISTANCE system variable. 

If the maximum distance is greater than the distance to the boundary of the Internal Area 
zone, the area allocated to that fixture will be determined by the distance to the Internal 
Area zone boundary. 

Sharing Areas between Fixtures 
If fixtures share areas, the space will be apportioned between them.  
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If we take the example of Fixture 1, it will feel out towards Fixtures 3 and 4. Similarly, 
Fixtures 3 and 4 will feel out towards Fixture 1. The total areas will be subdivided 
between then, which will approximate to the hatched areas in the diagram above. The 
end cap is more complex. It will feel out forwards until it reaches the boundary of the 
internal area. It will also feel out left and right and will be constrained by Fixtures 2, 3, 5 
and 6. The end cap will thus be allocated a larger area. 

Using the Allocated Area Calculation 

Running the Allocated Area Calculation 
The Allocated Area calculations can be run from the Calculations menu in either Planner 
or Merchandiser. 

 

Allocated Area Results 
Allocated Area results are stored in the AVTTB_FIXTURE table in the 
FIX_ALLOCATED_AREA field. 

 

Allocated Areas are only assigned to fixtures - they are not assigned to fittings, shelves, 
etc. As the AVTTB_FIXTURE table contains entries for all types of equipment, the results 
will have to be filtered to be specific for fixtures. 

Reporting Using Allocated Areas 
The default database supplied with Macro Space Planning does not contain any KPIs or 
Reports that use the results of Allocated Area calculations. These will have to be 
configured by the user; possibly using EPOS data. Possible reports include: 

 Fixtures with allocated areas above or below a specified value. 

 Total sales values per unit of allocated area. 

 Total profit per unit of allocated area. 

 Fixtures over and under-performing financially based on allocated area. 
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Aisle Adjacencies 

Principles of Aisle Adjacencies 
The Aisle Adjacency Calculation is used to assign fixtures to MSP Aisles. As these aisles 
have a direction, it is also possible to determine the sequence of the fixtures along that 
aisle. After products or planograms have been associated with those fixtures, it is then 
possible to generate reports stating whether those products are well or badly placed 
along the aisle.  

 

In the above example, Aisle 3 contains fixtures 18 - 22, with Fixture 18 at the start of the 
aisle and Fixture 22 at the end. It is then possible to use this information in custom 
reports. For example, once the planograms on the fixtures are known, it would be 
possible to: 

 Identify whether multi-bay planograms have been placed matching the direction 
of traffic flow they have been designed for. 

 Identify whether there are desirable product affinities - for example are pasta 
sauces next to pasta. 

Aisle Adjacency Technicalities 

System Variables Affecting Aisle Adjacencies 
The ADJACENCY_AISLESIZE system variable specifies the maximum distance that a 
fixture can be from an Aisle and still be associated with it. For example, if the 
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ADJACENCY_AISLESIZE is set to 48 inches (4 feet), no fixture greater than that distance 
from the aisle will be associated with it.  

Method of Measuring Distances 
The AVTTB_AISLE_ADJACENCY table contains two distances associated with a specific 
aisle. 

 AIL_DISTANCE_FROM_START 

This distance is measured from the start position of the aisle to the centre of the front of 
the fixture.  

 

In the above example, the red lines indicate the distances from the start of Aisle 2 to 
Fixtures 12, 13 and 14 is indicated by red lines. For this reason, it is best not to draw aisles 
using paths that wrap back on themselves.  
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In the above example Fixtures 1 and 6 will be shown as the closest to the start of the aisle; 
the true sequence along the aisle is 1 - 6. 

  AIL_DISTANCE_FROM_AISLE 

This distance is calculated perpendicular to the front of the fixture. 

 

In the above example the centres of the fronts of both fixtures are the same vertical 
distance from the aisle. However, because the distance to the aisle is measured 
perpendicular to the front of the fixture, Fixture 1 will be shown as being closer to the 
aisle than Fixture 2. 

Items of Equipment that can be Assigned to Aisles 
Only equipment of type Fixture can be assigned to aisles in the 
AVTTB_AISLE_ADJACENCY table. (Fixture types are assigned in the Category Tab of 
the Block Details dialog box in the Fixture Studio module - see the Fixture Studio User 
Guide for more information). 

In addition Fixtures will only be assigned to a single aisle - this will be the nearest aisle 
within the limits set by the ADJACENCY_AISLESIZE system variable. 

Using the Aisle Adjacency Calculations 

Running the Aisle Adjacency Calculation 
The Allocated Area calculations can be run from the Calculations menu in either Planner 
or Merchandiser. 

 

Aisle Adjacency Results 
Aisle Adjacency results are stored in the AVTTB_AISLE_ADJACENCY table.  
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Using Aisle Adjacency Results 
The default database supplied with Macro Space Planning does not contain any KPIs or 
Reports that use the results of Aisle Adjacency calculations. These will have to be 
configured by the user, and would require using data from other tables such as products 
(AVTTB_PRODUCT) and affinities between products 
(AVTTB_ADJACENCY_SEVERITY_TYPE). Possible reports include: 

 Identifying whether multi-bay planograms have been placed matching the 
direction of traffic flow they have been designed for. 

 Identifying whether planograms that require power (for example TV 
planograms) are in aisles that have been supplied with power 

 Identifying whether there are desirable product affinities - for example whether 
pasta sauces are next to pasta. 

 Identifying whether there are undesirable product affinities - for example 
whether shotgun shells are next to baby food. 

If the ADJACENCY_AISLESIZE system variable is set to a sufficient size, it is possible to 
include the fixtures on both sides of the aisle, allowing the product affinities to be 
established for products sharing the entire aisle.  

As an example, a short report could be generated for an aisle containing the 'Rice, Pasta 
and Noodles' category. 

Segment 
Side 
of 
Aisle 

Distance 
from 
Start 

Base 
Linear 
of 
Product 

Profit/Foot 

Instant Rice Left 0 ft 12 ft $125 

Ready to 
Heat Rice 

Right 0 ft 8 ft $150 

Instant 
Noodles Left 12 ft 8 ft $75 

Instant Pasta Right 8 ft 4 ft $125 

Dry Short 
Pasta Right 16 ft 4 ft $100 

This enables a store planner to see that the Instant Noodles segment with a profit of $75 
per base linear foot is placed in a prime position in the centre of the aisle yet is under-
performing. 

Fixture Adjacencies 

Principles of Fixture Adjacencies 
The Fixture Adjacency calculation is used for several purposes:  

 To determine which fixtures are assigned to a specific gondola and what the 
relationship of the fixtures are to each other within the gondola. 

 As a precursor to updating result in the AVTTB_FIXTURE_SEQUENCE table 
which is used to hold additional information on the arrangement of fixtures 
within gondolas. 

 As a necessary predecessor to the Product Adjacency calculation. 
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 As a necessary predecessor  to placing multi-bay planograms  in In-Store Space 
Collaboration 

The Fixture Adjacency calculation determines which fixtures are to the left, right, above 
or behind other fixtures. 

 
 In the above example, Fixture 2 has Fixture 1 to the left, Fixture 4 behind and to the right, 
etc.  

Fixture Adjacency Technicalities 

System Variables Affecting Fixture Adjacencies 
The following system variables affect the fixture calculation: 
 ADJACENCY_FIXTURE_SIZE 

 ADJACENCY_LATERALGAP 

 ADJACENCY_VERTICALGAP 

These system variables are set in the Administration Module - see the Administration 
Module User Guide for more information. 

Bitwise System Variables 
The results of the Fixture Adjacency calculations are stored in the 
AVTTB_FIXTURE_SEQUENCE table. The type of adjacency is stored in the ADJ_TYPE 
field as a bitwise system variable: 

1 = Adjacent to Right 

2 = Adjacent to Left 

4 = Adjacent to Back 
8 = Aisle Adjacency (Not in Use) 

16 = Not in Use 

32 = Adjacent Above 

Bitwise variables can be built up of combinations of numbers, so 5 = Adjacent to Right 
and Behind. 

Using Fixture Adjacencies 
The Fixture Adjacency calculations can be run from the Calculations menu in either 
Planner or Merchandiser. 
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Fixture Adjacency Results 
Aisle Adjacency results are stored in the AVTTB_FIXTURE_ADJACENCY table.  

 

More information pertinent to gondolas is stored in the AVTTB_FIXTURE_SEQUENCE 
table. 

 

Using the Fixture Adjacency Results 
1. Product Adjacencies 

Fixture Adjacency results are a necessary precursor for running the Product 
Adjacency calculations. 

2. Reports Based on Fixture Adjacencies 

Although it is not usual to generate reports or KPIs based on Fixture Adjacencies, it 
would be possible to produce specialised reports. An example would be to generate a 
report that used Fixture UDAs to identify if a fixture used to hold hot food has been 
placed directly behind a fixture used for frozen products.  

Product Adjacencies 

Principles of Product Adjacencies 
The Product Adjacency Calculation is used to determine the relationship of products on 
adjacent fixtures to one another. Products may be to the left, right, above or on the same 
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fixture as other products. Results are aggregated up to sub-class (sub-category/sub-
segment) level. 

 

A necessary precursor for running the product adjacency calculations is that the Fixture 
Adjacency Calculation has been run first.   

When run, Product Adjacency aggregates the products up to subclass (sub-category/sub-
segment) level and then reports which products are to the left/right/above other 
products. This information can then be used in conjunction with the Adjacency Severity 
rules to identify products that are well or badly placed. 

The Adjacency Severity rules are configured in the Administration module. 

 

The results are stored in the AVTTB_ADJACENCY_RULE table. 

Using Product Adjacencies 

Running the Product Calculation 
The Product calculations can be run from the Calculations menu in either Planner or 
Merchandiser. 
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Product Adjacency Results 
Product Adjacency results are stored in the AVTTB_PRODUCT_ADJACENCY table.  

 

Using the Product Adjacency Results 
The main way of using the product adjacency results (AVTTB_PRODUCT_ADJACENCY 
table) is in conjunction with the Adjacency Rules table (AVTTB_ADJACENCY_RULE 
table). This allows a report to be generated specifying whether products that are to the 
left, right or above another product are products that are desirable or undesirable to have 
in that relationship.  

Face Planes 

Principles of Face Planes 
Face Planes can be used to calculate the frontal area of products at display style level. 



Space Measurements 

Face Planes  121 

 

In the above example the base of the fixture contains a single product (1), the first shelf 
two products (2 & 3) and the top shelf three products (4, 5 & 6). The Face Plan calculation 
can be used to relate sales information to the frontal area of the products. 

Product 
Number Sales Area Sales ft2 

1 $225 4.5 ft2 $50/ft2 

2 $135 2.25 ft2 $60/ft2 

3 $90 2.25 ft2 $40/ft2 

4 $75 1.5 ft2 $50/ft2 

5 $45 1.5 ft2 $30/ft2 

6 $105 1.5 ft2 $70/ft2 

  

This allows (for example) space trading to be carried out. Product 5 is occupying the 
same frontal area as Product 6, but is generating less than half the sales per square foot. 
There would thus be a case to increase the number of facings of Product 6 and 
correspondingly reduce the number of facings of Product 5. 

Note: For a similar calculation using volumes see the section 
on Space Measurement. 

Face Plane Technicalities 

System Variables Affecting Face Plane Calculations 
There is no system variable connected with the Face Plane calculations. 

Imploded and Exploded Planograms 
Planograms can exist in two forms: 2D (imploded) and 3D (exploded). 
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The example planogram on the left is imploded (2D) and takes the form of a product 
block occupying the volume of the planogram. There is no information on the shelves 
and individual products present. The planogram on the right has been exploded to 3D 
form and contains information on both shelves and individual products.  

Planograms can be changed between the imploded and exploded form in the 
Merchandiser module. The Face Plane calculation will only return meaningful results for 
planograms in 3D (exploded) form that contain Display Styles. 

Display Styles 
Display Styles are the lowest level in the MSP Product hierarchy. Each display style is 
associated with a specific SKU and contains information on product dimensions. When 
the Face Plane calculation is run, results are aggregated up to the parent SKU. 

Calculation Method 
The calculation method is as follows: 

 

1. The total frontal area is found by multiplying the length of the shelf (or fixture) by 
the available height. 
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2. The frontage product occupies on the shelf is determined - for example Product 3 in 
the above example occupies 50% of the shelf. 

3. The total frontal area is proportioned among the products according to the frontage 
they occupy. 

  

Product Total 
Area Frontage Face 

Plane 

1 4 ft2 50% 2 ft2 

2 4 ft2 35% 1.4 ft2 

3 4 ft2 15% 0.06 ft2 

Using the Face Plane Calculations 

Running the Face Plane Calculation 
The Face Plan calculations can be run from the Calculations menu in either Planner or 
Merchandiser. 

 

Face Plane Results 
Face Plane results are stored in the AVTTB_FACE_PLANE table.  

 

Using the Face Plane Results 
There are a number of potential ways of using the face plane results. 

 By linking to individual planograms placed in a floor plan (AVTTB_PLANO 
table) to generate area based performance metrics. 

 By linking to the aisle adjacency table (AVTTB_AISLE_ADJACENCY table) to 
generate area based performance metrics for that aisle. 

 By linking to the product hierarchy (AVTTB_PRODUCT_DEF table) and the 
products placed in a floor plan (AVTTB_PRODUCT table) to generate area based 
performance metrics for entire categories, segments or sub-segments in a floor 
plan. 
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Space Measurements 

Principles of Space Measurements 
Space Measurements are used for calculating linear dimensions and volumes associated 
with planograms in a floor plan. These can then be combined with EPOS data for 
reporting purposes. For the full set of information in Space Measurements, the allocated 
area calculation must first have been run. In addition, the planogram must be in 
Exploded (3D) form - if not, the shelf linear figure will be inaccurate. 

Products will be aggregated up to sub-class (sub-category or sub-segment) level.  

The Space Measurement calculation provides the following information: 

Base Linear and Shelf Linear 

 

 Base Linear is the length of the fixture. 

 Shelf Linear is the cumulative length of the shelves on the fixture. 
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Footprint and Allocated Area 

 

 Footprint is the physical space the fixture occupies on the floor. It is calculated by 
multiplying the fixture length and depth. 

 Allocated Area is the space the fixture occupies on the floor when any associated 
areas of its aisle have been apportioned to it. 

Display Volume, Nominal Volume and Allocated Volume 
These provide different volumes for calculation purposes: 

 Display Volume is the actual volume occupied by the products. This will be less 
than the maximum volume of the parent fixtures because of finger gaps, unused 
spaces, etc. 

 Nominal Volume is the Base Linear value for the parent fixtures, multiplied by 
the values of the CALC_STND_DEPTH and CALC_STND_HEIGHT system 
variables. This provides a nominal volume for the fixtures that is purely 
dependent on the Base Linear values. 

 Allocated Volume is the Allocated Area for the parent fixtures multiplied by the 
value of the CALC_STND_HEIGHT system variable. It gives a volume within the 
floor plan for reporting purposes that takes into account any aisle space 
associated with the fixtures but which is not dependent on the height of the 
fixtures. 

Space Measurement Technicalities 

System Variables Affecting Space Measurement 
The following system variables affect the Space Measurement calculation: 
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 CALC_STND_DEPTH 

 CAL_STD_HEIGHT 

These system variables are set in the Administration Module - see the Administration 
Module User Guide for more information. 

Imploded and Exploded Planograms 
Planograms can exist in two forms: 2D (imploded) and 3D (exploded). 

 

The example planogram on the left is imploded (2D) and takes the form of a product 
block occupying the volume of the planogram. There is no information on the shelves 
and individual products present. The planogram on the right has been exploded to 3D 
form and contains information on both shelves and individual products.  

Planograms can be changed between the imploded and exploded form in the 
Merchandiser module. The Space Measurement calculation will only return meaningful 
results for planograms in 3D (exploded) form that contain Display Styles. 

Using Space Measurements 

Running the Space Measurement Calculation 
The Space Measurement calculations can be run from the Calculations menu in either 
Planner or Merchandiser. 

 

Space Measurement Results 
Space Measurement results are stored in the AVTTB_PRODUCT_MEASUREMENT table. 
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Reporting Using Space Measurements 
The default database supplied with Macro Space Planning does not contain any KPIs or 
Reports that use the results of Space Measurement calculations. These will have to be 
configured by the user; possibly using EPOS data. Results will be aggregated up to sub-
class (sub-category/sub-segment) level. 

Possible reports include: 
 Products at subclass level expressed as feet of shelf length (base linear plus shelf 

linear). 

 Sales turnover for products at subclass level expressed as turnover per foot of 
shelf length (base linear plus shelf linear). 

 Profit for products at subclass level expressed as profit per foot of shelf length 
(base linear plus shelf linear). 

 Products at subclass level expressed as square feet of floor area (based on 
allocated area). 

 Sales turnover for products at subclass level expressed as turnover per square 
feet of floor area (based on allocated area). 

 Profit for products at subclass level expressed as profit per square feet of floor 
area (based on allocated area). 

 Products at subclass level expressed as a cumulative volume (based on display, 
nominal or allocated volumes). 

 Sales turnover for products at subclass level expressed as a turnover per unit 
volume (based on display, nominal or allocated volumes). 

 Profit for products at subclass level expressed as profit per unit volume (based on 
display, nominal or allocated volumes). 
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12 
Quick Reports 

About Quick Reports 
Quick Reports can be called from the View menu in the Planner and Merchandiser 
modules. Because each retailer will have a different slant on the information they wish to 
see during store planning, Quick Reports can be customized to user requirements. They 
are used to provide information on specific aspects of the currently active floor plan.  

 

In the example above, a Quick Report has been configured to show all unpopulated 
fixtures in a floor plan. The store planner can then use the bay number or the highlight 
button on the toolbar to identify the fixtures. 

Forms of Quick Reports 
Quick Reports are of three broad types: 

General Reports 
These are reports that give general information from the database without being 
dependent on a floor plan or planogram being open. The example below shows a Quick 
Report developed to show which floor plans are currently checked out. 

 

Floor Plans 
These are reports that give information on the currently active floor plan. The example 
below shows a comparison between planograms placed in the currently active floor plan 
and the designated prototype store. 
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Planograms 
Quick Reports for Planograms can only be accessed when a planogram design is open for 
review in the Merchandiser Module. This form of Quick Report cannot be accessed from 
the Planner Module. In the example below, a simple Quick Report has been developed to 
list what products are present on what shelves in each planogram bay.  

 

Quick Reports and KPI's 
Quick Reports and KPIs complement each other. KPI's can be used to visually display the 
same information that a Quick Report can display in tabular form. 



About Quick Reports  

130 Oracle Retail Store Planner's User Guide 

 

In the above example, the financial performance of a pair of gondolas is being examined. 
Fixtures generating high levels of sales can be seen at a glance - as can poorly performing 
ones. As the KPI shows performance date in bands, it could be complemented by a Quick 
Report showing detailed information for each fixture. 

Configuring Quick Reports 
Quick Reports are completely configurable by implementors or administrators with 
access to the Macro Space Planning (MSP) Database. Information on how to carry out this 
configuration is included with the Macro Space Planning Data Model. Anyone wishing 
to configure will need a good working knowledge of SQL and a detailed knowledge of 
the database schema. 

What Quick Reports Can Be Used For  
Quick Reports can be used to display any information in the database pertinent to store 
planning tasks. Some examples of potential uses: 

Compliance 
Compliance is verifying that the floor plan does not contain errors that may prevent the 
floor plan being correctly implemented when the floor plan is published and put into 
service. Example Quick Reports that are possible include: 
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Aisles 
 Planograms that have a flow direction not appropriate for the aisles they have 

been placed in. 

Equipment 
 Items of equipment that are not due to come into service or will be taken out of 

service when the floor plan is implemented. 

 Fixtures that have not been populated with merchandise or which have multi-
placed planograms. 

Merchandise 
 Planograms on inappropriate fixtures; for example fixtures of the wrong size or 

wrong temperature range. 
 Multi-placed planograms that require correction. 

Zones 
 Merchandise that is not appropriate for that zone - for example clothing in a Food 

and Drink zone. 

External Information 
External information can be used as a basis for planning the currently active floor plan. 
Examples of such information include: 
 Product Targets: information from an external application such as Category 

Management as to the types and quantities of merchandise that are 
recommended for placement in the floor plan. 

 Comparison with Prototype Store: If a prototype store has been assigned, reports 
could compare the zones, fixtures, merchandise and financial performance of the 
currently active floor plan to its prototype.  

Fixture Attributes 
Customizable Fixture Attributes can be assigned to fixtures in a floor plan. This is done 
using the Fixture Attributes option in the Fixturing toolbar on the Object Browser. 
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These attributes can then be inspected on a 'fixture by fixture' basis in the floor plan by 
another store planner. It may be more convenient to create a quick report summarizing 
the information in the floor plan. 

Performance Metrics 
After Point of Sale data has been imported into the MSP database, this information can be 
used to give a variety of tabulated reports on performance of the currently active floor 
plan. Examples of such performance metrics include: 

 Sales and profit by zone (department). 

 Cumulative sales volume for a fixture. 
 Cumulative sales volume for a fixture expressed relative to the area occupied by 

the fixture and the area of aisle allocated to it. 

 Cumulative profit for a fixture. 

 Cumulative profit for a fixture expressed relative to the area occupied by the 
fixture and the area of the aisle allocated to it. 

 Best and worst performing products in the floor plan. 

Planogram Substitutions 
MSP can automatically substitute planograms in an existing floor plan and then publish 
that floor plan for implementation. Quick Reports could include:  

• Planograms that were substituted and their bay numbers. 

• Signage that will require changing as a result of the substitutions. 

Promotional Fixtures 
Promotional fixtures are fixtures that have been flagged in the MSP database as being in 
a position will generate high sales volumes. Examples include end caps, free standing 
bins for special offers and checkouts holding merchandise designed to induce impulse 
buys. It is possible to generate Quick Reports specific to these promotional fixtures 
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Note: The above list is not exhaustive. Any information in 
the database can potentially be used to give information on 
the currently active floor plan and hence improve some 
aspect of that floor plan. 

Using Quick Reports 
To open a Quick Report, select the Report option from the view menu in either Planner 
or Merchandiser. 

 

This will bring up the Quick Reports dialog box. The required report can be selected from 
the drop down list. On clicking the selected report, it will open. 

 

On clicking the selected report, it will open. 
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Multiple reports can be open at one time by revisiting the view menu and selecting 
additional reports.  

Dynamically Updating 
Quick Reports do not dynamically update so, once opened, they will progressively lose 
accuracy as changes are made in the floor plan. To overcome this, Quick Reports can be 
instantly updated by clicking Refresh in the toolbar. 

Synchronization 
Quick Reports are based on information currently held in the database. They will not be 
accurate if differences exist between the currently open floor plan and the database. 
Examples of this include changes made to zones with AutoCAD tools and changes made 
to the database with Batch tools. If in any doubt, the Synchronize option should be used 
to ensure the information in the current Planner floor plan and the database is identical.  

Quick Reports Toolbar 
The Quick Reports toolbar has the following options: 

Icon Description Comment 

 

Print 

This option will print the 
current contents of the quick 
report to the default printer 
for the computer MSM is 
being run on. 

 

Copy to 
Clipboard 

This option will copy the 
current contents of the report 
to the Windows clipboard. 
From there it can be pasted 
into other applications like 
Excel. 

 

Select report 

This option allows a user to 
select an alternative Quick 
Report without closing the 
dialog box. 

 

Refresh 

This option refreshes the quick 
report with the latest data held 
in the database. It also clears 
any filters that have been set. 
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Icon Description Comment 

 

Filter 

This filters the data in the 
report to match the data in the 
currently highlighted cell. 
Multiple filters can be used, 
each refining the data. 

 

Highlight in 
Floor Plan 

This option causes the selected 
object to highlight in the floor 
plan. For this to work in 
Planner the Quick report must 
contain the AutoCAD handle. 
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13 
Key Performance Indicators 

Overview of Key Performance Indicators 

Overview of KPIs 
Key Performance Indicators (KPIs) are used in parallel with Quick Reports and BI 
Publisher reports to give information on the currently active floor plan. Quick Reports 
and BI Publisher reports give tabulated information; KPIs are used to color code the floor 
plan with performance related criteria. 

 

The above example from the Merchandiser module shows products on shelves and 
fixtures color coded as to the level of profit they are making relative to the length of base 
or shelf linear that they occupy. 

Data Sources  
The following data sources can be used for KPIs: 
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SQL Statements 
SQL statement can be used for simple KPIs. For example a SQL statement could be used 
to return a list of promotional fixtures or a list of unpopulated fixtures. 

Stored Procedures 
Stored Procedures are recommended for more complex KPI's. This is because they are 
more efficient at processing large volumes of data. A stored procedure might be used to 
generate data for a KPI giving the cumulative profit for the products on a fixture while 
taking into account the amount of aisle space allocated to it.  

Views  
There are a number of views included with the database. Existing KPI's can reference 
those views for data. This facility has been removed for new KPI's. 

Note: Providing the appropriate permissions exist, it is 
possible to create data sources for KPIs that reference 
multiple schemas. For example data in the Macro Space 
Planning Database could be combined with data from other 
databases to create a KPI referencing (for example) extended 
product attributes. 

Overview of Creating KPIs 
KPI's are created as follows: 

 

Create Data Source 
The data source is created. Typically this will be a SQL statement or a stored 
procedure.  

Create Color Theme 
The next stage is to create a Color Theme to determine how the objects in the KPI will 
be colored. The simple example below show how objects can be coded red or gray 
according to whether a database flag is set or not. Any example of this is color coding 
fixtures as to whether they have been designated Promotional Fixtures or not. 
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Color Themes can be edited or created using the KPI Color Themes dialog box 
accessed from the toolbar in the KPI tab of the Object Browser in either the Planner or 
Merchandiser Modules. 

Configure KPI 
KPIs are configured using the Key Performance Indicators dialog box accessed from 
the toolbar in the KPI tab of the Object Browser in either the Planner or Merchandiser 
Modules. 

 
This enables the KPI Name, Data Source, Color Theme and other parameters to be 
configured. 

Test KPI 
After the KPI has been configured it should be tested against a set of verified data to 
ensure that objects are color coding as required.  

Overview of Running KPI's 
KPI's are run from the toolbars on the KPI tab of the Object Browser. 
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The upper toolbar give users the option to configure KPI Definitions, Configure Color 
Themes and to add a KPI to the currently active floor plan. The lower toolbar allows 
users to see the data being used for the KPI, edit the KPI parameters, remove the KPI 
from use in the floor plan and refresh the KPI definition if it has been updated by another 
user. 

Types of KPI 
There are four types of object that can be color coded using KPI's. 
 Zones 

 Fixtures 

 Shelves 

 Products 

Zones 
Zones can be color coded according to performance criteria. In the example below, the 
zones in Planner have been color coded according to the percentage of the available area 
taken up by equipment. As the number of fixtures in a zone increases, the color coding of 
a zone changes to reflect the increasing about of floor area taken up by equipment. 
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How a zone will color for a KPI in Planner depends on whether it is hatched or not. In 
the screen shot below, the left hand image shows a KPI applied with hatching turned off, 
the right hand image a KPI with hatching on. 

 

Zone KPIs will also display in the Merchandiser module. Objects not specific to the KPI 
in the Merchandiser module will display in a semi-transparent form. In the example 
below, the fixtures have been turned semi-opaque. 
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Fixtures 
Fixtures can also be color coded by performance criteria. In the example below from the 
Planner module, fixtures designated as promotional fixtures have been color coded 
differently to standard fixtures 

 

How Fixtures display in Planner depends on the visual style used. These can be changed 
using the visual style toolbar (shown below the fixtures). 
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The fixtures on the left are shown in conceptual visual style, the ones on the right in wire 
frame. 

Note: If KPI's are displayed in wire frame mode, only the 
outlines of the fixture will color. 

Fixture KPI's will also display in the Merchandiser module. 

 

Fixtures and Coloring for KPIs in Planner 
For fixture KPI's to work in Planner, the AutoCAD blocks used to represent the fixtures 
must have specific properties. Specifically, the block referenced by Fixture Studio must 
have the Color properties set to By Block. This enables individual fixtures to color as 
specified by the KPI functionality. If the Color property is left as the default (By Layer), 
the KPI will not work in Planner. 
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Shelves 
Shelf KPI's are generally only be used in the Merchandiser module. In this example the 
shelves on the fixtures have been color coded according to their performance. Objects not 
specific to the KPI will display in a semi-transparent form. In the example below, the 
fixtures have been turned semi-opaque. 

 

An example of a Shelf KPI might be a book shop giving the performance of the genre of 
books each shelf contains. 

Products 
Product KPI's can only be used in the Merchandiser module. In this example the 
products on the shelves and fixtures have been color coded according to their 
performance. Objects not specific to the KPI will display in a semi-transparent form. In 
the example below, the fixtures and shelves have been turned semi-opaque. 
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Creating and Maintaining Color Themes 
Color Themes are used to color code objects according to performance. They are created 
and maintained in the KPI Tab of the Object Browser. Clicking the Edit Themes button 
on the toolbar will bring up the KPI Color Themes dialog box. Once a color theme has 
been configured, it can be associated with a KPI. Once assigned, the color theme will 
appear in the Legend part of the Object Browser. 
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Creating a Color Theme Using the Wizard 
The simplest way to create a color theme is by using the Wizard. This is done as follows: 

1. Add the name of the new color theme by entering the name of the color theme in the 
text box at the top of the KPI Color Themes dialog box and pressing Return. 

 

2. Highlight the newly added color theme name in the list and click the Wizard button 
on the toolbar. 

 

3. This will bring up the Create Legend Wizard. 
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a. Specify the Band Size and Quantity. 

b. Specify the Start and End Colors 

c. Decide if the color bands are to be added to any existing color bands. 

d. click OK 

4. The KPI Color Themes dialog box will reappear with the band size and color added. 

 

5. Complete the Descriptions and select a Hatch style from the drop down list.  

 

6. On clicking OK, the color theme will be created. 
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Note: Color Theme bands are cumulative. In the above 
example, Very Low Profit will contain results 0 - 100, Low 
Profit 101 - 200, etc. 

Manually Creating a Color Theme 
Manually creating a color theme allows custom band sizes and colors. As the sequence of 
color bands cannot be altered once added, it is suggested that the bands be planned out 
prior to entering them. 

Band Name Band 
Size 

Cumulative 
Band Size Color 

Profit $0 - $50/Foot 50 0 - 50 Red 

Profit $51 - $150/Foot 100 51 - 150 Yellow 

Profit $151 - $250/Foot 100   Green 

To manually create a color theme: 
1. Add the name of the new color theme by entering the name of the color theme in the 

text box at the top of the KPI Color Themes dialog box and Pressing Return. 

 

2. Enter the required data into the dialog box.  

 

There is no way to re-order the data once entered, so when entering long lists off data 
care must be taken to enter it in the corr4ect sequence. Also note that for hatch styles 
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to work in the Merchandiser module, hatch patterns must first have been configured 
using the Hatch Styles option from the Planning menu in the Administration 
module. 

Editing a Color Theme 
Once created, it is possible to edit a color theme. An example would be changing the 
band size for one or more bands or adding or removing bands. Care should be taken 
editing color themes as this may affect any KPI's dependent on them. 

Configuring the KPI 

Data Source 
There are two main data sources for Key Performance Indicators: 

 SQL Statements 

 Stored Procedures 

These must first be created and tested before the KPI itself can be configured. These use 
standard SQL. The results must contain the following information: 

 A Store ID (STR_ID) to identify the bricks and mortar outlet the information is 
valid for. 

 A File ID (FIL_ID) to identify the specific floor plan the data is associated with. 

 A Calendar ID (CAL_ID) to identify the time period the data is valid for. 

 An Object ID to identify what object to color in the floor plan. This may be a Zone 
ID (ZON_ID), Fixture ID (FIX_ID), Shelf ID (SHF_ID or Product ID (PRO_ID). 
Each of these IDs is for the instance of the object placed in the floor plan. 

 One or more columns of results. 

Configuring the KPI 
The KPI can then be configured in the  
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KPI Name 
This is entered in the text box at upper left then added by pressing Return. The name will 
then appear in the name field in the right hand side of the dialog box. 

Description 
This is used purely in the dialog box and gives information on the purpose of the KPI. 

Data Source 
This is the SQL statement or stored procedure used to generate the data used in the KPI. 

Note: Older KPI's may use a table or a view as the data 
source. This functionality has been maintained for backward 
compatibility and new KPIs cannot use these as a data 
source. 

Column 
The column must be a column in the results returned by the SQL statement of stored 
procedure.  

Units 
The units are those for the data. The most commonly used are 'Pure Number' for data 
such as movement and currency values for financial results. 

Color Theme 
This is the color scheme used for coloring the results. The range of values it can cater for 
must be compatible with the expected range of results. Weekly financial results will thus 
have a different color theme from monthly, quarterly or yearly financial results. In Macro 
Space Management, results outside the ones specific in the Color Theme will not be 
colored. 

Legend Minimum 
This is used in In-Store Space Collaboration. Results below this value will result in the 
object being colored black.   

Legend Maximum 
This is used in In-Store Space Collaboration. Results above this value will result in the 
object being colored black.   

KPI Type 
This is used to specify the type of object to be colored. The SQL statement or stored 
procedure used to generate the result set must contain the appropriate ID for this type of 
object - for example a Fixture ID (FIX_ID) for KPIs designed for fixtures. 

Query Type 
This drop down list specifies whether the data source is a SQL statement or stored 
procedure. 



Using the KPI  

150 Oracle Retail Store Planner's User Guide 

Using the KPI 

Using the KPI 
The first stage is to select the KPI and click the Add button on the upper toolbar in the 
KPI tab of the Object Browser. 

 

This will bring up the Key Performance Indicator dialog box. This will open in the Details 
tab. 

 

This tab shows the name of the KPI (which can be edited before it displays in the Object 
Browser and the type of object that is being colored by the KPI - in this instance Fixtures. 

Note: the above screen shot shows the KPI dialog box from 
the Planner module. A slightly different one will appear in 
the Merchandiser module. 

Two other tabs can be used to further define the KPI before it is displayed. 

Stores Tab 
By default the KPI is run against the currently active floor plan. However, sometimes it is 
useful to look at results in a new store for which there is no operational data. This can be 
done by reading the data from another store. This will only be effective if the store 
arrangements are identical and the ID's in the database are also an exact match - for 
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example the Fixture ID for a fixture in a specific position in the store the KPI is being 
displayed in must have the exact same Fixture ID in the store the data is being read from. 
Reading in data from another store must therefore be done with care. 

 

To select data from another store: 

1. Uncheck the Current Store checkbox. 
2. This will display a list of all stores in the retail chain. 

3. Highlight the store it is desired to read data from. 

Data Tab 
The Data tab is used when data is time specific. 

 

The radio button allows users to select a data for time sensitive data. 

 Effective Date is for floor plans that have reached Authorised or Published 
status, but have not yet reached Current status. In this case data will be used that 
is pertinent to the Effective Date set in the File Properties dialog box in Store 
Manager. 
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 Current Date is used for files that have reached Current Status. It will use the 
date the floor plan is shown as reaching Current Status from the database. 

 Other Date can be set to any value using a calendar. 

 Active Date is used for floor plans in the earlier stages of planning. The date used 
for the data is the Active Date shown at the top of the Object browser (or in the 
file Properties dialog box in Store Manager). 

The data type is then set from the drop down list. This may be any time period ranging 
from a day's data to a year. This date in then converted to the corresponding calendar 
information and the data displayed in the KPI. 

Note: For time specific data to be used, the data must first 
exist in the correct for. For example, if weekly sales data is 
being used, that data must first exist in weekly form. If it 
does not, then the SQL Query or Procedure used for the KPI 
must have the ability (for example) to take daily data and 
roll it up into weekly data. 

On clicking the OK button, the name of the KPI will appear in the Layers part of the 
Object browser and the legend will appear. The selected objects will also color. If the 
floor plan in Planner is in wire frame mode (see below) only the outline of the fixture will 
color. This may make it difficult to see. 

 

To make KPI's more visible in Planner, it is possible to change the visual style (Visual 
Styles toolbar) to Conceptual visual style. This makes the entire fixture color and the KPI 
easier to read. 
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Individual items of data can be seen by bring up the Key Performance Indicator dialog 
box. This will be of maximum use when there is financial or movement data involved. 

 

The KPI data shown in the floor plan is static. If changes are made in the floor plan, it 
may be necessary to use the Refresh button in the KPI toolbar to rerun the KPI and 
update the floor plan. 
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Examples of KPI's 
Many types of KPI are possible. Many retailers create their own KPI's to address 
reporting requirements specific to their business. Some examples are given below, but in 
principle any information from the database can be used for KPI purposes. Data can also 
be combined with that held in other databases (for example POS data) to create more 
complex KPIs. 

Four basic forms of object can be color coded for performance: zones, fixtures, shelves 
and products. Some examples are given below. 

Zone KPIs 

Validation KPIs 
KPI's can be used to show things such as zone density: the proportion of floor space 
occupied by fixtures. A low zone density might indicate space is not being used 
efficiently, a high one that the store is a slightly claustrophobiac experience for 
customers. 

Performance KPIs 
If a floor has been subdivided into multiple departments and sub-departments, it is 
possible to show the overall financial performance for those departments in terms of 
sales, margins, profitability, etc. This shows overall performance of the store at a glance. 

Fixture KPIs 

Validation KPIs 
Validation KPI's could be written for fixtures to verify that planograms have been 
correctly placed. Examples include confirming that the planogram is on a fixture of the 
correct dimensions and type. 

Performance KPIs 
Performance KPIs can be used to show the results of the planograms on the fixtures. If 
the allocated area calculation is used, the sales performance can be related to the total 
floor area associated with the fixture. 

Other KPIs  
Other KPI's could use the Adjacency Rules (set up in the Administration module) to 
identify the relative position of products with strong affinities. This might let store 
planners optimize planogram placement by (for example) by changing planogram 
position to bring products with a strong sales affinity close together. 

Another use of Fixture KPIs would be to show fixtures containing products with high 
shrinkage. A concentration of such fixtures would indicate a part of the store with 
security issues.  

Shelf KPIs 
Shelf KPIs are more normally used in the Merchandiser module. 

Validation KPIs 
Validation KPIs can be used to verify positions of products for their intended 
demographic. For example, children's magazines should probably be at a low level, so 
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they are more visible to their target audience, while 'adult' magazines should be on a 
high shelf, out of reach of young children. 

Performance KPIs 
If a shelf contains products for which there is little merit in showing individual 
performance figures, then the overall performance of the shelf may be a better business 
indicator. An example would be a book shop, where the performance of a genre of books 
is more important than the performance on an individual book in that genre. 

Product KPI's 
Product KPI's are only possible in the Merchandiser module as display styles (detailed 
product information) cannot be displayed in the Planner module. 

Performance KPIs 
KPIs could be created to show the values of sales volume, profit or movement by band. 

Ranking KPIs 
KPIs could be created to highlight the top 10 and bottom 10 products by sales volume, 
profit, or movement. 
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Planner Module Basics 

Overview of Planner Module 
The Planner Module is based on AutoCAD. It can be used to plan the layout of 
departments (zones), equipment and merchandise within stores with considerable 
accuracy. It can also be used to generate reports on performance to enable the user to 
continually improve the efficiency and profitability of that store. 

 

It has the following components: 

Menu Bar - allows users to access various AutoCAD and Planner module commands. 
Toolbars - allows users to access various AutoCAD and Planner toolbars. 

Object Browser - allows users to add edit and delete zones, equipment and merchandise. 
Also allows users to see visual performance reports (hot-spotting/Key Performance 
Indicators). 

Object Grid - alternative method for users to place fixtures, products and planograms. 

Command Line - allowing text based input for many AutoCAD and Planner commands 
Status Bar - allows many AutoCAD commands to be toggled on or off. 

Floor Plan - the currently active representation of a floor within a specific store. 
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Planner Menu Overview 

The File Menu 
The File Menu allows users access to a number of general options. 

Note: This section of the help file refers to the File menu 
associated with the 2008 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 

Functionality Source Comment 

Open Macro Space 
Management 

Opens Store Manager 

Close Macro Space 
Management 

Closes the current drawing 

Save Macro Space 
Management 

Saves the current drawing 

eTransmit AutoCAD See AutoCAD Help File for further information. 

Export AutoCAD See AutoCAD Help File for further information. 

Publish AutoCAD See AutoCAD Help File for further information. 

Plot AutoCAD See AutoCAD Help File for further information. 

Options AutoCAD See AutoCAD Help File for further information. 
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Functionality Source Comment 

Configuration Macro Space 
Management 

Opens the Configuration Module 

Synchronize Macro Space 
Management 

Opens the Synchronization Module 

Refresh Browser Macro Space 
Management 

Refreshed the Object Browser with the latest 
information from the database 

Drawing Utilities AutoCAD Calls varying AutoCAD utilities - see AutoCAD 
Help File for further information. 

Send AutoCAD See AutoCAD Help File for further information. 

Drawing 
Properties 

AutoCAD See AutoCAD Help File for further information. 

Exit Macro Space 
Management 

Exits the Module 

The Edit Menu 
The Edit Menu mainly gives access to AutoCAD Functionality. 

Note: This section of the help file refers to the Edit menu 
associated with the 2008 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 

Functionality Source Comment 

Undo Macro Space 
Management 

Allows the last command(s) to be undone. (The exact 
text will vary depending on what the last executed 
command was). 
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Functionality Source Comment 

Redo Macro Space 
Management 

Allows the last command(s) to be undone. (The exact 
text will vary depending on what the last executed 
command was). 

Cut AutoCAD See AutoCAD Help File for further information. 

Copy AutoCAD See AutoCAD Help File for further information. 

Copy with Base 
Point 

AutoCAD See AutoCAD Help File for further information. 

Copy Link AutoCAD See AutoCAD Help File for further information. 

Paste AutoCAD See AutoCAD Help File for further information. 

Paste as Block AutoCAD See AutoCAD Help File for further information. 

Paste as Hyperlink AutoCAD See AutoCAD Help File for further information. 

Paste to Original 
Coordinates 

AutoCAD See AutoCAD Help File for further information. 

Paste Special AutoCAD See AutoCAD Help File for further information. 

Clear AutoCAD See AutoCAD Help File for further information. 

Select All AutoCAD See AutoCAD Help File for further information. 

OLE Links AutoCAD See AutoCAD Help File for further information. 

Find AutoCAD See AutoCAD Help File for further information. 

The View Menu 
The View Menu provides the following options: 

Note: This section of the help file refers to the View menu 
associated with the 2008 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 
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Functionality Source Comment 

Redraw AutoCAD See AutoCAD Help File for further information. 

Regen AutoCAD See AutoCAD Help File for further information. 

Regen All AutoCAD See AutoCAD Help File for further information. 

Display 2D Macro Space 
Management 

Displays the drawing in Macro Space 
Management 2D Mode. (The blocks must have been 
configured accordingly). 

Display 3D Macro Space 
Management 

Displays the drawing in Macro Space Management 
3D Mode. (The blocks must have been configured 
accordingly). 

Zoom AutoCAD See AutoCAD Help File for further information. 

Pan AutoCAD See AutoCAD Help File for further information. 

Orbit AutoCAD See AutoCAD Help File for further information. 

Walk and Fly AutoCAD See AutoCAD Help File for further information. 

Aerial view AutoCAD See AutoCAD Help File for further information. 

Rotate View AutoCAD See AutoCAD Help File for further information. 

Viewports AutoCAD See AutoCAD Help File for further information. 

3D views AutoCAD See AutoCAD Help File for further information. 

Visual Styles AutoCAD See AutoCAD Help File for further information. 

Toolbars AutoCAD See AutoCAD Help File for further information. 
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Functionality Source Comment 

Color Products Macro Space 
Management 

Allows products be to colored according to 
their general type. 

Reports Macro Space 
Management 

Allows simple reports to be produced on 
objects within the current drawing. 

Drawing 
Comparison 

Macro Space 
Management 

Allows one drawing to be compared with 
another. 

Show (Hide) 
Object Browser 

Macro Space 
Management 

Will show or hide the Object Browser. 

Show (Hide) 
Object Grid 

Macro Space 
Management 

Will show or hide the Object Grid. 

The Insert Menu 
The Insert Menu provides ways to attach further information to the store plan. 

Note: This section of the help file refers to the Insert menu 
associated with the 2008 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 

Functionality Source Comment 

Block AutoCAD See AutoCAD Help File for further 
information. 

External 
References 

AutoCAD See AutoCAD Help File for further 
information. 

DWF Underlay AutoCAD See AutoCAD Help File for further 
information. 

Add 
Architectural 
Plan 

Macro Space 
Management 

X-Refs an architectural plan to the 
currently active drawing 

Add Title Block AutoCAD See AutoCAD Help File for further 
information. 

Update Title 
Block 

AutoCAD See AutoCAD Help File for further 
information. 
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Functionality Source Comment 

Bay Numbering Macro Space 
Management 

Add numbering to the fixtures in the 
store plan 

  

The Format Menu 
The Format Menu provides allows the user to control the layers, dimensions and units 
associated with the drawing. 

Note: This section of the help file refers to the Format menu 
associated with the 2009 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 

Functionality Source Comment 

Layer Aliases Macro Space 
Management & 
AutoCAD 

Calls a mixture of Macro Space Management 
and AutoCAD functionality. 

Layer AutoCAD See AutoCAD Help File for further 
information. 

Layer States 
Manager 

AutoCAD See AutoCAD Help File for further 
information. 

Layer Tools AutoCAD See AutoCAD Help File for further 
information. 

Dimension Style AutoCAD See AutoCAD Help File for further 
information. 

Units AutoCAD See AutoCAD Help File for further 
information. 

Drawing Set Up Macro Space 
Management 

Allow the user to select the scales for Paper 
space. 

The Modify Menu 
The Modify Menu provides functionality for modifying objects in the store plan. 
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Note: This section of the help file refers to the Modify menu 
associated with the 2008 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 

Functionality Source Comment 

Properties AutoCAD See AutoCAD Help File for further information. 

Match Properties AutoCAD See AutoCAD Help File for further information. 

Change to 
ByLayer 

AutoCAD See AutoCAD Help File for further information. 

Object AutoCAD See AutoCAD Help File for further information. 

Clip AutoCAD See AutoCAD Help File for further information. 

Erase AutoCAD See AutoCAD Help File for further information. 

Copy AutoCAD See AutoCAD Help File for further information. 

Array AutoCAD See AutoCAD Help File for further information. 

Move AutoCAD See AutoCAD Help File for further information. 

Rotate AutoCAD See AutoCAD Help File for further information. 

Blocks Macro Space 
Management & 
AutoCAD 

Calls a mixture of Macro Space Management and 
AutoCAD functionality. 

Attributes Macro Space 
Management 

Allow the user to select the scales for Paper space. 

Text Macro Space 
Management & 
AutoCAD 

Calls a mixture of Macro Space Management 
and AutoCAD functionality. 

Calculations Menu 
The Calculations Menu enables users to initiate varying calculations that write data into 
the central Macro Space Planning database. 
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None of the functionality accessed from this menu is AutoCAD functionality. 

The Window Menu 
The Window Menu allows users to arrange multiple drawings, if open, and to select an 
active drawing from a set of open drawings. 

Note: This section of the help file refers to the Window 
menu associated with the 2008 version of AutoCAD. Users 
using earlier versions of AutoCAD may find a slightly 
different menu. 

 

All functionality in this menu is AutoCAD functionality. 

The Help Menu 
The Help Menu contains a number of options that access Help and Assistance. 

Note: This section of the help file refers to the Help menu 
associated with the 2008 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 
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Functionality Source Comment 

AutoCAD Help AutoCAD See AutoCAD Help File for further 
information. 

New Features 
Workshop 

AutoCAD Not yet available 

Planner Help Macro Space 
Management 

Calls Macro Space Management's Help 
File for this module. 

Additional 
Resources 

AutoCAD See AutoCAD Help File for further 
information. 

Customer 
Involvement 
Program 

AutoCAD See AutoCAD Help File for further 
information. 

About AutoCAD Gives the AutoCAD version. 

About Planner Macro Space 
Management 

Gives the Planner version 

Tools Menu 
The tools menu has options concerning Planogram Substitution. 

 

Functionality Source Comment 

Planogram 
Substitution 

Administration 
Module 

Pertinent permissions 
required. 

Run Planogram 
Substitution 

Administration 
Module 

Pertinent permissions 
required. 

Permissions to access the planogram substitution functionality are set in the 
Administration module. If the appropriate permissions are not available, a warning 
message will result and access to the functionality will be denied. 
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15 
Business Processes for Floor Plan and 

Planogram Tools 
Information in Planner Floor Plans and the Database 

When considering batch processes, it is useful to understand how Macro Space Planning 
stores and processes data.  

The Macro Space Planning Database 
All information is held in the Macro Space Planning database. This information can be 
viewed and edited manually in one of three ways: 

 Via an AutoCAD based floor plan in the Planner module. 

 Via the Virtual Reality representation in the Merchandiser Module 

 Via the simple graphic interface in the In-Store Space Collaboration application. 

Data may also be modified directly in the database by means of batch processes. An 
example of this is running planogram substitutions. 

 

Reading and Writing Data in the Database 
If a floor plan is viewed or edited in the Merchandiser module or in the In-Store Space 
Collaboration application, data is written directly to and from the database. Any changes 
made in one application are immediately visible in the other. Changes made by a batch 
process are written directly to the database and are also visible immediately in the 
Merchandiser module or in the In-Store Space Collaboration application 

The situation is more complex for the AutoCAD floor plan in Planner.  

Changes made Manually in Planner 
What is read from or written back to the database during manual editing varies 
considerably depending on whether Auto-Synchronisation or Dynamic Synchronization 
are turned on.  

 If Auto-Synchronisation is on, changes made in the database are automatically 
applied to the AutoCAD floor plan when it is opened. This includes changes 
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made manually in the Merchandiser module or in the In-Store Space 
Collaboration application and by batch processes. If Auto-Synchronization is Off, 
any changes that exist purely in the database will not be reflected in the 
AutoCAD floor plan and such changes must be included by manual 
synchronisation. 

 If Dynamic Synchronisation is on, changes made to the majority of (but not all) 
changes made to objects in the floor plan using AutoCAD (rather than Planner) 
functionality are written to the database at the time. If Dynamic Synchronization 
is Off, any changes that exist purely in the AutoCAD floor plan may not be 
reflected in the database and such changes must be included by manual 
synchronisation. 

This means that changes made in the Merchandiser module or in the In-Store Space 
Collaboration application, made by batch processes or made by AutoCAD tools may 
result in differences in the data held in the database and in the AutoCAD version of the 
floor plan. Store planners working in Planner thus need to follow a clear business process 
to ensure that the information in the database and AutoCAD floor plan remain consistent 
with each other. 

Changes Made by Batch Processes Prior to Publishing Floor Plans  
The differences between the database and the information held in the Planner AutoCAD 
floor plan achieve their greatest significance when considering floor plan publishing. The 
floor plan that is published is the copy held in the Windows folder on the Macro Space 
Planning file server. If changes have been made to the database by a batch process (for 
example planogram substitution) immediately prior to publishing the floor plan, those 
changes will not yet be reflected in those Planner AutoCAD floor plan. Those floor plans 
need to be processed prior to publishing to update the products, annotation and any 
associated calculations. This can be done as a discrete Floor Plan Processing operation 
run via BatchRunner and the command line. Alternatively, it can be done by using the 
Floor Plan Processing built into the Floor Plan Publishing process. 

Overview of Automated Floor Plan and Planogram Publishing 

Introduction 
Macro Space Planning is a store planning tool that allows store plans to be created with 
the aid of imported planograms. After the floor plans have been created, the information 
needs to be transmitted to the store and executed there. This process is normally 
executed by administrators, but a brief explanation has been included in the store 
planning help for the benefit of store planners. 

How the Process is Configured and Operated 
The process is configured in the Administration module using the Configure Floor Plan 
Publishing and Configure Planogram Publishing options accessed from the File menu. 
The process can then run by invoking a small Macro Space Planning tool called 
BatchRunner. The precise way BatchRunner operates is controlled by command line 
switches. BatchRunner is normally initiated by a scheduling tool. More sophisticated 
scheduling tools can automatically pass the command line switches to BatchRunner. The 
scheduling tool can also operate a small utility called UpdateStatus.exe.  This is used to 
change the status of the floor plan from Published to Current. 

BatchRunner and UpdateStatus.exe 
BatchRunner can be found in the C:\Program Files\Oracle Retail\MSM\Common.Net 
folder on each MSM installation. Access to the functionality is controlled in the 
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Functional Security dialog box in the Administration Module. BatchRunner is controlled 
via the command line and can run the following operations: 

 Processing Floor Plans (running operations such as calculations and restructure 
drawing). 

 Publishing Floor Plans. 

 Publishing Planograms. 

 Executing Planogram Substitution and Revision Changes. 

UpdateStatus.exe can be found in the C:\Program Files\Oracle Retail\MSM\Common 
folder in each MSM installation. Access to the functionality is controlled in the Functional 
Security dialog box in the Administration Module. When executed, UpdateStatus.exe 
changes the status of files from Published to Current when the Effective Date is reached 
or exceeded. 

Other Business Processes 
Retailers will also have business processes for carrying out actions associated with 
implementing those floor plans and planograms that are outside of the scope of Macro 
Space Planning. These include giving the stores access to the published floor plans and 
planograms and putting the necessary orders into the supply chain. 

Reports 
As installed, Macro Space Planning does not provide any reports for monitoring the 
results of batch process controlled floor plan processing, floor plan publishing, 
planogram publishing or planogram substitution. It is the retailer's responsibility to 
provide these.  

Automated Floor Plan and Planogram Publishing 
The basic process is described in the flow chart below. Conceptually, it can be viewed as 
taking place in the following general stages: 

A store plan is created and set to Authorized status. At the same time the Publish and 
Effective Dates are set. 

1. BatchRunner will initiate the publishing of both floor plans and planograms to 
specified directories or printers when the Publish Dates are reached or exceeded. 

2. Reaching the Publish date is also the trigger for the retail chain to notify the store that 
the floor plans and planograms are available in specified locations. The retail chain 
will also initiate ordering the required equipment and merchandise. 

3. When the Current Date is reached, Update Status will change the status of the floor 
plan to Current. This is the signal to put it into service in the store.  
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This may be seen in slightly simplified form in this process flowchart: 
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Details of Process 

Note: floor plans and planogram designs can either be 
published in electronic form or printed as a hard copy. This 
example assumes electronic form: it is equally applicable for 
printed documentation.  

Generating Floor Plans 
For floor plans to be published they must first be at Authorised status with Publish Date 
and Effective Date set. These dates act as triggers for successive action.  

Generating Planogram Designs 
Planogram designs are normally imported into Macro Space Planning. There is a chain of 
logic determining when the planogram design is published. 

 When the Publish Date is met or exceeded the planogram will be published. This 
will set the Last Published Date. 

 If the Last Modified Date exceeds the Last Published Date, the planogram will 
also be published - this indicates that a modification has been made to the 
planogram.  

Floor Plan Publishing  
The first stage of the process is to publish the floor plan. For an automated process, this is 
done via the BatchRunner utility. This will be run by a scheduling tool at regular 
intervals. When BatchRunner identifies that a Publish Date has been met or exceeded it 
changes the status of the floor plan from Authorised to Published. Simultaneously, the 
Floor Plan Publishing tool sends a copy of the floor plan to a Windows folder structure 
under the Floor Plan Publishing root specified in the Directories Tab of the Configuration 
Module. (This tab can only be accessed by opening the Configuration Module in the 
Administration Module). 

Floor Plan Publishing and Floor Plan Processing 
Floor plan processing allows the AutoCAD drawing representing the floor plan to be 
refreshed with the latest changes. For example, if planogram substitution has been 
carried out, the AutoCAD drawing will have to be synchronized relative to the database, 
have annotation refresh and have the calculations refreshed prior to publishing the floor 
plan. This can be done as a separate option via the command line or it can be done 
during the floor plan publishing process using options specified in the Floor Plan 
Publishing Configuration dialog box. 

Another use of floor plan processing is to run calculations prior to running reports to 
ensure the data used for the reports is fully up to date. 

Note: The flowchart above assumes floor plan processing is 
carried out as part of the floor plan publishing process.   

Planogram Publishing 
In parallel with publishing the floor plan, a set of planogram designs need to be sent to 
the store. For a routine update, this will just be the planograms that are being changed. 
For a remodel, a full set of planogram designs will be required. For an automated 
process, this is done via the BatchRunner utility. This will be run by a scheduling tool at 
regular intervals. When BatchRunner identifies that the planogram needs to be published 
by comparing Publish Date, Last Published Date and Last Modified Date, it will cause 
that planogram to be published to a Windows folder structure under the Planogram 
Publishing root specified in the Directories Tab of the Configuration Module. (This tab 
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can only be accessed by opening the Configuration Module in the Administration 
Module). 

Note: Depending in settings in the Planogram Publishing 
Configuration dialog box in the Administration module, the 
planogram designs sent to the windows folder will either be 
a complete set of planograms for the store or just the 
planograms that have been recently updated or revised. 

Notification that Information has been Published 
The Floor Plan and Planogram Publishing functionality will send copies of the floor plans 
and planograms to specified Windows folders. Notifying the store that new floor plans 
and planograms are available and ensuring that the store can access that information is 
the responsibility of the retailer. 

Implementation Actions by Retailer 
After the floor plans and planogram designs have been published, preparations need to 
be made for executing them in store. This is a retailer responsibility - Macro Space 
Planning can provide the data to orchestrate those actions. 

Executing the Changes 
The floor plan also has an Effective Date. UpdateStatus.exe (run at intervals by a 
scheduling tool) will identify when the Effective Date is met or exceeded and then 
change the floor plan status to Current. When a floor plan reaches Current status, this is a 
signal to the store that all planned changes should have been executed on that date and 
the floor plan put into service. 

At the same time as the floor plan is changed to current, its properties are changed to 
read only to prevent further changes being made in it. The floor plan being changes to 
current also causes the floor plan it replaces to be changed to Historical status. 

Overview of Automated Planogram Substitution 

Introduction 
Macro Space Planning allows users with the appropriate privileges to first define 
planogram substitutions and then to execute those substitutions in selected stores. This 
section has been included to show how a floor plan can be updated with a different suite 
of planograms using batch processes. The updated floor plans (and new planogram 
designs) can then be published by batch processes in turn. 

There are several ways of accomplishing this: the diagram below shows how a Current 
floor plan can be used to generate a duplicated file incorporating the required planogram 
substitutions.  

Note: This example assumes the 
PLANOGRAM_SUBSTITUTION_COPY_FILE system 
variable is set to On (allowing floor plans of Current Status 
to be modified by Planogram Substitution) and that 
planogram substitution definitions have been set up 
accordingly. 

How the Process is Configured and Operated 
Planogram Substitutions are configured in the Planogram Substitution dialog box. This 
can be accessed from the Administration Module, the Planner Module, the Merchandiser 
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Module and directly from the provided shortcut. BatchRunner is capable of running 
those planogram substitutions against a specified floor plan - in this case a floor plan at 
Current status in a specific store. 

 

 

As a result of running the planogram substitution a duplicate floor plan will be created in 
the same revision at Authorised status. This floor plan will have the Publish Date set to 
the Effective Start Date of the Planogram Substitution. The Effective Date of the floor 
plan will be set based on the Publish Data of the floor plan and the time interval specified 
in the EFFECTIVE_DATE_LEAD_PERIOD system variable. The AutoCAD version of this 
floor plan will be an exact copy of the floor plan it was cloned from as the planogram 
substitutions were executed purely in the database.  

The next stage is therefore to use floor plan processing to update the AutoCAD version of 
the floor plan so it reflects the revised information in the database. This is done by means 
of the Floor Plan Processing option. BatchRunner can run varying options depending on 
the switches used in the command line.  The options required are: 

 Synchronization: 'Match the Database' will bring in the planogram substitutions 
held in the database. (An alternative is to use the Auto-Sync option). 

 Annotation: The new planograms will require the annotation refreshed to reflect 
the changes. 

 Calculations: These require updating so that any subsequent reporting will be 
accurate.  

Note: Floor Plan Publishing has the option to carry out floor 
plan processing as part of the publishing process. This 
example shows how floor plan processing can be run as a 
separate operation. One reason for doing this would be a 
store planner briefly looking at the duplicated store plan 
before submitting it for the floor plan publishing operation.   
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Note: If the duplicated floor plan is opened in the 
Merchandiser Module or in In-Store Space Collaboration, the 
information is read directly from the database and no 
synchronisation is needed. However, it is the AutoCAD 
version of the floor plan that is published, this needs to be 
updated before Floor Plan Publishing is carried out. 

Once the AutoCAD version of the floor plan has been processed, it will be identical to the 
information held in the database. As it is at Authorized status with the Publish Date and 
Effective Date set, the floor plan will be published by any automated floor plan 
publishing process when the Publish Date is reached of exceeded. 

Reports 
As installed, Macro Space Planning does not provide any reports for monitoring the 
results of batch process controlled planogram substitution. These would normally be 
configured during the implementation process to requirements specified by the retailer.  

Immediate Publishing of Floor Plans and Planograms 

Overview of Immediate Publishing 
The majority of retail organizations will publish floor plans and planograms as part of an 
overnight batch process. This process can be scheduled on different frequencies varying 
from daily to weekly. Occasions will inevitably occur when there is a need to publish 
information before the next scheduled batch run. Planner has several tools to assist in this 
process. Three are:  

 Immediate Floor Plan Publishing: Publish selected floor plans at Authorised 
status that have met or exceeded their Publish Date. 

 Immediate Planogram Publishing: Publish selected planograms. The 
planograms available for publishing will depend on criteria set in the 
Administration Module.  

 Print Planograms: This allows a store planner to print off a copy of selected 
planograms in the currently active floor plan. Alternatively, they may be 
generated in PDF form. 

Access to Immediate Floor Plan Publishing and Immediate Planogram Publishing is 
controlled by settings in the Functional Security dialog box in the Administration 
module. Planograms can be printed from the currently active store plan by any users 
with access rights. 

Publishing Floor Plans 
This option is for urgent publishing of floor plans. An example of this would be if floor 
plans are being published and transmitted to store by a weekly batch process. If this 
batch process ran every weekend, there might be a need to publish selected floor plans in 
mid-week so as to avoid waiting for the next scheduled batch run. 

Permission to Access the Floor Plan Publishing Functionality 
Publishing a floor plan will often trigger other actions within a retail organization. 
Generally, it will cause orders to be placed into the supply chain and the store to start 
planning for the changes. Accordingly, users require permission to access to the 
functionality. This is done in the Group Relationships tab of the Functional Security 
dialog box in the Administration Module. Users without this permission will not be able 
to open the dialog box. 
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The Publish Floor Plans Dialog Box 
The Publish Floor Plans dialog box is accessed from the File menu. It opens with the 
same settings as those for batch processing - these are configured using the Configure 
Floor Plan Publishing dialog box in the Administration Module. Floor plans can be 
selected for publishing by ticking the check boxes and then clicking OK. 

 

This dialog box will show all floor plans at Authorised Status that have met or exceeded 
their Publish Date. 

Where Floor Plans Will Be Published To 
Immediate publishing of floor plans will result in the files being sent to the same folders 
as used for the batch process. The root folder for this is specified in the Directory Tab of 
the Configuration Module. (This tab can only be accessed if the Configuration Module is 
opened from the Administration Module). The file structure below the root folder and 
the form of the file name are specified in the Output tab of the Floor Plan Publishing 
Configuration dialog box in the Administration module.  

Other Floor Plan Publishing Tabs  
 Rendering: The Rendering tab gives a number of options for controlling the 

visual appearance of the floor plan when published. 

 Collation: The Collation tab determines the way floor plans will be published 
below the Floor Plan Publishing root. 
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 Pre-Processing: This option allows the user to carry out a series of operations on 
the floor plan to ensure that the information in it and data associated with it are 
completely up to date. 

 Validation: These are the checks that are performed before the floor plan is 
published. Any individual floor plan that fails validation will not be published, 
while an entry will be written to the pertinent log table. 

Immediate Publishing of Planograms 
This option is for urgent publishing of planograms. An example of this would be if 
planograms are being published and transmitted to store by a weekly batch process. If 
this batch process ran every weekend, there might be a need to publish selected 
planograms in mid-week so as to avoid waiting for the next scheduled batch run. 

Permission to Access the Immediate Planogram Publishing Functionality 
Because the Immediate Planogram Publishing option could result in large numbers of 
planograms being published during working hours (with the corresponding load on the 
system), users require permission to access to the functionality. This is done in the Group 
Relationships tab of the Functional Security dialog box in the Administration Module. 
Users without this permission will not be able to open the dialog box. 

The Immediate Planogram Publishing Dialog Box 
The Immediate Planogram Publishing dialog box is accessed from the File menu. It opens 
with the same settings as those for batch processing - these are configured using the 
Configure Planogram Publishing dialog box in the Administration Module. Planograms 
can be selected for publishing by ticking the check boxes and then clicking OK. 
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The quantity of planograms that appear in this dialog box depends on a setting in the 
Output tab of the Planogram Publishing Configuration dialog box in the 
Administration module.  

 If the Re-publish planogram if files are missing option is checked, all 
planograms (irrespective of whether the have been published or not) will be 
available for selection. 

 If the Re-publish planogram if files are missing option is not checked, only 
planograms that have not been published or planograms that have been modified 
since they were last published will be available for publishing. 

Note: Care should be taken when selecting planograms for 
Immediate Planogram Publishing if the Republish 
planogram if files are missing option is checked. 
Planograms will be published for all stores that have that 
planogram placed. If a large number of planograms are 
selected for publishing, this will means a substantial amount 
of processing and significant amounts of data passed over 
the network. If Immediate Planogram Publishing is run with 
during the day with large amounts of planograms selected, 
 it may slow the response for other users. 

Where Planograms Will Be Published To 
Immediate publishing of planograms will result in the files being sent to the same folders 
as used for the batch process.  
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Other Planogram Publishing Tabs  
 Templates: The Templates tab allows the user to select the form the planogram 

definition will be output in. 

 Collation: The Collation tab determines the way planograms will be published 
below the Planogram Publishing root. 

 Validation: These are the checks that are performed before the floor plan is 
published. Any individual floor plan that fails validation will not be published, 
while an entry will be written to the pertinent log table. 

Printing Planograms 
The Planogram Printing option is called from the File menu and allows planograms from 
the currently active floor plan to be printed. The selected planograms will be sent to the 
default printer for the computer Macro Space Management is running on. Planograms 
can be selected for printing by ticking the check boxes and then clicking OK. 

 

Planograms are selected in the Filtering tab, with the type of report required selected in 
the Templates tab. (These templates are configured in the report designer module). The 
sequence the planograms are printed in is specified in the Collation tab. This is useful if a 
large number of planograms are being printed. 
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16 
Find and Open 

Overview of Find and Open 
Find and Open provides and alternative to opening floor plans via Store Manager. It will 
return a list of all floor plans that a user has permissions for and allow them to select 
which to open. It is accessed from the File menu in the Planner module. 

 

Selecting the Find and Open option will bring up the Find and Open dialog box. 
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Note: Users will only be able to see floor plans they have 
been assigned permissions for in the Administration 
Module. If a user has not been assigned those permissions, 
they will not be able to see the floor plan in the Find and 
Open dialog box. 

The basic method of operation is as follows: 

 

Administration Module 
Within the Administration Module: 
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 The Stores users have permissions to open floor plans from are assigned in the 
Data Security dialog box - Stores Tab. 

 The Store Statuses users have permissions to open floor plans from are assigned 
in the Data Security dialog box - Statuses Tab 

 The File Statuses users have permissions to open floor plans from are assigned in 
the Data Security dialog box - Statuses Tab. 

 Custom SQL (configurable from the Custom Query option accessed from the 
General Menu in the Administration module) will determine what fields appear 
in the Find and Open dialog box. This is done by modifying the Floor Plan Print 
dialog box. 

 The Custom Query Option in the Administration Module (General Module) can 
be used to configure what fields can be search using the Find option. This is done 
by modifying the Stores query. 

These settings determine what will appear in the Find and Open Floor Plans dialog box 
when it is accessed in the Planner module and what fields can be searched. 

Note: In order to access the Administration Module, users 
must have permission to do so. 

Planner Module 
The Print Floor Plans dialog box may be accessed from the File Menu > Find and Open 
option. Users with permissions to access the Planner module automatically have 
permission to use the functionality. 

Using Find and Floor Plan 
The functionality is used as follows: 
1. The Find and Open Plans dialog box is selected from the file menu. 

2. The appropriate floor plans are selected in the Filtering tab of the Print Floor Plans 
dialog box. 

3. Settings determining the visual appearance of the printed drawing are specified in 
the Rendering tab. 

4. On clicking the Open button, the selected floor plans will be opened. At the same 
time as they are opened, the required changes to the visual appearance (specified in 
the Rendering tab) will be made. 

5. After the selected floor plans have been opened, the Find and Open Plans dialog box 
will remain open until the Cancel button has been clicked. 

The Filtering Tab 
The Filtering tab enables the user to select the Floor Plans to open. It will populate with 
all floor plans that the user has permission to access. 
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Find 
Which fields Find will operate on is determined by the Custom SQL configured in the 
Custom Query option accessed from the General Menu in the Administration module. 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 

Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in 
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Wild 
Card 

Description 

this position 

# Any number in this 
position 

  

If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'New' will be treated as '*New*' and will find New York, New Delhi, etc. 

Right Click Menu 

The right click menu provides a quick way of modifying the selected items. 

 

 Select All will select (but not check) all rows of data 

 Clear All will deselect (but not uncheck) all rows of data 

 Check Selected will check all rows of selected data 
 Uncheck Selected will uncheck all rows of selected data 

 Check All will check all rows of data 

 Uncheck All will uncheck all rows of data 

 Paste allows users to paste a carriage returned list of floor plan identifiers from 
the Windows clipboard. All rows in the dialog box that match the pasted 
information will be checked. 

Filtering 
The dialog box is provided with a series of filters on each column. Setting a filter on one 
column will affect data in all other columns. 
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They are used as follows: 

 Show All - this option shows all results. 

 Custom Filter - this option allows users to set filters using Boolean logic. The 
options are: 

– Equal to: will return rows that are an exact match for the entered text. 

– Not Equal to: will return rows that do not match the text string 

– Contains: will return rows where part of the data matches the text string. 
(Uses implied wild cards). 

– Does not contain: will return rows where no part of the data matches the 
text string. (Uses implied wild cards). 

– Begins with: will return rows where the text string is an exact match for the 
start of the data. 

– Ends with: will return rows where the text string is an exact match for the 
end of the data. 

– Does not begin with: will return rows where the text string is not an exact 
match for the start of the data. 

– Does not end with: will return rows where the text string is not an exact 
match for the end of the data. 

 Blanks - column will be filtered to only show rows with null values. 

 Non-Blanks - column will be filtered to only show rows containing a value 
 Results - column will be filtered to only show the selected result. 

Boolean logic also includes the use of And or Or. 
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 And means that both conditions must be met. A and B means the data returned 
must contain both A and B. 

 Or means either condition can be met. A or B means the data returned can 
contain either A or B. It does not need to contain both. 

Selecting Floor Plans to open 

Floor plans may be selected for opening by ticking the appropriate check box. On 
clicking OK, the floor plan(s) will open. 

The Rendering Tab 
The Rendering Tab is used to ensure the visual appearance of the floor plan is as 
desired. 

 

Set Layer Theme 
If the check box is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 

These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Aliased dialog box on the Format menu. 
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Change Visual Appearance 
If the checkbox is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 
 2D Wire Frame 

 3D Wire Frame 

 Hidden Detail 

 Shaded 

 Shaded with Edges 

 Conceptual 
 Realistic 

 

The images above show the different visual appearances available. They can be set by 
means of the Visual Styles toolbar or Visual Styles Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options: Add Titleblock or Use 
Existing Layout. 

1. Add Titleblock 

If the Add Titleblock option is selected, users may select a title block from a drop 
down list. The list of available title blocks is configured using the Title Block option 
on the Planning menu in the Administration module. 
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2. Use Existing Layout 

If the Use Existing Layout option is selected, users can enter a name matching the 
name of a paper space tab. This may be typed in. Alternatively it may be selected 
from the drop down list, which will contain the last ten names. Information in the 
drop down list is not case sensitive and the following wild cards may be used: 

Wild 
Card 

Comment 

* Any number of 
characters 

? Any single 
character 

# Any single number 

The names of the paper space tabs can be seen at the foot of the floor plan in the 
Planner module. In the example below they are named Overall Store, Food and 
Drink, Electrical and Clothing. 
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17 
Floor Plan Printing 

Overview of Floor Plan Printing 
Floor Plan Printing allows the user to list all floor pans that they have access rights to. 
They then have the ability to select plans to be printed and, before they are printed, 
specify how the appearance and data associated with the floor plans can be updated. 
After printing, all changes will be undone so that the floor plan is in the condition it was 
in before printing. 

Note: Users wishing to Publish the floor plan (output it in 
electronic or hard copy form with permanent changes) 
should use the Immediate Floor Plan Publishing option from 
the File menu. 

Assessing Floor Plan Printing 
The Print Floor Plan functionality is accessed from the File Menu > Plot > Search and 
Print option. Users with permissions to access the Planner module will automatically 
have permission to use the functionality. 

 

The Print Floor Plan dialog box will appear. 
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If there are any errors during selecting the options, a warning icon will appear on the 
appropriate tab and an explanation will appear in the status bar. In the example below, 
there is a problem with the selected options on the collation tab. 

 

Reversing Changes Made During Floor Plan Printing 
Options in the Print Floor Plans dialog box allow the use to specify the changes required 
to the floor plan before it is printed. The settings selected in the Rendering and Pre-
Processing tabs will affect the visual appearance of the floor plan and will be made 
before it printing. This allows users to review a hard copy version of the floor plan in a 
specified condition. 

After printing, the changes will be reversed and the floor plan returned to the state it was 
before printing. The status of the floor plan will also be left unchanged. 
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Using Floor Plan Printing 
The basic method of operation is as follows: 

 

Administration Module 
Within the Administration Module: 
 The Stores users have permissions to print floor plans from are assigned in the 

Stores option of the Status tab of the Data Security dialog box. 

 The Store statuses users have permissions to print floor plans from are assigned 
in the Stores option of the Status tab of the Data Security dialog box. 

 The file statuses users have permissions to print floor plans from are assigned in 
the Files option of the Statuses tab of the Data Security dialog box. 

Note: the floor plans that a user can see are dependent on 
the combination of store, store status and file status 
permissions. 

 The fields that display in the Filtering Tab of the Print floor Plans dialog box are 
configured in the Custom SQL dialog box. 

These settings determine what will appear in the Print floor Plans dialog box when it is 
accessed in the Planner and Merchandiser modules. 

Note: In order to access the Administration Module, users 
must have permission to do so. 

Planner Module 
The Print Floor Plans dialog box may be accessed from the File Menu > Plot option. Users 
with permissions to access the Planner module automatically have permission to use the 
functionality. 

Using Floor Plan Printing 
The functionality is used as follows: 

 The Print Floor Plans dialog box is selected from the file menu. 

 The appropriate floor plans are selected in the Filtering tab of the Print Floor 
Plans dialog box. 

 Settings determining the visual appearance of the printed drawing are specified 
in the Rendering tab. 



The Filtering Tab  

190 Oracle Retail Store Planner's User Guide 

 Settings determining how data associated with the floor plan is updated are 
specified in the Pre-Processing tab. 

 The sequence the selected floor plans are to be printed in is specified in the 
Collation Tab. 

 On clicking the Print button, the first floor plan will be opened (if not already 
open) in the sequence specified in the Collation Tab. 

 Changes will be made to the floor plan as specified in the Rendering and Pre-
processing tabs. 

 The floor plan will be printed on the default printer associated with the user's 
computer. 

 The changes made for printing purposes will be undone and the floor plan 
checked back in. 

The Filtering Tab 
The Filtering tab enables the user to select the Floor Plans to print. It will populate with 
all floor plans which have Publish Dates on or before the current date. 

 

Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 
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Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in 
this position 

# Any number in this 
position 

  

If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'New' will be treated as '*New*' and will find New York, New Delhi, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 

 Select All will select (but not check) all rows of data 

 Clear All will deselect (but not uncheck) all rows of data 

 Check Selected will check all rows of selected data 

 Uncheck Selected will uncheck all rows of selected data 

 Check All will check all rows of data 

 Uncheck All will uncheck all rows of data 
 Paste allows users to paste a carriage returned list of floor plan identifiers from 

the Windows clipboard. All rows in the dialog box that match the pasted 
information will be checked. 
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Selecting Floor Plans to Process 
Floor plans may be selected for printing by ticking the appropriate check box. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 

 

They are used as follows: 

 Show All - this option shows all results. 

 Custom Filter - this option allows users to set filters using Boolean logic. The 
options are: 

– Equal to: will return rows that are an exact match for the entered text. 

– Not Equal to: will return rows that do not match the text string 

– Contains: will return rows where part of the data matches the text string. 
(Uses implied wild cards). 

– Does not contain: will return rows where no part of the data matches the text 
string. (Uses implied wild cards). 

– Begins with: will return rows where the text string is an exact match for the 
start of the data. 

– Ends with: will return rows where the text string is an exact match for the 
end of the data. 
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– Does not begin with: will return rows where the text string is not an exact 
match for the start of the data. 

– Does not end with: will return rows where the text string is not an exact 
match for the end of the data. 

 Blanks - column will be filtered to only show rows with null values. 

 Non-Blanks - column will be filtered to only show rows containing a value 

 Results - column will be filtered to only show the selected result. 

Boolean logic also includes the use of And or Or. 

 And means that both conditions must be met. A and B means the data returned 
must contain both A and B. 

 Or means either condition can be met. A or B means the data returned can 
contain either A or B. It does not need to contain both. 

The Rendering Tab 
The Rendering Tab is used to ensure the visual appearance of the floor plan is as 
desired. 

 

Set Layer Theme 
If the check box is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
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individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 

These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Aliased dialog box on the Format menu. 

 

Change Visual Appearance 
If the checkbox is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 

 2D Wire Frame 
 3D Wire Frame 

 Hidden Detail 

 Shaded 

 Shaded with Edges 

 Conceptual 

 Realistic 

 

The images above show the different visual appearances available. They can be set by 
means of the Visual Styles toolbar or Visual Styles Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options: Add Titleblock or Use 
Existing Layout. 

1. Add Titleblock 

If the Add Titleblock option is selected, users may select a title block from a drop down 
list. The list of available title blocks is configured using the Title Block option on the 
Planning menu in the Administration module. 
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2. Use Existing Layout 

If the Use Existing Layout option is selected, the user has two options; to publish all 
layouts except model space, or to publish selected layouts. 

• All layouts except model space 

If this option is selected, all layouts except the model space layout will be 
published for each floor plan. The layout names option will also be greyed out 
and unavailable. 

• Layout Names 

If this option is selected, users can enter a name matching the name of a paper 
space tab. This may be typed in. Alternatively it may be selected from the drop 
down list, which will contain the last ten names. Information in the drop down 
list is not case sensitive and the following wild cards may be used: 

Wild 
Card 

Comment 

* Any number of 
characters 

? Any single 
character 

# Any single 
number 

The names of the paper space tabs can be seen at the foot of the floor plan in the 
Planner module. In the example below they are named Overall store, food and 
drink, Electrical and Clothing. 

 
If multiple layout names are required, these should be separated by a comma. 

3. Set Viewing Direction 

The viewing direction can be set if a Layout tab has been selected in the set Layout 
section. Users can then select the View direction from the drop down list. The options 
are: 

 Plan 

 NE Isometric 
 SW Isometric 

 SE Isometric 

 NW Isometric 
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 N Elevation 

 E Elevation 

 S Elevation 

 W Elevation 
These correspond to the options in the 3D view option from the View menu, or in the 
View toolbar. 

If the user elects to Use Custom View, the user will be able to type in the name of a 
custom view. This custom view name may use standard wild cards to allow for 
inconsistencies in the actual name. It will not be case sensitive. 

The example below shows a floor plan in SW Isometric view. 

 

The Collation Tab 
The Collation Tab allows users to specify the sequence the floor plans will be printed in. 
This makes it easier to sort and distribute them after printing. 

At least one collation option must be selected, or the tab will show as having an error. 
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The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 
 Region is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 

 District is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 
 Store Number is the Store Code in the Store dialog box in Store Manager. 

 Store Name is the Store Name in the Store dialog box in Store Manager. 



The Collation Tab  

198 Oracle Retail Store Planner's User Guide 

 
 Floor Type is the Floor Type in the Floor dialog box in Store Manager. 

 Floor Description is the Floor Description in the Floor dialog box in Store 
Manager. 

 
 Revision Name is the Revision Name in the Floor dialog box in Store Manager. 
 Revision Number is the Revision Number in the Floor dialog box in Store 

Manager. 
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 Effective Date is the Effective Date in the File Properties dialog box in Store 

Manager 

 Publish Date is the Publish Date in the File Properties dialog box in Store 
Manager. 

 

The Pre-Processing Tab 
The Pre-processing tab is used to ensure that the information in the floor plan is up to 
date. 
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Synchronize 
Synchronize is used to make sure that the information in the floor plan matches that held 
in the Macro Space Planning database. This information could differ for a number of 
reasons: 

 Changes have been made in the floor plan using AutoCAD tools and these 
changes have not been written to the database. 

 Changes have been manually made to floor plans in the Merchandiser module, or 
in In-Store Space Collaboration. 

 Changes have been made to floor plans in the database by batch processes. 

 Changes have been made to the floor plan outside Macro Space Planning - for 
example in raw AutoCAD. 

The following options are available: 

 None - no synchronization operations will be carried out. 

 Auto-Synchronize - the application will automatically detect which form of 
synchronization is required: 

– If the information in the database exceeds the date the floor plan was last 
modified and saved in Planner (or modified in raw AutoCAD), the 
information will be synchronized "match the database". 

– If the date of the information in the floor plan (or the date it was modified in 
raw AutoCAD) exceeds the date the information was written to the database, 
the information will be synchronized "match the drawing". 
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– If (i) the date the floor plan was last modified in raw AutoCAD exceeds the 
date the floor plan was last modified in Planner and (ii) the date the floor 
plan was last modified in Planner is less than the date the floor plan was last 
modified in Merchandiser, In-Store Space Collaboration or by a batch 
process, synchronization will be by 'cross-matching'. 

• Information in the floor plan for zones, fixtures and other blocks and 
aisles will be written to the database. 

• Information in the database for shelves and merchandise will be written 
into the floor plan. 

 Synchronize to Match Database - information in the database will be written 
into the floor plan. 

 Synchronize to Match Drawing - information from the floor plan will be written 
to the database. 

 Cross Match - information on zones, fixtures and other blocks and aisles will be 
written to the database, while information on shelves and merchandise will be 
written into the floor plan. 

Items to Synchronize 
Once the synchronization method has been selected, specific items can be selected for the 
synchronization operation to work on. 

 Include Fixtures - fixtures and fittings will be synchronized. 

 Include Shelves - shelf objects will be synchronized. 

 Include Products - products and planograms will be synchronized 

 Include Other Blocks – blocks of type Other will be synchronized. 
 Include Zones - Zones will be synchronized. 

 Include Views - view positions in Planner or Merchandiser will be synchronized. 
(This will not affect In-Store Space Collaboration). 

 Include Aisles - Aisles will be synchronized.. 

The following points should be noted: 

 If shelf positions are changed in Planner and the 'Synchronize to Match Drawing' 
option is selected, the modified shelf positions will be written back to the 
database. This could potentially affect any planograms using those shelves. 

 Zones can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current zone information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

 Aisles can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current aisle information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

Restructure Drawing 
Restructure Drawing allows users to update the drawing so that the blocks in the 
drawing match the latest information defined in Fixture Studio. 

 Redefine Blocks from Disc - this results in the DWG files in the drawing being 
updated with the latest versions of those DWG files defined in Fixture Studio. 
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 Explode Composite Blocks - this will explode all blocks defined as composites in 
Fixture Studio. These blocks will be placed on Layer 0 and will require having 
Color, Line type and Line-Weight to set to BYLAYER. 

Note: Composite Blocks that are not flagged as composite in 
Fixture Studio will not be exploded. 

 Reset Levels - this will reset the elevation of the block to that defined by the level 
assigned to it in the Insertion Tab of the Block Details dialog box in Fixture 
Studio. 

 Reset Color, Line type and Line-Weight to BYLAYER - this option will look at 
the color, line type and line weight of each instance of a block in the drawing. It 
they differ from the defaults for that layer, they will be set back to those defaults. 

 Reset Layer - if blocks have been moved to a layer different to that specified in 
the Insertion Tab of the Block Details dialog box in Fixture Studio, the block will 
be restored to the default layer. 

Annotation 
The annotation option allows users to update the annotation in the floor plan so it 
matches the latest annotation rules specified in the Text Styles option in the 
Administration Module. 

 Annotate Fixtures - all fixtures that have had the 'Include in Fixture Annotation' 
check box ticked in the Category Tab of the Block Details dialog box in Fixture 
Studio will have their annotation updated. 

 Annotate Products - all products, planograms and planogram profiles will have 
their annotation updated. 

 Annotate Zones - all zones will have their annotation updated. 

 Update Title Block - all text boxes in the title block that reference information in 
the database will have that information updated. 

Calculations 
This option is used to update the calculations associated with the floor plan. This has a 
number of benefits including ensuring that reports based on this floor plan are accurate 
and up to date. It also ensures that annotation draws correctly. 

 Calculate Areas - this updates the area calculations; and hence the floor area 
assigned to each fixture. 

 Calculate Fixture Adjacencies - this updates the fixture adjacencies; and hence 
the relationship of one fixture to another. 

 Calculate Product Adjacencies - this updates the product adjacencies; and hence 
the relationship of one product to another. 

 Calculate Aisle Adjacencies - this updates the aisle adjacencies; and hence which 
products share an aisle. 

 Calculate Space Measures - this updates space measures: the volume occupied 
by each product in a planogram. 

 Calculate Face Planes - this updates face planes: the frontal area occupied by 
each product in a planogram. 
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18 
Floor Plan Processing 

Overview of Floor Plan Processing 
Floor Plan Processing is used to prepare floor plans for further use after manual or other 
batch operations have been carried out. 

Accessing Floor Plan Processing  
The Process Floor Plan functionality is accessed from the File Menu > Drawing Utilities > 
Automated Processing option. 

 

Selecting Automated Processing will bring up the Process Floor Plans dialog box. This 
will open at the filtering tab and will display all floor plans that are at or have exceeded 
their Publish Date. 
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Note: The columns that are displayed in the dialog box are 
configurable in the Custom SQL option available from the 
General Menu in the Administration module. 

Using Floor Plan Processing 
Floor Plan Processing is used to prepare floor plans for further use after manual or other 
batch operations have been carried out. The options available are: 

 

The basic method of operation is as follows: 
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Administration Module 
 Permissions to use the floor plan pre-processing functionality are assigned in the 

Functional security dialog box in the Administration module. 

 The stores that users have permissions to process floor plans for are set in the 
Stores tab of the Data Security dialog box in the Administration module. 

 The store statuses that users have permissions to process floor plans for are set in 
the Stores option of the Status tab of the Data Security dialog box in the 
Administration Module. 

 The file statuses that users have permission to process are set in the Files option 
of the Status tab of the Data Security dialog box in the Administration module. 

Note: The floor plans that a user has permission to process 
are dependent on the combination of store, store status and 
file status permissions. 

 The fields that users can see in the Floor Plan Processing dialog box are specified 
in the Custom SQL dialog box in the Administration Module. 

Batch Processes 
Floor Plan Pre-Processing can be run as a batch process. In order to do this, a user must 
first have been assigned permission in the Functional Security dialog box in the 
Administration Module. The Batch Process will then execute using command line 
switches to define parameters. 

Planner Module 
In order to use Immediate Floor Plan Pre-Processing a user must first have been assigned 
permission in the Functional Security dialog box in the Administration Module. When 
the Floor Plan Processing dialog box first opens, the user must manually chose the 
required settings. 

The options available in Floor Plan Processing are: 

 Synchronization 

Synchronization is used to ensure that the floor plan (DWG file) used in the 
Planner module and the information held in the database is identical. Differences 
could build up between the two. Differences can occur if for instance, changes 
are made to the floor plan outside the Macro Space Planning, or changes are 
made to the database by processes such as planogram substitution. Using 
synchronize resolves these differences. 

 Rendering 

Rendering is used to ensure the visual appearance of the published or printed 
drawing conforms to a specified format. This includes configuring the layers 
used in the floor plan, the visual appearance of the blocks used, refreshing the 
data displayed in the title block and selecting the layout tab in AutoCAD paper 
space. 

 Restructuring Drawing 

The restructure options are used to ensure that the blocks in the floor plan 
conform to the latest versions defined in the Fixture Studio module. For example, 
the functionality can be used to ensure that the version of the DWG file used to 
represent the block is the latest version, that its color, line type and line weight 
are set to the correct values for the layer is designated to be on and that its 
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elevation in the drawing (z coordinate) is identical to the value specified in 
Fixture Studio. 

 Annotation 

The annotation options are used to refresh zone, fixture and product annotation. 
They are also used to ensure the information displayed in the Title Block is up to 
date. For example, if the Planogram Substitution functionality has been used to 
change some of the planograms in the floor plan, it would be necessary to re-
annotate the floor plan to reflect the changed merchandise. 

 Calculations 

The calculation option is used to ensure that information used for reporting 
purposes is up to date. For example, if the Planogram Substitution functionality 
has been used to change some of the planograms in the floor plan, Product 
Adjacency, Aisle Adjacency, Face Plane and Space Measurement calculations 
would probably have to be re-run to ensure the information generated for any 
reports associated with that floor plan was up to date. 

Examples of the use of Floor Plan Automated Processing include:   

 Ensure Floor Plan data is up to date before generating reports 

If manual changes have been made in floor plans, it is by no means guaranteed 
that the person editing the floor plan has remembered to update the calculations 
before saving and closing the drawing. Running the calculations via Floor Plan 
Automated Processing is a prudent step to ensure reporting accuracy. 

 Planogram substitutions have been run as a batch process 

The need then is to prepare the floor plans for when they are next manually 
opened, or for when they are published. The processing tasks would include: 

– Synchronize (batch the database) to bring the substituted planograms into 
the Planner floor plans (DWG files). 

– Annotation to update the annotation associated with the changed 
planograms. 

– Calculations (Product Adjacency, Aisle Adjacency, Face Plane and Space 
Measurement) to ensure than any subsequent reports are accurate. 

 Floor Plans are to be published and reports are to be generated 

If floor plans are to be published and reports are to be generated, business work 
flows may make it sensible to run Floor Plan Automated Processing as a 
predecessor to generating the reports and floor plans. In this case Floor Plan 
Publishing would be configured without any options selected on the pre-
processing tab. 

Results from Floor Plan Processing 
The results from Floor Plan Processing are stored in two tables within the database. 
These results can be viewed via reports generated from BI Publisher (or similar 
software). 

Permissions to Run Process Floor Plans 
Before a user can run the Process Floor Plans functionality, they must first have been 
assigned the appropriate permissions in the Administration module. This is done using 
the Functional Security dialog box accessed from the Security menu. 
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Note: For users to access the Administration Module, they 
must first have the appropriate permissions. 

 

Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor Plan Automated Publishing, Floor Plan Publishing, Planogram 
Publishing) have the ability to use that functionality. In the example above, the 
Equipment Planning Manager and Merchandise Planning Manager User Groups have 
been assigned permission to use the Floor Plan Automated Processing functionality. 

Note: Floor Plan Automated Processing (the right to run 
calculations on floor plans) is a separate user group to Floor 
Plan Publishing. Floor Plan Publishing users can run 
calculations on floor plans as part of the publishing process. 
To run Floor Plan Automated Publishing 'stand alone' as a 
preparatory action for outputting reports, etc, requires the 
user to have separate permission for that functionality. 

The User Groups precise rights depend on settings in the Permissions dialog box. This is 
accessed from the right click menu in the Functional Security dialog box. 
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This will bring up the Permissions dialog box. 

 

 If the User Group belongs to a Command Group higher in the Command Group 
hierarchy, by default it will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the 
selections made using the check boxes. 

 If the User Group only exists at this level in the hierarchy, the Permissions dialog 
box will initially have all check boxes blank. The Administrator must then assign 
Allow of Deny permissions.   

The Filtering Tab 
The Filtering tab enables the user to select the Floor Plans to Process. It will populate 
with all floor plans which have Publish Dates on or before the current date. 
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Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 

Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in 
this position 
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Wild 
Card 

Description 

# Any number in this 
position 

  

If explicit wild cards are not used, implicit wild cards will be assumed. For example, the 
text entry 'New' will be treated as '*New*' and will find New York, New Delhi, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 

 Select All will select (but not check) all rows of data 

 Clear All will deselect (but not uncheck) all rows of data 

 Check Selected will check all rows of selected data 

 Uncheck Selected will uncheck all rows of selected data 

 Check All will check all rows of data 

 Uncheck All will uncheck all rows of data 

Selecting Floor Plans to Process 
Floor plans may be selected for processing by ticking the appropriate check box. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 
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They are used as follows: 

 Show All - this option shows all results. 
 Custom Filter - this option allows users to set filters using Boolean logic. The 

options are: 

– Equal to: will return rows that are an exact match for the entered text. 

– Not Equal to: will return rows that do not match the text string 

– Contains: will return rows where part of the data matches the text string. 
(Uses implied wild cards). 

– Does not contain: will return rows where no part of the data matches the 
text string. (Uses implied wild cards). 

– Begins with: will return rows where the text string is an exact match for the 
start of the data. 

– Ends with: will return rows where the text string is an exact match for the 
end of the data. 

– Does not begin with: will return rows where the text string is not an exact 
match for the start of the data. 

– Does not end with: will return rows where the text string is not an exact 
match for the end of the data. 

 Blanks - column will be filtered to only show rows with null values. 

 Non-Blanks - column will be filtered to only show rows containing a value 

 Results - column will be filtered to only show the selected result. 

Boolean logic also includes the use of And or Or. 
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 And means that both conditions must be met. A and B means the data returned 
must contain both A and B. 

 Or means either condition can be met. A or B means the data returned can 
contain either A or B. It does not need to contain both. 

The Rendering Tab 
The Rendering Tab is used to ensure the visual appearance of the floor plan is as 
desired. 

 

Set Layer Theme 
If the check box is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 

These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Aliased dialog box on the Format menu. 
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Change Visual Appearance 
If the check box is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 
 2D Wire Frame 

 3D Wire Frame 

 Hidden Detail 

 Shaded 

 Shaded with Edges 

 Conceptual 
 Realistic 

 

The images above show the different visual appearances available. They can be set by 
means of the Visual Styles toolbar or Visual Styles Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options: Add Titleblock or Use 
Existing Layout. 

 Add Titleblock 

If the Add Titleblock option is selected, users may select a title block from a drop 
down list. The list of available title blocks is configured using the Title Block 
option on the Planning menu in the Administration module. 



The Pre-processing Tab  

214 Oracle Retail Store Planner's User Guide 

 
 Use Existing Layout 

If the Use Existing Layout option is selected, users can enter a name matching the 
name of a paper space tab. This may be typed in. Alternatively it may be selected 
from the drop down list, which will contain the last ten names. Information in 
the drop down list is not case sensitive and the following wild cards may be 
used: 

Wild 
Card 

Comment 

* Any number of 
characters 

? Any single 
character 

# Any single 
number 

The names of the paper space tabs can be seen at the foot of the floor plan in the 
Planner module. In the example below they are named Overall store, food and drink, 
Electrical and Clothing. 

 

The Pre-processing Tab 
The Pre-processing tab is used to ensure that the information in the floor plan is up to 
date. 
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Synchronize 
Synchronize is used to make sure that the information in the floor plan matches that held 
in the Macro Space Planning database. This information could differ for a number of 
reasons: 

 Changes have been made in the floor plan using AutoCAD tools and these 
changes have not been written to the database. 

 Changes have been manually made to floor plans in the Merchandiser module, or 
in In-Store Space Collaboration. 

 Changes have been made to floor plans in the database by batch processes. 

 Changes have been made to the floor plan outside Macro Space Planning - for 
example in raw AutoCAD. 

The following options are available: 

 None - no synchronization operations will be carried out. 

 Auto-Synchronize - the application will automatically detect which form of 
synchronization is required: 

– If the information in the database exceeds the date the floor plan was last 
modified and saved in Planner (or modified in raw AutoCAD), the 
information will be synchronized "match the database". 

– If the date of the information in the floor plan (or the date it was modified in 
raw AutoCAD) exceeds the date the information was written to the database, 
the information will be synchronized "match the drawing". 
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– If (i) the date the floor plan was last modified in raw AutoCAD exceeds the 
date the floor plan was last modified in Planner and (ii) the date the floor 
plan was last modified in Planner is less than the date the floor plan was last 
modified in Merchandiser, In-Store Space Collaboration or by a batch 
process, synchronization will be by 'cross-matching'. 

– Information in the floor plan for zones, fixtures and other blocks and aisles 
will be written to the database. 

– Information in the database for shelves and merchandise will be written into 
the floor plan. 

 Synchronize to Match Database - information in the database will be written 
into the floor plan. 

 Synchronize to Match Drawing - information from the floor plan will be written 
to the database. 

 Cross Match - information on zones, fixtures and other blocks and aisles will be 
written to the database, while information on shelves and merchandise will be 
written into the floor plan. 

Items to Synchronize 
Once the synchronization method has been selected, specific items can be selected for the 
synchronization operation to work on. 

 Include Fixtures - fixtures and fittings will be synchronized. 

 Include Shelves - shelf objects will be synchronized. 

 Include Products - products and planograms will be synchronized 

 Include Other Blocks - this synchronizes all blocks assigned as type 'other' in 
Fixture Studio. 

 Include Zones - Zones will be synchronized. 

 Include Views - view positions in Planner or Merchandiser will be synchronized. 
(This will not affect In-Store Space Collaboration). 

 Include Aisles - Aisles will be synchronized. 

The following points should be noted: 
 If shelf positions are changed in Planner and the 'Synchronize to Match Drawing' 

option is selected, the modified shelf positions will be written back to the 
database. This could potentially affect any planograms using those shelves. 

 Zones can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current zone information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

 Aisles can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current aisle information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

Restructure Drawing 
Restructure Drawing allows users to update the drawing so that the blocks in the 
drawing match the latest information defined in Fixture Studio. 

 Redefine Blocks from Disc - this results in the DWG files in the drawing being 
updated with the latest versions of those DWG files defined in Fixture Studio. 
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 Explode Composite Blocks - this will explode all blocks defined as composites in 
Fixture Studio. These blocks will be placed on Layer 0 and will require having 
Color, Line type and Line-Weight to set to BYLAYER. 

Note: Composite Blocks that are not flagged as composite in 
Fixture Studio will not be exploded. 

 Reset Levels - this will reset the elevation of the block to that defined by the level 
assigned to it in the Insertion Tab of the Block Details dialog box in Fixture 
Studio. 

 Reset Color, Line type and Line-Weight to BYLAYER - this option will look at 
the color, line type and line weight of each instance of a block in the drawing. If 
they differ from the defaults for that layer, they will be set back to those defaults. 

 Reset Layer - if blocks have been moved to a layer different to that specified in 
the Insertion Tab of the Block Details dialog box in Fixture Studio, the block will 
be restored to the default layer. 

Annotation 
The annotation option allows users to update the annotation in the floor plan so it 
matches the latest annotation rules specified in the Text Styles option in the 
Administration Module. 

 Annotate Fixtures - all fixtures that have the 'Include in Fixture Annotation' 
checkbox ticked in the Category Tab of the Block Details dialog box in Fixture 
Studio will have their annotation updated. 

 Annotate Products - all products, planograms and planogram profiles will have 
their annotation updated. 

 Annotate Zones - all zones will have their annotation updated. 

 Update Title Block - all text boxes in the title block that reference information in 
the database will have that information updated. 

Calculations 
This option is used to update the calculations associated with the floor plan. This has a 
number of benefits including ensuring that reports based on this floor plan are accurate 
and up to date. It also ensures that annotation draws correctly. 

 Calculate Areas - this updates the area calculations; and hence the floor area 
assigned to each fixture. 

 Calculate Fixture Adjacencies - this updates the fixture adjacencies; and hence 
the relationship of one fixture to another. 

 Calculate Product Adjacencies - this updates the product adjacencies; and hence 
the relationship of one product to another. 

 Calculate Aisle Adjacencies - this updates the aisle adjacencies; and hence which 
products share an aisle. 

 Calculate Space Measures - this updates space measures: the volume occupied 
by each product in a planogram. 

 Calculate Face Planes - this updates face planes: the frontal area occupied by 
each product in a planogram. 
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Floor Plan Publishing 

Overview of Floor Plan Publishing 
Note: The way that planogram publishing performs in the 
Planner and Merchandiser modules is dependent of settings 
in other modules. This section is included so that users of the 
Planogram Publishing Functionality can discuss requested 
changes with the Administrators. 

The purpose of publishing a floor plan is to disseminate information on the type, 
quantity and layout of equipment and merchandise to those tasked with implementing 
the change. Publishing this floor plan can be done in hard copy or electronic format. The 
date at which this is executed depends on the Publish Date set in the File Properties 
dialog box in Store Manager. 

 

Note: Publishing floor plans should not be confused with 
reporting on that floor plan. Reporting is used for the 
collation of information required for ordering the equipment 
and merchandise required to implement the floor plan. 
Reports will be used in conjunction with the purchasing 
system and supply chain planning in order to ensure the 
required equipment and merchandise arrive at the required 
locations in a timely manner. 

The Floor Plan Publishing functionality is used to disseminate floor plans to specified 
printers or Windows folders to facilitate implementing those floor plans. 



Floor Plan Publishing 

Overview of Floor Plan Publishing  219 

Note: A retail organization will still need a method of 
distributing the floor plans from the printer or Windows 
folder to the end user. 

If there are any errors during selecting the options, a warning icon will appear on the 
appropriate tab and an explanation will appear in the status bar. In the example below, 
there is a problem with the selected options on the collation tab. 

 

Using Floor Plan Publishing 
The basic method of operation is as follows: 

 

Administration Module 
The Administration module is used to configure access to the different parts of the 
functionality. It is also used to assign permissions to print or publish specific floor plans 
and planograms. Finally, it is used to configure how the batch processes for publishing 
floor plans will work. There are four options that affect publishing and printing of floor 
plans: 
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 The Functional Security option (Security menu) allows Administrators to control 
who can run Floor Plan as a batch process. It also controls who can access 
Immediate Floor Plan Publishing in the Planner Module. 

 The Data Security option (Security menu) allows Administrators to control what 
stores, store statuses and file statuses a user can use to print or publish from 
within the Planner module - this in turn control what floor plans they see. 

 The Custom Query dialog box allows an Administrator to specify what fields 
will appear in the Immediate Floor Plan Publish dialog box in the Planner 
module. 

 Configuring Outputs for Batch Process: the outputs for the batch process are 
configured in the administration module using the Floor Plan Publishing 
Configuration dialog box. 

Running as a Batch Processes 
Floor Plan Publishing can be run as a batch process - this is typically run overnight so 
that these processor hungry tasks can be executed without affecting the manual users of 
the system. The settings determining how Floor Plan Publishing operates when called by 
the batch process are set in the Floor Plan Publishing Configuration dialog box. 

Floor Plan Pre-Processing (running a series of calculations to make sure that information 
used for reporting, etc., is accurate) can either be done as a separate preceding batch 
process, or it can be done according to settings in the Pre-Processing Tab of the Floor 
Plan Publishing Configuration dialog box. 

The rights for both Floor Plan Pre-Processing and Floor Plan Publishing are set in 
Functional Security in the Administration Module. 

Planner Module 
Within the Planner module, the Immediate Publishing of Floor Plans functionality can 
only be accessed by users that have been granted permissions in the Administration 
module. 

Other Functionality 
There are three other items of functionality that affect floor plan publishing. 

 In the Configuration Module, the Directories tab allows users to specify where 
the root folder holding published floor plans is located. Sub-folders holding 
specific published floor plans will be created as children of this root folder. 

 Tables in the Macro Space Planning database hold the results of floor plan pre-
processing and floor plan publishing operations. 

 BI Publisher (or a similar application) can be used to generate reports based on 
the information held in the tables in the database - for example the names and 
results of floor plans that have been processed. 

Permissions to Run Immediate Floor Plan Publishing 
Before a user can run Immediate Floor Plan Publishing, they must first have been 
assigned the appropriate permissions in the Administration module. This is done using 
the Functional Security dialog box accessed from the Security menu. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 
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Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In the example above, the 
Equipment Planning Manager and Merchandise Planning Manager User Groups have 
been assigned permission to use the Floor Plan Publishing functionality. 

Note: Floor Plan Automated Publishing (the right to run 
calculations on floor plans) is a separate user group. Users 
with permissions for Floor Plan Publishing can set 
calculation options in the Pre-processing tab of the Floor 
Plan Publishing Configuration dialog box. These will 
execute during the publishing of floor plans. They will not 
execute unless the user is a member of a User Group with 
permissions for the Floor Plan Automated Publishing User 
Group. 

The User Groups precise rights depend on settings in the Permissions dialog box. This is 
accessed from the right click menu in the Functional Security dialog box. 
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This will bring up the Permissions dialog box. 

 

 If the User Group belongs to a Command Group higher in the Command Group 
hierarchy, by default it will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the 
selections made using the check boxes. 

 If the User Group only exists at this level in the hierarchy, the Permissions dialog 
box will initially have all check boxes blank. The Administrator must then assign 
Allow or Deny permissions.   

Dates Floor Plans will be Published 
The purpose of publishing a floor plan is to disseminate information on the type, 
quantity and layout of equipment and merchandise to those tasked with implementing 
the change. Publishing a floor plan can be done in hard copy or electronic format. The 
date at which this is executed depends on the Publish Date set in the File Properties 
dialog box in Store Manager. 
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Note: the Publish Date operates on the date only and takes 
no account of the time of day. Publish Dates are stored in 
Date/Time format in the database, but the functionality only 
references the Date. 

 

Another factor affecting the date at which at which floor plans will be published is the 
Lead Time Tolerance (Hours) setting on the Output tab of the Floor Plan Publishing 
Configuration dialog box in the Administration Module. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 
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Batch processes can be set to start at any time of the day. For example, the batch process 
might initiate at 8 p.m. (20.00 hrs) in the evening to allow the maximum number of batch 
processes to be run before users come in for work again the following morning. 
However, the Publish date for the floor plan might be set for when the following day 
begins at midnight. The Lead Time Tolerance (Hours) setting allows for this. 

For example, if batch process is run on the 2nd June at 20.00 hrs in the evening and has 
no lead time tolerance, a floor plan that has a Publish Date of 3rd June would be ignored 
for publishing purposes by this run of the batch process. If however, the Lead Time 
Tolerance (Hours) setting is set to 5 hours, this will be added onto the Date and Time for 
the batch process and cause the batch process to operate as if it were running at 01.00 hrs 
in the morning of 3rd June. All floor plans with a Publish Date of 3rd June would then be 
published. 

Criteria for Publishing Floor Plans 

There are two criteria for publishing floor plans: 

 Floor Plan Publish Date is equal to or earlier than the current date 

If the Publish Date set in the File Properties dialog box in Store Manager is equal 
to or earlier than the current date (taking into account the Lead Time Tolerance 
(Hours) setting), the floor plan will be published. 

 Floor Plan has been Updated since it was Published 

In some implementations of Macro Space Planning it is possible that the floor 
plan may have been modified after it was last published. The condition for this is 
that the Modified by Planner date is greater than the Last Published Date. 
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Locations Floor Plans will be Published To 
The locations Floor Plans will published to and the file names used are specified in the 
Output tab of the Floor Plan Publishing Configuration dialog box in the Administration 
module. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 

 
This dialog box allows Administrators to specify the directory structure, file format and 
file name that will be used when floor plans are published. 

The starting point for the location floor plans will published to in electronic form can be 
seen in the details for the Floor Plan Publish system directory specified in the Directories 
Tab of the Configuration module. This tab can only be accessed if the Configuration 
module is opened from the Administration module. 
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The Filtering Tab 
The Filtering Tab is used to select the floor to publish. 
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Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 

Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in 
this position 
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Wild 
Card 

Description 

# Any number in this 
position 

  

If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*Wine*' and will find White Wine, Red Wine, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 

 Select All will select (but not check) all rows of data 

 Clear All will deselect (but not uncheck) all rows of data 

 Check Selected will check all rows of selected data 

 Uncheck Selected will uncheck all rows of selected data 

 Check All will check all rows of data 

 Uncheck All will uncheck all rows of data 
 Paste allows users to paste a carriage returned list of floor plan identifiers from 

the Windows clipboard. All rows in the dialog box that match the pasted 
information will be checked. 

Selecting Floor Plans to Process 
Floor plans may be selected for printing by ticking the appropriate check box. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 
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They are used as follows: 

 Show All - this option shows all results. 
 Custom Filter - this option allows users to set filters using Boolean logic. The 

options are: 

– Equal to: will return rows that are an exact match for the entered text. 

– Not Equal to: will return rows that do not match the text string 

– Contains: will return rows where part of the data matches the text string. 
(Uses implied wild cards). 

– Does not contain: will return rows where no part of the data matches the 
text string. (Uses implied wild cards). 

– Begins with: will return rows where the text string is an exact match for the 
start of the data. 

– Ends with: will return rows where the text string is an exact match for the 
end of the data. 

– Does not begin with: will return rows where the text string is not an exact 
match for the start of the data. 

– Does not end with: will return rows where the text string is not an exact 
match for the end of the data. 

 Blanks - column will be filtered to only show rows with null values. 

 Non-Blanks - column will be filtered to only show rows containing a value 

 Results - column will be filtered to only show the selected result. 
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Boolean logic also includes the use of And or Or. 

 And means that both conditions must be met. A and B means the data returned 
must contain both A and B. 

 Or means either condition can be met. A or B means the data returned can 
contain either A or B. It does not need to contain both 

The Rendering Tab 
The Rendering Tab is used to ensure the visual appearance of the floor plan is as 
desired. 

 

Set Layer Theme 
If the checkbox is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 
These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Aliased dialog box on the Format menu in the Planner module. 
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Change Visual Appearance 
If the check box is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 
 2D Wire Frame 

 3D Wire Frame 

 Hidden Detail 

 Shaded 

 Shaded with Edges 

 Conceptual 
 Realistic 

 

The images above show the different visual appearances available. Within the Planner 
module, the option can be set in either the Visual Styles toolbar or Visual Styles Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options: Add Titleblock or Use 
Existing Layout. 

 Add Titleblock 

If the Add Titleblock option is selected, users may select a title block from a drop 
down list. The list of available title blocks is configured using the Title Block 
option on the Planning menu in the Administration module. 
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 Use Existing Layout 

If the Use Existing Layout option is selected, the user has two options; to publish 
all layouts except model space, or to publish selected layouts. 

 All layouts except model space 

If this option is selected, all layouts except the model space layout will be 
published for each floor plan. The layout names option will also be greyed out 
and unavailable. 

If this option is chosen, it will not be possible to republish floor plans. This is 
because without a list of specified layout names, it is not possible to determine 
which layouts require republishing.  

 Layout Names 

If this option is selected, users can enter a name matching the name of a paper 
space tab. This may be typed in. Alternatively it may be selected from the drop 
down list, which will contain the last ten names. Information in the drop down 
list is not case sensitive and the following wild cards may be used: 

Wild 
Card 

Comment 

* Any number of 
characters 

? Any single 
character 

# Any single 
number 

If wild cards are used, the Republish option will only publish a single match for 
each floor plan. For example, if the wildcard is Con*, the Confectionery layout 
will be published and the Consumables layout will be omitted. 

The names of the paper space tabs can be seen at the foot of the floor plan in the 
Planner module. In the example below they are named Overall Store, Food and 
Drink, Electrical and Clothing. 

 
If multiple layout names are required, these should be separated by a comma. 
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The Collation Tab 
The Collation Tab allows users to specify the sequence floor plans will be published or 
printed in. Its main use is in printing hard copy versions of the floor plans where the 
sequence they are printed in makes it easier to sort and distribute them after printing. 

At least one collation option must be selected, or the tab will show as having an error. 

 

The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 
 Region is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 

 District is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 
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 Store Number is the Store Code in the Store dialog box in Store Manager. 

 Store Name is the Store Name in the Store dialog box in Store Manager. 

 

 Floor Type is the type selected from the drop down list in the Floor dialog box in 
Store Manager. 

 Floor Description is the Description in the Floor dialog box in Store Manager. 

 

 Revision Number is the Revision Number in the Revision dialog box in Store 
Manager. 

 Revision Name is the Revision Description in the Revision dialog box in Store 
Manager. 
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 Publish Date is the Publish Date set in the File Properties dialog box in Store 
Manager. 

 Effective Date is the Effective Date set in the File Properties dialog box in Store 
Manager. 

 

The Pre-processing Tab 
The Pre-processing tab is used to ensure that the information in the floor plan has been 
correctly updated. 
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Synchronize 
Synchronize is used to make sure that the information in the floor plan matches that held 
in the Macro Space Planning database. This information could differ for a number of 
reasons: 

 Changes have been made in the floor plan using AutoCAD tools and these 
changes have not been written to the database. 

 Changes have been manually made to floor plans in the Merchandiser module, or 
in In-Store Space Collaboration. 

 Changes have been made to floor plans in the database by batch processes. 

 Changes have been made to the floor plan outside Macro Space Planning - for 
example in raw AutoCAD. 

The following options are available: 

 None - no synchronization operations will be carried out. 

 Auto-Synchronize - the application will automatically detect which form of 
synchronization is required: 

– If the information in the database exceeds the date the floor plan was last 
modified and saved in Planner (or modified in raw AutoCAD), the 
information will be synchronized "match the database". 

– If the date of the information in the floor plan (or the date it was modified in 
raw AutoCAD) exceeds the date the information was written to the database, 
the information will be synchronized "match the drawing". 
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– If (i) the date the floor plan was last modified in raw AutoCAD exceeds the 
date the floor plan was last modified in Planner and (ii) the date the floor 
plan was last modified in Planner is less than the date the floor plan was last 
modified in Merchandiser, In-Store Space Collaboration or by a batch 
process, synchronization will be by 'cross-matching'. 

 Information in the floor plan for zones, fixtures and other blocks and 
aisles will be written to the database. 

 Information in the database for shelves and merchandise will be written 
into the floor plan. 

 Synchronize to Match Database - information in the database will be written 
into the floor plan. 

 Synchronize to Match Drawing - information from the floor plan will be written 
to the database. 

 Cross Match - information on zones, fixtures and other blocks and aisles will be 
written to the database, while information on shelves and merchandise will be 
written into the floor plan. 

Date information can be seen in the File Properties dialog box in Store Manager. 

 

Items to Synchronize 
Once the synchronization method has been selected, specific items can be selected for the 
synchronization operation to work on. 

 Include Fixtures - fixtures and fittings will be synchronized. 

 Include Shelves - shelf objects will be synchronized. 

 Include Products - products and planograms will be synchronized 

 Include Other Blocks - this synchronizes all blocks assigned as type 'other' in 
Fixture Studio. 

 Include Zones - Zones will be synchronized. 

 Include Views - view positions in Planner or Merchandiser will be synchronized. 
(This will not affect In-Store Space Collaboration). 
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 Include Aisles - Aisles will be synchronized. 

The following points should be noted: 

 If shelf positions are changed in Planner and the 'Synchronize to Match Drawing' 
option is selected, the modified shelf positions will be written back to the 
database. This could potentially affect any instances of placed planograms using 
those shelves. 

 Zones can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current zone information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

 Aisles can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current aisle information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

Restructure Drawing 
Restructure Drawing allows users to update the drawing so that the blocks in the 
drawing match the latest information defined in Fixture Studio. 

 Redefine Blocks from Disc - this results in the DWG files in the drawing being 
updated with the latest versions of those DWG files defined in Fixture Studio. 

 Explode Composite Blocks - this will explode all blocks defined as composites in 
Fixture Studio. These blocks will be placed on Layer 0 and will require having 
Color, Line type and Line-Weight to set to BYLAYER. 

Note: Composite Blocks that are not flagged as composite in 
Fixture Studio will not be exploded. 

 Reset Levels - this will reset the elevation of the block to that defined by the level 
assigned to it in the Insertion Tab of the Block Details dialog box in Fixture 
Studio. 

 Reset Color, Line type and Line-Weight to BYLAYER - this option will look at 
the color, line type and line weight of each instance of a block in the drawing. If 
they differ from the defaults for that layer, they will be set back to those defaults. 

 Reset Layer - if blocks have been moved to a layer different to that specified in 
the Insertion Tab of the Block Details dialog box in Fixture Studio, the block will 
be restored to the default layer. 

Annotation 
The annotation options allow users to update the annotation in the floor plan so it 
matches the latest annotation rules specified in the Text Styles option in the 
Administration Module. 

 Annotate Fixtures - all fixtures that have the 'Include in Fixture Annotation' 
check box ticked in the Category Tab of the Block Details dialog box in Fixture 
Studio will have their annotation updated. 

 Annotate Products - all products, planograms and planogram profiles will have 
their annotation updated. 

 Annotate Zones - all zones will have their annotation updated. 

 Update Title Block - all text boxes in the title block that reference information in 
the database will have that information updated. 
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Calculations 
This option is used to update the calculations associated with the floor plan. This has a 
number of benefits including ensuring that reports based on this floor plan are accurate 
and up to date. It also ensures that annotation draws correctly. 

 Calculate Areas - this updates the area calculations; and hence the floor area 
assigned to each fixture. 

 Calculate Fixture Adjacencies - this updates the fixture adjacencies; and hence 
the relationship of one fixture to another. 

 Calculate Product Adjacencies - this updates the product adjacencies; and hence 
the relationship of one product to another. 

 Calculate Aisle Adjacencies - this updates the aisle adjacencies; and hence which 
products share an aisle. 

 Calculate Space Measures - this updates space measures: the volume occupied 
by each product in a planogram. 

 Calculate Face Planes - this updates face planes: the frontal area occupied by 
each product in a planogram. 

The Validation Tab 
The Validation Tab enables users to set a series of validation checks that must be 
satisfied before the floor plan is published. If any of the checks fail, the floor plan will be 
not be published and details written to the AVTTB_PROCESS_FILE_LOG table. 
Information in this table can be read by means of a BI Publisher report or similar. 
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The tolerance values will use the system units, i.e. inches for imperial systems, and 
millimeters for metric systems. The values on the left are the lower tolerance; the values 
on the right are the upper tolerance. 

 Check for equipment that is obsolete or not yet available - if selected, this 
validation option will compare the effective and expiry dates of the equipment 
against the effective date of the planogram 

The Effective and Expiry Dates of the equipment are set in the Category tab of 
the Block Details dialog box in Fixture Studio. 
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The Effective Date of the Planogram is set in the Details tab of the Planogram design 
dialog box in the Merchandiser module. 
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This validation check will error if the Planogram Effective Date is before the 
Equipment Effective Date or after the Equipment Expiry Date. 

The relevant part of the check will be ignored if the equipment effective or expiry 
date is undefined. 

 Check for empty fixtures - if selected, this validation option will search for 
fixtures which do not contain any products. 

 Check for expired planograms - if selected, this validation option will compare 
the effective and expiry dates of the planogram against the effective date of the 
floor-plan. It will check: 

– The Effective Date of the Planogram is less than or equal to the Floor Plan 
Effective Date 

– The Floor Plan Effective Date is less than the Planogram Expiry Date 

The Floor Plan Effective Date is set in the File Properties dialog box in Store 
Manager. (Store Manager can be accessed from the Planner or Merchandiser 
modules). 
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Note: Active Dates can also be set in the File Properties 
dialog box in Store Manager. 

The relevant part of the check will be ignored if the planogram effective or expiry 
date is undefined. 

 Check for store-specific planograms - if selected, this validation option will 
check the placed planograms are either store specific and associated with this 
store, or are generic planograms that are associated with all stores. 

Whether planogram are store specific or not is specified in the Stores tab of the 
Planogram Design dialog box in the Merchandiser module. 
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 Check that planograms are placed on correct length fixtures - if checked, this 
option will check that the length of the planogram falls within the total of the 
fixture lengths that the planogram is placed on. This check will take into account 
the length tolerances. 

 Check that planograms are placed on correct depth fixtures - if checked, this 
option will check that the depth of the planogram matches the fixture depths that 
the planogram is placed on. This check will take into account the depth 
tolerances. 

 Check that planograms are placed on correct height fixtures - if checked, this 
option will check that the height of the planogram matches the fixture heights 
that the planogram is placed on. This check will take into account the heights 
tolerances. 

 Check that planograms are placed on correct fixture styles - if checked, this 
option will check that the fixture style assigned to the planogram matches the 
fixture styles assigned to the fixtures it has been placed on. 

Floor Plan Publishing and Status Change 
When floor plans are reviewed and accepted for subsequently being put into service, the 
status is set to Authorized and the Publish Date and Effective Dates set in the File 
Properties dialog box in Store Manager. 
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When Floor Plan Publishing is run, the status of the Floor Plan will be changed to 
Published. (Depending on settings in the Status dialog box, it may also be changed to 
Read Only). 

 

This change of status allows the progress of the floor plan through its business life cycle 
to be monitored. 
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Planogram Publishing 

Overview of Planogram Publishing 
Note: The way that planogram publishing performs in the 
Planner and Merchandiser modules is dependent of settings 
in other modules. This section is included so that users of the 
Planogram Publishing Functionality can discuss requested 
changes with the Administrators. 

Note: The default settings for the Planogram Publishing 
dialog box are derived from settings in the Planogram 
Publishing Configuration dialog box in the Administration 
module. 

The purpose of publishing a planogram is to disseminate information on the type, 
quantity and location of shelves and merchandise to those tasked with implementing the 
change. Publishing a planogram design can be done in hard copy or electronic format. 
The date at which this is executed depends on the Publish Date set in the Details tab of 
the Planogram Design dialog box in the Merchandiser module. 
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The Planogram Publishing functionality is used to disseminate planogram designs to 
specified printers or Windows folders to facilitate implementing those planogram 
designs. 

Note: A retail organization will still need a method of 
distributing the planogram designs from the printer or 
Windows folder to the end user. 

The basic method of operation is as follows: 

 

Administration Module 
The Administration module is used to configure access to the different parts of the 
functionality. It is also used to assign permissions to print or publish specific floor plans 
and planograms. Finally, it is used to configure how the batch processes for publishing 
floor plans. There are three options that affect publishing and printing of planograms: 
 The Functional Security option (Security menu) allows Administrators to control 

who can run Planogram Publishing as a batch process. It also controls who can 
access Immediate Planogram Publishing in the Planner Module. It also allows 
Administrators to control who can access Report Designer to create report 
templates for publishing planogram designs. 

 The Data Security option (Security menu) allows Administrators to control what 
planograms a user can print or publish from in the Planner and Merchandiser 
modules (and in In-Store Space Collaboration). 
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 The Custom Query dialog box allows an Administrator to specify what fields 
will appear in the Immediate Planogram Publish dialog box in the Planner 
module. 

Configuring Outputs for Batch Process: the default settings for the batch process output 
of planogram designs are configured in the administration module using the Planogram 
Publishing Configuration dialog box. 

Running as a Batch Processes 
Planogram Publishing can be run as a batch process - typically run overnight so that 
processor hungry tasks can be executed without affecting the manual users of the system. 
The settings determining how this operates are set in the Planogram Publishing 
Configuration dialog box. The rights for Planogram Publishing are set in Functional 
Security in the Administration Module. 

Planner Module 
Within the Planner module, the Immediate Publishing of Floor Plans functionality can 
only be used by users for whom permissions have been granted in the Administration 
module. 

Merchandiser Module 
Within the Merchandiser module, the Immediate Publishing of Floor Plans 
functionality can only be used by users for whom permissions have been granted in the 
Administration module. 

Report Designer 
Report Designer can be used to create report templates that determine the format the 
planogram design is published in. 

Other Functionality 
There are three other items of functionality that affect planogram publishing. 

 Configuration Module - the Directories tab allows users to specify where the 
root folders holding published planograms are located. Sub-folders holding 
specific planograms will be created as children of this root folder. 

 Tables in the Macro Space Planning database hold the results of planogram 
publishing operations. 

 BI Publisher (or a similar application) can be used to generate reports based on 
the information held in the database - for example the names and results of 
planograms that have been published. 

Permissions to Run Immediate Planogram Publishing 
Before a user can run Immediate Planogram Publishing, they must first have been 
assigned the appropriate permissions in the Administration module. This is done using 
the Functional Security dialog box accessed from the Security menu. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 
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Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In the example above, the 
Merchandise Planning Manager User Group has been assigned permission to use the 
Planogram Publishing functionality. 

The User Groups precise rights depend on settings in the Permissions dialog box. This is 
accessed from the right click menu in the Functional Security dialog box. 

 

This will bring up the Permissions dialog box. 
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1. If the User Group belongs to a Command Group higher in the Command Group 
hierarchy, by default it will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the selections 
made using the check boxes. 

2. If the User Group only exists at this level in the hierarchy, the Permissions dialog box 
will initially have all check boxes blank. The Administrator must then assign Allow 
of Deny permissions.   

Dates Planograms will be Published 
The purpose of publishing a planogram is to disseminate information on the type, 
quantity and location of shelves and merchandise to those tasked with implementing the 
change. Publishing a planogram design can be done in hard copy or electronic format. 
The date at which this is executed depends on the Publish Date set in the Details tab of 
the Planogram Design dialog box in the Merchandiser module. 

Note: the Publish Date operates purely on the date only and 
takes no account of the time of day. Publish Dates are stored 
in Date/Time format in the database, but the functionality 
only references the Date. 
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Another factor affecting the date at which at which planograms will be published is the 
Lead Time Tolerance (Hours) setting on the Output tab of the Planogram Publishing 
Configuration dialog box in the Administration Module. 

Note: This dialog box will only be accessible to users with 
access rights to the Administration Module. 
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Batch processes can be set to start at any time of the day. For example, the batch process 
might initiate at 8 p.m. (20.00 hrs) in the evening to allow the maximum number of batch 
processes to be run before users come in for work again the following morning. 
However, the Publish date for the planogram might be set for when the following day 
begins at midnight. The Lead Time Tolerance (Hours) setting allows for this. 

For example, if batch process is run on the 2nd June at 20.00 hrs in the evening and has 
no lead time tolerance, a planogram that has a Publish Date of 3rd June would be ignored 
for publishing purposes by this run of the batch process. If however, the Lead Time 
Tolerance (Hours) setting is set to 5 hours, this will be added onto the Date and Time for 
the batch process and cause the batch process to operate as if it were running at 01.00 hrs 
in the morning of 3rd June. All planograms with a Publish Date of 3rd June would then 
be published. 

Criteria for Publishing Planograms 
There are two criteria for publishing planograms: 

1. Publish Date has been exceeded 

If the Publish Date set in the Planogram Design dialog box in Merchandiser exceeds the 
current date (taking into account the Lead Time Tolerance (Hours) setting), the 
planogram will be published. 

2. Planogram has been Updated since it was Published 

It is possible that the planogram may have been modified after it was last published - for 
example of a later revision has been created. The condition for this is that the Last 



Planogram Publishing 

Locations Planogram Designs will be Published To  253 

Modified date is greater than the Last Published Date. These can be seen on the 
Properties tab of the Planogram Design dialog box in the Merchandiser module. 

 

Note: Planograms may also be republished if the Republish 
planogram if files are missing option has been checked in 
the Planogram Publishing Configuration dialog box. 

Locations Planogram Designs will be Published To 
The locations Planogram designs will published to and the file names used are specified 
in the Output tab of the Planogram Publishing Configuration dialog box in the 
Administration module. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 
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This dialog box allows Administrators to specify the directory structure, file format and 
file name that will be used when planogram designs are published. 

The starting point for the location planograms will published to in electronic form can be 
seen in the details for the Planogram Publish system directory specified in the Directories 
Tab of the Configuration module. This can only be accessed if the configuration module 
is opened from the Administration module. 
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The Filtering Tab 
The Filtering Tab is used to select the planograms to publish. 
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Find 

The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next planogram matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 

Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in 
this position 

# Any number in this 
position 
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If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*Wine*' and will find White Wine, Red Wine, etc. 

Right Click Menu 

The right click menu provides a quick way of modifying the selected items. 

 

 Select All will select (but not check) all rows of data 

 Clear All will deselect (but not uncheck) all rows of data 

 Check Selected will check all rows of selected data 

 Uncheck Selected will uncheck all rows of selected data 

 Check All will check all rows of data 
 Uncheck All will uncheck all rows of data 

 Paste allows users to paste a carriage returned list of planogram identifiers from 
the Windows clipboard. All rows in the dialog box that match the pasted 
information will be checked. 

Selecting Planograms to Process 
Planograms may be selected for publishing by ticking the appropriate check box. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 
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They are used as follows: 

 Show All - this option shows all results. 

 Custom Filter - this option allows users to set filters using Boolean logic. The 
options are: 

– Equal to: will return rows that are an exact match for the entered text. 

– Not Equal to: will return rows that do not match the text string 

– Contains: will return rows where part of the data matches the text string. 
(Uses implied wild cards). 

– Does not contain: will return rows where no part of the data matches the text 
string. (Uses implied wild cards). 

– Begins with: will return rows where the text string is an exact match for the 
start of the data. 

– Ends with: will return rows where the text string is an exact match for the 
end of the data. 

– Does not begin with: will return rows where the text string is not an exact 
match for the start of the data. 

– Does not end with: will return rows where the text string is not an exact 
match for the end of the data. 

 Blanks - column will be filtered to only show rows with null values. 
 Non-Blanks - column will be filtered to only show rows containing a value 

 Results - column will be filtered to only show the selected result. 

Boolean logic also includes the use of And or Or. 

 And means that both conditions must be met. A and B means the data returned 
must contain both A and B. 

 Or means either condition can be met. A or B means the data returned can 
contain either A or B. It does not need to contain both. 
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The Templates Tab 
The Templates Tab is used so specify the type of report that will be used to output 
details of the planogram design. 

 

The user can use a radio button to specify the form the report will take: an imported 
'associated planogram document' or a template that is configured in the Report Designer 
Module. 

 Use Associated Planogram document - this option publishes the planogram 
design information using a pre-generated report using one of the following file 
formats: BMP, GIF, JPEG, JPG, PDF, PNG, TIFF or WMF. This report will be 
imported when a planogram is imported using Oracle Data Integrator (ODI). The 
Associated Document (if available) is specified in the Associated Document text 
box in the Details tab of the Planogram Design dialog box in the Merchandiser 
module. 
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There are two options (selected using the radio button) for when the pre-generated 
report is missing. 

– Write an error to the AVTTB_PUBLISH_POG_LOG table. Information in this 
table can be read by means of a BI Publisher report or similar. 

– Use the default Report Designer template. 

 Use Template - this option allows the user to define the way the template from 
the Report Designer module is selected. There are two options: 

– Use Planograms preferred template, if defined - this option is specified in 
the Preferred Template drop down list in the Details tab of the Planogram 
Design dialog box in the Merchandiser module. 

– Use Selected Template from List Below - this option can be set by checking 
items in the list of available templates. One or more templates may be 
selected. If multiple templates are selected, the name of the template will be 
added to the file name in brackets - for example 1_Bay_Mixed_Fizzy_Drinks 
(Basic Planogram Report).pdf 

If necessary, the list of templates can be searched by entering a text string into the 
drop down list, then clicking the Find button. (Actual or implied wild cards can 
be used). Each click of the Find button will cause the search engine to move 
forward through the matching results until no results are left. 

Note: The last 10 text strings can be selected using the drop 
down list in the text box. 
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The Collation Tab 
The Collation Tab allows users to specify the sequence the planogram designs will be 
published or printed in. Its main use is in printing hard copy versions of the designs 
where the sequence they are printed in makes it easier to sort and distribute them after 
printing. 

At least one collation option must be selected, or the tab will show as having an error. 

 

The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 

 Region is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 District is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 
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 Store Number is the Store Code in the Store dialog box in Store Manager. 

 Store Name is the Store Name in the Store dialog box in Store Manager. 

 

 Department is the department (zone) in the floor plan the planogram is 
associated with. 

 Aisle is the aisle the planogram is associated with. For this option to operate, 
aisles must first be drawn in the floor plan in the Planner module. In the example 
below, Aisle F-1 has been drawn between two runs of fixtures. 
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 Bay Number is the bay number associated with the fixtures the planogram is 
placed on. For this option to operate, the fixtures in the floor plan must 
previously have been bay numbered. 

 

 Bay Group is the Name assigned to a number of fixtures sharing a common 
characteristic. It is assigned in the Name field of the Bay Numbering dialog box 
in the Planner module. 

 

 Planogram Name is the name of the planogram. This is set in the Name field of 
the Planogram Design dialog box in Merchandiser. 
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 Planogram Code is the code for the planogram. This is set in the Client Code 
field of the Planogram Design dialog box in Merchandiser. 

 

Errors and Results 
If any settings in the Planogram Publishing dialog box will lead to errors during 
publishing, an error symbol will be displayed on the tab containing the data with the 
problem. The OK button will also be grayed out and unavailable. 

 

Users must correct the problems before the OK button will activate. 

The results from Planogram Publishing are stored in two tables within the database. 
These results can be viewed via reports generated from BI Publisher (or similar 
software). 
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The Validation Tab 
The Validation tab enables users to set a series of validation checks that must be satisfied 
before the planogram design is published. If any of the checks fail, the details will be 
written to the AVTTB_PUBLISH_POG_LOG table. Information in this table can be read 
by means of a BI Publisher report or similar. 

 

 Check for empty shelves - this option will check the parent fixture and associated 
shelf objects. It will raise an error report if: 

– The fixture and associated shelf objects can be populated with product 
display styles, but no product display style has been placed. 

– The fixture and associated shelf objects can be populated with display styles, 
but no display styles have been placed. 

 Check for products that have expired or are not yet effective - this option will 
check all products in the planogram against the effective date of the planogram. 
It will raise an error report if: 

– The Product Effective Date is after the Planogram Effective Date - i.e. the 
product is not yet available to place in the planogram. 

– The Product Expiry Date is before the Planogram Effective Date - i.e. the 
product will expire while the planogram is still in service. 

The check will be ignored if the product effective or expiry date is undefined. 

The Planogram Effective Date is set in the Details tab of the Planogram Design dialog 
box in Merchandiser. 
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The Product Effective and Expiry dates are set in the Details tab of the SKU dialog 
box in Product Studio. 
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 Check for equipment that is obsolete or not yet available - this option will check 
all equipment in the planogram against the effective date of the planogram. It 
will raise an error report if: 

– The Equipment Effective Date is after the Planogram Effective Date - i.e. the 
equipment is not yet available for the planogram. 

– The Equipment Expiry Date is before the Planogram Effective Date - i.e. the 
equipment will be taken out of service while the planogram is still in use. 

The check will be ignored if the equipment effective or expiry date is undefined. 

The Equipment Effective and Expiry dates are set in the Category tab of the Block Details 
dialog box in Fixture Studio. 
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 Validation Scope - this controls when to apply the validation checks. There are 
three options - selectable by the radio button. 

– Apply to all planograms. 

– Apply to non-imported (manually created) planograms. 

– Apply to imported planograms. 
The application will automatically distinguish between imported and manually 
created planograms by means of the information held in the Macro Space 
Planning database. This can be used to reduce the time required for validating 
planograms - for example if the planogram designs have already been validated 
in the third party software used to design them, there may be no need to validate 
them again when this functionality is used to publish planograms. 
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Planogram Printing 

Overview of Planogram Printing 
Planogram Printing allows users to select planograms in the currently active floor plan 
and print out information on the ones they have permissions to print. 

Note: Users wishing to Publish the planogram design plan 
(output it in electronic or hard copy form with permanent 
changes) should use the Immediate Planogram Publishing 
option from the File menu. 

Note: the default settings for this dialog box are derived 
from settings in the Planogram Publishing Configuration 
dialog box in the Administration module. 

 

The basic method of operation is as follows: 
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Administration Module 
Within the Administration Module: 

 The planogram users have permissions to print are assigned in the Data Security 
dialog box - Planograms Tab. 

 The fields that display in the Filtering Tab of the Print Planograms dialog box are 
configured in the Custom SQL dialog box. 

 Planograms can be printed using report templates specified in the Report 
Designer module. Permission to access this module is specified in the Functional 
Security dialog box. 

These settings determine what will appear in the Print Planograms dialog box (and the 
reports that will be available) when it is accessed in the Planner and Merchandiser 
modules. 

Note: In order to access the Administration Module, users 
must have permission to do so. 

Planner Module 
The Print Planograms dialog box may be accessed from the File Menu - a floor plan 
containing planograms must previously have been opened. Users with permissions to 
access the Planner module automatically have permission to use the functionality. 

Merchandiser Module 
The Print Planograms dialog box may be accessed from the File > Print Menu - a floor 
plan containing planograms must previously have been opened. Users with permissions 
to access the Merchandiser module automatically have permission to use the 
functionality. 

Report Designer 
The Report Designer module is used to design report templates that can be specified for 
use in the Print Planograms dialog box. Permissions to access this module are assigned in 
the Functional Security dialog box in the Administration module. 

Using Planogram Printing 
The functionality is used as follows: 
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1. A floor plan containing planograms is opened in the Planner or Merchandiser 
module. 

2. The Print Planogram option is selected from the File menu in the Planner or 
Merchandiser module. 

3. The appropriate planograms are selected in the Filtering tab of the Print Planograms 
dialog box. 

4. The report to use is specified in the Templates tab. 

5. The sequence the selected floor plans are to be printed in is specified in the Collation 
Tab. 

6. On clicking the Print button, the selected planogram reports will be printed on the 
default printer associated with the user's computer. 

Accessing the Planogram Print Functionality 

Note: before accessing the Print Planogram functionality, 
users should open a floor plan containing planograms. 

The Print Planogram functionality is accessed from the File Menu. Users with 
permissions to access the Planner module will automatically have permission to use the 
functionality. 

 

Opening State of Functionality 
When the Print Planogram dialog box opens it will be populated with all planograms in 
the currently active floor plan. By default, they will be checked for selection. 
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Note: the columns that are displayed in the dialog box are 
configurable in the Custom SQL option available from the 
General Menu in the Administration module. 

The Filtering Tab 
The Filtering tab enables the user to select the Planograms to print. It will populate with 
all planograms in the currently active floor plan. 

Note: If there are multiple instances of a planogram in a 
floor plan, only a single entry will appear in the list of 
planograms. 
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Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 

Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in 
this position 
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Wild 
Card 

Description 

# Any number in this 
position 

  

If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*wine*' and will find I Bay Red Wine, 1 Bay White 
Wine, etc. 

Pick 
Pick takes the user to the currently active floor plan. They can then use AutoCAD 
selection methods to select specific planograms. When the AutoCAD selection is 
completed with a right mouse click, the user will be returned to the Print Planogram 
dialog box and the dialog box will populate with the selected planograms. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 

 Select All will select (but not check) all rows of data 

 Clear All will deselect (but not uncheck) all rows of data 

 Check Selected will check all rows of selected data 

 Uncheck Selected will uncheck all rows of selected data 
 Check All will check all rows of data 

 Uncheck All will uncheck all rows of data 

 Paste allows users to paste a carriage returned list of floor plan identifiers from 
the Windows clipboard. All rows in the dialog box that match the pasted 
information will be checked. 

Selecting Planograms to Print 
Planograms may be selected for printing by ticking the appropriate check box. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 
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They are used as follows: 

 Show All - this option shows all results. 
 Custom Filter - this option allows users to set filters using Boolean logic. The 

options are: 

– Equal to: will return rows that are an exact match for the entered text. 

– Not Equal to: will return rows that do not match the text string 

– Contains: will return rows where part of the data matches the text string. 
(Uses implied wild cards). 

– Does not contain: will return rows where no part of the data matches the 
text string. (Uses implied wild cards). 

– Begins with: will return rows where the text string is an exact match for the 
start of the data. 

– Ends with: will return rows where the text string is an exact match for the 
end of the data. 

– Does not begin with: will return rows where the text string is not an exact 
match for the start of the data. 

– Does not end with: will return rows where the text string is not an exact 
match for the end of the data. 

 Blanks - column will be filtered to only show rows with null values. 

 Non-Blanks - column will be filtered to only show rows containing a value 

 Results - column will be filtered to only show the selected result. 

Boolean logic also includes the use of And or Or. 
 And means that both conditions must be met. A and B means the data returned 

must contain both A and B. 
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 Or means either condition can be met. A or B means the data returned can 
contain either A or B. It does not need to contain both. 

The Templates Tab 
The Templates Tab allows users to specify the template format to be used when printing 
planogram designs. 

IMPORTANT NOTE: There is a known issue with 
planogram templates. The Planogram Publishing 
Configuration dialog box in the Macro Space Management 
Administration Module has an option to print associated 
planogram documents. At present this option is not 
available in the Print Planogram dialog box. Accordingly, 
the Template Tab in the Planogram Publishing 
Configuration dialog box should have the option set to Use 
Template. 

 

The user can use a radio button to specify the form the report will take: an imported 
'associated planogram document' or a template that is configured in the Report Designer 
Module. 

 Use Associated Planogram document - this option publishes the planogram 
design information using a pre-generated report using one of the following file 
formats: BMP, GIF, JPEG, JPG, PDF, PNG, TIFF or WMF. This report will be 
imported when a planogram is imported using Oracle Data Integrator (ODI). The 
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Associated Document (if available) is specified in the Associated Document text 
box in the Details tab of the Planogram Design dialog box in the Merchandiser 
module. 

 

There are two options (selected using the radio button) for when the pre-generated 
report is missing. 

– Write an error to the AVTTB_PUBLISH_POG_LOG table. Information in this 
table can be read by means of a BI Publisher report or similar. 

– Use the default Report Designer template. 
 Use Template - this option allows the user to define the way the template from 

the Report Designer module is selected. There are two options: 

– Use Planograms preferred template, if defined - this option is specified in 
the Preferred Template drop down list in the Details tab of the Planogram 
Design dialog box in the Merchandiser module. 

– Use Selected Template from List Below - this option can be set by checking 
items in the list of available templates. One or more templates may be 
selected. If multiple templates are selected, the name of the template will be 
added to the file name in brackets - for example 1_Bay_Mixed_Fizzy_Drinks 
(Basic Planogram Report).pdf 

If necessary, the list of templates can be searched by entering a text string into the 
drop down list, then clicking the Find button. (Actual or implied wild cards can 
be used). Each click of the Find button will cause the search engine to move 
forward through the matching results until no results are left. 
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Note: the last 10 text searches can be selected using the drop 
down list in the text box. 

The Collation Tab 
The Collation Tab allows users to specify the sequence the planogram designs will be 
published or printed in. Its main use is in printing hard copy versions of the designs 
where the sequence they are printed in makes it easier to sort and distribute them after 
printing. 

At least one collation option must be selected, or the tab will show as having an error. 

 

The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 

 Region is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 District is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 



Planogram Printing 

The Collation Tab  279 

 

 Store Number is the Store Code in the Store dialog box in Store Manager. 

 Store Name is the Store Name in the Store dialog box in Store Manager. 

 

 Department is the department (zone) in the floor plan the planogram is 
associated with. 

 Aisle is the aisle the planogram is associated with. For this option to operate, 
aisles must first be drawn in the floor plan in the Planner module. In the example 
below, Aisle F-1 has been drawn between two runs of fixtures. 
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 Bay Number is the bay number associated with the fixtures the planogram is 
placed on. For this option to operate, the fixtures in the floor plan must 
previously have been bay numbered. 

 

 Bay Group is the Name assigned to a number of fixtures sharing a common 
characteristic. It is assigned in the Name field of the Bay Numbering dialog box 
in the Planner module. 

 

 Planogram Name is the name of the planogram. This is set in the Name field of 
the Planogram Design dialog box in Merchandiser. 
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 Planogram Code is the code for the planogram. This is set in the Client Code 
field of the Planogram Design dialog box in Merchandiser. 

 

Errors and Results 
If any settings in the Print Planograms dialog box will lead to errors during printing, an 
error symbol will be displayed on the tab containing the data with the problem. The Print 
button will also be grayed out and unavailable. 

 

Users must correct the problems before the Print button will activate. 

The results from Floor Plan printing are stored in two tables within the database. These 
results can be viewed via reports generated from BI Publisher (or similar software). 
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22 
Synchronisation 

Overview of Synchronization 

Planner and Synchronization 
The Planner module is based on AutoCAD. Work done in the floor plans is initially 
saved back to an AutoCAD (DWG) file before information is written back to the Macro 
Space Planning (MSP) database. However, there are ways that the information in the 
AutoCAD floor plan can diverge from the information held in the database. These ways 
are: 

 The floor plan has been modified in Raw AutoCAD. 

 AutoCAD functionality can be used which results in changes to the floor plan, 
but not to the database. This will occur when dynamic synchronization is set to 
Off. 

 Changes can be made to the floor plan in the Merchandiser module - this will 
write information back to the MSP database but not to the AutoCAD drawing in 
Planner. 

 Changes can be made to the floor plan in In-Store Space Collaboration - this will 
write information back to the MSP database but not to the AutoCAD drawing in 
Planner. 

 Changes can be made to the floor plan using batch processes such as Planogram 
Substitution. This will write information back to the MSP database but not to the 
AutoCAD drawing in Planner. 

Synchronization is therefore used to ensure that what is show graphically in the floor 
plan is also what is held in the database. There are three forms of synchronization. 

Manual Synchronization 
Manual synchronization is synchronization carried out by the user by invoking the 
functionality from the menu bar or Retail toolbar. 

Dynamic Synchronization 
Dynamic Synchronisation can be turned on or off by the user. If turned on, many of the 
changes made by AutoCAD tools are simultaneously written back to the database. 

Auto-Synchronization 
Auto-Synchronization is used when changes have been made to the database by work 
carried out in the Merchandiser module, in In-Store Space Collaboration or by Batch 
tools. If active, when a floor plan is subsequently opened in Planner, the required 
updates will be made to the floor plan. Dependent on settings; confirmation may be 
required from the user first. 

Synchronisation and the Administration Module 
Some of the synchronisation functions in the Planner are affected by settings in the 
Administration module. 



Synchronization 

Synchronisation and the Administration Module  283 

Dynamic Synchronize 
The default setting for dynamic synchronization in held in the DYNAMIC_SYNC system 
variable set in the System Variable dialog box accessed from the General menu of the 
Administration module. This may be set to one of two options: 

• Off: Dynamic sync is not enabled.  

• On: Dynamic Sync is enabled  

Auto-Synchronize 
Depending on settings for the AUTOSYNC system variable, when a Planner floor plan is 
opened and there are differences between that floor plan and the database, one of three 
options will occur. 

• No auto-synchronization will occur, leaving the user to manually synchronize the 
floor plan as required. 

• Auto-Synchronisation will occur, but requires confirmation by the user before it goes 
ahead. 

• Auto-Synchronisation will occur automatically as the floor plan opens. 

Saving Default Synchronisation Settings 
Depending on settings for the SYNC_SETTINGS system variable user will find the 
synchronisation dialog box opens with either: 

• A generic set of default settings common to all users. 

• A user selected set of default settings. 

The settings that can be specified are: 
1. The Form of Synchronization that takes place 

 This may be either: 

 Match the Drawing (floor plan) 

 Match the Database 

 Merge 

 Keep Identical 

  

2. The Items that are Synchronized 

These can include: 

 Fixtures 

 Shelves 

 Products 
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 Other blocks 

 Zones 

 Views 

 Aisles 
 Markups 

 

See your Administrator for more information on what has been implemented. 

Manual Synchronization 
Manual Synchronisation is used to ensure that the information held in the floor plan in 
the Planner module is identical to the information held in the database. It is done using 
the Synchronisation dialog box.  

 

Synchronisation can be done in several ways: 

Match the Drawing 
Data in the database will be overwritten with data from the drawing. 
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In this example, the drawing contains Fixtures 1, 2 and 3, together with products A, B 
and C. This information overwrites the data on Fixtures 2, 3 and 4 and their associated 
products B, D and E that was originally held in the database. 

Match the Database 
Data in the drawing will be overwritten with data from the database. 

 

In this example, the drawing contains Fixtures 1, 2 and 3, together with products A, B 
and C. This information is updated with Fixtures 2, 3 and 4 and their associated products 
B, D and E that is held in the database. 

Merge 
Merge combined the data in the drawing and the database so the same information is 
present in both places. Where information is present in both locations, merging can be 
done with priority to the drawing or priority to the database. 

 

 In this Merge example, priority has been given to the drawing. Data is modified as 
follows: 

 Fixture 4 and Product E do not exist in the drawing, so they are added. 
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 Fixture 1 and Product A do not exist in the database, so they are added. 

 Fixtures 2 and 4, together with Product B are identical in both the database and 
drawing, so no changes are made. 

 Product C in the drawing coincides with Product D in the database. Because 
priority has been given to the drawing, Product C overwrites Product D in the 
database. 

Keep Identical 
Keep identical only keeps items that are identical in the drawing and the database. 

 

In this example, only Fixtures 2 and 3 and product B are identical. After the synchronize 
operation these three items only will be present in both database and drawing. 

Manual Synchronization Dialog Box 

Accessing the Synchronization Dialog Box 
The synchronisation dialog box can be accessed from the File menu. 
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Alternatively, it can be accessed from the Retail toolbar. 

 

Parts of the Synchronization Dialog Box 
The synchronisation dialog box has the following components. 

 

 Synchronisation Options: These specify the form synchronization is to take - for 
example write the contents of the floor plan to the database (Match the Drawing). 

 Items to Synchronize: These specify what objects in the floor plan are to be 
synchronised - for example zones, aisles and fixtures. 

 Venn Diagram: This can be used to determine which synchronization option is 
required.  

 Synchronize Button: This initiates manual synchronization options. 

If the mouse pointer is poised over a category of information in the Venn diagram, a 
black question mark will appear. 

 

Left clicking on the category will bring up a dialogue box with details of the items. 

. 
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Guidelines for Manually Synchronizing 
The appropriate synchronisation actions can be determined using the Venn diagram in 
the synchronisation dialog box. This will vary according to the Synchronisation option 
selected in the upper right of the dialog box. The Venn diagram identifies: 

 Objects that are identical in the drawing (floor plan) and the database. 

 Objects that exist in the drawing and database but differ in some way - for 
example in their position. 

 Objects that exist in the drawing only. 

 Objects that exist in the database only.   

Note: Manual Synchronization will only be required if Auto-
Synchronisation has not been enabled. 

Match the Drawing 
The Match the Drawing option has a light blue circle highlighting what data is identical 
in the drawing and database, what is different and what is in the drawing only. The dark 
blue circle shows data in the database only. 

 

Use this option when the information in the currently active Planner floor plan is the 
version you wish to save back to the database. This may be required if: 

 A raw AutoCAD drawing has been imported. 

  The USERI1 system variable has been set to 0 and the results of specific 
AutoCAD operations are not being written to the database. 

Match the Database 
The Match the Database option has a light blue circle highlighting what data is identical 
in the floor plan and database, what is different and what is in the database only. The 
dark blue circle shows data in the drawing only. 
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Use this option if the floor plan has been modified outside of the planner module. This 
could occur if: 
 The floor plan has been updated in the Merchandiser module. 

 The floor plan has been updated in In-Store Space Collaboration 

 The floor plan has been updated by a batch process. 

Merge 
This option is not commonly used. It might be required if changes have been made to the 
floor plan in the Planner module but not written back to the database. If the floor plan is 
in this condition when (for example) batch tools are used it will be difficult to establish 
what the correct version of the drawing should be like. In this event it may be necessary 
to merge to changes so that floor plan and database are identical, then use KPI's and 
reports to determine where errors exist in the floor plan.  

 

All data is enclosed within the light blue circles. 

 Data in the drawing but not in the database will be written to the database. 

 Data in the database but not in the drawing will be written to the drawing. 

 Data for objects that have differences (but are identical in position) will be 
overwritten in the drawing or database depending on which priority radio 
button is selected. 

Only Keep Identical 
This option is not commonly used. It applies to a similar situation where a floor plan has 
had changes made in both the planner module and (for example) by a batch process. The 
data may have become confused. The most practical option might be only to keep data 
that is identical in the drawing and database as only this data can be guaranteed to be 
correct. Any necessary changes can then be reapplied. 



Dynamic Synchronization  

290 Oracle Retail Store Planner's User Guide 

 

All data is enclosed within dark blue circles. Only data shown as identical within the 
drawing and database will be retained. 

Dynamic Synchronization 

Overview of Dynamic Synchronization 
Dynamic Synchronization can be turned on or off as required. The setting determines 
whether changes to Fixtures, Product Blocks and Other Blocks made in a Planner 
AutoCAD floor plan using AutoCAD commands are automatically written back to the 
database when they are executed or whether manual synchronization is subsequently 
required. 

Note: Zones, Aisles and Shelves are not affected by Dynamic 
Synchronization and will require a manual synchronize to 
write changes made with AutoCAD tools to the database. 

DYNAMIC_SYNC System Variable 
The initial setting for a new user is governed by the value of the DYNAMIC_SYNC 
system variable set in the System Variable dialog box accessed from the General menu of 
the Administration module. This may be set to one of two options: 

 Off: Dynamic sync is not enabled.  
 On: Dynamic Sync is enabled  

The first time a user accesses a Planner floor plan, the dynamic synchronisation setting 
for that user will be set to that matching the DYNAMIC_SYNC system variable. After the 
global value of dynamic synchronization has been set, individual users can then toggle 
dynamic synchronization on or off as required. 

Changing Individual Settings for Dynamic Synchronization 
Once an individual user has been assigned the global value for dynamic synchronisation, 
they can change this as desired via the AutoCAD command line. 

 
Entering the command AVT_DYNAMICSYNC will allow users to enter On or Off as an 
option.  

Note: once users have entered their personal setting for Dynamic Synchronization this 
will not be affected by changes to the DYNAMIC_SYNC system variable. 
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Use of Dynamic Synchronization 
Users have the option of turning Dynamic Synchronization On or Off. There are 
advantages for either option. 

Dynamic Synchronization On 
If dynamic synchronization is on, changes made to fixtures, products, planograms and 
other blocks made with AutoCAD tools will be immediately written back to the 
database. This will mean the information in quick reports, the summary window in the 
Object Browser, etc will be continually updated. However, for large floor plans, 
performance of the application may be marginally slowed.  

Dynamic Synchronization Off 
If dynamic synchronization is off, performance of the application may be slightly faster. 
However, the user will have to manually synchronize the floor plan in order to ensure 
that the effects of changes made with AutoCAD tools will be written back to the 
database. 

Auto-Synchronizing 
Depending on settings in the Administration module, it is possible to set the floor plan to 
automatically undergo the required changes when opened in the Planner module. Based 
on settings in the Administration module, this will either require the user to confirm the 
synchronisation can occur, or it will occur without requiring permissions. If confirmation 
is required, a dialog box will appear, requiring the user to click OK before 
synchronization can proceed. 

 

Note: Depending on the auto-synchronize options, different 
objects will be synchronized - see below for details. 

How Auto-Synchronization Works 
Auto-Synchronisation works by comparing a series of dates held in the AVTTB_FILE 
table in the database. This table is only available to people with permissions to access the 
database - although most can be seen in the File Properties dialog box in Store Manager. 
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These dates have the following significance: 

AVTTB_FILE 
Table Field 

Properties 
Dialog 
Box Date 

Comment 

FIL_BDATE Created 

This can be the date the floor plan was originally created 
in Store Manager. If the floor plan was copied from 
another floor plan in Store Manager, this will be the date 
the floor plan was copied. If the floor plan was imported, 
this will be the date it was originally created in raw 
AutoCAD. 

FIL_DATE File Modified 

This is the date the floor plan was originally created in 
Store Manager. Alternatively, if the floor plan was 
imported, this will be the date it was last modified in raw 
AutoCAD. Once the file has been saved in Planner, the 
FIL_DATE field will hold the date of that save but the 
File Modified field will continue to show the date it was 
last modified in raw AutoCAD. 

FIL_LAST_MODIFIED Last Modified 
This is the date the file was last saved by a user in the 
Planner or Merchandiser modules or in In-Store Space 
Collaboration. 

FIL_LAST_PROCESSED Modified by 
Automation 

This is the date the file was last modified by a batch 
process such as planogram substitution. 

DWG_DATE Not in Dialog 
Box 

This date is stored purely in the DWG file for the floor 
plan. It is the date the floor plan was created in raw 
AutoCAD or last modified in raw AutoCAD.  

The logic of Auto-Synchronization can be seen in the following flowchart. 



Synchronization 

Auto-Synchronizing  293 

 

 When the floor plan is opened, Test 1 (FIL_DATE <> DWG_DATE) is applied.  

 If this test is True, Test 2 (FIL_LAST_PROCESSED > FIL_DATE or 
FIL_LAST_MODIFIED > FIL_DATE) is applied to determine whether the 
synchronisation should be Cross Match or Match Drawing.  

 If Test 1 is not true, Test 3 (FIL_LAST_PROCESSED > FIL_DATE or 
FIL_LAST_MODIFIED > FIL_DATE) is checked to determine whether to 
synchronize Match Database or take no action. 

Synchronize 'Match the Database' 
The following objects will be synchronised. 

 Fixtures 

 Products 
 Other Blocks 

 Markups 

Synchronize 'Match the Drawing' 
The following objects will be synchronised: 

 Fixtures 

 Products 
 Other Blocks 

 Zones 

 Aisles 

 Markups 

Synchronize 'Cross Match' 
The following objects will be synchronised: 
 Fixtures 

 Shelves 

 Products 

 Other Blocks 
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 Zones 

 Aisles 

 Markups 

Fixtures, other blocks, zones and aisles and markups will be updated in the database to 
match the floor plan using the existing synchronize functionality. Shelves, planogram 
definition placeholders and product placeholders will be updated in the floor plan to 
match the database using the existing Synchronize functionality. 

 
 

  



 

295 

23 
Prototype Stores 

Overview of Prototype Stores 
Prototype Stores are a Macro Space Management concept. They are stores that can be 
designated as having specific properties that can be used as a basis for comparison for 
other stores. 

Setting and Designating Prototype Store 
Designating a store as a prototype store is done is Store Manager by checking the Set as 
Prototype check box in the General Tab of the Add/Edit Store dialog box (left hand 
screen shot below). Once prototype stores have been designated, they can be selected as 
the basis for comparison by other stores. This is done by selecting the required from the 
Store Prototype drop down list in the General Tab of the Add/Edit Store dialog box 
(right hand screen shot below). This associates the store with its designated prototype 
store in the database. This link can then be used for reporting purposes. 

 

A further action will be required in the File Properties dialog box (right click Menu in 
Store Manager). 
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Here the Prototype Store to be used as the basis for comparison is set using the drop 
down list in the Details tab. 

Technicalities of Using Prototype Stores 
When a prototype store is assigned, a flag is set in the database.  
 The STR_PROTOTYPE field is set in the AVTTB_STORE table when the 

prototype store is designated in the Add/Edit Store dialog box in Store Manager. 

 The STR_PROTOTYPE field is set in the AVTTB_FILE table when the prototype 
store is designated in the File Properties dialog box in Store Manager. 

This information can then be used by Macro Space Management's Custom SQL to 
generate information specific to the currently active floor plan. Example uses include 
comparing the zones, equipment or merchandise between a store and its designated 
prototype. This comparison normally meets two criteria: 

 The floors are the same type; for example the first floor in one store is being 
compared with the first floor in another. 

 The floor plan in the prototype store is at Current status as this represents the in-
service version of the prototype store 

Example Uses of Prototype Stores 
Once a store has been set as a prototype and referenced by another store/floor plan, the 
information can be used in several ways: 

 As a basis for comparison in the Object Browser. 

 As a filter for selection in the Object Grid. 

 As a basis for comparison in Quick Reports 
 As data used in Key Performance Indicators (KPIs). 

 As a store to compare against in Store Comparison.  

Using Prototype Stores in Planner 

Example Uses of Prototype Stores 
Once a store has been set as a prototype and referenced by another store/floor plan, the 
information can be used in several ways: 

 As a basis for comparison in the Object Browser. 

 As a filter for selection in the Object Grid. 

 As a basis for comparison in Quick Reports 

 As data used in Key Performance Indicators (KPIs). 

 As a store to compare against in Store Comparison.  

Object Browser 
The information displayed in the Summary Window can be customized by changing the 
Custom SQL that returns the information. In the example below, the standard 
information has been customized to allow a comparison of the area of the zones in the 
current and prototype stores. This allows the areas of the zones in stores of dissimilar 
shape to be adjusted until they occupy roughly the same area.  
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Similar modifications can be made to the Custom SQL to display comparisons between 
the equipment and merchandise in the current and prototype stores.  

Object Grid 
The information displayed in the object grid for the current floor plan can be compared 
relative to information in the prototype store. In the example below, planograms present 
in the prototype store and already placed in the current floor plan are shown in black, 
planograms present in the prototype store but not yet present in the current floor plan 
are shown in red. 

 

Quick Reports 
Prototype Stores can also be used in Quick Reports. In the example below, the Quick 
Report has been set up to show the base linear for products at sub-class level in the 
currently active store and its associated prototype.  

 

KPIs 
KPI's are another way of comparing the prototype store to the currently active store pan. 
In the example below, planogram performance in the current floor plan is being 
compared to that of the prototype store. This enables anyone viewing the floor plan to 
see relative performance at a glance. 
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Drawing Comparison 
Drawing Comparison is a utility available from the View menu in the planner module, or 
run directly from the C:\Program Files\Oracle Retail\MSM\Common folder. The utility 
allows comparison of equipment, merchandise categories or planograms between a 
designated prototype store and the current floor plan. 
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24 
Planogram Substitution 

Configuring Access to the Planogram Substitution Functionality 
Access to the planogram substitution functionality is configured in the Administration 
Module. Only users with access to the Administration module will be able to configure 
access to the Planogram Substitution functionality. 
The steps can be summarized as follows: 

User Group Role 
The User Group the User belongs to (accessed from the Security menu > Functional 
Security dialog box > User Groups tab in the Administration Module) must have the 
Admin User role assigned. 

 

Add User Group to Planogram Substitution Command Group 
While still in the Functional Security dialog box, switch to the Group relationships tab. 
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The User Group the User belongs to must be a member of the Planogram Substitution 
command group. 
In addition, the permissions must also be set (right click menu) for that User Group. 

 

When the above actions have been carried out, specific users will have been assigned the 
right to access the Planogram Substitution Functionality in the Planner Module and to 
run substitutions in the currently active floor plan. 

Planogram Substitution Technicalities 

Forms of Planogram Representation 
There are three forms that planograms can take. 

1. 2D Planogram (Placeholder) 
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2. 3D planogram (called 2.5 D in the Merchandiser Module). 

3. 3D with Product Items (Full Detail). 

These appear in the Merchandiser module as follows: 

 

A 2D planogram is purely a placeholder. A 3D planogram (2.5 D in Merchandiser) shows 
the shelves and a simple product block to show the shelves are occupied. A 3D 
planogram with Product items shows the shelves, together with full details of the 
products. 

Planograms can only be placed in 2D form in the Planner module and in In-Store space 
Collaboration. Users in the Merchandiser module have the option to place in 2.5D or 3D 
form (depending on settings in the Merchandising tab of the Configuration Module) and 
can explode 2D or 2.5D planograms to the 3D form.  

Planograms are only visible in the Planner module if they are in 2D form. Planograms in 
2.5D or 3D form will not be visible (but can be indicated by means of a KPI).  

The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED System Variable 
The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable has a 
significant impact on the way planogram substitutions are carried out. It can be set to 0, 
1, 2, 3 or 4 in the Administration Module (General menu). 

System Variable Values 

System 
Variable 

Description 

0 Only planograms in 2D form will be substituted - with planograms in 3D form being 
ignored. The substituted planograms will be placed in 2D form. No information on 
the planograms that have been ignored for substitution will be written to the 
Planogram Substitution Log. 
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System 
Variable 

Description 

1 Only planograms in 2D form will be substituted - with planograms in 3D form being 
ignored. The substituted planograms will be placed in 2D form. Information on the 
planograms in 3D form that have been ignored for substitution will be written to the 
Planogram Substitution Log. 

2 Planograms in 2D form will be substituted with planograms also in 2D form. 
Planograms in 3D and 2.5D form will be placed in 2D form when substituted. 

3 3D and 2.5D planograms will be substituted by 2D planograms. A warning will be 
written to the Planogram Substitution Log identifying the 3D and 2.5 D planograms 
that were placed in 2D form during the substitution. 

4 Planograms in 3D form will be substituted with planograms also in 3D form. 
Planograms in 2D form will be placed in 3D form when substituted. Planograms in 
2.5D form will be replaced by a 2D form if that is the way the planogram design has 
been defined. It will be replaced by a 3D form if the planogram design is in 3D 
format. 

Examples of Planogram Substitution 
Planogram Substitution can come in many forms. This allows users complete flexibility 
in selecting planograms to be substituted and defining the planograms that are to be 
inserted as their replacements. 

Note: A number of examples are given below - in practice 
the validity of each substitution will be determined by rules 
selected on the rules tab of the Planogram Substitution 
Definition dialog box. For example, if the 'Length' rule is off, 
lengths will not be validated and planograms of unequal 
lengths can be substituted. 

One to One 
The simplest form of planogram substitution is a 'one to one' substitution. One 
planogram of a specified length is replaced by another planogram of equal length. 

 

In the above example, the 12 foot planogram 'B' has been replaced with another 12 foot 
planogram 'C'. 

One to Many 
Another form of planogram substitution is a 'one to many' substitution. One planogram 
of a specified length is replaced by two or more planograms whose combined lengths are 
the same as that of the planogram they are replacing. 
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In the above example the 12 foot planogram 'B' has been replaced by the 4 foot 
planograms 'D', 'E' and 'F'. 

Many to One 
In Many to One planogram substitutions, several planograms are selected and replaced 
by a single planogram equal in length to the sum of the lengths of the planograms it is 
replacing. 

 

In the above example, the 8 foot planogram 'A' and the 12 foot planogram 'B' are to be 
replaced by the single 20 foot planogram 'G'. 

Many to Many 
A 'Many to Many' planogram substitution occurs when multiple planograms are selected 
for replacement and are substituted for by multiple planograms occupying the same 
length as the planograms they are replacing. 

 

In the above example, the 8 foot planogram 'A' and the 12 foot planogram 'B' are to be 
replaced by the 4 foot planogram 'H' and the 16 foot planogram 'J'. 

One to None 
It is possible to carry out a One to None Substitution - the removal of a planogram 
without specifying a replacement. This might be called for when a planogram has to be 
removed for legal reasons, etc., but no replacement has been decided on. 

 

In the above example the planogram 'X' on the end cap of the gondola is to be removed 
without a replacement being specified. 

Note: It is also possible to carry out 'Many to None' 
substitutions. 

One to None with Fixture Removal 
As well as a One to None substitution, it is also possible to remove the parent fixture. 
This might be because parts of a store are being assigned to a different purpose and the 
fixturing is changing as well as the planograms. 
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In the above example the planogram 'X' on the end cap of the gondola is to be removed 
along with its parent fixture. 

Revision Substitution 
If no existing planograms have been selected for substitution, it is still possible to carry 
out Revision Substitution.  Revision Substitution is when slight changes have been made 
to a planogram design and it has been saved as a new version rather than a new design. 
When planogram substitution is carried out, all other planograms in the store will be 
automatically be updated to the latest revision providing the Effective Date of the 
revision is less than the Active Date of the floor plan the Revision Substitution is being 
carried out in. 

Accessing and Configuring Planogram Substitutions 

Accessing the Planogram Substitution Functionality 
The Planogram Substitution functionality is accessed from the Tools menu. 

 

Functionality Source Comment 

Planogram 
Substitution 

Administration 
Module 

Pertinent permissions 
required. 

Run Planogram 
Substitution 

Administration 
Module 

Pertinent permissions 
required. 

Permissions to access the planogram substitution functionality are set in the 
Administration module. If the appropriate permissions are not available, a warning 
message will result and access to the functionality will be denied. 

 

Configuring Planogram Substitutions 

Note: For full details on the Planogram Substitution dialog 
boxes click the Help buttons on the dialog boxes. 

Upon selecting Planogram substitution from the Tools menu, the first dialog box to open 
is the Planogram Substitution dialog box. 



Planogram Substitution 

Accessing and Configuring Planogram Substitutions  305 

 

Double clicking any named planogram substitution will bring up the Planogram 
substitution definition dialog box. 

 

Details of an individual planogram substitution can be configured in the dialog box. 
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Running Planogram Substitutions 
Note: Users will require permissions to be set in the 
Administration Module before they can access the 
Planogram Substitution functionality. 

Initiating the Planogram Substitution 
Planogram Substitutions can be initiated from the Tools Menu. 

 

This will cause all valid substitutions to be run for the currently active floor plan. 

Alternatively, users can use the Run option in the Planogram Substitution dialog box. 

 

Only highlighted planogram substitutions will run - in the above example the Brown to 
White Bread substitution has been selected. 

Actions after Running a Planogram Substitution 
Planogram Substitutions execute in the database. In the example above, the database 
table will have been changed to indicate the currently active floor plan now contains a 
White Bread rather than a Brown Bread planogram. However, the information in the 
displayed in the Planner floor plan will remain unchanged. In order to make the floor 
plan match the information in the database, synchronization is required. This is done by 
calling the Synchronization dialog box from either the File menu or Retail toolbar. 
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After Synchronizing Match the Database, the planograms in the currently active floor 
plan will match those held in the database. 
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Other Planner Functionality 

Restructure Drawing 
Restructuring Drawing can be initiated from the Retail Toolbar. 

 

Alternatively, the functionality can be invoked from the Modify menu. 

 

This will bring up the Restructure Drawing dialogue box. 
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The purpose of this dialog box is to restore blocks in the currently active floor plan to 
match the properties of the blocks as defined in Fixture Studio. 

Selecting Blocks for Restructuring 
Selecting Blocks for Restructuring is done by using the varying selection options and 
building up a list of blocks for the Restructuring operations to be carried out on.   

 

Each selection is added to the current list (Add to Selection radio button) or removed 
from the current list (Remove from Selection radio button). A list containing several 
types of blocks can thus be built up - the total number of blocks currently selected being 
shown in the dialogue box. 
Clicking on Select or Select By Block temporarily hides the Restructure Drawing 
dialogue box and takes the user to the currently active floor plan. 

The apply button will remain grayed out until blocks have been selected and one or more 
check boxes selected. 

Select 
Select takes the user to the drawing where they can use standard AutoCAD selection 
methods to select one or more blocks. Valid methods include individual selection, 
windows or crossing selection boxes and fences. Selection must be completed with a 
right mouse click. 
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Select by Block 
This option takes the user to the currently active floor plan. Selecting an individual block 
will select all blocks of that type. Multiple block types may be selected before selection is 
completed with a right mouse click. 

Select all Blocks 
Clicking this button will select all blocks in the currently active floor plan. 

Clear Selection 
Clicking this button will deselect all currently selected blocks. 

Once the blocks have bene selected, varying restructuring options can be chosen. 

 

Restructure Block Options 

Redefine blocks from Disk 
If the master block definition registered in Fixture Studio has been updated, it is possible 
to update the older version of the block held in the currently active floor plan with the 
more recent block held in Fixture Studio. On clicking the Apply button the block 
definition held in the 'database' section of the drawing will be updated, resulting in all 
visible instances of the block being changed. 

Note: Block names will be ignored if they are not registered 
in Fixture Studio. 

Explode Composite Blocks 
This option will take any selected blocks and determine if they are composite (a block 
made up of made up of two or more previously defined blocks). 

If any blocks are composite, they will be exploded into their component blocks and any 
connection points associated with the composite blocks removed. (If individual blocks 
within the composite have connection points assigned, these will not be affected). 

Note: blocks correctly registered and configured in Fixture 
Studio have an attribute called BSLINK-ATT assigned to 
them. If a composite has this attribute assigned, it will be 
removed when the composite is exploded using Restructure 
Drawing. If the composite is exploded using AutoCAD 
Explode, this attribute may be left in the floor plan. It is 
therefore suggested that Macro space Planning composites 
are exploded using Restructure Drawing. 
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Reset Level 
This option results in any selected blocks being reassigned to the level (elevation above 
floor level) they are assigned to in the Insertion Tab of the Block Definition dialog box in 
Fixture Studio. 

If the level is set to 'undefined', no changes will be made in the level for the block. 

Note: Both shelves and products should be on undefined 
levels and should not be affected by this command. 

Reset Color, Line Type and Line Weight to BYLAYER 
If the colors, line types and line weights of any selected block in the currently active floor 
plan are different from the default properties of the layer on which they have been 
placed, the properties of the selected blocks will be set back to those defaults. An 
example of this could be if a KPI was run in the floor plan. If there was some sort of 
failure before the floor plan was checked back in, the individual blocks in the drawing 
could be colored according to the KPI. Running Reset Color, Line Type and Line Weight 
to BYLAYER will reset those properties to the default values assigned in Fixture Studio. 

Reset Layer 
If the selected block is on a different layer to that defined for that block in Fixture Studio, 
the block will be reassigned to that layer in the currently active floor plan. 

List Unknown Blocks 
It is possible for blocks to exist in the drawing, but not be registered in Fixture Studio. 
These sorts of blocks are shown in the Processing Blocks dialogue box that appears when 
the drawing is being restructured. 

 

The Retail Layers Toolbar 
The Retail Layers Toolbar enables users to quickly control which layers pertinent to 
Retailing are visible. 

 

Buttons Description 

 

  
Turns on all zones, zone text and aisles / 
boundary layers 



Display 2D and 3D  

312 Oracle Retail Store Planner's User Guide 

Buttons Description 

 

  

Turns off all zones, zone text and aisles / 
boundary layers 

 

  

Turns on all fixtures (but not fittings) 

 

  

Turns off all fixtures (but not fittings) 

 

  

Turns on all fittings (but not fixtures) 

 

  

Turns off all fittings (but not fixtures) 

 

  

Turns on all products, shelves and associated 
annotation 

 

  

Turns off all products, shelves and associated 
annotation 

 

  

Turns on all general notes, markups and general 
dimension lines 

 

  

Turns off all general notes, markups and 
general dimension lines 

 

Toggles fixtures to 2D layer (if set up for this) 

 

Toggles fixtures to 3D layer (if set up for this) 

Display 2D and 3D 
The Display 2D and Display 3D options are available from the View pull down menu. 
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They are also available from the Retail Layers toolbar. 

 

This functionality is specific to Macro Space Management. It requires fixtures that have 
been configured in a specific way prior to having been registered in Fixture Studio. (The 
method is described in more detail in the Fixture Studio help file). Fixtures that have not 
been configured in this manner will not toggle between 2D and 3D form. 

If Display 2D is selected, only the base of the fixture will be displayed, giving an outline 
plan view. If display 3D is selected, all of the fixture will be displayed, giving a three 
dimensional view if the drawing is viewed from an oblique angle. 

The purpose of the 2D functionality is to simplify the floor plan when the floor plan is 
being published prior to being put into service. Instead of all the construction lines for 
the fixtures being visible, only the outline is visible in the printed output. This makes the 
published plan easier to read when distributed to the stores for implementation. 
The difference can be seen in the example below where the same fixtures can be seen in 
both 3D form (top) and 2D form (bottom). 
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Zones in Planner 

Overview of Zones 
Note: The information in this section is for guidance only. It 
should not be taken as a definitive business process. 

 

Configuring Zones 
Zones are configured in the Administration Module - their properties can thus only be 
changed by a user with Administration privileges. 

Placing Zones 
After the floor plan has been created in Store Manager, the next stage is to subdivide the 
available floor area into departments/zones. These zones serve to define a section of 
floor that is used for a specific and clearly defined purpose. Examples would include 
areas for food and drink sales, cafeterias, holding stock or staff only areas.  
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Zones can be added to a floor plan and subsequently edited. If zones contain obstructions 
such as staircases, pillars or lifts, 'holes' can be cut in the zone to allow for these non-
productive areas. 

Clashing Zones 
Because it is important for reporting accuracy to avoid overlapping zones of the same 
type, a Detect Clashes facility is available. This allows overlapping zones to be easily 
identified and corrected. 

Filtering using Zones 
It is possible to configure Macro Space Management so that the zones can be used for 
filtering purposes when selecting from the Object Grid. For example, it is possible to filter 
the list of available products to they are pertinent for the zone the selected fixture is in. 

Reporting using Zones 
Zones can be used as filters for reporting purposes. For example it is possible to return 
performance figures per square foot department by department.  

Zones, Filtering and Reporting 

Technicalities of Allocating Fixtures to Parent Zones 
Zones have several uses for reporting purposes. The exact use depends on what parent 
type the zone has been assigned to in the Administration module. The three zone types 
are: 
 Internal Area 

 Department 

 Other 

Internal Area 
The Internal Area type zone is used to define the maximum area used for retail purposes. 
There should only be one zone of zone type Internal Area per floor. In the example 
below, it defines the maximum area within the store. 
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For accuracy, the internal area zone can be added in a series of stages. This prevents the 
thickness of walls being taken into account. In the example below, an internal area has 
been added for each room in the store, ensuring the total area relates to floor area alone 
and not occupied by the footprint of the walls. 

 

The internal area zone also set bounds for how much area can be assigned to a fixture in 
the Allocated Area calculation. 

Department  
Department type zones are the main zone used for reporting purposes. This is because 
fixtures can be assigned to one (and one only) department type zone. (This information is 
stored in the ZON_ID field of the AVTTB_FIXTURE table). 
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Other 
All zones not of Internal Area type or Department type belong to the Other type. Fixtures 
can be assigned to multiple zones of type Other as well as type Department. (This 
information is stored in the AVTTB_ZONE_FIXTURE_LINK table). 

Example of Reporting using Department and Other Type Zones 
Consider the example below. In the left hand image all the fixtures are within a 
Department type zone. In the AVTTB_FIXTURE table they will be shown as exclusively 
belonging to that department for reporting purposes. 

 

In the right hand image sub-departments have been assigned within the main 
department. The AVTTB_ZONE_FIXTURE_LINK table will show fixtures as belonging 
to both the parent department and the pertinent sub-department. In the case of fixtures 
crossing the sub-department boundaries, they may be show as belonging to bother 
departments. Filtering and reporting needs to take this into account.  

Note: Information on how fixtures are assigned to tables is 
not normally accessible to ordinary users. The information 
on tables specified above is mainly for the benefit of 
implementors and administrators. 

Filtering 
Because of the way Macro Space Management (MSM) automatically assigns fixtures to 
parent zones, this information can be used for filtering purposes in the Object Grid. For 
example, it is possible to modify the Custom SQL (AVTTB_CUSTOM_SQL table) for the 
Object Grid so that it only displays products and planograms pertinent to the zone the 
selected fixtures are in. This form of filtering can be used to save time and make it faster 
to populate a floor plan with merchandise. 

Reporting 
Zones can be used as filters for reporting purposes. For example, because fixtures are 
associated with zones and products or planograms can then be associated with their 
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parent fixtures, it is possible to report on the performance of the merchandise within a 
specific zone. These reports can then be aggregated as necessary.  

For example, it would be possible to report in the sub-departments within the Food and 
Drink department to see how sub-segments of this department were performing. It 
would then be possible to aggregate these reports up to see the performance of the entire 
department. Because zones have measurable areas, it is possible to report performance 
related to area.  

Department 
or Sub-
Department 

Area Profit Profit/square 
foot 

Drinks 10,000 ft2 $44,000 $4.40/ft2 

    Spirits and 
Liqueurs 1,500 ft2 $10,000 $6.67 

Wines 2,000 ft2 $12,000 $6.00 

Beers and Lagers 2,500 ft2 $13,500 $5.40 

Soft Drinks 4,000 ft2 $8,500 $2.13 

  

Zones and the Administration Module 
Options in the Administration Module allow several aspects of Zones to be configured. 

Note: The Administration Module is only available to users 
with Administrators Privileges. 

If you do not have these privileges, you will not be able to access the Administration 
Module. 

 Zone Types can be configured using the Zone Types option. 

 Zone Definitions can be configured using the Zone Definition option. 
 Zone Hatch Styles can be configured using the Hatch Styles option. 

 Zone Annotation can be configured in using the Text Styles option. 

Zone Types 
Zones are assigned to one of three types: Internal Area, Department and Other. These 
types are configured in the Zone Types dialog box. 
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Zone Definitions 
Zone definitions are the actual zones that are placed. The hierarchy, name, hatch style 
and color, etc, can all be set up in the Zone Definitions dialog box in the Administration 
module. 

 

Hatch Styles 
Hatch styles are a method of coloring zones in both the Planner and Merchandiser 
modules. Planner comes with a pre-configured set of hatch styles, but hatch styles need 
to be configured for Merchandiser. This is done in the Hatch Styles dialog box. 

 

Annotation 
The annotation for zones is controlled from the Text Styles dialog box. This allows full 
control over the text description placed, together with its position and size. 
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Zones and In-Store Space Collaboration 
In-Store Space Collaboration (an application that can use and modify data created in 
Macro Space Planning can only work within department type zones within a floor plan. 
If no zones of that type are available, then an error message will result when a user tries 
to open that floor plan.  

 

Accordingly, all floor plans intended for use within In-Store Space Collaboration should 
have a minimum of one department type zone.  

Practical Tips for Drawing Zones 
When drawing zones, some practical tips should be bourne in mind. 

Zones and End Caps 
End caps on gondolas present a specific problem as far as zones and reporting are 
concerned. By virtue of their position, many end caps are precisely bisected by a zone 
drawn along the axis of gondola. This 50/50 split can cause problems with reporting as it 
is difficult for the functionality to determine which zone the majority of the fixture is in. 



Practical Tips for Drawing Zones  

322 Oracle Retail Store Planner's User Guide 

In the example below, the central gondola is precisely bisected by the boundaries of two 
zones. 

 

The solution is to move the position of the boundaries by using AutoCAD vertices. To do 
this, select a boundary line for a zone, right click and select Add Vertex. 

 

With Object Snap (OSNAP) turned on, snap the line to a corner of the end cap. 
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Continue until both zones have been lead round the sizes of the end caps. In the example 
below, one zone boundary has been selected for clarity. 

 

This will ensure accuracy for any reports based on zones. 
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Zones on the Object Browser 

Overview of Zones on the Object Browser 
The Zones Tab can be used to add and delete zones in the currently active floor plan. It 
can also be used for other operations involving zones including highlighting them in the 
zone hierarchy or floor plan and adding and removing hatching. 

 

 The Zones Toolbar contains a series of icons used to control operations 
concerning zones. 

 The Zones Hierarchy displays the available zones. 

 Clicking on the Splitter Bars will open or close individual windows on the Object 
browser. 
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 The Properties Window has information on the zone currently highlighted in the 
hierarchy. 

 The Summary Window has information on the zones currently placed in the 
floor plan. 

Using the Object Browser for Zone Operations 
The Zones Toolbar contains a series of icons allowing various operations to be carried 
out on Zones. 

 

Icon Description 

 

Add Zone Boundary 

 

Add Hole 

 

Delete all of Zone 
Description 

 

Delete Specific Zone 

 

Highlight Zone in 
Drawing 

 

Highlight Zone in 
Tree 

 

Find 

 

Detect clashes 

 

Configuration 
Options 

 

Refresh 

 

Add Hatching 

 

Remove Hatching 

  
The Zones Hierarchy Window is found immediately below the toolbar. 
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It contains a Hierarchical Tree giving a list of all the available Zone types. 

Note: Zone types and descriptions can be added, edited or 
deleted using the Administration Module. 

The Properties Window gives details of the Zone Definition that has been selected in the 
hierarchy. 

 

Note: Information in this window is controlled from Custom 
SQL in the AVTTB_CUSTOM_SQL table. Administrators can 
customise the information that appears in the Properties 
Window by modifying the Custom SQL. 

The Summary Window contains details of Zones within the currently active drawing. 

 

The information typically includes Zone Name, Zone Description, and Gross and Net 
Areas. Zone Names and Zone Descriptions can be sorted by clicking on the column 
headings. If a zone has been selected in the drawing, it will be highlighted in the 
summary of zone properties. 

Note: Information in this window is controlled from Custom 
SQL in the AVTTB_CUSTOM_SQL table. Administrators can 
customise the information that appears in the Summary 
Window by modifying the Custom SQL. 
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Creating and Editing Zones 

Adding the Zone 
Zones can be added to the currently active floor plan by highlighting a zone in the zone 
hierarchy in the Object Browser and clicking the Add Zone icon on the toolbar.  

 

Alternatively, zones can be added by highlighting a zone and using the right click menu. 

 

Drawing the Zone 

Note: Zones must be a single closed boundary. If the end of 
the line defining the boundary is not correctly attached to 
the start (Closed in AutoCAD terminology), the zone will 
not draw correctly.  

Once Add Zone has been selected from the Object Browser toolbar, the Specify start 
point prompt will appear in the command line. 

 

The zone can be drawn using various methods in AutoCAD. The easiest of these are: 

 Using OSNAPS 

An effective way to draw a zone conforming to the contours of door, walls, 
stairs, etc, is to turn AutoCAD's OSNAP (Object Snap) functionality on and draw 
the zone section by section, snapping to specific points in an architectural plan. 
The final part of the zone (joining the line back to the start point) is best done by 
typing the AutoCAD Close command into the command line. This will cause a 
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line to be drawn from the position of the last drawn point to the start of the zone, 
thus forming the closed boundary required for the zone to be drawn directly.  

 Drawing the zone using AutoCAD's coordinate system 

An alternative way of drawing the zone is to draw a line to points defined by 
AutoCAD's coordinate system; either to absolute points (560,480) or to points 
relative to the last point (@560,480). As per the OSNAP method, the final part of 
the zone (joining the line back to the start point) is best done by typing the 
AutoCAD Close command into the command line. 

Cutting Holes 
There will be unproductive areas of floor in any floor plan. In the example below, the 
area under the stairs cannot be used. The white rectangle visible under the stairs 
represents a hole cut in the zone.  

 

This allows performance metrics to be based on the usable area of the zone, not its total 
area.   

 

In this example, the Gross Area of the zone is 3466 square feet and the net area 2926 
square feet. Assuming the zone has generated $50,000 of sales in a week, using the gross 
area would give sales of $14.4 per square foot and using the net area would give sales of 
$17.1 per square foot. The latter figure is probably more representative of how the zone is 
performing. 

To cut the hole, highlight the zone into which the hole is to be cut in the zone hierarchy in 
the Object Browser then click the Cut Hole icon on the Zone toolbar. 
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The hole can then be drawn in a similar way to a zone. 

Editing the Zone Boundaries 
The position of a zone boundary can be changed using AutoCAD Grips. To resize a zone, 
click on the boundary to activate the grips. These appear as blue squares or rectangles. 

 

The grips can then be used to drag the zone boundary to its new position. 

 



Creating and Editing Zones  

330 Oracle Retail Store Planner's User Guide 

On hitting the Escape Key, the boundary will become permanent in its new position. 

 

The zone annotation will update to reflect the new size, but changes in the zone 
boundary position will not be written back to the database. Accordingly, after the zone 
boundaries have been modified, the floor plan must be synchronised Match the 
Drawing.   
A slightly more advanced way of changing the zone boundaries is to activate the 
AutoCAD grips, the hover the mouse pointer over one of them. This will bring up a list 
of additional options. 

 

After using these options, the floor plan must again be synchronized. 

Hatching the Zone 
If zones are not set to hatch automatically on being placed (configuration module), they 
can be hatched (or have the hatching removed) by means of the Add Hatch or Delete 
Hatch icons on the zones toolbar. 
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The example below show solid, hexagon and zig-zag hatches. 

 

Deleting Zones and Holes 
Deleting holes and zones can be done in one of two separate ways: 

 Deleting all instances of a zone (and its associated holes) in a floor plan 

 Deleting a specific instance of a zone or a hole 

Deleting all instances of a zone (and its associated holes) in a floor plan 
Deleting all instances of a zone within a floor plan is done by highlighting the 
appropriate zone in the zone hierarchy in the object browser and clicking Delete zone in 
the toolbar. 

 

The Delete Zone confirmation will appear. On clicking OK, the zone will be deleted. 
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Deleting a specific instance of a zone or a hole 

 

Deleting as specific instance of a zone within a floor plan (or hole within a zone) is done 
by clicking the Delete Boundary/Hole icon on the toolbar. A prompt will appear in the 
command line asking the user to select 

 

On left clicking the outline of a zone or hole, it will be deleted from the floor plan without 
the need for further confirmation. 

Zone Highlighting Options 
There are two highlighting options available on the zones toolbar. 

 Highlight Zone 

 Highlight Selected Item in Tree 

Highlight Zone 
Highlight zone allows a user to find a zone in the floor plan. The option has to be turned 
on by toggling the icon on the Zones toolbar so it is depressed.  

 

After the icon has been toggled on, highlighting any zone in the zone hierarchy will 
cause the selected zone to be highlighted in the floor plan. The highlighting method will 
depend on setting in the Zones tab of the Configuration module. 

Note: It is recommended that the Highlight zone option be 
left off until needed - leaving it on may have a marginal 
impact on performance in the floor plan. 
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Highlight Selected Item in Tree 
Highlight Selected Item in Tree allows a user to select a zone in the floor plan and have it 
highlighted in the Zone Hierarchy in the Object browser. The option has to be turned on 
by toggling the icon on the Zones toolbar so it is depressed.  

 

Clicking on the boundary of the zone in the floor plan will then cause that zone to be 
highlighted in the hierarchy. 

Note: It is recommended that the Highlight zone option be 
left off until needed - leaving it on may have a marginal 
impact on performance in the floor plan. 

Find In Tree 
Find in Tree allows users to search for Zone Names in the Zone Hierarchy. 

 

Clicking the icon will bring up the Find Zone dialogue box. 
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To use the dialogue box: 

1. Type a text string into the text box 
2. Click on the search Icon 

3. Any zones with a name matching the search string will be listed 

4. To select a zone in the hierarchy, highlight it and click the OK button 

Detect Clashes 
Clashes occur when the boundaries of two zones of the same type (which must be on the 
same AutoCAD layer) overlap. This could mean inaccurate reporting. If the Detect 
Clashes option in the zones tab of the Configuration module has not been selected, the 
Detect Clashes option on the Zones toolbar can be used to manually check for clashes. 

 

If clashes exist, the offending zones will be highlighted. 
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In the above example highlighting has been set to the thicken option - the two 
overlapping zones have greatly thickened boundaries. 

Configuring Zone Behavior 
The way zones behave can be configured in the Configuration module. To access the 
Zones tab, click Properties on the Zones toolbar. 

 

This will bring up the Zones tab of the Configuration module. 
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The general options are as follows: 

 Auto Close will cause the zone boundary to close (became a continuous 
boundary) when drawing it if you left click with the mouse within the Proximity 
distance of the start point of the zone. 

 Hatch determines if the zones should hatch when drawn. 
 Hatch over Text specifies whether the hatch should overlap the text or not. 

 Detect Clashes will cause any zones of the same zone type to flash if the 
boundaries overlap when being drawn. This is important for reporting accuracy. 

 Prompt for Name will allow the user to enter a custom name for the zone when 
placing it. 

 The highlight options are as follows: 
 Thicken Boundary will cause the zone boundary to thicken when the Highlight 

Zone option is chosen on the zone toolbar. 

 Flash will cause the zone boundary to flash when the Highlight Zone option is 
chosen on the zone toolbar. 

 Zoom will cause the zone boundary to increase in size when the Highlight Zone 
option is chosen on the zone toolbar. 

Refreshing Zone Information 
The Refresh option refreshes zone information in the Object Browser. 
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Clicking on the Refresh button in the zones tab will load the latest zone information from 
the database into the zone hierarchy. This is used to update the Object Browser when 
changes have been made to Zone Types and Zone Descriptions in the Administration 
module. 

Adding and Removing Hatching 
Hatching can be added to or removed from zones using the appropriate option. 

 

 To hatch a zone, select the zone in the hierarchy and click the Hatch icon. 

  To remove the hatch, select the zone in the hierarchy and click the Delete Hatch 
icon 

In the example below, the top zone is hatched, the bottom one is not. 
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Overview of Fixturing 

The Planner Module and the Business Life Cycle 
The Planner module is part of the Business Life Cycle. 
  

 

Store Manager Activities start the business cycle. 
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Here stores, floors and revisions are added, edited or deleted. Revisions contain store 
plans. These are often x-refed to architectural plans so that fixtures and gondolas can be 
placed relative to the walls of the store. 

(Store Manager can be accessed from both Planner and Merchandiser). 
Store Planning involves the placement of zones, fixtures and merchandise. 

Zones can only be placed in Planner (although they can be seen in Merchandiser). 

Fixtures and merchandise can be placed in both Planner and Merchandiser. (It is 
normally more convenient to carry out Fixturing Operations in Planner and 
Merchandising operations in Merchandiser). 

Using the Fixtures module, the user can: 
 Place single or multiple fixtures, fittings and gondolas. 

 Move or rotate fixtures, fittings and gondolas. 

 Erase fixtures, fittings and gondolas. 

 Number bays in fixtures and gondolas. 

 Calculate effective sales areas. 

 Collate information on fixtures and fittings. 
After the floor plan has been designed, each fixture can subsequently be populated by a 
predetermined quantity and arrangement of sales products using the Planogram 
Selection and Add Product modules. After the floor has been merchandised, Macro Space 
Management can be used to analyze and report on the effectiveness of the layout. 

Result Management involves checking the completed store layout by means of Reports 
and Key Performance Indicators before releasing the layout to stores for implementation 
or starting on the next phase of planning. 

About Fixture Studio 
Fixture Studio is a stand alone module where Fixtures and Gondolas can be added, 
edited and deleted. These fixtures and gondolas can then be used on the Planner (and 
Merchandiser) environments 

Fixture Studio can be opened (or activated if already open) from the Object Browser in 
the Planner module by clicking on the Edit icon on the Fixturing toolbar. (There is an Edit 
Fixture icon when working with fixtures and an Edit Gondola icon when working with 
gondolas). 
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Fixture studio allows the properties of fixtures and gondolas to be specified. It also 
allows the hierarchical tree in which they are organized to be modified. 

 

About Merchandiser 
The Merchandiser Module is a virtual reality environment that can be used in 
conjunction with the Computer Aided Design (CAD) environment of the Planner 
module.   

 

The merchandiser module has several functions: 

Firstly, it can be used to design planograms. 
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Secondly, it can be used to design a floor layout; fixtures, fittings and gondolas being 
placed and viewed in the 3D virtual reality (VR) environment. It is not as precise as the 
Planner environment, but gives a more visual representation of the store plan. 

Finally, the fixtures and gondolas can be populated with shelves, products and 
planograms, again in the 3D virtual reality (VR) environment. 

Note: Shelves can only be placed in the Merchandiser 
environment, although they can be seen in the Planner 
environment after Synchronization. 

 

Note: Products can only be placed at display style level in 
Merchandiser. Such products are not visible in Planner. 
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Overview of Fixturing on the Object Browser 
Clicking on the Fixturing Tab on the Object Browser brings up a series of options for 
adding, editing and deleting Fixtures and Gondolas. 

 

 The Toolbar gives access to a series of options concerning fixtures. 

 The Buttons allow the user to toggle between Fixtures (Blocks) and Gondolas. 

 The Hierarchy Window allows users to select fixtures (or gondolas) from the list 
available. 

 The Properties Window shows the properties assigned to the selected fixture. 
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 The Summary Window shows the number of instances of the selected fixture 
placed in the drawing. 

 The Preview Window shows a preview of the selected Fixture 

Using the Object Browser for Fixturing Operations 
The Fixturing Toolbar is found on the Object Browser. It is selected by clicking on Blocks 
in the Fixturing window. 

 

It contains a series of icons allowing various operations to be carried out on Fixtures. 
Some may be greyed out if they are not available for that operation. 

Icon Description 

 

Add Fixture 

 

Edit Fixture 

 

Delete Fixture 

 

Highlight selected item in 
view 

 

Highlight selected item in 
tree 

 

Search 

 

Configuration Options 

 

Refresh 

 

Attributes 

 

Promotional Fixtures On or 
Off 

  

The Fixtures Hierarchies Window shows a hierarchical tree of all the available fixtures 
or gondolas. 
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The tree can be expanded or contracted by clicking on the + or – icons. 

The Fixturing window can be minimized by clicking on the splitter bar. 

 

The Blocks or Gondolas buttons immediately above the window determines whether the 
hierarchical tree shows fixtures or gondolas. 

The hierarchical tree can be configured in Fixture Studio.  

The Properties Window will show the properties for the currently selected fixture. 

 

The Properties window can be minimized by clicking on the splitter bar. 

 

Note: Information in this window is controlled from Custom 
SQL in the AVTTB_CUSTOM_SQL table. Administrators can 
customise the information that appears in the Properties 
Window by modifying the Custom SQL. 

The Summary Window will show a user defined list of fixtures placed in the drawing. 

 

Clicking on a column heading will re-order that column. Clicking again will reverse the 
sort order. 
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The Summary window can be minimized by clicking on the splitter bar. 

 

Note: Information in this window is controlled from Custom 
SQL in the AVTTB_CUSTOM_SQL table. Administrators can 
customise the information that appears in the Summary 
Window by modifying the Custom SQL. 

The Preview Window shows a low resolution image of the fixture selected in the 
hierarchical tree. The - or + options to the upper left can be used to display two different 
types of preview. 

 

The window can be resized in the horizontal plane by dragging the edge of the Object 
Browser with the mouse. It can be resized in the vertical plane by dragging the bottom of 
the window with the mouse. 

The Preview window can be minimized by clicking on the splitter bar. 

 

The virtual reality form of the preview can be rotated by positioning the mouse pointer in 
the screen and holding down the left mouse key. The position of the mouse cursor will 
determine the direction of rotation, while the distance of the mouse cursor from the 
object will determine the speed of rotation. The image can be moved up and down using 
the central wheel on the mouse. 

The image can be resized by holding down the <Ctrl> key, then left clicking the mouse 
and dragging the object. 

Deleting Fixtures 
Deleting Fixtures is done from the Object Browser 

Sequence of Actions Required 
There are two potential ways of deleting fixtures. The first is to select the required fixture 
first. 

1. Select required fixture or fixtures and right click to confirm selection. 

2. Click the Delete icon. 
3. The selected fixtures will be deleted. 

The alternative is to select the delete option first. 

1. Click the Delete icon  

2. Select required fixture or fixtures. 
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3. Right click to confirm selection and the fixtures will be deleted. 

Either way is valid. This example will use the latter option of selecting the delete option 
first and the fixtures last. 

Deleting Fixtures 
Deleting products can be carried out as follows: 

1. Select the Fixtures Button on the Merchandising tab of the Object Browser 

 

2. Select the Delete option from the Toolbar 

 

3. Selecting Fixtures 

On clicking Delete Fixture, the command line in Planner will prompt users to select 
fixtures.  

 

These can be selected by standard AutoCAD methods including left clicking 
individual fixtures or using window and crossing selection boxes. In this instance, 
four fixtures have been selected be left clicking, the information being reflected in the 
command line. 
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Note: Clicking on the products themselves will not be effective - 
deleting products requires the user to select the parent fixtures 
for the products. Accordingly, users should left click on the 
fixture itself or use window and crossing selection boxes that 
encompass both the product and its parent fixture. 

On right clicking to complete the selection, the fixtures will be deleted. 

Editing Fixtures 
Fixtures can be edited by clicking the Edit Product icon on the tollbar. This icon will only 
be active if the user belongs to a user group with access rights to Fixture Studio. 

 

On clicking Edit fixture, the user will then be taken to fixture Studio. If a fixture is 
highlighted in the product hierarchy at the time the Edit Fixture icon is clicked, this 
product will be open for editing in Fixture Studio.  

Fixture Highlighting Options 
There are two highlighting options available on the Fixturing toolbar. 

 Highlight Fixture 

 Highlight Selected Fixture in Tree 

Highlight Fixture 
Highlight zone allows a user to find a fixture in the floor plan. The option has to be 
turned on by toggling the icon on the Fixturing toolbar so it is depressed.  

 



Finding Fixtures in the Hierarchy  

348 Oracle Retail Store Planner's User Guide 

After the icon has been toggled on, highlighting any fixture in the fixture hierarchy will 
cause the selected fixture to be highlighted in the floor plan. The highlighting method 
will depend on setting in the Fixturing tab of the Configuration module. 

Note: It is recommended that the Highlight zone option be 
left off until needed - leaving it on may have a marginal 
impact on performance in the floor plan. 

Highlight Selected Item in Tree 
Highlight Selected Item in Tree allows a user to select a fixture in the floor plan and have 
it highlighted in the Fixture Hierarchy in the Object browser. The option has to be turned 
on by toggling the icon on the Fixturing toolbar so it is depressed.  

 

Clicking on the boundary of the fixture in the floor plan will then cause that fixture to be 
highlighted in the hierarchy. 

Note: It is recommended that the Highlight zone option be 
left off until needed - leaving it on may have a marginal 
impact on performance in the floor plan. 

Finding Fixtures in the Hierarchy 
Find in Tree allows users to search for fixtures in the Fixture Hierarchy. 

 

Clicking the icon will bring up the Find Zone dialogue box. 
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To use the dialogue box: 

1. Type a text string into the text box 
2. Click on the search Icon 

3. Any fixtures with a name matching the search string will be listed 

4. To select a fixture in the hierarchy, highlight it and click the OK button 

Configuring Fixture Properties 
The Fixturing Options can be accessed by clicking on the Properties icon on the Fixturing 
toolbar. 

 

This will bring up the Fixturing Tab from the Configuration Module. 
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Full information is contained in the help for the Configuration module. For new users, 
the following settings are recommended: 

 In the Placement frame, set the drop down list to Auto Move and uncheck Auto 
Rotate and Auto Reinsert. This will assist when adding fixtures. 

 In the Highlighting frame, select a highlighting option. Flash is simplest for new 
users. 

Refreshing Fixture Information 
The Refresh option refreshes both Fixtures and Gondola information in the respective 
hierarchical trees. 

 

Clicking on the Refresh button in the Fixturing tab will load the latest fixture information 
from the database into the Fixture hierarchy. At the same time, it will load the latest 
gondola information from the database into the Gondola Hierarchy. 

Dragging and dropping a fixture from the appropriate hierarchy after the refresh button 
has been pressed will add that fixture to the drawing using the latest definition from 
Fixture Studio. Similarly, using the Add button will also add a fixture to the drawing 
using the latest definition from Fixture Studio. 

If a drawing is already open then fixtures already placed in the drawing will not use any 
changes loaded during the refresh operation until the drawing is closed and reopened. 
However, new fixtures added to the open drawing will use the new data. 
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Fixture Attributes 
Fixture Attributes can be assigned by selecting a fixture or fixtures and clicking on the 
Fixture Attribute icon in the toolbar. 

 

This will bring up the Fixture attributes dialogue box. If multiple fixtures are selected, 
only fields with common data will display information. The list of Fixture Attributes that 
are displayed is configured in Fixture Studio and can customized to suit an individual 
retailer's requirements. 

 

Fixture attributes can have many uses. In the above screen shot, the fixture attributes are 
configured to check on in-store compliance. Macro Space Management's sister product in 
the Macro Space Planning suite (In-Store Space Collaboration) can be used on the floor of 
a store enabling a user to walk around and physically examine the fixtures. Fixtures that 
have problems relative to the current version of the floor plan can have the check boxes 
ticked.  

The same data is visible in Macro Space Management (MSM) and In-Store Space 
Collaboration (ISSC). After a store survey using ISSC, MSM users can run a KPI to 
determine which fixtures have attributes assigned. This enables the floor plan to be 
updated by taking into account what is physically present in a store.  

Promotional Fixtures 
Certain fixtures with a store are known to generate high levels of profits. Examples 
include end caps on gondolas and displays by the checkout designed to increase impulse 
buying. Macro Space Planning allows specific fixtures in a floor plan to be designated as 
Promotional Fixtures. These fixtures can them be readily identified. They can then be 
used for special offers, promotions or the introduction of new products, etc. 
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Some retail chains also have a specific team responsible for merchandising promotional 
fixtures - designating the fixtures as such assists in identifying which fixtures that team is 
responsible for the merchandise on. 

Assigning Promotional Fixtures 
Once fixtures have been placed in a floor plan, they can be designated as promotional 
fixtures by using the Promotional Fixtures option from the Blocks toolbar of the 
Fixturing tab of the Object Browser. 

 

Identifying Promotional Fixtures 
Once promotional fixtures are assigned, they can be identified in two ways in a floor 
plan. 

Highlight 
The Promotional Fixtures option includes a highlight option in the drop down list of 
options. This will cause any fixtures that have been designated as Promotional fixtures to 
be highlighted in the floor plan. The exact highlighting method will depend on the 
options selected in the Merchandising Tab of the configuration module. 

Key Performance Indicator 
 Another way of identifying promotional fixtures is with KPI's. Without the KPI selected, 
the Promotional Fixtures are difficult to identify. 
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With the KPI active, the promotional fixtures are readily apparent. In this case the end 
caps and three bins in the aisle have been designated as promotional fixtures. 

 

Note: one of the easiest ways of seeing fixture KPI's is to use 
the Conceptual Visual Style option from AutoCAD's Visual 
Styles toolbar. This causes the entire fixture to color, not just 
the outlines.  

Using Promotional Fixtures 
There are a number of ways of using promotional fixtures. One possible method is: 
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1. Identify fixtures that have a high visibility to shopper traffic. Such fixtures 
include end caps on gondolas, display on checkout, power wings and bins in the 
centre of aisles. 

2. Use the Promotional Fixture on the Object Browser to designate those fixtures as 
promotional fixtures. 

3. Bay number these fixtures differently from other fixtures in the floor plan - possibly 
with a P suffix. 

4. It is then possible to report on and merchandise those fixtures separately to the other 
fixtures in the store - for example it would be possible to produce a weekly store plan 
showing promotional fixtures only that would allow a constantly changing program 
of special offers. 
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The Insert Fixture Dialog Box 

Overview of Insert Fixture Dialogue Box 

Options in the Insert Fixture Dialog Box 
The Insert/Edit Fixture dialogue box appears when the Add Fixture icon is clicked on the 
Fixtures toolbar. 

 

Note: The availability of some of these options depends on 
settings within the Fixturing tab of the Configuration 
Module. For example the arraying option will not be 
available if the Auto Reinsert option is checked. 

This dialogue box contains a series of options for manipulating the fixture during 
placement. 

Icon Description 

 

Move Fixture 

 

Attach Fixture 
to Another 

 

Move and 
Align Fixture 

 

Move Fixture 
to be between 
others 

 

Place Fixture 
on Top of 
Another 

 

Offset the 
Fixture 

 

Place Fixture 
In-Line with 
Another 

 

Change 
Justification 
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Icon Description 

 

Rotate the 
Fixture 

 

Rotate the UCS 

 

Create an 
Array of 
Fixtures 

 

Change the 
Size of the 
Fixture 

 

Add the same 
fixtures as the 
last added 

 

Undo the last 
change 

 

Modify the 
Options for 
this Fixture 

The Insert Fixture dialog box is used by toggling on the required option. Click on each 
button to activate the required option. When that operation is completed, select the next 
option if one is required. When the fixture placement options is satisfactory; complete 
insertion by clicking on the cross in the upper right corner of the Insert/Edit Fixture 
dialogue box, or press <Escape>. 

Configuring Operation of the Insert Fixture Dialog Box 
The exact way the Insert Fixture dialog box behaves is configured in the Fixturing Tab of 
the Configuration module. This can be accessed by clicking the Properties icon in the 
Fixturing toolbar on the Object Browser. 
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Placement Options 
Placement Options determine which button in the Insert Fixture dialog box is active 
when it is first activated. There are three options in the drop down list: 

 Auto Move makes the move button active.  

 Auto Attach makes the Attach button active. 

 Auto Align makes the Align button active. 

Other Options 
Other options can be selected by means of the check boxes. 

 Auto Rotate requires the user to specify a rotation angle when the fixture is first 
inserted. 

 Auto Reinsert allows the user to add additional copies of the fixture by left 
clicking in the floor plan. 

 Explode Composites causes all blocks specified as composites in Fixture Studio 
to be exploded into their component blocks when inserted into the floor plan. 
(This feature is not currently active) 

 Display UCS Icon controls display of the UCS icon in the floor plan. (This 
feature is not currently active). 

 Prompt for Sizes will cause a dialog box to appear when a stretchable block is 
placed in the floor plan. This allows the user to select the specific size for the 
block.  

Recommended Options 
New users may find the following settings easiest to use when first using the Insert 
Fixture dialog box. 
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 Placement option set to Auto Move. 

 Auto Rotate and Auto Reinsert set to off. 

 Explode Composites, Display UCS Icon and Prompt for Sizes set to on. 

Move Fixture option 

 

This option will be active when the Insert Fixture dialog box first opens if the Auto Move 
option has been chosen in the Fixturing tab of the configuration module.  

If toggled on, the fixture being currently inserted will place in the floor plan where the 
cursor is left clicked. Clicking in the floor plan will also turn the move option off in the 
dialog box. If it is desired to move the fixture again, the Move button should be toggled 
on, whereupon the fixture can be moved and repositioned by right clicking in the floor 
plan again. 
If, there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Attach Fixture to Another option 

 

This option will be active when the Insert Fixture dialog box first opens if the Auto 
Attach option has been chosen in the Fixturing tab of the configuration module.  

Auto Attach allows two fixtures to be snapped together in a precise alignment by means 
of connection points. Connection points are assigned to fixtures in the Connections Tab 
in the Block Details dialog box in Fixture Studio - see the Fixture Studio help file for more 
information. The behavior of the connection points is controlled by settings in the 
Fixturing tab of the Configuration module. This can be accessed by clicking the 
Properties icon in the Fixturing toolbar on the Object Browser.  
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The behavior of the connection points is provided by the three filtering options provided. 

 If the Gender filter is on, male will only connect to female or neutral gender. 
Male (for example) cannot connect to male. 

 If the Size filter is on, only connection points of similar or overlapping sizes will 
connect together. (This feature is currently not active). 

 If the Shape filter is on, only connection points of similar shapes will connect 
together. 

The appearance of the connection points ids governed by further options. 

 The Pointer Size allows the display size of the connection points to be adjusted. 

 Line Size affects the size of connection lines. This feature is only active in the 
Merchandise module. 

 The colors affect the visual appearance of the connection point. 

Using the Attach Fixture Option 
In order to use the Attach Fixture option, there must already be at least one fixture with 
compatible connection points present in the floor plan. The default connection point will 
be active on the fixture being placed: 

 

When the active fixture come within a set proximity of any other fixture with compatible 
connection points, the two fixtures will snap together in an alignment determined by the 
position of the connection points. 
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If, there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Move and Align Fixture option 
Note: Move and Align can be used in conjunction with the 
Offset the Fixture option. See the section on this option for 
more information. 

 

This option will be active when the Insert Fixture dialog box first opens if the Auto Align 
option has been chosen in the Fixturing tab of the configuration module.  

This allows the fixture to be aligned with lines in the floor plan. An example of its use 
would be to align a fixture with a line representing a wall. In the example below, the 
fixture being placed in the floor plan is first brought into proximity with the line 
representing the wall. (In this instance the wall is in an associated architectural plan). 

 

When the fixture reaches a sufficiently close proximity to a suitable line, it will 
automatically align to that line. 

 

If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 
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Move Fixture to Between Others option 

 

This option can only be selected after the fixture has been placed in the floor plan by 
another command from the Insert Fixture dialog box. It is used to place the fixture 
midway between two selected points.  

Note: This command works well in conjunction with the 
AutoCAD Object Snap (OSNAP) option. 

In this instance it is desired to place a fixture midway between the two existing fixtures 
in the floor plan. 

 

After selecting the Move Fixtures Between Others option in the dialog box, it is then 
necessary to click once in the floor plan to return focus to the floor plan. A prompt will 
appear in the command line asking the user to select the starting point of the line from 
which the midpoint will be selected. 

 
Clicking on this icon will bring up a dialogue at the cursor asking for the start position of 
the line on which the fixture will be placed at the midpoint. In this instance the insertion 
point of the first fixture has been selected by left clicking it. 

 

Another prompt will appear in the command line asking the user to select the end point 
of the line from which the midpoint will be selected. 
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The insertion point of the second fixture is selected by left clicking it. 

 

The insertion point of the fixture being placed will then be positioned exactly midway 
between the two selected points. 

 

If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Place Fixture on Top of Another option 

 

This option can only be selected after the fixture has been placed in the floor plan by 
another command from the Insert Fixture dialog box. It is used to place the active fixture 
on top of a selected object. In the example below, it is intended to place the condiment 
cabinet on top of the freezer. 
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After selecting the Place Fixture on Top of Another option, left click in the floor plan to 
transfer the focus to the floor plan. A prompt will appear in the command line  

 
On left clicking an object to select it, the insertion point of the object being placed on top 
will be placed in the centre of the selected object. 

 

Note: In cases like the above example, further operations 
may be necessary to complete positioning the fixture. 

Offset the Fixture option 

 

The Offset the Fixture option is used in conjunction with the Move and Align function. 
Move and Align will align the fixture being placed in the floor plan with a physical 
fixture such wall. Additional use of the Offset the Fixture allows the user to align at a 
specific distance from the selected object. 

The initial stage is to place the fixture in the floor plan with a left click to temporarily 
position it. Clicking the Offset the Fixture icon will bring up the Offset dialog box. 
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This allows the required offset to entered - all offsets being relative to the front. In the 
above example an offset of 36" in the Y axis will place the fixture 36" away from the wall 
that will be selected using the Move and Align option. Click OK and then select Move 
and Align. 

 

When the mouse cursor is close to a wall or other line, it will align relative to that wall at 
the specified offset. Left click to place the fixture. 

 

If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

In-Line the Fixture option 

 
The In-Line the Fixture option allows users to align the fixture currently being placed 
with another fixture already in the floor plan. Clicking in In-Line the Fixture icon brings 
up the In-Line dialogue box. 
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The functionality is used as follows: in the example below, it is desired to align the blue 
fixture (in the process of being placed) with the already placed red fixture. Accordingly, 
one of the alignment buttons in clicked in the In-Line dialog box.  

 
This will result in a prompt to select a fixture. 

 
Click in the floor plan to change focus there and then click on the outline of the required 
fixture. The fixtures will be moved so they are in the desire alignment. 

 
Control will also be returned to the In-Line dialog box. Click the OK button to confirm 
the placement and return to the Insert Fixture dialog box.  

If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Change Justification option 

 

Clicking on the Change Justification icon brings up the Justification dialogue box. 
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This dialog box allows the datum used for inserting the fixture to be temporarily 
modified. In diagram 1 below, a fixture with a 'back-left' insertion point has been inserted 
using the centre of the red cross as a datum. In diagram 2, the justification has been 
changed to 'centre' and the centre of the fixture has moved over the datum point. 
Similarly, in diagram 3, the justification has been changed to front right and the location 
of the fixture has changed again. 

 

The Undo button will not be active until al least on change in justification has been made. 
Clicking undo will then return the fixture to its previous justification. Clicking OK will 
confirm the placement of the fixture and return the user to the Insert Fixture dialog box. 

Rotate the Fixture option 

 

The rotate fixture option allows a fixture to be rotated during placement. Clicking the 
rotate icon brings up the Rotate Block dialogue box. 
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Relative and Absolute Angles 
The Relative Angle is the angle the fixture will be rotated through each time the apply 
button is clicked. The Absolute Angle is the angle relative to the WCS that the fixture 
will be rotated to. Altering one of the values causes the result of the change to be 
reflected in the second value. 
 Relative Angle 

If the relative angle is set, the value for the absolute angle is the angle of the 
fixture relative to the WCS after the rotation has been executed by clicking the 
Apply button. 

 

In the above example a 30 degree relative rotation will be applied. After the 
rotation the UCS will be at a 60 degree angle to the WCS. 

 Absolute Angle 

If the absolute angle is set, the relative angle is the angle the fixture will be 
rotated through to get to the specified absolute angle relative to the WCS. 

 

In the above example, the UCS is to be set to an absolute angle of 270 degrees 
relative to the WCS. This will require a relative rotation of 240 degrees from its 
present position.  

Align with Object 
The usual use of the Align with Object option is to align with an object such as a wall in 
an architectural plan. In order to do so:    
1. Click the Align with Object Button. 

2. Click once in the floor plan to change the focus to the floor plan. 
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3. Click on an object to set the alignment for the fixture. 

4. The fixture will rotate with the front face parallel to the selected object. 

 

In the above example, the wall in the architectural plan has been used for alignment 
purposes, causing the fixture to rotate accordingly. 

Measure 
Clicking the Measure button allows the user to manually draw a line defining the 
rotation angle for the block. The initial point of the line has its origin at the insertion 
point of the block. The user sets the other end by left clicking at another point in the floor 
plan. 

 

If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Rotate the UCS option 

 

This option allows users to rotate the UCS (Universal Coordinate System). Planner has a 
World Coordinate System (WCS) that has a fixed set of orientations. Using the UCS 
allows the user to set a custom set of XY coordinate specific to the fixture placement. An 
example would be aligning relative to a wall. 
  
Clicking the Rotate the UCS icon brings up the Rotate UCS dialog box.  
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Relative and Absolute Angles 
The Relative Angle is the angle the UCS will be rotated through each time the apply 
button is clicked. The Absolute Angle is the angle relative to the WCS that the UCS will 
be rotated to. Altering one of the values causes the result of the change to be reflected in 
the second value. 
 Relative Angle 

If the relative angle is set, the value for the absolute angle is the angle relative to 
the WCS after the rotation has been executed by clicking the Apply button. 

 

In the above example a 45 degree relative rotation will be applied. After the 
rotation the UCS will be at a 135 degree angle to the WCS. 

 Absolute Angle 

If the absolute angle is set, the relative angle is the angle the present UCS will be 
rotated through to get to the specified absolute angle relative to the WCS. 

 

In the above example, the UCS is to be set to an absolute angle of 45 degrees 
relative to the WCS. This will require a relative rotation of 80 degrees from its 
present position.  

Align with Object 
The usual use of the Align with Object option is to align with an object such as a wall in 
an architectural plan. In order to do so:    

1. Click the Align with Object Button. 
2. Click once on the floor plan to change the focus to the floor plan. 

3. Click on an object to set the alignment for the UCS. 
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4. The UCS will be set with the X axis perpendicular to the selected object and the Y 
axis parallel to it. 

 

In the above example, the wall in the architectural plan has been used for alignment 
purposes, causing the UCS (lower left) to rotate accordingly. 

Measure 
Clicking the Measure button allows the user to manually draw a line defining the X axis 
of the revised UCS. The initial point of the line has its origin at 0, 0 in the floor plan. The 
user sets the other end by left clicking at another point in the floor plan. 

 

Create an Array of Fixtures option 

 

The Create an Array of fixtures option allows users to insert a single fixture into the floor 
plan then create a regular array of that fixture. In the example below the original 
checkout (in blue) has been arrayed to form a line of checkouts. 

 

In the second example, a single 4-Way clothing fixture (red) has been inserted into the 
floor plan and then arrayed to lay out part of a clothing department. 
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To create an array, first place a single fixture into the floor plan. On clicking the Create an 
Array of Fixtures option, the Array dialog box will appear. 

 

Columns and Rows 
Row and columns refers to the number or rows and columns of fixtures that will be 
present after the array has been created. 

 

Apply Button 
The apply button will result in the current settings in the Array dialog box being applied 
to create a temporary array in the floor plan. Changing the setting in the Array dialog 
box and clicking apply again will result in the displayed array being changed to match 
the new settings.  
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Undo Button 
The Undo button will not be active until at least one trial version of an array has been 
placed in a floor plan. Clicking undo will take the use back to the previous version of the 
placed array. Clicking the Undo button will not change the settings in the Array dialog 
box. 

OK Button 
The apply button places a temporary version of the array in the floor plan. The OK 
button will make that array permanent and return the user to the Add Fixtures dialog 
box. 

Spacing, Number and Distance 
Spacing, number and distance are inter-related. The radio button selects the field that is 
the result of multiplying the other two fields together. 

 

 Spacing is the distance between successive insertion points. If the fixture is 24 
inches long and the spacing is 60 inches, the insertion points will be 60 inches 
apart with a 36 inch gap between fixtures. 

 Number is the number of fixtures in that direction. 

 Distance is the total distance the insertion points will occupy - this value does 
not take into account the dimensions of the fixture. Four fixtures with a spacing 
of 60 inches will therefore occupy a distance of 180 inches.  

 

Rotation Angle 
The rotation angle allows the array to be drawn at a specified angle. 



The Insert Fixture Dialog Box 

Change the Size of the Fixture option  373 

 

Measure 
Measure allows the user to select an area to draw the array in. The fixtures will be spaced 
according to the current settings in the array dialog box. On clicking the Measure button, 
the user will be taken to the floor plan. The user can then draw a rectangle from the 
fixture that is the origin or the array. Fixture outlines will automatically populate the 
rectangle. On left clicking to specify the final dimensions of the rectangle, the user will be 
taken back to the Insert Fixture dialog box. Simultaneously, the distance values in the 
dialog box will be updated. The user should then click the Apply or OK buttons to draw 
the array.  

 

If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Change the Size of the Fixture option 

 

This button will allow the fixture to change in size during insertion. This will only work 
for specific fixtures - those that have a size assigned in the Sizes tab of the Block Details 
dialog box in Fixture Studio. Such blocks are called stretchable. 
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If the block being inserted is stretchable and the Change the Size of the Fixture option is 
active, the Size dialog box will appear. This allows the use to set the size of the 
stretchable fixture to any value within the parameters configured in Fixture Studio. 

 

On clicking OK, the user will be returned to the floor plan with the Insert Fixture dialog 
box active. 

If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Insert a Copy of the Current Fixture 

 

This option allows the user to insert another instance of the last block to be inserted by 
simply clicking on the icon. This removes the need to re-select the fixture from the Object 
Browser. On clicking the Insert a Copy of the Current Fixture icon, another instance of 
the fixture will appear in the floor plan and the button selected will default to that 
selected in the Placement options of the Fixturing tab of the Configuration module.  

If there are no further operations to carry out, placement is completed by clicking on the 
x in the upper right part of the Insert/Edit Fixtures dialogue box, or pressing <Escape>. 

Undo the Last Change option 
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The Undo the Last Change option undoes the effect of the last action carried out in the 
Insert Fixture dialog box. It will not be active until the first action has been completed. 

Modify the Options for this Fixture 

 

Selecting this option brings up the Fixturing Tab from the Configuration Module. 

 

This allows users to configure some options determining how the Insert Fixtures dialog 
functionality will behave while the dialog box is active. Once changes have been made to 
the tab, it can be closed and another option selected on the Add Fixture dialog box. 
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Fixture Swap and Manipulation 

Overview of Fixture Manipulation 
The Planner module is integrated with AutoCAD. Experienced AutoCAD users can make 
use of the majority of AutoCAD functionality to lay out floor plans in the Planner 
module. However, AutoCAD is a complex program and some users carrying out store 
planning tasks may not be familiar with AutoCAD functionality. Accordingly, Planner 
has been provided with some Fixture Manipulation tools. These enable users to perform 
a variety of operations including moving, rotating and aligning fixtures. One way of 
accessing these is from the Fixturing toolbar. 

 

Fixture Manipulation and Child Objects 
One of the advantages of using the Fixture Manipulation tools is that they control child 
objects. The Planner floor plan is divided into layers, each containing a particular type of 
object - such as fixtures or zone annotation. The display or selection of objects is often 
controlled by turning off or locking layers. If purely AutoCAD tools are used, objects on 
the turned off or locked layers are not included in the selection. This can result in some 
objects being moved, while their child objects are left in their original location. 

Another problem that can occur when using AutoCAD selection tools is that it is possible 
to select objects that it is not intended to move. For example the selection set could 
include blocks representing pillars or columns in a store. Fixture Manipulation filters the 
selected objects so that only fixtures and merchandise are moved, together with their 
associated annotation and bay numbers. 

The available Fixture Manipulation options are: 

Group On or Group Off for Fixtures 
Gondolas are items of equipment placed in a precise relationship to each other. When 
manipulating gondolas it is some times useful to manipulate then as a whole and it is 
sometimes useful to manipulate individual parts of a gondolas. If Fixture Grouping is 
On, selecting one part of a gondola will select all parts of that gondola. If Fixture 
Grouping is Off, individual parts of a gondola can be selected without selecting the 
whole. 

Move Fixtures 
Move fixtures enables the user to move the selected items of equipment (together with 
any merchandise and annotation) any direction in the X and Y axes. The elevation of the 
equipment remains unchanged. 

Slide Fixtures 
Slide fixtures enables the user to move the selected items of equipment (together with 
any merchandise and annotation) at 90 degree increments to the present orientation and 
position of the fixture. This enables the user to move the selected fixtures left, right, 
forward or back. The elevation of the equipment remains unchanged. 
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Offset Fixtures 
Align fixtures enables the user to take a selected set of equipment (and its merchandise 
and annotation) and align it relative to another object in the floor plan. It is also spaced a 
selected distance (offset) from that object. This might be used to take a gondola and place 
it a specific distance from a wall. 

Match Rotation 
Match Rotation enables the user to take a selected set of equipment (and its merchandise 
and annotation) and align it relative to another object in the floor plan. 

Cut 
Cut removes the selected equipment (and its merchandise and annotation) from the floor 
plan and pastes them to the clipboard. If a planogram has been 'exploded' (shows full 
detail of shelves and merchandise), this detail will also be pasted to the clipboard. 

Copy 
Copy takes details of the selected equipment (and its merchandise and annotation) from 
the floor plan and pastes the information into the clipboard. If a planogram has been 
'exploded' (shows full detail of shelves and merchandise), this detail will also be pasted 
to the clipboard. 

Paste 
Pastes takes the information from the clipboard and inserts it into the floor plan. If a 
planogram has been 'exploded' (shows full detail of shelves and merchandise), this detail 
will also be pasted to the floor plan. 

Delete 
Delete removes the selected equipment (and its merchandise and annotation) from the 
floor plan. 

Rotate 
Rotate takes the selected equipment (and its merchandise and annotation) and allows it 
to be rotated by any angle about the geometric center of the selected objects. 

Rotate 90 Degrees Clockwise 
Rotate 90 Degrees Clockwise takes the selected equipment (and its merchandise and 
annotation) and gives it a clockwise 90 degree rotation about the geometric center of the 
selected objects. 

Rotate 90 Degrees Anti-clockwise 
Rotate 90 Degrees Anti-clockwise takes the selected equipment (and its merchandise and 
annotation) and gives it an anti-clockwise 90 degree rotation about the geometric center 
of the selected objects. 

Rotate 180 Degrees 
Rotate 180 Degrees takes the selected equipment (and its merchandise and annotation) 
and gives it a 180 degree rotation about the geometric center of the selected objects. 

Mirror 
Mirror produced a mirror image of a selected set of equipment, merchandise and 
annotation. The selected objects are 'reflected' about a specified axis. 
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Array 
Array takes a selected set of equipment, merchandise and annotation and generates 
additional rows and columns of that set of objects. 

Overview of Fixture Swap 
The Fixture Swap functionality allows users to automatically swap selected fixtures in 
the active floor plan for replacements of a different type. Fixture Swap can be called from 
the Command Line (AVT_FIXTURESWAP) or from the Fixturing toolbar. 

 

The process works as follows: 

 

1. The Fixtures it is desired to swap in the floor plan are selected. 
2. The Fixture swap dialog box is selected and will populate with the selected fixtures. 

3. A fixture is selected to be swapped out. 

4. The fixture to be swapped in (replacement fixture) is selected. 

5. The two fixtures (in and out) are defined as a swap pair. 

6. The user continues to define swap pairs as required. 

7. When all swap pairs have been defined, the fixtures are swapped. 

Note: it is possible to reverse the first two steps - i.e. open 
the dialog box first, then select the required fixtures. 

Examples of Fixture Swaps 
One example of Fixture Swap is shown below, where it has been decided to replace two 
racking fixtures with slatwalls - allowing planograms involving hung products to be 
placed in the future. 
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Fixture swap also changes the size of planogram placeholders if they are on the fixtures 
being swapped. In the example below, the original planograms are shown on the rear 
gondola run. Two fixtures have been resized - and the planogram placeholders have 
changed size accordingly. This can be seen in the front gondola run. 

 

Accessing Fixture Swap and Manipulation Options 
Fixture Swap 

Fixture Swap can be initiated in the following ways: 

1. From the command line by typing AVT_FIXTURESWAP and pressing Return. 

2. From the Fixturing Toolbar 

 

Fixture Manipulation 
Fixture Manipulation can be accessed in the following ways: 

1. From the command line by typing in individual commands and pressing Return. 

Option Command 

Group On/Off None 

Move Fixtures AVT_MOVE 

Slide Fixtures AVT_SLIDE 

Offset Fixtures AVT_OFFSET 

Match Rotation AVT_MATCH_ROTATION 

Cut Fixtures AVT_CUT 

Copy Fixtures AVT_COPY 
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Option Command 

Paste Fixtures AVT_PASTE 

Rotate Fixtures AVT_ROTATE 

Rotate Fixtures 90 
Degrees Clockwise 

AVT_ROTATE_90 

Rotate Fixtures 90 
Degrees 
Anticlockwise 

AVT_ROTATE_270 

Rotate Fixtures 180 
Degrees 

AVT_ROTATE_180 

Mirror Fixtures AVT_MIRROR 

Array Fixtures AVT_ARRAY 

  

2. As a keyboard shortcut 

Option Shortcut 

Group On/Off Ctrl + Alt + G 

Move Fixtures Ctrl + Alt + M 

Slide Fixtures Ctrl + Alt + E 

Offset Fixtures Ctrl + Alt + O 

Match Rotation Ctrl + Alt + L 

Cut Fixtures Ctrl + Alt + X 

Copy Fixtures Ctrl + Alt + C 

Paste Fixtures Ctrl + Alt + V 

Delete Fixtures Ctrl + Alt + D 

Rotate Fixtures Ctrl + Alt + R 

Rotate Fixtures 90 Degrees 
Clockwise 

Ctrl + Alt + Right 
Cursor Arrow 

Rotate Fixtures 90 Degrees 
Anticlockwise 

Ctrl + Alt + Left 
Cursor Arrow 

Rotate Fixtures 180 
Degrees 

Ctrl + Alt + Down 
Cursor Arrow 

Mirror Fixtures Ctrl + Alt + I 

Array Fixtures Ctrl + Alt + A 

  

3. From the Fixturing toolbar. 
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Option Icon 

Group On/Off 
 

Move Fixtures 
 

Slide Fixtures 
 

Offset Fixtures 
 

Match Rotation 
 

Cut Fixtures 
 

Copy Fixtures 
 

Paste Fixtures 
 

Delete Fixtures 
 

Rotate Fixtures 
 

Rotate Fixtures 90 
Degrees Clockwise 

 

Rotate Fixtures 90 
Degrees Anticlockwise  

Rotate Fixtures 180 
Degrees  

Mirror Fixtures 
 

Array Fixtures 
 

  

4. From the right click menu accessed in the floor plan 
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Note: these commands should not be confused with the pure 
AutoCAD commands available from (for example) the 
Modify menu. 
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Turning Grouping On or Off 
Grouping affects how objects are selected for Fixture Manipulation or Fixture Swap. 
Grouping is Toggled on or Off using the icon on the Fixturing toolbar. 

 

Grouping On 
If Grouping is turned on, selecting a single item of equipment in a gondola selects all 
items of equipment in that gondola. 

Grouping Off 
If Grouping is turned off, items of equipment within a gondola must be individually 
selected; either by clicking on them, or by using Windows or Crossing selection boxes. 

In the example below, one fixture in the upper double sided gondola has been clicked 
while grouping was turned on - resulting in all fixtures and fittings in the gondola being 
selected. Grouping was then turned off, and a single fixture clicked in the bottom double 
sided gondola. Because grouping was turned off, only a single fixture was selected. 

 

Toggling Grouping On or Off has a significant effect on what is selected. 
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Factors Affecting Fixture Swap and 

Manipulation 
Technicalities of Fixture Swap and Manipulation 

Synchronization 
Synchronization is used to ensure that the information in the database matches that held 
in the Planner floor plan. There are three forms of synchronisation.  

 Auto-Synchronization which can be used to ensure a floor plan is correctly 
synchronised when it is opened.  

 Dynamic Synchronization which can be used to automatically write changes 
made by some AutoCAD commands immediately back to the database. 

 Manual Synchronization which allows the user to select objects to synchronize 
and where the data is to be written.  

Note: More information on these options can be found in the 
section on Synchronization. 

Prior to carry out any fixture swap or manipulation operations, it is suggested the user 
ensure that synchronization is up to date. 

Selection Sequence 
There are generally two ways a command can be executed: 

1. Select the objects first then issue the command. 

2. Issue the command and then select the objects. 

The examples given in this section are all based on selecting the objects first, then issuing 
the command. Issuing the command first, then selecting the objects is an equally valid 
way of working. 

In this case the command is invoked from the Fixturing toolbar. In the example below, 
the Move command has been selected. 

 

A prompt then appears in the command line. This identifies the command that has been 
invoked and prompts the user to select the objects the command is to be applied to. 

 

Once the objects have been selected, the rest of the command is executed in a similar 
manner to when the objects were selected first and then the command invoked. 

Object Height 
The position of an object can be described relative to the origin of the floor plan by three 
coordinates: 
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The origin of the floor plan is by convention always (0, 0, 0). 

1. The X axis is the distance along (to the left or right) of the origin. 

2. The Y axis is back of or in front of the origin. 
3. The Z axis is the height above or below the origin. 

 So, if an object is 20 feet to the left of the origin, 10 feet back from it and 3 ft above it, it 
would have Cartesian coordinates (expressed in feet) of   

(20, 10, 3). 

 Note: Cartesian coordinates are often expressed in inches or 
millimeters. If expressed in inches, the example above would 
be (240, 120,  36). 

All the Fixture Manipulation and Fixture Swap operations will affect the distance along 
from and back from the origin (X and Y coordinates). They will not affect the height (Z 
coordinate).  

Fixture Manipulation and XData 
Fixture Manipulation relies on the block (fixture) having been registered in a specific 
manner in Fixture Studio. When saving a block, there is an option to Write Block Files. 
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Note: Users require the appropriate permissions to access 
Fixture Studio. 

This writes additional information into the block in the form of Extended Object Data 
(XData). XData is then referenced by the software when the fixture is manipulated by a 
user in the floor plan. If this data is absent - for example because the fixture is a raw 
AutoCAD block - then the fixture manipulation functionality will not be effective for that 
fixture. 

Note: XData is embedded into the fixture in a way that is not 
accessible to users. If the fixture manipulation commands 
are failing for some blocks, it is recommended that the block 
be saved again from fixture studio ensuring that the Write 
Block Files option is used. See the Fixture Studio User Guide 
for more information on how to create fixtures. 

Selection Methods 
Before carrying out Fixture Manipulation or Fixture Swap operations, users must be able 
to select objects in the floor plan. Selected objects have a dotted outline and the insertion 
point shows as a small blue square. 

 

Individual Selection 
Individual objects can be selected by left clicking a line belonging to that object. 
Additional objects can be added to the selection set by continuing to left click lines in 
other items in the drawing. When all objects have been selected, the selection is 
completed by right clicking in the floor plan with the mouse. 
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Window Selection Box 
One way of selecting multiple fixtures is to use a window selection box. To do this click 
on a point in the floor plan, hold down the left mouse button and move the cursor to the 
right of the first point. A blue box will result. All objects completely enclosed by the box 
will be selected. 

 

In the above example, fixtures F-11 and F-12 will be selected because they are completely 
enclosed, but fixtures like F-27 that are not completely enclosed will not be selected. 

Multiple windows selection boxes may be used to select objects. The selection is 
completed by right clicking in the floor plan with the mouse. 

Crossing Selection Box 
One way of selecting multiple fixtures is to use a window selection box. To do this click 
on a point in the floor plan, hold down the left mouse button and move the cursor to the 
left of the first point. A green box will result. All objects fully or partially enclosed by the 
box will be selected. 

 

In the above example, fixtures F-10, F11, F-12, F-13, F-25, F-26, F27, and F-28 will be 
selected because they are fully or partially enclosed. 

Multiple crossing selection boxes may be used to select objects. The selection is 
completed by right clicking in the floor plan with the mouse. 
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De-Selecting Fixtures 
Any existing selection set can be de-selected by hitting the escape key. 

AutoCAD's Object Snap Functionality 
AutoCAD has Object Snap functionality. This can be toggled on or off by clicking the 
button on the AutoCAD status bar. 

 

Right clicking the Object Snap icon and selecting Settings enables the settings to be 
defined. Check boxes can be ticked to specify points that the cursor can snap to when 
carrying out fixture manipulation options. 

 

When carrying out a Fixture Manipulation command (for example Move), the user will 
be prompted to pick a base point in the selected objects. 

 

If Object Snap is on, the cursor will snap to any points that have been specified in the 
Settings dialog box. In the example below an Endpoint has been selected by clicking it. 
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Once the first Object Snap point has been selected, the user will be invited to select a 
point to move to. 

 
The user can then select another Object Snap point. In the example below, the corner of 
the wall in the architectural plan has been selected. 

 

On clicking the second Object Snap point the selected objects will be moved to that point. 
In the example below, the fixtures have been moved precisely into the corner of the wall. 
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Note: for more information on using Object Snap or 3D 
Object Snap see the AutoCAD help material. 

Fixture Swap and Custom SQL 
The information in the Fixture Swap dialog box is controlled by via the Administration 
Module. For example, columns can be added or removed. 
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Modifying the list of information in the Fixture Swap dialog box is carried out in the 
Custom Query dialog box in the Administration module. This is accessed from the 
General menu. 
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Fixture Manipuulation Commands - Move 

Move Fixtures 
Move Fixtures allows the user to move the selected set of equipment, merchandise and 
annotation from one point to another in the floor plan. 

 

The command is invoked from the Move option on the Fixturing toolbar. 

 

In the example below, the double sided gondolas are to be moved relative to the single 
sided gondolas along the wall. 
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The initial stage is to select the gondolas to be moved. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 

The user can then click the Move icon on the Fixturing toolbar. The Insertion points will 
disappear, but the fixtures will still remain as dotted outlines. 
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At the same time, the user will be prompted (via the command line) to select a base point 
for the move. 

 

If Object Snap is turned on in the Status Bar, the user can 'snap' the cursor to a convenient 
point on one of the selected fixtures. 

 

The cursor will then snap to a selected point on the fixture. 
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The fixtures can then be moved via the cursor to the point they are required in the floor 
plan. The fixtures will appear as a 'ghost' outline until finally placed. 
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On left clicking at the selected point in the drawing, the fixtures will be moved to that 
point. 

 

Slide Fixtures 
Slide Fixtures allows the user to move the selected set of equipment, merchandise and 
annotation from one point to another in the floor plan. 
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The command is invoked from the Slide option on the Fixturing toolbar. 

 
The Slide option is a more restricted form of the Move command. Fixtures can only be 
moved at 0, 90, 180 or 270 degrees relative to the selected fixtures. If it is desired to move 
the fixtures a precise distance in the specified direction, this distance can be entered into 
the AutoCAD command line. 

In the example below, the double sided gondolas are to be 'slid' relative to the single 
sided gondolas along the wall. 
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The initial stage is to select the gondolas to be moved. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 
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The use can then click the Slide icon on the Fixturing toolbar. The selected fixtures can be 
'slid' along the permitted axes until they are in the correct position. The fixtures will 
appear as a 'ghost' outline until finally placed. 
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On left clicking at the required point, the fixtures will be repositioned. 
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Offset Fixtures 
Offset Fixtures allows the user to align the selected set of equipment, merchandise and 
annotation a set distance from a line (for example a wall) in the floor plan. 
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In the above diagram, the left hand example shows the effect of selecting a wall to offset 
from and setting an offset of 0: the selected objects will align directly along the wall. The 
right hand sample shows the effect of a positive offset: the selected objects have aligned a 
specific distance from the wall. 

In the diagram below, the double gondola is to be moved parallel to and 8 feet from the 
single gondola along the wall. 

 

The command is invoked from the Offset option on the Fixturing toolbar. 
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The initial stage is to select the gondolas to be moved. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 

The user can then click the Offset icon on the Fixturing toolbar. The user will then be 
prompted to set the Offset distance - the distance the gondola will be from the selected 
wall, etc. 

 

Alternatively, click two successive points in the floor plan. After clicking the first point, 
the user will be invited to click a second: 

 

This method can be used to measure an existing distance between two objects in the floor 
plan (for example a gap between two other gondolas) and use it for the offset. 

The user will then be invited to select a source edge. This is the edge of the gondola that 
will be moved relative to another object. 
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The user will then be invited to select an angle along the source edge. This is done by 
clicking another point on the face of the gondola. 

 

 

The user will then be invited to select an edge of the object to be aligned with. 
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In the example below, the user has selected the front edge of the single gondola along the 
wall. 

 

The user will then be invited to select an angle along the reference edge. 

 

This is done by clicking on another point on the front edge of the single gondola along 
the wall. 
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The user will be invited to select the side of the reference line the double gondola is to be 
offset to. 

 

This is done by clicking on the side of the single gondola we wish the double gondola to 
be offset to. 
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As soon as this point is clicked, the selected equipment, merchandise and annotation will 
rotate until they are aligned with the selected edge. 

 

If Grouping is On, how the offset fixtures line up to their datum fixtures depends on the 
fixture clicked on to select the fixtures to offset and the fixture selected to specify the 
fixtures to offset to. When the fixtures to be offset move, the insertion points of the two 
selected fixtures will align. 

In the example below, the top left fixture of the double gondola was clicked when 
selecting the objects to offset, and the top fixture was selected in the gondola to offset to 
(left hand diagram). The result is shown in the right hand diagram. 
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In the example below, the bottom left fixture of the double gondola was clicked when 
selecting the objects to offset, and the bottom fixture was selected in the gondola to offset 
to (left hand diagram). The result is shown in the right hand diagram. 
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Match Rotation 
Match Rotation allows the user to align the selected set of equipment, merchandise and 
annotation with a line (for example a wall) in the floor plan. 

Note: If it desired to align the selected equipment, 
merchandise and annotation against a wall, etc., use the 
Offset command with an Offset of 0. 

In the example below, the single sided gondola is to be aligned with the wall behind it. 

 

The command is invoked from the Match Rotation option on the Fixturing toolbar. 

 

The initial stage is to select the gondolas to be moved. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Fixture Grouping is On or 
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The use can then click the Match Rotation icon on the Fixturing toolbar. The user will 
then be invited to select a source edge. This is the edge of the gondola that will be rotated 
relative to another object. 

 
This is done by clicking a point on the required edge of the gondola. 

Note: It is not possible to select an edge by clicking an 
insertion point. You must click on an edge of a fixture. 
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The user will then be invited to select an angle along the source edge. This is done by 
clicking another point on the face of the gondola. 

 

 

The user will then be invited to select an edge of the object to be aligned with. 
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In the example below, the user has clicked on the face of the wall the gondola run is to be 
aligned to.   

 

The user will then be prompted to select the direction for the edge. 

 
This is done by clicking on another point on the face of the wall. 
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As soon as the second point is clicked, the selected equipment, merchandise and 
annotation will rotate until they are aligned with the selected edge. 

 

If Grouping is On and the required fixtures are selected by clicking on an individual 
fixture, the insertion point of that fixture will serve as the point around which the fixtures 
will rotate. In the example below, if the top fixture (colored red in this example) is 
selected, the gondola will rotate about its insertion point. If the bottom fixture (colored 
blue in this example) is selected, the gondola will rotate about that insertion point. 
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Fixture Manipulation – Cut, Copy and Paste 

Cut, Copy and Paste Commands 
The Cut, Copy and Paste commands take a selected set of equipment, merchandise, 
annotation and bay numbers and move them to or from the clipboard. The Delete 
command removes the selected set of equipment, merchandise, annotation and bay 
numbers from the floor plan. The commands are invoked from the Fixturing toolbar. 

 

Cut or Copy Commands 
The Cut Command removes the selected equipment, merchandise, annotation and bay 
numbers from the floor plan and places the information into the clipboard. Any previous 
information in the clipboard is overwritten. 

The Copy Command takes a copy of the selected equipment, merchandise, annotation 
and bay numbers from the floor plan and places the information into the clipboard. Any 
previous information in the clipboard is overwritten. 

In the example below, the two double sided gondolas are to be either cut or copied from 
the floor plan and placed on the clipboard. 

 

The initial stage is to select the required fixtures. The outlines of the fixtures will turn 
dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
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using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 

If the Cut command is clicked on the fixturing toolbar, the selected equipment, 
merchandise, annotation and bay numbers will be removed from the floor plan and 
placed into the clipboard. Any previous information in the clipboard is overwritten. 

 

 

If the Copy command is clicked on the fixturing toolbar, the command Line will 
prompted the use to specify a base point. 
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If Object Snap is turned on in the Status Bar, the user can 'snap' the cursor to a convenient 
point on one of the selected fixtures. 

 

 

After clicking on the selected point, a copy of the selected equipment, merchandise, 
annotation and bay numbering will be taken from the floor plan and placed into the 
clipboard. Any previous information in the clipboard is overwritten. In addition, the 
equipment, merchandise and annotation remains in the floor plan and remains selected. 

 

Paste 

Paste takes the information from the clip board and inserts it into the floor plan. The 
Paste command is invoked from the Fixturing toolbar. 

 

After clicking the Paste button, the equipment, merchandise, annotation and bay 
numbering will be taken from the clip board and placed in the floor plan relative to the 
mouse cursor. 
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Copying Between Floor Plans 
The Copy function also allows users to take information from one floor plan and transfer 
it to another floor plan. This is done as follows: 

1. Open or make active the floor plan it is desired to take the information from. 

2. Select the required equipment and merchandise 
3. Use the Cut or Copy commands to place a copy of the information in the clipboard. 

This information will include annotation, bay numbering, etc. 

4. Open or make active the floor plan it is desired to transfer the information into 

5. Use the paste command to add the information into the floor plan. 

The information will automatically be synchronized with the information in the database. 

Delete Command 
The Delete command can be used to delete fixtures, together with their associated 
shelves, merchandise, annotation and bay numbers. This is because the display or 
selection of objects is often controlled by turning off or locking layers. If purely 
AutoCAD tools are used, objects on the turned off or locked layers are not included in 
the selection. This can result in some objects being moved, while their child objects are 
left in their original location. 

The Delete function is found on the fixturing toolbar. 

 

In order to delete fixtures and their associated child objects: 
1. Select the required fixtures in the floor plan 
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2. Click the Delete command on the Fixturing toolbar or on the Toolbar of the Fixturing 
Tab of the Object Browser 

3. The fixtures and their child objects will then be deleted. 
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Fixture Manipulation – Rotate Commands 

Rotate Fixtures 
Rotate Fixtures takes a selected set of equipment, merchandise and annotation and 
rotates them about the center of the selected objects. 

 

The command is invoked from the Rotate option on the Fixturing toolbar. 

 

In the example below, the double sided gondolas are to be rotated to through 80 degrees 
relative to the single sided gondola along the wall. 
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The initial stage is to select the gondolas to be rotated. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 

Once the fixtures have been selected and the Rotate button has been clicked on the 
Fixture Manipulation toolbar, they can be rotated around the center of the selected 
objects by means of the mouse cursor. The new position of the fixtures will be shown as a 
'ghost' outline. If this method of rotating the fixtures is being used, the fixtures will be 
drawn in their final position after a left mouse click in the floor plan. 

 

Alternatively, a precise rotation angle can be entered into the Command line.  If this 
method of rotating the fixtures is being used, the fixtures will be drawn in their final 
position when Return is pressed. 
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The fixtures have been rotated as required. Other options (such as the Move or Slide 
commands can then be used to further adjust their position). 

 

Rotate Fixtures 90 Degrees Clockwise 
Rotate Fixtures 90 Degrees Clockwise takes a selected set of equipment, merchandise 
and annotation and rotates them 90 degrees clockwise about the center of the selected 
objects. 

 

The command is invoked from the Rotate 90 degrees Clockwise option on the Fixturing 
toolbar. 
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In the example below, the double sided gondolas are to be rotated 90 degrees clockwise. 

 

The initial stage is to select the gondolas to be rotated. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or Crossing selection boxes, continue selecting until all required objects 
are in the selection set). The fixtures will rotated about the center of the selected objects. 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 

Once the fixtures have been selected, the Rotate 90 Degrees Clockwise button is clicked 
on the Fixture Manipulation toolbar. The fixtures will then be drawn in their final 
position in the floor plan. 
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Rotate Fixtures 90 Degrees Anticlockwise 
Rotate Fixtures 90 Degrees Anticlockwise takes a selected set of equipment, 
merchandise and annotation and rotates them 90 degrees anticlockwise about the center 
of the selected objects. 

 

The command is invoked from the Rotate 90 degrees anticlockwise option on the 
Fixturing toolbar. 

 

In the example below, the double sided gondolas are to be rotated 90 degrees clockwise. 
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The initial stage is to select the gondolas to be rotated. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). The fixtures will rotated about the center of the selected objects. 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 

Once the fixtures have been selected, the Rotate 90 Degrees Anticlockwise button is 
clicked on the Fixture Manipulation toolbar. The fixtures will then be drawn in their final 
position in the floor plan. 
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Rotate Fixtures 180 Degrees 
Rotate Fixtures 180 Degrees takes a selected set of equipment, merchandise and 
annotation and rotates them 180 degrees about the center of the selected objects. 

 

The command is invoked from the Rotate 180 degrees option on the Fixturing toolbar. 

 
In the example below, the double sided gondolas are to be rotated 180 degrees. 
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The initial stage is to select the gondolas to be rotated. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). The fixtures will rotated about the center of the selected objects. 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 

Once the fixtures have been selected, the Rotate 180 Degrees button is clicked on the 
Fixture Manipulation toolbar. The fixtures will then be drawn in their final position in 
the floor plan. 
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Fixture Manipulation – Other Commands 

Mirror Fixtures 
Mirror Fixtures enables users to produce a mirror image of the selected fixtures. 

In the example below, the merchandiser has decided to swap the equipment and 
merchandise to opposite sides of the aisle. The left hand side of the diagram below shows 
the aisle before mirroring and the axis about which the aisle will be mirrored. The right 
hand side of the diagram shows the aisle after mirroring. 

 

In the example below, the merchandiser has decided to swap the equipment and 
merchandise about the center of the aisle. The left hand side of the diagram below shows 
the aisle before mirroring and the axis about which the aisle will be mirrored. The right 
hand side of the diagram shows the aisle after mirroring. 
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The command is invoked from the Mirror option on the Fixturing toolbar. 

 
In the example below, the equipment and merchandise in the two double gondolas is to 
be mirrored about the specified axis. 

 

The initial stage is to select the objects to be mirrored. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button. If using 
Windows or Crossing selection boxes, continue selecting until all required objects are in 
the selection set). The fixtures will be mirrored about the center of the selected objects. 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 
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Note: Care must be taken to select only the fixtures and 
merchandise it is intended to mirror. 

Click the Mirror command on the fixturing toolbar. The cursor will be returned to the 
floor plan and (if not already on) the AutoCAD Ortho command will be turned on. This 
restricts the permissible angle the fixtures can be mirrored through to 0, 90, 180 and 270 
degrees. Moving the cursor about will select the varying possible angles. At the same 
time a 'ghost' image will show where the fixtures are to be mirrored to. 

 

On left clicking in the floor plan, the selected objects will be mirrored. 
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Note: if it is desired to mirror at any other angle than 0, 90, 
180 and 270 degrees, it is possible to manually turn off the 
AutoCAD Ortho command during the mirroring operation. 
The blocks can then be mirrored about any specified angle. 

Fix Mirrored Blocks 
Because the blocks have been mirrored, they are a precisely inverted reflection of the 
original block. This includes the insertion points. The Mirror command automatically 
calls the Fixed Mirrored Blocks command and (provided the block is symmetrical) the 
insertion points are adjusted to the correct position. 

Non-Symmetrical Objects 

The functionality is unable to fully mirror non symmetrical objects. An example would 
be the checkouts seen in the bottom of this diagram. The Mirroring axis is shown in the 
left hand part of this diagram. When the double sided gondolas and checkouts are 
mirrored, the double sided gondolas become a mirror image of each other. However, 
because the checkout are not symmetrical, they are 'reflected' to the new position, but the 
block itself remains 'un-reflected'. 
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Array Fixtures 
Array takes a selected set of equipment, merchandise and annotation and generates 
additional rows and columns of that set of objects. In the diagram below, the original red 
fixture has been used as the basis for an array of three rows and two columns of similar 
fixtures. 

 

The command is invoked from the array option on the Fixturing toolbar. 

 
Arraying can be used to speed up laying out the arrangement of equipment in a store. In 
the example below, the original checkout (shown in red for clarity), has been extended 
into a row of checkouts by means of the array command. 
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Similarly, in the example below, the original gondola (shown in red for clarity), has been 
copied twice by means of the array command. 

 

To use the array command, consider the following example: 
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Having laid out some initial checkouts and gondolas, it has been decided to put down an 
array of bins for special offers. The initial bin (shown in red for clarity) has already been 
placed. The array command can then be used to space additional bins. The steps are as 
follows: 

1. Establish the dimensions of the bin. In this example it is 36 inches square. 
2. Establish the X and Y dimensions for the array. In this case it has been decided to 

leave a 5 ft gap between adjacent bins in the X axis, and to align the bins with the 
ends of the gondolas in the Y axis. The gondola runs are 12 ft between centers. 

3. Select the bin and then click the Array command on the fixturing toolbar. This will 
cause the Array dialog box to appear. 

 
4. The number of columns is set to 3 (to match the number of gondolas) and the row 

offset is set to 144 (to match the centers of the gondola runs). 



Array Fixtures  

436 Oracle Retail Store Planner's User Guide 

5. The number of rows is set to 2. As we want to leave 5 ft (60 inches) between the bins, 
the column offset is set to 96 (36 inches for the bin, plus 60 inches for the gap between 
them. 

6. Clicking the Preview button will show a preview of the arrayed fixtures. Pressing 
Escape will return the user to the Array dialog box. Pressing Return will place the 
arrayed fixtures in the floor plan. 
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Fixture Swap 

The Fixture Swap Dialog Box 
The Fixture Swap dialog box is made up of a number of parts. 

 

Toolbar 
The toolbar allows users to mirror (copy) and delete filter settings. It also allows users to 
delete defined swaps and to copy information to the clipboard. 

Filter Options 
Each column in the Selected Fixtures and Replacement Fixture sections of the dialog box 
can be filtered to refine the list of available data. 

Fixtures to Swap 
The Selected Fixtures/Fittings section contains a list of all equipment that was selected in 
the floor plan when the Fixture Swap dialog box was activated. 

Fixtures Available to Swap 
The Replacement Fixtures/Fittings section contains a list of all equipment that could be 
used to replace the equipment in the floor plan. 
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Defined Swaps 
This section of the dialog box contains a list of all the fixture swaps that have been 
defined. 

Action Buttons 
The action buttons allow the user to execute the currently defined swaps, execute the 
currently defined swaps and exit, and cancel the currently defined swaps and exit. 

Status Bar 
The status bar gives information in the number of objects found in the drawing, and the 
number selected. 

The Fixture Swap Filters 
Filters are available to reduce the number of fixtures displayed for selection in the 
Selected Fixtures/Fittings and Replacement/Fixtures/Fittings frames of the Fixture 
Swap dialog box. They can be activated by clicking on the arrow head by each column of 
data. 

 

This will bring up a drop down menu with a number of options. 
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 Selecting Show All will remove the filters and show all rows of data. 

 Selecting Custom Filter will bring up a custom filter allowing Boolean operations 
on the data (see below). 

 Selecting Blanks will reduce the data to those rows that have blank values in that 
column. 

 Selecting Non-Blanks will reduce the data to those rows that have a value in that 
column. 

In addition, the lower part of the drop down menu contains a list of the individual items 
of data in that column. Clicking an item reduces the rows to that item of data. 

Custom Filters 

The custom filter option is invoked from the filter drop down menu. 

 

It enables users to use Boolean logic. In the above example (with numerical data 
selected), the lengths will be filtered to find all fixtures with lengths between 36 and 48 
inches. (This filtering logic also applied to Date values). 
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Condition Description 

Equals Values must be exact: for example select all rows with a value of 48 

Does Not 
Equal 

Values will exclude that value: for example select all rows that do not 
have a value of 48. 

Greater Than Selects all values above a specific value: for example Greater Than 48 
will return 49, 50, 51, etc. 

Less Than Selects all values below a specific value: for example Less Than 36 
will return 35, 34, 33, etc. 

Greater Than 
or Equal 

Selects all values equal to or above a specific value: for example 
Greater Than or Equal to 48 will return 48, 49, 50, etc. 

Less Than or 
Equal 

Selects all values equal to or below a specific value: for example Less 
Than or Equal to 36 will return 36, 37, 38, etc. 

  

If a text value is selected, a different set of Boolean logic applies 

Condition Description 

Equals Values must be exact: will return rows that are an exact match for the 
entered text. 

Does Not 
Equal 

Values will exclude that value: will return rows that do not match the 
text string 

Contains Will return rows where part of the data matches the text string. (Uses 
implied wild cards). 

Does Not 
Contain 

Will return rows where no part of the data matches the text string. 
(Uses implied wild cards). 

Begins With Will return rows where the text string is an exact match for the start of 
the data. 

Does Not 
Begin With 

Will return rows where the text string is an exact match for the end of 
the data. 

Ends With Will return rows there the text string is not an exact match for the 
start of the data. 

Does Not End 
With 

Will return rows there the text string is not an exact match for the end 
of the data. 

 Boolean logic also includes the use of And or Or. 

 And means that both conditions must be met. A and B means the data returned 
must contain both A and B. 

 Or means either condition can be met. A or B means the data returned can 
contain either A or B. It does not need to contain both. 
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Mirroring and Clearing Filters 

 

1. Mirroring Filters 

The Selected Fixtures/Fittings and Replacement Fixtures/fittings frames contain 
identical columns. If a filter is set in (for example) the Fixture Length column in the 
Selected Fixtures/Fittings frame, clicking Mirror Filter will also set that filter in the 
Replacement Fixtures/fittings frame. (The reverse case also applies). 

2. Clearing Filters 

Clicking the Clear Filters icon will clear all the filters set in the Fixture Swap dialog box. 

Other Data Manipulation Options 
There are two other ways data can be ordered in the dialog box. 
Selecting Columns to Display 

Right clicking on the column header area in either the Selected Fixtures Fitting or the 
replacement Fixtures/fittings frames allows the users to select which columns of data are 
displayed. 

 

Note: Block Name and Block Type are mandatory columns 
and cannot be deselected. 

Sorting Columns of Data 

Columns of data can be sorted in ascending or descending order by clicking the header. 
When the data in a column has been sorted, a small triangle will appear in the header - 
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the direction of the triangle indicating whether the data is sorted ascending or 
descending. 

 

In the above example, the Width column has been sorted in ascending order. 

Note: the Width column can be compared to the Length 
column, where data has not been sorted. 

Carrying Out Fixture Swaps 
Carrying out Fixture Swaps is achieved as follows: 

1. The Fixtures are selected 

 

2. Fixture Swap is called 

This can be done from the Command Line (AVT_FIXTURESWAP) or from the Fixturing 
toolbar. 
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Note: Selecting the Fixtures and Invoking Fixture Swap can 
be done in either order. 

3. The Fixture Swap dialog box will open 

When the Fixture Swap dialog box opens, only the Selected Fixtures/Fittings list of data 
is populated. Filters can be used to refine the list. 

 

4. Select the Fixture or Fitting to be replaced 

The fixture or fitting to be replaced is selected in the list of Fixtures and fittings. This 
causes the list of replacement fixtures and fittings to populate. 
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It is possible to select multiple fixtures for replacement by holding down the Control Key 
and left clicking on additional rows. 

5. Select the Replacement Fixture or Fitting 

A replacement fixture or fitting is selected. (Filters can be used to refine the list of 
available replacements). Clicking the Add Swap Pairs button causes the Swap Pairs pane 
to populate. 
One a fixture has been added to a swap pair, the entry will be removed from the top 
(Selected Fixtures/Fittings) frame to prevent multiple swap types being defined for that 
fixture. If the swap pair is subsequently deleted, the fixture will be added back to those in 
the Selected Fixtures/Fittings frame. 

 

6. Make the Swap 

Click the Apply button to cause all the defined swaps to execute and leave the dialog box 
open to define further swaps. Click the OK button to make all the defined swaps and exit 
the dialog box.- 

Limitations of Fixture Swap 
The Fixture Swap functionality is useful for making large scale changes to equipment 
within a store plan, but there are some limitations on what it can achieve. These 
limitations are explained below. 

Size and Type 
Fixture Swap does not place any restrictions on the size of the equipment that can be 
swapped. In the example below, the back gondola run is the original gondola. The 
middle gondola run represents what would happen if 4 foot long fixtures were replaced 
by 3 ft long ones. The front gondola run shows what would happen if fixtures are 
replaced by inappropriate ones: in this instance racking has been replaced by freezer 
units. 
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Effect of Planograms 
If exploded (3D) planograms have been placed on fixtures in Merchandiser, they will not 
be visible in Planner. However, as the information is held in the database on what 
fixtures do contain exploded planograms, fixture swaps will not be carried out on those 
fixtures. 
In the example below, the back gondola run has two planograms. The fixtures containing 
these planograms have been color coded yellow in this diagram. It would not be 
immediately apparent to a user in Planner that these fixtures contain planograms because 
they will not contain product blocks - unlike if the planogram was in 2D (imploded) 
form. 

 

If the fixtures are selected for a fixture swap operation, only the fixture that does not 
have a planogram placed will be swapped, despite all fixtures being included in the 
selection. The effect of this can be seen in the front gondola run. The user will be given a 
warning in the AutoCAD command line - although the fixtures containing planograms 
are not identified. 
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Note: one solution for this limitation is to create a KPI (Key 
Performance Indicator) to color code all fixtures containing 
planograms. It is then possible to determine which 
planograms are not merchandised (and which can be 
subjected for Fixture Swap) and which are merchandised 
and cannot be swapped. 

Effect on Planograms 
If planograms are present as placeholders (2D form), they are visible in the Planner 
module. If a fixture is swapped for one of a different size, the planogram placeholder is 
scaled to suit. However, the planogram design is not changed. In the example below, the 
rear gondola run has the planogram placed on a fixture of the intended size. In the front 
planogram run, the correctly sized fixture has been swapped for one that is both higher 
and wider. 

 

The effect of this can be seen when the planogram is viewed in exploded (3D) form in the 
merchandiser module. As can be seen in the example below, both the shelving and 
merchandise fail to correctly fill the larger fixture that was swapped in. 
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When swapping fixtures, it may be necessary to subsequently swap the existing 
planograms for ones of a more appropriate size for the replacement fixture.   

Note: planograms on inappropriately sized fixtures can be 
identified by means of KPI's and Reports. 
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Gondola Operations 

Overview of Gondolas 
Gondolas are pre-defined arrangements of fixtures and fittings. This enables long runs of 
fixtures to be put down quickly, making it easy to lay out or modify equipment in a floor 
plan.  

Fixture Studio 
Gondolas are configured in the Fixture Studio Module in the Gondola Definitions dialog 
box. This enables all details of the gondola to be configured including which options will 
appear in the Add Gondola dialog box in the Planner and Merchandiser modules. 

 

Planner Module 
Gondolas are placed in the Planner module by selecting a Gondola from the Object 
Browser and clicking the Add Gondola option on the toolbar. 
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After being invited to select a start position, the Add Gondola dialog box will appear. 

 

Users can select from a variety of options including: 

 Gondola Dimensions: in the above example users can select from six 
combinations of length and height. 

 Number of Bays: Users can select the number of bays to place. 

 Optional Parts: Some parts may be optional. In the above example users can opt 
whether to have Start and End Caps.  

 Origin and Placement Angle: Users can select where the gondola starts from and 
what angle to place it at. 

After selecting the appropriate options, click OK and the gondola will be placed. 
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Placing a Gondola - Basic Options 
Gondolas are placed in the Planner module by selecting a Gondola from the Object 
Browser and clicking the Add Gondola option on the toolbar. Alternatively, a gondola 
can be selected from the hierarchy, then 'dragged and dropped' into the floor plan. 

 

Users will then be invited to select a start position in the AutoCAD command line. 

 

Some AutoCAD options may help in selecting the start point. 

 

 The Snap Mode can be turned on or off. If turned on, the cursor will snap to a 
grid of points in the floor plan. 

 The Grid Display turns display of the snap grid on or off.  

 Object Snaps (OSNAP) allows the cursor to snap to specific points in the floor 
plan (like the corner of another fixture). 

Note: See the AutoCAD help file for more information. 

Once the Start Position has been selected, the Add Gondola dialog box will appear. 
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Gondola Dimensions 
Users can select the dimensions of the fixtures for the gondola. For many gondolas, the 
option will exist to select length, depth and height - although other options are possible. 
If a combination of sizes is selected that does not reference an existing fixture, an error 
message will appear. 

 

Note: this problem can be prevented by careful 
configuration of the gondola options when defining the 
gondola in Fixture Studio. 

Options 
Some gondola parts can be made optional. These parts can be selected or deselected by 
means of the check boxes in the Options frame. 

Number and Angle 
The number of bays can be selected using the spin control, while the angle the gondola 
will be drawn at can also be specified. 

Placing the Gondola 
Click the OK button to place the gondola. It will then draw in the floor plan. 
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Placing Island Gondolas 
Island Gondolas are placed using similar techniques. One useful technique is using 
AutoCAD construction lines and offsets. 

 

In the example above, construction lines (the red lines in the screen shot) were drawn 
along the edges of the wall gondolas. Additional construction lines were then offset from 
the originals to give the correct spacings. In the above example, the construction lines 
were used to ensure the aisles were a precise 8 feet in width. After the gondolas have 
been placed, the construction lines will be deleted.    

Similar construction lines have been used to place the next sequence of gondola runs. 



Gondola Operations 

Placing a Gondola - Basic Options  453 

 

After the construction lines are deleted, this leaves the new gondola runs precisely 
positioned with minimum aisle widths maintained. 
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Placing a Gondola - Advanced Options 
Gondolas running along walls will often require the specific number of bays required to 
fill a specified distance - for example from the corner of a wall to the edge of a door 
frame. The measure options allow users to place that gondola run quickly and accurately.  

 

 Number (Measure) allows the user to draw a line in the floor plan. This specifies 
the length of the gondola and which end of the line the first bay of the gondola 
will be drawn at. 

 Starting Point (Measure) enables the user to specify point in the drawing which 
will be the origin from where the gondola will be drawn. 

 Start Position (left or right) specifies whether the first bay of gondola at the left 
end or right end of the gondola run. 

 Extend or Best Fit determines whether the number of bays drawn will fit entirely 
inside the line or partially extend outside of the line. 

Once these options are understood, it is simple to draw gondolas fast and accurately in 
plan view. When learning how to use the options, it is sometimes easier to draw some 
gondolas in isometric view to see how those options work. 

Worked Example 

AutoCAD Settings 
It is suggested that AutoCAD's Object Snaps (OSNAP) are turned on. This makes it easy 
to select corners, adjacent fixtures, etc as the starting point for the gondola. Ortho can be 
used if it is desired to draw the gondola at precise right angles in the floor plan. The snap 
grid and other options should be turned off. 

Placing the Gondola 
In the worked example below, it is desired to draw a gondola with its start point in the 
corner of the wall and extending up to the edge of the door. 
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Select the required gondola in the object browser and click the Add Gondola icon. The 
user will be taken to the floor plan and requested (AutoCAD command line) to pick a 
start point. Click in the corner of the wall. This sets the coordinates for the starting point. 

 

The Add Gondola dialog box will then appear. The initial stage is to click the Number 
(Measure) button. The user will be taken back to the floor plan. It is then necessary to 
click two points that will define the start point and end point of the gondola. 
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On clicking the end point, the user will be returned to the Add Gondola dialog box. The 
Best Fit check box should be selected because that will ensure the maximum number of 
gondola bays will be drawn without obstructing the door.  
The other option to be selected is the Left/Right button for the start point. This is 
determined by which bay of the gondola will be drawn first. It will be at the start point of 
the line that was drawn to define the gondola length. In this case viewed from the front 
of the gondola the first bay to be drawn is on the right hand end of the gondola.  

 

The start point is set to Right. On clicking the OK button the gondola will be drawn.  



Gondola Operations 

Placing a Gondola - Advanced Options  457 

 

Placing Island Gondolas 
One useful technique for placing island gondolas is using AutoCAD construction lines 
and offsets. 

 

In the example above, construction lines (the red lines in the screen shot) were drawn 
along the edges of the wall gondolas. Additional construction lines were then offset from 
the originals to give the correct spacings. In the above example, the construction lines 
were used to ensure the aisles were a precise 8 feet in width. The intersections of the 
construction lines can be used to specify the start and end points of the line defining the 
gondola position that is required after the Measure button is clicked in the Add Gondola 
dialog box. After the gondolas have been placed, the construction lines will be deleted.    
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Similar construction lines have been used to place the next sequence of gondola runs. 

 

After the construction lines are deleted, this leaves the new gondola runs precisely 
positioned with minimum aisle widths maintained. 
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Placing a Gondola - Other Considerations 
The section of help explains the more advanced options for gondola placement. This 
section should be read in conjunction with the section on basic options. 

Dimensions 
Gondolas can be assigned varying numbers of dimensions. The gondola definition in the 
example below is used to draw heavy duty racking used in storage areas. This racking 
comes in a standard depth and height, but in varying lengths. Accordingly, store 
planners are only required to select the length. 

 

More complex gondolas can have up to six dimensions. In the example below the 
dimensions of both the main part of the gondola and the start and end caps can be 
specified. 
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Dimensions do not have to be confined to physical sizes. In the example below, a 
gondola has been configured to allow the store planner to select the material as well as 
the physical dimensions. This would only be effective if the gondola parts come in 
similar sizes but different materials.  

 

Extend and Best Fit  
Extend and best fit determine the number of bays that will be drawn for a specific 
measured length.  

 Best Fit: the number of bays drawn will be the maximum where the total length 
does not exceed the measured length. 
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 Extend: the number of bays drawn will be the maximum where the start position 
of the last bay is inside the measured length. 

Extend will generally result in one more bay being drawn than best fit.  

 

In the above example, the red line represents the measured length. The gondola at the 
top was drawn using Best Fit., the one at the bottom with Extend. 

Gondolas and In-Store Space Collaboration 
There is a limitation on placing gondolas in the In-Store Space Collaboration application 
(a companion application to Macro Space Management). It can only place gondolas with 
three dimensions of Length, Depth and Height. Accordingly, more complex gondolas 
should be placed in Macro Space Management. Their position can then be adjusted if 
necessary in In-Store Space Collaboration.  

Editing and Deleting Gondolas 

Editing Gondolas 

Grouping 
Once gondolas are placed, they effectively become a collection of associated fixtures. The 
behavior of a gondola for editing is determined by whether grouping is on or off. This is 
set using the Grouping option on the fixturing toolbar. 

 

If grouping is on, selecting a single fixture on the gondola will automatically select all 
fixtures. If grouping is off, individual fixtures in the gondola can be selected. 

Fixture Manipulation 
Once gondolas have been selected, their position can be modified by use of some of the 
Fixture Manipulation tools such as slide, move and rotate.  

Note: Fixture Manipulation tools are most useful for users 
not familiar with AutoCAD functionality.  

Editing using AutoCAD 
Once placed, fixtures can be moved and rotated using standard AutoCAD functionality. 
If AutoCAD functionality is used for this purpose it may be necessary to use 
synchronization afterwards to ensure the information in the floor plan and database is 
identical. 
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Deleting Gondolas 
Because Gondolas become a collection of associated fixtures when they are placed, there 
is no Delete Gondola option on the Gondola toolbar on the Object Browser. The way to 
delete gondolas using Macro Space Management tools is to turn on grouping on the 
fixturing toolbar, select the gondola required for deletion and then use the Delete fixture 
option on the Fixturing toolbar of the Object Browser. 

 

Deleting using AutoCAD tools 
It is also possible to delete gondolas using standard AutoCAD functionality. It may then 
be necessary to use synchronization afterwards to ensure the information in the floor 
plan and database is identical. 
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Gondolas on the Object Browser 

Overview of Gondolas on the Object Browser 
Clicking on the Fixturing Tab on the Object Browser brings up a series of options for 
adding, editing and deleting Fixtures and Gondolas. 

 

 The Toolbar gives access to a series of options concerning gondolas. 

 The Buttons allow the user to toggle between Fixtures (Blocks) and Gondolas. 

 The Hierarchy Window allows users to select fixtures (or gondolas) from the list 
available. 
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 The Properties Window shows the properties assigned to the selected fixture. 
This will be blank for gondolas. 

 The Summary Window shows the number of instances of the selected fixture 
placed in the drawing. It will not show data specific to gondolas. 

 The Preview Window will be blank for gondolas. 

Using the Object Browser for Gondola Operations 
The Gondolas tool bar is found on the Object Browser. It is selected by clicking on 
Gondolas in the Fixturing window. 

 

It contains a series of icons allowing various operations to be carried out on Fixtures. 
Some may be greyed out if they are not available for that operation. 

Icon Description 

 

Add Gondola 

 

Edit Gondola 

 

Delete Gondola 

Not 
available 
for 
Gondolas 

Highlight selected item 
in view 

Not 
available 
for 
Gondolas 

Highlight selected item 
in tree 

Not 
available 
for 
Gondolas 

Search 

Not 
available 
for 
Gondolas 

Configuration Options 

 

Refresh 

 

Attributes 

 

Promotional Fixtures On 
or Off 
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The Gondola Hierarchies Window shows a hierarchical tree of all the available fixtures 
or gondolas. 

 

The tree can be expanded or contracted by clicking on the + or – icons. 

The Fixturing window can be minimized by clicking on the splitter bar. 

 

The Blocks or Gondolas buttons immediately above the window determines whether the 
hierarchical tree shows fixtures or gondolas. 

The hierarchical tree can be configured in Fixture Studio.  

The Properties Window will be blank for gondolas. 

 

The Properties window can be minimized by clicking on the splitter bar. 

 

The Summary Window will show a user defined list of fixtures placed in the drawing. As 
gondolas are added or deleted, the list of fixtures will be modified accordingly, but no 
gondola specific information will be available. 

 

Clicking on a column heading will re-order that column. Clicking again will reverse the 
sort order. 

The Summary window can be minimized by clicking on the splitter bar. 
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Note: Information in this window is controlled from Custom 
SQL in the AVTTB_CUSTOM_SQL table. Administrators can 
customise the information that appears in the Summary 
Window by modifying the Custom SQL. 

The Preview Window will be blank for gondolas. 

 

The Preview window can be minimized by clicking on the splitter bar. 

 

Non Functional Options for Gondolas 
Several options are grayed out and non-available for gondolas. 

 

This is because gondolas are treated as collections of fixtures once placed in a floor plan. 
In addition they can be modified by addition, changing or deletion of fixtures once 
placed. The Highlight in Store, Highlight in Tree, Find and Options icons are thus not 
appropriate for gondolas and have been disabled. 

  

Functional Options for Gondolas 

Add Gondola 
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This option allows users to add a gondola by highlighting it in the hierarchy and clicking 
the Add button.   

Edit Gondola 

 

The Edit Gondola option allows users to edit the Gondola Definition in Fixture Studio. 
To use it, highlight a gondola in the hierarchy and click the edit icon. 
Changes made to a Gondola while in Fixture Studio will affect further placements of that 
type. 

Refresh 
The Refresh option refreshes both Fixtures and Gondola information in the respective 
hierarchical trees. 

 

Clicking on the Refresh button in the Fixturing tab will load the latest fixture information 
from the database into the Fixture hierarchy. At the same time, it will load the latest 
gondola information from the database into the Gondola Hierarchy. 

If a gondola definition has been updated in Fixture Studio, all gondolas placed after 
refresh will use the new information. However, any gondolas already placed in the floor 
plan will still conform to the old definition. 

Attributes 
Attributes only apply to fixtures. 

 

The option is available on the Gondolas toolbar as fixtures may require attributes to be 
assigned as part of the workflow immediately after the gondola has been placed in a 
floor plan. 

Promotional Fixtures 
Promotional Fixtures can be assigned by selecting a fixture or fixtures and clicking on the 
Promotional Fixture icon in the toolbar. 

 

The option is available on the Gondolas toolbar as fixtures (such as end caps) may be 
required to be designated as promotional fixtures as part of the workflow immediately 
after the gondola has been placed in a floor plan. 
  



 

468 

40 
Bay Numbering 

Overview of Bay Numbering and Bay Groups 
Bay Numbering (used in conjunction with Bay Groups) allows each fixture within the 
floor plan to be assigned a unique identification code for reporting and identification 
purposes. 

Note: Only fixtures can be assigned bay numbers. Fittings 
and shelves are automatically excluded from any selections 
made. 

Bay Groups 
Bay Groups are a preliminary action before bay numbering is applied. They enable a 
group of fixtures to be treated as a single bay with sub-numbers applied to the individual 
fixtures. 

 

In the example above, two fixtures have been grouped together for bay numbering 
purposes. When bay numbering was applied, the fixtures were given a master bay 
number (A-1) and two sub numbers (A-1.1 and A-1.2) 

Bay Numbering 
Bay Numbering applies an identification number to a fixture or bay group. These have a 
number of different shapes, colors and prefixes. 

 

When applied, bay numbering provides an easy way of locating specific fixtures in an 
electronic or printed copy of a floor plan. 

 

Gondola Numbering 
Gondola numbering is an alternative to bay numbering. 
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It is of the format: Gondola Number/Gondola Side/Gondola Level/Fixture Number. 
Thus 1/2/0/4 is gondola number 1 in the drawing, the second side of the gondola, level 
0 (floor level) and the fourth fixture on that side. 

Preparations for Bay Numbering 

Synchronisation 
Before bay numbering is carried out, it is recommended that the floor plan be 
synchronized to ensure information in the database matches the information in the floor 
plan. Several factors affect synchronization.  

Auto-Synchronization 
If auto-synchronization is on, the floor plan will automatically be synchronized when it is 
opened. Bay Numbering at this point will not require any further synchronisation. 

Dynamic Synchronization 
If dynamic synchronization is on, changes made to fixtures, products, planograms and 
other blocks made with AutoCAD tools will be immediately written back to the 
database. The floor plan will not generally require any further synchronization before 
bay numbering is carried out. 

Manual Synchronization 
If auto or dynamic synchronization are turned off (or if the user suspects some other 
form of problem), the floor plan can be manually synchronized in order to ensure 
information in the database matches the information in the floor plan. This is done by 
means of the Synchronization dialog box. This can be invoked from the file Menu or the 
Retail toolbar. 
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Note: See the help file section on Synchronization for further 
information. 

Fixture Adjacency 
Some features in the bay numbering dialog box rely on the Fixture Adjacencies to be up 
to date. To run Fixture adjacency, select Calculate Fixture Adjacency from the 
Calculations menu.  

 

After the Fixture adjacencies have been updated, a confirmatory dialog box will appear. 

 

Accessing Bay Numbering 
The Bay Numbering dialog box can be accessed from the Insert Menu. Alternatively, it 
can be accessed from the Bay Numbering toolbar. 

 

The Bay Numbering Dialog Box 
The Bay Numbering dialog box has three main parts: 
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 The Select Bays frame has the options for selecting some or all of the fixtures in 
the floor plan for bay numbering, together with some options as to the sequence 
they will be numbered in. 

 The Group frame allows users to label sub-sets of fixtures and to specify the form 
of the text. 

 The Action frame allows users to actually add or remove bay numbers. 

Select Bays Frame 

Add or Remove Radio Button 
The Add or Remove radio button determines whether the next selection of fixtures will 
be added to or removed from any already selected fixtures. In the above example, 54 
fixtures have already been selected. Because the Add radio button is selected, and 
fixtures selected in the floor plan will be added to this total. 

Use Adjacencies 
If the Use Adjacencies option is selected, this will use the Fixture Adjacency information 
to decide what sequence to add bay numbers in. In order to use this option the Fixture 
Adjacency option from the Calculations menu must first have been run. Once the Use 
Adjacencies check box has been selected, the Sort Bays and Direction options will become 
available. 

 Sort Bays enables the direction Radio button to become active 

 The Left to Right or Right to Left radio button causes fixtures selected in bulk 
with AutoCAD windows or crossing selection boxes to be numbered in the 
sequence specified by the Fixture Adjacency calculation. 

If fixtures have not been selected in a specific sequence (for example with an AutoCAD 
Fence command) and the Use Adjacencies command is not selected, fixtures will number 
in the sequence the information was written to the database when they were placed in 
the floor plan. This may result in apparently random bay numbering sequences in the 
floor plan. 
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Selection Options 
 Clear Selection will de-select all currently selected fixtures. 

 Preview will cause all currently selected fixtures to highlight in the drawing - the 
highlighting method will depend on the options chosen in the Fixturing tab of 
the Configuration module. 

 Select Bays takes users to the currently active floor plan and allows users to 
select the fixtures to be bay numbered using AutoCAD selection methods. 

 By Bay Run will not be active unless the Use Adjacencies check box has been 
checked. Sort Bays and either Left to Right or Right to Left should also be 
selected. Providing Fixture Adjacencies has been run from the Calculate menu 
first, clicking By Bay Run will allow the user to select a gondola by clicking a 
fixture in it. All fixtures in the gondola will then be bay numbered. 

 By Group can be used if named groups of numbered bays are already present in 
the floor plan. Selecting the required name from the drop down list in the Group 
frame and clicking the By Group button will cause those fixtures to be selected. 

 All Bays will select all fixtures in the floor plan. 

 Unlabeled Bays will select all bays that have not yet been assigned a bay 
number. 

Group Frame 
 Name enables users to specify a reference name for a group of fixtures that will 

be assigned bay numbers. Example of names would be Food and Drink, 
Clothing, Health and Beauty. The button to the right of the drop down list will 
take users to the floor plan. Clicking on a bay number will return users to the Bay 
Sequence Numbering dialog box with the name for that sequence of bay numbers 
selected. 

 Prefix enables users to specify a letter, number or symbol to be added before the 
bay number. Adding a prefix of A- will result in fixtures being numbered A-1, A-
2, a-3 etc. 

 Start is used to specify the number that numbering will start at. Bay numbers 
may not be duplicated, so two bay numbers cannot both have the number 10 
assigned. A-10 and B-10 are not regarded as duplicates. 

 Label Block specifies that shape of the outline that will surround the bay 
number. 

 Color specifies the color for the text of the bay number. The color of the Label 
Block cannot be specified. 

 Scale specifies the size of the text. The bay number can be made larger or smaller 
by adjusting this value. 

 Labelling/Gondola Numbering: This radio button specifies whether to apply 
bay numbering or gondola numbering. 

Action Frame 
 Add: selecting this option will add the specified bay numbering to the selected 

fixtures. 

 Remove: selecting this option will remove the existing bay numbering from the 
selected fixtures. 

 Exit: This option will close the Bay Numbering dialog box. 
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Adding Basic Bay Numbering 
This worked example shows how to add basic bay numbering to a gondola. 

 

Running the Fixture Adjacency Calculation 
To ensure the bay numbering follows a neat sequence, the first stage is to run the 
Calculate Fixture Adjacencies option from the Calculations menu. This ensures that the 
database contains current information on which fixtures are to the left, right, behind or 
above each other. 

 

Operations in the Bay Numbering Dialog Box 

 

Select Bays Frame - Options 
The first stage is to set how the bays will be numbered when selected. 

 The radio button is set to Add. At this stage there will be 0 bays selected. When 
we add bays at a later stage, we want them to be added to the selection. 
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 The Use Adjacencies, Sort Bays and Left to Right options are selected. This will 
ensure bay number in a logical sequence. 

Group Frame 
The next stage is to set some information as to the appearance of the bay numbering. 

 The Name is what this group of bay numbers will be called. In this example it is 
Food. If it is intended to apply bay numbers to other gondola later, this set of bay 
numbers might de given a name like clothing. 

 The Prefix will go before the bay number - in this case it will result in the fixtures 
being numbered F-1, F-2, F-3, etc. 

 Start is the value of the first bay number. In this case the numbers will start at 1. 

 The Label Block will result in a circular outline, while the Color for the text is set 
to Red. 

 The Scale is left at 1 as this is a good size for the text, while Labelling is selected 
to place Bay Numbers. 

Select Bays Frame - Selecting the Bays 
The next Stage is to select the bays. To do this, click the Select Bays button. This will take 
the user to the floor plan. Select the fixtures by standard AutoCAD methods and right 
click to finish the selection. In the example below, the fixtures are being selected by a 
Crossing Selection Box. 

 

On right clicking to complete the selection, the user will be returned to the Bay 
Numbering dialog box. 

Action Frame 
The Bay Numbering can now be added by clicking the Add button in the Action frame. 

 

Advanced Bay Numbering 
Note: Please refer to the Adding Basic Bay Numbering topic 
first before following this worked example. 

It is possible to use the AutoCAD Fence command to exert precise control over the bays 
selected and the sequence they will number in. In the example below, a limited number 
of fixtures have been selected for numbering. 
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Bay Numbering Dialog Box 
The first stage is to bring up the Bay Numbering dialog box. 

 

Note: there is no need to run the Fixture Adjacency 
calculation - in this example the bays will be numbered in 
the sequence they are selected with the Fence command. 

Select Bays Frame - Options 
The first stage is to set how the bays will be numbered when selected. 

 The radio button is set to Add. At this stage there will be 0 bays selected. When 
we add bays at a later stage, we want them to be added to the selection. 

 The Use Adjacencies option is not selected. This will ensure that the fixtures bay 
number in the order they are selected. 

Group Frame 
The next stage is to set some information as to the appearance of the bay numbering. 

 The Name is what this group of bay numbers will be called. In this example it is 
TV. If it is intended to apply bay numbers to other gondola later, this set of bay 
numbers might be given a name like clothing. 
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 The Prefix will go before the bay number - in this case it has been set as TV-. 

 Start is the value of the first bay number. In this case the numbers will start at 1. 

 The Label Block will result in a circular outline, while the Color for the text is set 
to Blue. 

 The Scale is left at 1 as this is a good size for the text, while Labelling is selected 
to place Bay Numbers. 

Select Bays Frame - Selecting the Bays 
The next Stage is to select the bays. To do this, click the Select Bays button. This will take 
the user to the floor plan. Type the word Fence into the AutoCAD command line. 

 
A fence is a line. Any fixtures the line passes through will be selected. The fence must 
start outside of the first fixture, only pass once through any selected fixture and finish 
outside of the last fixture. 

 

Once the fence has been drawn, press Return to indicate the fence is complete and right 
click to complete the selection set. The user will be returned to the Bay Numbering dialog 
box. It will show 7 fixtures have been selected. 

Action Frame 
The Bay Numbering can now be added by clicking the Add button in the Action frame. 

 

Removing Bay Numbering 
Removing bay numbering is the reverse of adding it. Bay Numbering can be removed in 
various ways. 
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All Bays Option 
This is the simplest way of removing bay numbers. Simply click the All Bays button in 
the Select Bays Frame. This will select all fixtures in the currently active floor plan. Click 
Remove in the Action frame and all bay numbering in the floor plan will be removed. 

Select Bays Option 
The Select Bays option allows the user to use standard AutoCAD selection methods such 
as windows and crossing selection boxes or the fence command. Once the required 
fixtures have been selected click Remove in the Action frame and the bay numbering will 
be removed from the specified fixtures. 

Name Option 
This method relies on the fact that specific bay numbers are associated with a name in the 
Name drop down list in the Group frame. The first stage is to set the name to that 
required. This can be done by manually setting the name to that required or by clicking 
the button to the right of the name drop down list. This will take the user to the floor 
plan. Click on a bay number and this will select its parent name. Next click the By Group 
button to select all fixtures associated with that name. Finally, click Remove in the Action 
frame and the bay numbering will be removed from the specified fixtures. 

Bay Groups 
Bay Groups can be used to group several fixtures together for reporting purposes. An 
example of this would be fixtures holding long products such as wooden dowel or 
electrical conduit in a DIY store.  In the example below, the two left-most fixtures have 
been combined into a bay group with master bay number of 1 and sub bay numbers of 
1.1 and 1.2. 
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Accessing the Bay Group Options 
Bay Group options can be accessed from the Modify > Blocks menu or the Bay 
Numbering toolbar. 

 

These give access to three options: 

 Group fixtures (bays) to make them into a bay group. 
 Clear the bay group so it reverts to individual fixtures for bay numbering 

purposes. 

 Select the bay group by clicking on a member to show all other members.  

Bay Group Operations 

Grouping Fixtures to make them into a Bay Group 
To make Bay Groups from Fixtures 

1.  From the Modify >Blocks menu, click the Group Bays option. Alternatively use the 
Group Bays option from the Bay Numbering toolbar. 

2. A prompt will appear in the command line asking the user to select the required 
fixtures. 

 

3. Fixtures can be selected by standard AutoCAD selection methods including 
individual selection, selection windows or a fence. Selection must be terminated by 
the standard AutoCAD method of a right click. 
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 The selected fixtures will now be treated as a bay group.  

Clearing Bay Groups 
To remove a bay group is done as follows: 

1. From the Modify > Blocks menu, click the Clear Bay Group option. Alternatively 
use the Clear Bay Group option from the Bay Numbering toolbar. 

2. A prompt will appear in the command line asking the user to select a fixture. 

 

3. A single fixture can be selected by clicking it. This will cause the fixtures forming the 
bay group to be de-selected. 

Selecting a Bay Group 
Selecting the fixtures forming a bay group is done as follows: 

1. From the Modify > Blocks menu, click the Select Bay Group option. Alternatively 
use the Select Bay Group option from the Bay Numbering toolbar. 

2. A prompt will appear in the command line asking the user to select a fixture. 

 

3. A single fixture can be selected by clicking it. This will cause all other fixtures in the 
bay group to be selected. 

 

Note: It would also be possible to use a KPI to show fixtures 
in bay groups. The simplest way to do this would be to 
reference the FIX_BAYGROUP field in the AVTTB_FIXTURE 
table. 

Bay Numbering and Bay Groups 
When fixtures are bay numbered, fixtures associated with a bay group will receive a 
master bay number and sub bay-numbers for individual fixtures. In the example below, 
there is one bay group of 4 fixtures; two bay groups of two fixtures each and two single 
bays.   
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Aisles in Planner 

Overview of Aisles 
Aisles are lines drawn in Planner to represent actual aisle in stores: They serve several 
purposes: 

 They allow actual aisles in stores to be identified in a floor plan. 
 They allow traffic flows to be specified 

 The allow reports to be created showing the performance of specific aisles. 

 

In the above diagram, each aisle is represented by a line identified by a number, letter or 
simple word. In the above diagram there are three aisles; numbered 1, 2 and 3. Aisles can 
be used to identify the general direction of traffic flow through a store. Shoppers are 
defined as starting at the head of an aisle and moving towards its end.  
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In the above diagram, the implied traffic flow is specified by the aisles placed in the floor 
plan.  

Note: Actual traffic flows in a store will have to be 
determined by observation - possibly by use of observers or 
reviewing security camera footage. 

After the aisles have been drawn, the Calculate Aisle Adjacency function (available from 
the Calculations menu) will cause fixtures to be associated with the nearest aisle within a 
specific distance. 

 

In the above diagram the fixtures have been bay numbered for clarity. Each fixture 
(identifiable by its bay number) will associate itself with the nearest aisle. Once fixtures 
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have been associated with aisles, this information can be used for reporting purposes. For 
example, it would be possible to report on the performance of all planograms sharing an 
aisle.  

Adding, Editing and Deleting Aisles 
Adding, Editing and Deleting Aisles is controlled from the Aisles toolbar. 

 

Adding Aisles 
Adding Aisles is initiated by clicking Add Aisle on the Aisles toolbar. 

 

The Aisle dialog box will appear, allowing the name of the aisle to be specified. 

 

After entering the aisle name and clicking OK, the command line will invite the user to 
select the start point. 

 

After specifying the start point the user will be invited to select the next point. 

 

The user may draw a straight aisle using just two points, or they may opt to add 
additional segments. Pressing Return will cause the aisle to be drawn. 
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Useful Ways of Drawing Aisles 
Many of the standard AutoCAD methods can be used to draw aisles. Two useful ones 
are: 

Mid of 2 Points (m2p) 
The AutoCAD Mid of 2 Points command is initiated by entering m2p into the command 
line. 

 

This will result in the user being invited to select 2 points. The aisle will be drawn 
initiating from the centre of a line connecting those two points. 

 

In the above example, the m2p command has been used for the start and the end of the 
aisle, resulting in an aisle drawn equidistant from both gondolas and neatly aligned with 
the ends. 

Construction Lines 
AutoCAD allows the use of construction Lines - infinitely long straight lines. There (in 
conjunction with other AutoCAD functionality such as Offsets and Object snaps) can be 
used to accurately lay out aisles. In the example below, construction lines have been 
added to the floor plan using Offsets and Object snaps. 

 

The Aisle can then be drawn by snapping to the intersections. 
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When the construction lines are deleted, an accurately positioned aisle remains. 

 

Editing Aisles 
Editing Aisles is initiated by clicking Edit Aisle on the Aisles toolbar. 

 

The command line will then invite a user to select an aisle. 

 

This can be selected by left clicking on it to select it then right clicking (standard 
AutoCAD method to end selection). The aisle dialog box will then appear. 
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The name of the aisle can then be edited. 

Editing Aisle Positions 
Aisle positions cannot be edited by Macro Space Management (MSM) functionality. 
Instead AutoCAD functionality must be used. For example, the position could be 
changed by means of the Move command. After the move command has been used, the 
MSM Synchronize functionality must be used to ensure the changes are written back to 
the database. 

Deleting Aisles 
Editing Aisles is initiated by clicking Delete Aisle on the Aisles toolbar. 

 

The command line will then invite a user to select an aisle. 

 

This can be selected by left clicking on it to select it then right clicking (standard 
AutoCAD method to end selection). Upon right clicking, the selected aisle or aisles will 
be deleted without further confirmation. 

Aisles and Aisle Adjacency 
After aisles have been drawn in a floor plan, the Calculate Aisle Adjacency option 
(Calculations menu) will associate fixtures with aisles. This section of help explains that 
process. 

ADJACENCY_AISLESIZE System Variable 
The ADJACENCY_AISLESIZE system variable (set in the System Variables dialog box 
in the Administration Module) determines the maximum distance a fixture can be from 
a file and still be associated with it. When the Calculate Aisle Adjacency option is run, 
the distance perpendicular to the front of each fixture will be determined. Each fixture 
will be associated with the nearest aisle - provided its is within the maximum distance set 
by the ADJACENCY_AISLESIZE system variable 
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In the diagram above, the fixtures will be associated with Aisle 1 because that is the 
closest and within the maximum distance specified by the ADJACENCY_AISLESIZE 
system variable. If Aisle 1 did not exist, the fixtures would not be associated with Aisle 2 
because that is outside the maximum distance specified in the 
ADJACENCY_AISLESIZE system variable 

 

Care needs to be taken if the aisle is not parallel to the front of the fixtures. In the above 
example, Fixture 1 will associate with Aisle 1, but Fixture 5 (which is outside the 
ADJACENCY_AISLESIZE distance) will not. 

Ordering Fixtures for Reporting Purposes 
Once the Calculate Aisle Adjacencies functionality has been run, information will be 
written to the AVTTB_AISLE_ADJACENCIES table. This contains several pieces of 
information useful for reporting including the distance from the start of the aisle and 
whether the fixture is on the left or right of the aisle. 

 

Distance from Start 
The distance from the start is measured from the start of the aisle to the centre of the 
front face of the fixture. In the above diagram, Fixtures 1 - 6 can be ranked in their 
sequence along the aisle. 
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Location to Left or Right 
Aisles are drawn to show the general direction of travel of shoppers. The start of the aisle 
is shown by the location of its name, with direction of travel towards the other end. 
Fixtures associated with an aisle are show to the left or right relative to the direction of 
travel. 

Potential Problems with Aisle Adjacency 
The diagram below shows a correctly drawn aisle and one with potential problems. 

 

Aisle A 
Aisle A has all fixtures within the distance specified within the 
AVTTB_AISLE_ADJACENCIES system variable and can be used for accurate reporting. 

Aisle B 
There are two problems with Aisle B: 

 The aisle is in a 'U' shape. As distances are measured from the start of the aisle to 
the centre of the front of the fixture, Fixture 22 will be closest to the start. 
However, Fixture 20 will be shown as closer to the start than Fixture 24, leading 
to reports ranking the fixtures in an incorrect sequence along the length of the 
aisle. 

 One end cap (Fixture 21) is not pointing at the aisle. It will 'feel out' to the 
maximum distance specified in the AVTTB_AISLE_ADJACENCIES system 
variable, fail to find the aisle and not be included in reports associated with that 
aisle. 

When drawing aisles, care needs to be taken to ensure that fixtures will correctly 
associate with the pertinent aisles and the sequence they are reported on is correct.   
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Overview of Merchandising in Planner 
The merchandising options in Planner allow users to lace planograms or products. 

 

Planner can be used to merchandise a store at placeholder level - it cannot be used to 
merchandise at display style level. Two forms of placeholders are possible: 

 Products: Placeholders can be at any level in the hierarchy from SKU upwards. 

 Planograms 

In both cases, the placeholders indicate the presence of specific items of merchandise 
exists on a fixture. However, the placeholders themselves do not hold any information on 
the product quantity, position or orientation.  
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Using External Information to Plan Merchandise 
Store planning is not done in isolation. A key objective is to take optimized data from 
other applications and use it to translate a list of tabulated requirements into an 
optimized spatial arrangement.  

Product Targets and Prototype Stores 
The flowchart below shows one method to achieve this. 

 

1. Data on the quantities of required products is generated by an external application. 

2. This information is imported into Macro Space Planning's 
AVTTB_PRODUCT_TARGET table. 

3. The product targets are used to create (or update) a prototype store. This translates a 
tabulated list of information into a spatial arrangement of products and planograms.  

4. The prototype store is used as a basis for comparison for other stores. For example, 
stores in a specific cluster in Store Manager could be validated against the prototype 
before being put into service.  

Using Product Targets 
The Macro Space Planning Database contains a table called 
AVTTB_PRODUCT_TARGET. 

 

This table can be used to hold information from another application - such as Category 
Management. It can be populated imported data for base linear or shelf linear lengths for 
products at Category, Sub-Category or Segment level. This information can be both store 
and season specific, allowing the table to hold optimized information.  

Product Targets and Quick Reports 
Quick Reports can be accessed from the View menu. They are designed to give a 
continually updated view of specific aspects of the currently active floor plan. Macro 
Space Planning is supplied with a standard set of Quick Reports, but retailers can 
develop their own customized quick reports to suit their specific business processes. 
(This can be done by implementors or administrators making changes to the 
AVTTB_CUSTOM_SQL table in the database). 

In the example below a Quick Report has been developed to show the product targets for 
the currently active floor plan. It shows the base linear for products at Segment level, 
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together with the average gross margin for those segments. This data can then be 
compared with data for merchandise actually placed in the store to ensure that the broad 
quantities of products placed fall within calculated criteria.   

 

Using Prototype Stores 

Placing Merchandise 
Prototype stores can be used to convert a list of product targets into a specific spatial 
arrangement. In the example below, aisles have been drawn to indicate traffic flow and 
planograms placed to meet the base linear targets. This information can be used by other 
store planners as a comparison when planning their stores. In the example below, once 
the prototype has been selected or planned, other store planners can see which 
planograms belong in which aisle and which sequence they are placed in. 

 

Comparing with Quick Reports 
It is also possible to use Quick Reports for comparison purposes: for example it is 
possible to produce a custom quick report that compares the base linear values of 
merchandise in the prototype store with that in the current store.  
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Comparing with Store Comparison 
The Store Comparison option can be used to establish what is the same, different, 
missing or present in larger quantities in one store compared to another.  

 

Planogram Forms 
Planograms can exist in several forms in a floor plan. 
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In the above diagram: 

 The planogram on the left is in 2D form. This is purely a placeholder and the 
database will not hold floor plan specific information on the position of the 
shelves or products in the planogram. 

  The planogram in the centre is in 2.5D form. The shelves are accurately 
represented by the products are in placeholder form with no information on 
quantity, position or orientation. 

 The planogram on the right is in 3D form. Shelves are accurately represented, as 
is the quantity, position and orientation of the products. 

Planogram Placement in Planner 
Planograms in Planner always place in 2D form. They can be exploded to 3D form in the 
Merchandiser module if full planogram details are required to be visible.  

If the planogram is in 2D form, it can be viewed in Schematic Preview in In-Store Space 
Collaboration, while if it is 3D form it can be viewed in Front Graphical View. 

Shelf and Product KPI's and Reports 
KPIs and reports need to take into account the form of the planogram. If it is in 2D form, 
full planogram details can only be found in the AVTTB_PLANO table (and its Child 
tables). If the planogram has been exploded in Merchandiser, the KPI reports can use 
other tables in the database - for example the AVTTB_SHELF and AVTTB_PRODUCT 
tables. 

The form of the KPIs reports is thus dependent on how the application was configured 
when it was implemented. 

Effect of Settings in Configuration Module 
Settings in the Merchandising tab of the Configuration module can have a significant 
effect on the way merchandise places. 
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Full information on each setting can be found in the Configuration Module User Guide, 
but the following basic settings are helpful for new users: 

Selection Frame 
This frame controls how fixtures are selected for placing merchandise on. Set the 
following: 

 Fixture Selection Method to Standard Selection. 

 Always Show Selection Dialog to On. 

 Select Whole Planogram to On. 
 Sort left-most to On. 

Highlight Frame 
This frame controls how merchandise is highlighted in the floor plan.  
 Set highlight method to Flash. 

Check Rules Frame 
This frame controls the advisory warnings that occur when placing planograms. 
 Set all Check Rules to On with the exception of allow Multiple Profiling. 

The Floor Plan Active Date 

Overview of Floor Plan Active Date 
The Active Date is intended as a filter to ensure that only appropriate merchandise is 
placed in a floor plan. It is visible at the top of the Object Browser  
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It is set by double clicking on it. This will bring up the Change Date dialog box. 

 

This can be set to one of three options: 

 Effective Date. The Effective Date is the date the floor plan is scheduled to come 
into service. If the Effective Date has been set in the File Properties dialog box for 
the floor plan in Store Manager, the Active Date of the floor plan will be set to 
reflect this. 

 Current Date. If selected, the active date will be set to today's date. 

 Other Date. If selected, this allows the Active Date to be set to any required date.  

MERCH_TREE_EFFECTIVE_DATE System Variable 
The effect of the Active date can be turned on or off by means of the 
MERCH_TREE_EFFECTIVE_DATE system variable in the Administration Module. If 
turned on all products and planograms that have an Effective date after the Active Date 
of the currently active floor plan will be grayed out and unavailable for selection from 
the Object Browser. 

Using the Floor Plan Active Date 
If the MERCH_TREE_EFFECTIVE_DATE system is On, merchandise with: 

 An Effective Date after the Active Date set for the floor plan will be grayed out 
and unavailable for placement. This is because the product or planogram is not 
scheduled to be available until after the date the floor plan is scheduled to go into 
service. 

 An Expiry Date before the Active Date set for the floor plan will be grayed out 
and unavailable for placement. This is because the product or planogram will be 
removed from the list of available merchandise before the floor plan comes into 
service. 

Limitations of the Floor Plan Effective Date 
If a file has not been given an effective date, all products will be available. If products are 
copied from one drawing to another, they will be placed in the drawing even if their 
product dates are not valid for this file. 
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Display Style Products and Exploded Planograms 
There are two forms of product that can be placed in the Merchandiser module, but 
which are not visible in the Planner module. 

Products at Display Style Level 
There are a number of possible levels in the product hierarchy. The lowest is Display 
style, represented in the screen shot below by the Big Button 100 - Boxed and Big Button 
100 - Display options. 

 

Some placed display styles can be seen in the screen shot below. They allow individual 
products to be placed. For example, there a four products on the top shelf, three on the 
lower and a TV on the base of the fixture. The dimensions and orientations of these 
products can also be taken into account. 

 

Planner can only display products down to SKU level using product placeholders. It 
cannot display products at Display Style level. Accordingly, Display Style level products 
in Merchandiser will not be visible. This can result in an apparently empty fixture in 
Planner actually containing merchandise.  
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Planogram Form 
Planograms can exist in several forms in a floor plan. 

 

In the above diagram taken from the Merchandiser module: 

 The planogram on the left is in 2D form. This is purely a placeholder and the 
database will not hold floor plan specific information on the position of the 
shelves or products in the planogram. 

  The planogram in the centre is in 2.5D form. The shelves are accurately 
represented by the products are in placeholder form with no information on 
quantity, position or orientation. 

 The planogram on the right is in 3D form. Shelves are accurately represented, as 
is the quantity, position and orientation of the products. 

Planogram Placement in Planner 
Planograms in Planner always place in 2D form. They can be placed in 2D, 2.5D form or 
3D form in Merchandiser. 2D and 2.5D planograms can also be exploded to 3D form. 
When in 2.5D or 3D form, the planograms will not be visible in Planner. This can result in 
an apparently empty fixture in the Planner module actually containing shelves and 
products. 

Use of KPIs 
Although neither display style products, nor 2.5D or 3D planograms show in the Planner 
module, the information exists in the database. It is therefore possible to create KPI's that 
will highlight apparently empty fixtures in planner that have in fact been populated in 
the Merchandiser module. 

Promotional Fixtures 
Certain fixtures with a store are known to generate high levels of profits. Examples 
include end caps on gondolas and displays by the checkout designed to increase impulse 
buying. Macro Space Planning allows specific fixtures in a floor plan to be designated as 
Promotional Fixtures. These fixtures can them be readily identified. They can then be 
used for special offers, promotions or the introduction of new products, etc. 

Some retail chains also have a specific team responsible for merchandising promotional 
fixtures - designating the fixtures as such assists in identifying which fixtures that team is 
responsible for the merchandise on. 
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Assigning Promotional Fixtures 
Once fixtures have been placed in a floor plan, they can be designated as promotional 
fixtures by using the Promotional Fixtures option from the Blocks toolbar of the 
Fixturing tab of the Object Browser. 

 

Identifying Promotional Fixtures 
Once promotional fixtures are assigned, they can be identified in two ways in a floor 
plan. 

Highlight 
The Promotional Fixtures option includes a highlight option in the drop down list of 
options. This will cause any fixtures that have been designated as Promotional fixtures to 
be highlighted in the floor plan. The exact highlighting method will depend on the 
options selected in the Merchandising Tab of the configuration module. 

Key Performance Indicator 
 Another way of identifying promotional fixtures is with KPI's. Without the KPI selected, 
the Promotional Fixtures are difficult to identify. 
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With the KPI active, the promotional fixtures are readily apparent. In this case the end 
caps and three bins in the aisle have been designated as promotional fixtures. 

 

Note: one of the easiest ways of seeing fixture KPI's is to use 
the Conceptual Visual Style option from AutoCAD's Visual 
Styles toolbar. This causes the entire fixture to color, not just 
the outlines.  

Using Promotional Fixtures 
There are a number of ways of using promotional fixtures. One possible method is: 
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1. Identify fixtures that have a high visibility to shopper traffic. Such fixtures 
include end caps on gondolas, display on checkout, power wings and bins in the 
centre of aisles. 

2. Use the Promotional Fixture on the Object Browser to designate those fixtures as 
promotional fixtures. 

3. Bay number these fixtures differently from other fixtures in the floor plan - possibly 
with a P suffix. 

4. It is then possible to report on and merchandise those fixtures separately to the other 
fixtures in the store - for example it would be possible to produce a weekly store plan 
showing promotional fixtures only that would allow a constantly changing program 
of special offers. 

Planogram Substitutions 
Planogram Substitutions can be used to automatically swap one planogram for another 
in single or multiple stores across the retail chain.  

Configuring Planogram Substitutions 
Planogram substitutions are configured in the Administration module - using the option 
assessed from the Merchandising menu. 
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Many planogram substitutions are then executed automatically using batch processes to 
modify the information held in the database. If this is the case, the Planner floor plan may 
require synchronization so that the information in it matches that held in the database. 

Manually Running Planogram Substitutions 
Users with the correct privileges can also manually run planogram substitutions from the 
Tools menu for the currently active floor plan. 

 

Unknown Category 
The Product hierarchy in the Object Browser contains the products of "unknown" type. 

 

These products are in the hierarchy as defaults for the planogram import process and 
should play no role in merchandising floor plans. 
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Overview of Merchandising on the Object Browser 
The Merchandising Tab can be used to add and delete products or planograms in the 
currently active floor plan. It can also be used for other operations involving merchandise 
including highlighting products or planograms in the hierarchy. 

     

 The Merchandising Toolbar contains a series of icons used to control operations 
concerning products or planograms. There are two toolbars - which is visible will 
be determined by whether the Products or Planograms button has been selected. 

 The Products or Planograms Buttons toggle the Object Browser between product 
or planogram operations.  
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 The Hierarchy displays the available products or planograms.  There are two 
hierarchies - which is visible will be determined by whether the Products or 
Planograms button has been selected. 

 Clicking on the Splitter Bars will open or close individual windows on the Object 
browser. 

 The Properties Window has information on the product or planogram currently 
highlighted in the hierarchy. 

 The Summary Window has information on the merchandise currently placed in 
the floor plan. 

 The Preview Window will show an image if a product at display style level is 
selected and the display style has previously had an image associated with it. 

Using the Object Browser for Merchandising Operations 
The Products toolbar is found on the Merchandising Tab of the Object Browser. It is 
active when the Products button is selected. 

 

It contains a series of icons allowing various operations to be carried out on Products. 

Icon Description 

 

  

Add to Selected Fixture 

 

  

Edit Definition 

 

  

Remove from Fixture 

 

  

Move between Fixtures 

 

  

Highlight where used in store 

 

  

Highlight Selected Item in Tree 

 

  

Find Product or Planogram 

 

  

Show Merchandising Options 

 

  

Refresh 

  

The Planograms toolbar is found on the Merchandising Tab of the Object Browser. It is 
active when the Planograms button is selected. 
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It contains a series of icons allowing various operations to be carried out on Planograms. 

Icon Description 

 

  

Add to Selected Fixture 

Not 
available 
for 
Planograms 

  

Edit Definition 

 

  

Remove from Fixture 

 

  

Reverse Planogram Placement 
Direction 

 

  

Highlight where used in store 

 

  

Highlight Selected Item in Tree 

 

  

Find Product or Planogram 

 

  

Show Merchandising Options 

 

  

Refresh 

  

The Hierarchy Window is found immediately below the toolbar. It will show the product 
or planogram hierarchy dependent on whether the Products or Planograms button has 
been selected. 

 

The Product hierarchy can be imported or configured in Product Studio. The planogram 
hierarchy can be imported or configured in the Merchandiser Module. 
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The Properties Window gives details of the product or planogram that has been selected 
in the hierarchy. 

 

Note: Information in this window is controlled from Custom 
SQL in the AVTTB_CUSTOM_SQL table. Administrators can 
customise the information that appears in the Properties 
Window by modifying the Custom SQL. 

The Summary Window contains details of merchandise within the currently active 
drawing. 

 

The information typically includes information on products, base linear and quantities. 

Note: Information in this window is controlled from Custom 
SQL in the AVTTB_CUSTOM_SQL table. Administrators can 
customise the information that appears in the Summary 
Window by modifying the Custom SQL. 

The Preview Window contains an image if a product at display style level is selected and 
the display style has previously had an image associated with it. 
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Factors Affecting Product Operations 
A number of factors affect product placement.  

Object Browser and Object Grid 
Products can either be added from the Object Browser or Object Grid. Which one will 
result in more efficient product addition depends both on the situation it is being used in 
and user preferences.  

Active Date 
The active date can be seen at the top of the Object Browser. 

 

If the MERCH_TREE_EFFECTIVE_DATE system variable (Administration module) is set 
to on, this will place constraints on what products can be added: 

 If the Effective Date of the product is after the Active Date of the floor plan, the 
product cannot be placed because it will not be available when the floor plan is 
implemented. 

 If the Expiry Date of a product is before the Active Date of the floor plan, the 
product cannot be placed because it will no longer be available when the floor 
plan is implemented.  

Fixture Selection  
There are two possible fixture selection methods. These can be set in the Merchandising 
Tab of the configuration module - accessed by clicking the Properties Icon on the 
Products toolbar of the Object Browser. 

 

There are two methods. Standard Selection is suggested for new users. 
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Grouping 
When the fixtures were placed in the floor plan, if more than one fixture was placed at 
one (for example if a gondola was placed) it is possible to select all fixtures that were 
placed together, or individual fixtures. This is controlled by the Grouping option on the 
Fixturing toolbar. 

 

It is recommended that Grouping be turned Off while placing products. That way, 
individual fixtures can be selected. If Grouping is left On, when an individual fixture is 
selected from a gondola, all fixtures and fittings in that gondola will be simultaneously 
selected. 

Fixtures and Fittings 
The floor plan can contain a mixture of fixtures and fittings. Only fixtures can accept 
merchandise. If an attempt is made to merchandise a fitting, a warning will appear in the 
command line.  

 

Product Form 
In Planner, products can only be added as placeholders. The floor plan will indicate that 
a specific type of product is present on the fixture, but no information on quantity, size or 
orientation can be determined from it. Product placeholders can be added from any level 
on the product hierarchy from SKU upwards. An example of use would be adding 
category level placeholders to get some preliminary reports on a new floor plan. 

Merchandiser allows a floor plan to be merchandised with an additional level of detail - 
Display Styles. These allow information on quantity, size or orientation for a specific 
product to be associated with a floor plan. 

 

Display Styles are visible in the Object Browser in Planner but cannot be placed. Instead, 
selecting the Display Style (Hung Plus 9V Batteries in the above example) will result in 
the parent SKU (Duracell Plus 9V Battery) being placed. 
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Visibility of Display Styles 
If products are placed at Display Style level in Merchandiser (or if Planograms are 
exploded to 3D form), these forms of merchandise will not be directly visible in Planner. 

 

Macro Space Management has the capacity to create custom KPI's. In the above example, 
a KPI has been created to show fixtures populated with display styles and exploded 
planograms. In the floor plan to upper right, the fixtures are apparently unpopulated. 
When the KPI has been used (lower right), the populated fixtures become visible. 

Adding Product Placeholders from the Object Browser 

Sequence of Actions Required 
There are two potential ways of adding products. The first is to select the required fixture 
first. 

1. Select required fixture or fixtures. 

2. Select Product in Hierarchy in Object Browser or in List in Object Grid 

3. Click the Add icon  

The alternative is to select the product first. 
1. Select Product in Hierarchy in Object Browser or in List in Object Grid 

2. Click the Add icon  

3. Select required fixture or fixtures. 

Either way is valid. This example will use the latter option of selecting the product first 
and the fixtures last. 

Adding Product Placeholders 
Adding products can be carried out as follows: 

1. Select the Products Button on the Merchandising tab of the Object Browser 
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2. Select Required Product from Hierarchy 

The initial stage is to select the required product from the hierarchy. In this example, 
the Beers, Lagers and Ciders placeholder is to be added. Useful information is 
displayed in the properties window. For example, this product is at sub-class (sub-
category) level and the category role is that of a Traffic Builder product. 

Note: Category Roles are derived from Category Management 
and explain the purpose the retailer is using that sub-class of 
product for. In this case, the retailer is using Beers, Lager and 
Ciders to try and increase the number of customers using the 
store. 

 

Note: If products cannot be found by means of a manual search, 
there is a Find option available. (See below). 

3. Select Add Option from Toolbar 
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The next stage is to click Add Product on the toolbar. 

 

4. Selecting Fixtures 

On clicking Add Product, the command line in Planner will prompt users to select 
fixtures.  

 

These can be selected by standard AutoCAD methods including left clicking 
individual fixtures or using window and crossing selection boxes. In this instance, 
four fixtures have been selected be left clicking, the information being reflected in the 
command line. 

 

On completing the selection with a right click (the standard AutoCAD way of 
finishing selecting objects) the selected fixtures will be populated with placeholders. 

 

At the same time as the fixtures are populated, they will annotate with information 
on what products have been placed.  

Note: Annotation is controlled using the Text Styles option 
accessed from the Planning Menu in the Administration Module. 
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Adding Multiple Product Placeholders to a Fixture 
It is possible to add multiple Product placeholders to a single fixture. Once the fixture has 
been merchandised with the first placeholder, it can be merchandised with a second 
placeholder by following exactly the same procedure. 

 

The second fixture from the left has been merchandised with a combination of Beers, 
Lagers and Ciders and Spirits placeholders. This situation might occur if a store planner 
was considering having the upper shelves on a fixture devoted to spirits and the lower to 
beers, lagers and ciders. The annotation can be set of offset so that the annotation for the 
second placeholder does not overwrite that for the first. 

Using the Find Option 
The Find option can be found on the Products toolbar. It can be used if a store planner 
does not know how to manually navigate to the required product. 

 

On clicking the Find icon, the Find Product dialog box will appear. 
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To use this dialog box: 

1. Type a search string into the Find text box. (The text string used implied wild cards). 
2. Click the Find icon 

3. Highlight a product in the list returned. 

4. Click OK to be taken to that product in the product hierarchy in the Object Browser. 

Adding Product Placeholders from the Object Grid 

Sequence of Actions Required 
There are two potential ways of adding products. The first is to select the required fixture 
first. 

1. Select required fixture or fixtures. 
2. Select Product in Hierarchy in Object Browser or in List in Object Grid 

3. Click the Add icon  

The alternative is to select the product first. 

1. Select Product in Hierarchy in Object Browser or in List in Object Grid 

2. Click the Add icon  

3. Select required fixture or fixtures. 
Either way is valid. This example will use the latter option of selecting the product first 
and the fixtures last. 

Adding Product Placeholders 
Adding products can be carried out as follows: 

1. Select the Products Button on the Merchandising tab of the Object Browser 
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2. Select Required Product Group in the Hierarchy 

The initial stage is to highlight the required product group in the hierarchy. 

 

Toggling the Refresh button on in the Object Grid will then populate the Object Grid 
with a list of products associated with that Product Group. This list can be refined 
using the options in the Filter and Sort options in the Object Browser. 

3. Adding the Product 

To add the product, highlight the fixture the product will be added to, highlight the 
required product in the Object Browser and click the Add button. The product will 
then be added. 
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Note: If a fixture has not been selected, the user will be able 
to select it in the floor plan using standard selection 
methods. 

The selected fixtures will be populated with the product placeholder. 

 

Note: Annotation is controlled using the Text Styles option 
accessed from the Planning Menu in the Administration Module. 

Deleting Product Placeholders 
Deleting Products can only be done from the Object Browser 

Sequence of Actions Required 
There are two potential ways of deleting products. The first is to select the required 
fixture first. 

1. Select required fixture or fixtures. 

2. Click the Delete icon  

3. Confirm in the delete Planograms dialog box. 
The alternative is to select the delete option first. 
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1. Click the Delete icon  

2. Select required fixture or fixtures. 

3. Confirm in the delete Planograms dialog box. 

Either way is valid. This example will use the latter option of selecting the delete option 
first and the fixtures last. 

Deleting Products 
Deleting products can be carried out as follows: 

1. Select the Products Button on the Merchandising tab of the Object Browser 

 
2. Select the Delete option from the Toolbar 

The next stage is to click Delete Product on the toolbar. 

 
3. Selecting Fixtures 

On clicking Delete Product, the command line in Planner will prompt users to select 
fixtures.  

 
These can be selected by standard AutoCAD methods including left clicking 
individual fixtures or using window and crossing selection boxes. In this instance, 
four fixtures have been selected be left clicking, the information being reflected in the 
command line. 
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Note: Clicking on the products themselves will not be effective - 
deleting products requires the user to select the parent fixtures 
for the products. Accordingly, users should left click on the 
fixture itself or use window and crossing selection boxes that 
encompass both the product and its parent fixture. 

On right clicking to complete the selection, the Delete Products dialog box will 
appear. 

4. Delete Products Dialog Box 

The Delete Products dialog box allows users to confirm which products to delete. 

 
 The Radio Button specifying whether to Delete complete instance or Only 

delete from the selected fixtures only applies to planograms. 

 Select the required products to delete 

 Click OK to delete the specified products. 

 The specified products will be deleted and the Delete Products dialog box will 
close. 

Note: The Delete Products dialog box will always appear if two 
or more products are selected. It will also appear if a single 
product is selected if the Always show selection dialog option is 
checked in the Merchandising tab of the Configuration module. 

Editing Product Placeholders 
Product Placeholders can be edited by clicking the Edit Product icon on the tollbar. This 
icon will only be active if the user belongs to a user group with access rights to Product 
Studio. 
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On clicking Edit Product, the user will then be taken to Product Studio. If a product is 
highlighted in the product hierarchy at the time the Edit product Icon is clicked, this 
product will be open for editing in Product Studio.  
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45 
Planogram Operations 

Factors Affecting Planogram Operations 
A number of factors affect planogram placement.  

Object Browser and Object Grid 
Planograms can either be added from the Object Browser or Object Grid. Which one 
will result in more efficient product addition depends both on the situation it is being 
used in and user preferences.  

Active Date 
The active date can be seen at the top of the Object Browser. 

 

If the MERCH_TREE_EFFECTIVE_DATE system variable (Administration module) is 
set to on, this will place constraints on what products can be added: 

 If the Effective Date of the planogram is after the Active Date of the floor plan, 
the planogram cannot be placed because it will not be available when the floor 
plan is implemented. 

 If the Expiry Date of a planogram is before the Active Date of the floor plan, the 
planogram cannot be placed because it will no longer be available when the floor 
plan is implemented.  

Fixture Selection  
There are two possible fixture selection methods. These can be set in the Merchandising 
Tab of the configuration module - accessed by clicking the Properties Icon on the 
Products toolbar of the Object Browser. 

 

There are two methods. Standard Selection is suggested for new users. 
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Grouping 
When the fixtures were placed in the floor plan, if more than one fixture was placed at 
one (for example if a gondola was placed) it is possible to select all fixtures that were 
placed together, or individual fixtures. This is controlled by the Grouping option on the 
Fixturing toolbar. 

 

It is recommended that Grouping be turned Off while placing products. That way, 
individual fixtures can be selected. If Grouping is left On, when an individual fixture is 
selected from a gondola, all fixtures and fittings in that gondola will be simultaneously 
selected. 

Fixtures and Fittings 
The floor plan can contain a mixture of fixtures and fittings. Only fixtures can accept 
merchandise. If an attempt is made to merchandise a fitting, a warning will appear in the 
command line.  

 

Sort Left Most 
When selecting fixtures, if selecting by individual left clicks, the fixtures are added to the 
selection in the sequence they are selected. If the fixtures are selected by a Windows or 
Crossing selection box, the fixtures in the selection are ordered in the sequence they were 
placed in the drawing. For multi-bay planogram placement it is generally necessary to 
place the bays in a specified sequence; functionality called Sort Left Most can be 
activated from the Merchandising tab of the Configuration module. (This tab can be 
accessed by clicking the Properties icon on the Planogram toolbar on the Object Browser). 

 

The selected fixtures will them be populated left most first.  
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The left-most fixture is based on when the fixtures are viewed from the front. The 
apparent front direction will change when the back face of a gondola is considered 
relative to the front. 

Planogram Reversal 
Some multi-bay planograms are designed to be viewed from a specific direction. How 
the bays are placed depends on the traffic flow along an aisle.  

 

When aisles are drawn, they can be used to show the direction of traffic flow along an 
aisle. It is from the head of the aisle (denoted by its name or number), to the other end. In 
the above diagram, traffic predominately flows from right to left. If it is desired to place a 
3 bay planogram with Bay 1 the first to be viewed by shoppers, then how it is placed will 
depend on which side of the aisle it is placed. If it is placed on the island gondola (Bays 
B-1, B-2 and B-3) with sort left most on, it can be placed in its normal sequence. 
If it is placed on the wall gondola (Bays A-1, A-2 and A-3) the effect of sort left most will 
be to place the first bay at A-1, where it will be the last bay to be seen by a customer 
following the normal direction of travel along an aisle. This can be corrected by using the 
Reverse Planogram option on the planogram toolbar. 
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The effect of this is to reverse the sequence the bats are placed, with Bay 3 being placed 
first. Bay 1 will thus end up on fixture A-3 and will be the first bay seen by a customer. 

Check Rules 
Check Rules are used when planograms are placed. They provide a series of warnings if 
a planogram is being placed on inappropriate fixtures. The selection of the check rules is 
in the Merchandising tab of the Configuration module (accessed from the Properties 
button on the Planogram toolbar).  

 

Depending on the selections made, warnings will be given during planogram placement 
if the fixtures do not match the ones the planogram was designed from. 

 

Exploded Planograms 
Planograms can be places in two main forms: 2D (imploded) and 3D (exploded). In the 
diagram below, the planogram on the left is in 2D form and the one on the right is in 3D 
form. 
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Planograms placed in the planner module are always placed in 2D form, with no details 
of products or shelves visible. Planograms in the Merchandiser module can be toggled 
between 2D and 3D form. If exploded to 3D form in Merchandiser, the planograms will 
no longer be directly visible in Planner. 

Visibility of Exploded Planograms 
If products are placed at Display Style level in Merchandiser (or if Planograms are 
exploded to 3D form), these forms of merchandise will not be directly visible in Planner. 

 

Macro Space Management has the capacity to create custom KPI's. In the above example, 
a KPI has been created to show fixtures populated with display styles and exploded 
planograms. In the floor plan to upper right, the fixtures are apparently unpopulated. 
When the KPI has been used (lower right), the populated fixtures become visible. 
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Adding Planograms from the Object Browser 

Sequence of Actions Required 
There are two potential ways of adding planograms. The first is to select the required 
fixture first. 

1. Select required fixture or fixtures. 

2. Select Planogram in Hierarchy in Object Browser or in List in Object Grid 

3. Click the Add icon  

The alternative is to select the planogram first. 

1. Select Planogram in Hierarchy in Object Browser or in List in Object Grid 
2. Click the Add icon  

3. Select required fixture or fixtures. 

Either way is valid. This example will use the latter option of selecting the planogram 
first and the fixtures last. 

Adding Planogram Placeholders 
Adding planograms can be carried out as follows: 
1. Select the Planograms Button on the Merchandising tab of the Object Browser 

 
2. Decide if Planogram is to be placed Normally or Reversed 

When multi-bay planograms are designed, they sometimes take traffic direction into 
account. 
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If Planner aisles have been drawn, these can be used to identify the predominant 
traffic flow in the real life aisle. In the above example traffic is flowing from right to 
left. If Sort Left Most is On (Merchandising tab in Configuration Module) the selected 
fixtures will be populated with the left most fixture first (as viewed from the front of 
the fixture. 

In the above example, if the planogram is to be placed match its flow instructions, it 
can be placed normally on the lower (island) gondola, but must be placed reversed 
on the upper (wall) gondola. 

3. Select Reverse Planogram if Required 

If it is necessary to reverse the planogram, the Reverse Planogram option must be 
toggled On by depressing the icon on the toolbar. 

 

Note: When the Reverse option is no longer needed it should be 
toggled off. This will prevent planograms being placed reversed 
when not required. 

4. Select Required Planogram from Hierarchy 

The initial stage is to select the required planogram from the hierarchy. In this 
example, the 2 Bay Tilda Rice Planogram is to be added. Useful information is 
displayed in the properties window.  
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Note: If planograms cannot be found by means of a manual 
search, there is a Find option available. (See below). 

5. Select Add Option from Toolbar 

The next stage is to click Add Planogram on the toolbar. 

 
6. Selecting Fixtures 

On clicking Add Planogram, the command line in Planner will prompt users to select 
fixtures.  

 
These can be selected by standard AutoCAD methods including left clicking 
individual fixtures or using window and crossing selection boxes. In this instance, 
four fixtures have been selected be left clicking, the information being reflected in the 
command line. 
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On completing the selection with a right click (the standard AutoCAD way of 
finishing selecting objects) the selected fixtures will be validated against information 
in the planogram design. 

7. Check Rules 

The check rules are set in the Merchandising Tab of the Configuration Module. This 
can be accessed by clicking Properties on the Planogram toolbar. 

 
This will bring up the Merchandising Tab from the Configuration Module. This 
allows the Check Rules to be set - settings being individual to each user. 

 

Note: See the Configuration Module Help File for detailed 
information on these settings. 

These settings determine which validation rules are applied. Any violations come up 
in the Planogram Placement Errors dialog box, otherwise the planogram is placed. 

8. Planogram Placement Errors 
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If the validation process identifies problems, the Planogram Placement Errors dialog 
box will appear. This will identify problems based on the check rules selected. The 
user then has two options: 

 Click OK. The planogram will not be placed. 

 Click Ignore. The warnings will be overridden and the planogram placed. 

 Store planners should exercise caution when overriding the warnings. This will 
result in a planogram being placed on an inappropriate fixture in the real life 
store. Some of the potential consequences of this include: 

 Planogram being placed on fixture of different dimensions to what it was 
designed for. The number of facings and total quantities of products on the shelf 
could be incorrect. For example, if there are fewer products on the shelves than 
the planogram designer intended, there could be frequent out of stocks and loss 
of sales. 

 Planograms being placed on inappropriate fixtures - for example by overriding 
temperature warnings. If the planogram is designed for a chiller unit at standard 
chill temperature (0 - 1 degrees centigrade) and it is placed on a chiller set to a 
different temperature, product life should be shortened and losses incurred by 
having to throw away spoiled produce. 

 Turning off the Multiple Profiling warning could result on two planograms 
being placed on a fixture when only one was intended. 

 Turning off the Split Planograms warning could result in inappropriate 
planogram placement. For example a 2 bay planogram could be placed either 
side of a 3 feet wide pillar, impacting on sales for that planogram. 

9. Planogram Placement 

If there are no check rule violations, or if the Check Rule warnings are overridden, 
the planograms will be placed in the floor plan. 
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At the same time as the fixtures are populated, they will annotate with information 
on what planograms have been placed.  

Note: Annotation is controlled using the Text Styles option 
accessed from the Planning Menu in the Administration Module. 

There are two forms of annotation in the above example: 
 Profile Annotation: These are numbers identifying the Bay of the planogram. 

These numbers can be used in conjunction with any aisles drawn in the floor plan 
to determine whether a planogram has been placed in normal or reversed order. 

 Planogram Annotation: This is information identifying the planogram. A 
common way of doing this is via the planogram name.  

Using the Find Option 
The Find option can be found on the Planograms toolbar. It can be used if a store planner 
does not know how to manually navigate to the required planogram. 

 
On clicking the Find icon, the Find Planogram dialog box will appear. 

 
To use this dialog box: 

1. Type a search string into the Find text box. (The text string used implied wild cards). 

2. Click the Find icon 

3. Highlight a planogram in the list returned. 
4. Click OK to be taken to that planogram in the planogram hierarchy in the Object 

Browser. 
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Deleting Planograms 
Deleting Products can only be done from the Object Browser 

Sequence of Actions Required 
There are two potential ways of deleting planograms. The first is to select the required 
fixture first. 

1. Select required fixture or fixtures. 

2. Click the Delete icon 

3. Confirm in the delete Planograms dialog box.  

The alternative is to select the delete option first. 
1. Click the Delete icon  

2. Select required fixture or fixtures. 

3. Confirm in the delete Planograms dialog box. 

Either way is valid. This example will use the latter option of selecting the delete option 
first and the fixtures last. 

Deleting Planograms 
Deleting planograms can be carried out as follows: 

1. Select the Planograms Button on the Merchandising tab of the Object Browser 

 
2. Select the Delete option from the Toolbar 

The next stage is to click Delete Planogram on the toolbar. 

 
3. Selecting Fixtures 
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On clicking Delete Planogram, the command line in Planner will prompt users to 
select fixtures.  

 
These can be selected by standard AutoCAD methods including left clicking 
individual fixtures or using window and crossing selection boxes. In this instance, 
four fixtures have been selected be left clicking, the information being reflected in the 
command line. 

 

Note: Clicking on the planograms themselves will not be 
effective - deleting planograms requires the user to select the 
parent fixtures for the planograms. Accordingly, users should 
left click on the fixture itself or use window and crossing 
selection boxes that encompass both the planogram and its 
parent fixture. 

On right clicking to complete the selection, the Delete Planograms dialog box will 
appear. 

4. Delete Planograms Dialog Box 

The Delete Planograms dialog box allows users to confirm which planograms to 
delete. 

 
 The Radio Button specifying whether to Delete complete instance or Only 

delete from the selected fixtures only applies to planograms. 

– If Delete complete instance is selected, the entire planogram will be deleted, 
even if just a single bay of a multi-bay planogram has been selected. 

– If Only delete from the selected fixtures is selected, only those parts of the 
planogram on the selected fixtures will be deleted. 

Note: Caution should be used when selecting the Only 
delete from the selected fixtures option. This could result in 
some bays of a multi-bay planogram being left in the floor 
plan while others are deleted.  

 Select the required planograms to delete 

 Click OK to delete the specified planograms. 

 The specified planograms will be deleted and the Delete Planograms dialog box 
will close. 
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Note: The Delete Planograms dialog box will always appear if 
two or more planograms are selected. It will also appear if a 
single planogram is selected if the Always show selection dialog 
option is checked in the Merchandising tab of the Configuration 
module. 
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Operations Common to Products and 

Planograms 
Highlighting Options for Merchandise 

There are two highlighting options available for merchandise. 

 Highlight Where Used in Store 

 Highlight Selected Item in Tree 

Selecting Products or Planograms to Highlight 
Selecting whether to highlight products or planograms is done by clicking the 
appropriate button in the Merchandising tab. 

 

Highlight Where Used In Store 
Highlight zone allows a user to find a product or planogram in the floor plan. The option 
has to be turned on by toggling the icon on the product or planogram toolbar so it is 
depressed.  

 
After the icon has been toggled on, highlighting any product in the product hierarchy 
will cause the selected product to be highlighted in the floor plan. Similarly, highlighting 
any planogram in the product hierarchy will cause the selected planogram to be 
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highlighted in the floor plan. The highlighting method will depend on setting in the 
Merchandising tab of the Configuration module. 

Note: It is recommended that the Highlight Where Used in 
Store option be left off until needed - leaving it on may have 
a marginal impact on performance in the floor plan. 

Highlight Selected Item in Tree 
Highlight Selected Item in Tree allows a user to select a product or planogram in the floor 
plan and have it highlighted in the appropriate hierarchy in the Object browser. The 
option has to be turned on by toggling the icon on the Product or Planograms toolbar so 
it is depressed.  

 
Clicking on a product or planogram in the floor plan will then cause that object to be 
highlighted in the hierarchy. 

Note: It is recommended that the Highlight Selected Item in 
Tree option be left off until needed - leaving it on may have 
a marginal impact on performance in the floor plan. 

Find Merchandise in Tree 

Selecting Products or Planograms to Find 
Selecting whether to find products or planograms is done by clicking the appropriate 
button in the Merchandising tab. 

 
Find in Tree allows users to search for product or planogram names in their respective 
Hierarchies. 
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Clicking the icon will bring up the respective Find dialogue boxes. 

 
To use the dialogue box: 

1. Type a text string into the text box 

2. Click on the search Icon 

3. Any product or planogram with a name matching the search string will be listed 
4. To select a product or planogram in the hierarchy, highlight it and click the OK 

button 

Configuring Merchandise Behavior 
The way zones behave can be configured in the Configuration module. To access the 
Zones tab, click Properties on the either the Products or Planograms toolbar. 

 
This will bring up the Merchandising tab of the Configuration module. Settings in this 
tab can have a significant effect on the way merchandise places. 
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Full information on each setting can be found in the Configuration Module User Guide, 
but the following basic settings are helpful for new users: 

Selection Frame 
This frame controls how fixtures are selected for placing merchandise on. Set the 
following: 

 Fixture Selection Method to Standard Selection. 

 Always Show Selection Dialog to On. 

 Select Whole Planogram to On. 

 Sort left-most to On. 

Highlight Frame 
This frame controls how merchandise s highlighted in the floor plan.  
 Set highlight method to Flash. 

Check Rules Frame 
This frame controls the advisory warnings that occur when placing planograms. 

 Set all Check Rules to On with the exception of allow Multiple Profiling. 

Refreshing Merchandise Information 
The Refresh Option causes the respective hierarchical tree in the products or planograms 
window to be updated with any information in the database that has been added or 
edited since the Planner module was opened for the current session. (This is useful if 
work is being carried out in parallel in any other module). 
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Other Information 

Product Studio 
Product Studio can be invoked using the Edit Definition option in the toolbar in the 
Merchandising Tab of the Object Browser. It is used to configure the product 
placeholders that can be placed in the Planner Module. 

 

  

Edit 
Definition 

Product Studio allows the design and editing of product images. These images can be 
arranged in a hierarchy and subsequently used to populate a store. Options within the 
module allow attributes to be assigned to each product, giving it intelligent properties. 

 

Merchandiser 
Merchandiser can be invoked from the Edit Planogram option from the pop-up menu in 
the Object Browser. 
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Merchandiser allows the planograms, and the fixtures on which they have been placed, 
to be viewed in a Virtual Reality (VR) 3D environment. Using the provided controls, the 
Macro Space Management user can ‘fly’ round the VR store. 

Merchandiser is also used to design and edit planograms (and to place them in a 3D 
environment). 
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Planograms can be designed in varying levels of detail. These planograms can be 
arranged in a hierarchy and subsequently used to populate a store. 

System Variables Used in the Merchandising Tab 
There are six system variables that affect the Merchandising Tab: 

1. DEFAULT_MERCH_BLOCK specifies the block to be used as the default when 
populating fixtures in 2D in the Planner environment. 

2. FINGER_GAP specifies the practical tolerance to be allowed above products for 
placing those products on shelves. For example, if the vertical distance between 
shelves is 500 mm, a small gap has to be left for the stackers fingers when they place 
boxes, etc on that shelf. 

3. MERCH_DB_DETAIL specifies whether 2D, 3D or full 3D information should be 
saved to the DB (Merchandising). The more detail that is specified, the more data 
storage capacity will be required. 

4. MERCH_DWG_DETAIL specifies whether 2D, 3D or full 3D information should be 
saved to the drawing. Specifying more detail will result in larger drawing files. 

5. MERCH_TOLERANCE_OVER specifies how much larger a planogram can be 
relative to the nominal size of a fixture and still be placed. 

6. MERCH_TOLERANCE_UNDER specifies how much larger a planogram can be 
relative to the nominal size of a fixture and still be placed. 

Note: The MERCH_DB_DETAIL system variable should be 
defined during the implementation stage and not changed 
frequently. 

Note: Some of these system variables can be changed in both 
the Administration and Configuration Modules. 
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Annotation in Planner 

About Annotation 
Annotation is used to label objects with text within a floor plan. This information then 
assists anyone reading the floor plan with identifying those objects. The example below is 
annotation for a zone. 

 

The example below shows two bay numbered fixtures that have been labelled with three 
forms of information: 

 The fixture name 

 The planogram 

 The bay number for the planogram 

 

The form of the annotation is configured using the Text Styles Administration Tool 
dialog box from the Planning Menu in the Administration Module. 
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Note: See the Administration Module User Guide for 
information on how to configure Text Styles. 

Using Annotation 
Note: For fixtures to annotate, the Include in Fixture 
Annotation check box must be selected for that item of 
equipment in the Category tab of the Block Details dialog 
box in Fixture Studio. 

Annotations can be selected from the Modify>Text menu. Alternatively, the same 
options can be selected from the retail toolbar. 
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Annotate Fixtures 
Fixtures do not automatically annotate when placed in a floor plan. If the Include in 
Fixture Annotation check box has been checked in Fixture Studio, clicking the Annotate 
Fixtures option will cause all valid fixtures to annotate or refresh. 

Annotate Products 
Clicking Annotate Products will cause annotation associated with products and 
planograms to refresh. 

Annotate 
Clicking Annotate will bring up the Annotate dialog box. 

 

 The Refresh button ensures that all recent changes to the annotation rules made 
in the Administration module are updated in Planner. 

 Highlighting an annotation style causes that specific style to be selected for 
updating. 

 The Select>> button takes the user to the floor plan where standard AutoCAD 
methods can be used to select a specific subset of objects for updating. 

 The OK button causes the selected objects to update. 

MSM, ISSC and Markups 
Revision Clouds can be added in both MSM and ISSC.  

Planner Module - Macro Space Management 
There are several ways to add a revision cloud in MSM. The method below is a simple 
one for users not experienced in the full capabilities of AutoCAD. 
1. Ensure the current layer is set to REVISION. This can be done using the Layers 

toolbar.  

2. On the command line, enter the Circle command. Draw a circle of the appropriate 
radius. 

Note: It is also possible to draw revision clouds freehand - 
the result will not be as neat as using the circle command. 
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3. On the command line enter the Revcloud command. 

a. Type S to set the style. Ensure this is set to Normal as the Planner module does 
not recognise the Calligraphy style. 

b. Type A to set the Arc Length. Set the minimum and maximum arc lengths to an 
appropriate value such as 12 inches. 

c. Type O to select the required object. On left clicking the circle, the outline will 
change to that of a revision cloud. 

d. The command line will ask the user whether the revision cloud should be normal 
or reversed: select Normal. 

4. If required, select the revision cloud and type Properties. The color of the line for 
the revision cloud can now be set. 

5. The revision cloud will now look similar to the screenshot below.  

 
6. The revision cloud will currently exist only in the floor plan. To write it to the 
database so it is visible to users in ISSC, open the Synchronize dialog box. Select Match 
the Drawing and ensure that only the Markups option is checked. Click the Synchronize 
button. The information on the revision cloud will now be written to the database. 

 

In-Store Space Collaboration 
Macro Space Management's sister application In-Store Space Collaboration (ISSC) has the 
ability to add two additional forms of annotation to a floor plan; Markups and Revision 
Clouds. 
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The top gondola shows examples of markups, the lower gondola revision clouds. They 
will be imported into MSM when manual or automated synchronisation is carried out. 
To manually synchronize, open the Synchronize dialog box, select the Match the 
Database option and the Markups checkbox. Click the Synchronize button. The 
information on the revision cloud will now be written to the floor plan. 

Note: Users should ensure they understand the effects of 
synchronization before using this functionality. 
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Drawing Comparison 

Overview of Drawing Comparison 
Drawing Comparison can be used to compare the equipment, planograms and product 
categories in two floor plans. This can be done in one of two ways: 

 Comparison between the currently active floor plan and any designated 
prototype store for that floor plan. 

 Comparison between the currently active floor plan and any other currently 
active floor plan. 

Accessing Drawing Comparison 
Drawing Comparison can be accessed in two main ways: 

From the View Menu in Planner 
Drawing Comparison can be accessed from the View Menu.  

 

Alternatively, it can be accessed from the local C:\Program Files\Oracle 
Retail\MSM\Apps directory. 
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Opening Floor Plans with Store Comparison 

Opening Directly from Directory 
If opened directly from the local C:\Program Files\Oracle Retail\MSM\Apps 
directory, there are two ways Store Comparison can behave. These depend on whether 
the Planner Module is open or not. 

Opening without the Planner module being open 
If the Planner module is not open, the Select File dialog box will appear. Highlight   

 

Using Drawing Comparison 
Once the floor plans have been selected, the Drawing Comparison dialog box will 
appear. This can be used to show differences between the selected floor plan and the 
template/prototype store it is being compared with. 
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Menus and Toolbar 

Menu Bar 
There are three Menus - File, View and Reports 

 

File Menu 
This contains the following options: 

 Open opens the Select File dialog box, allowing users to select floor plans to 
compare. 

 Export exports the current set of results to an Excel spreadsheet. 

 Print Preview brings up the Print Preview dialog box. This gives a preview of the 
information to be printed. Users can opt to print the information or exit the 
option. 

 Printer Setup being up a dialog box for changing the default printer and options 
for that printer. 

 Exit causes store Comparison to close. 

View Menu 
This contains the following options: 

 Sort Ascending sorts the data into ascending order. It will be based on the 
column containing the currently highlighted cell.  

 Sort Descending sorts the data into descending order. It will be based on the 
column containing the currently highlighted cell. 

 Refresh updates the results with any changes made in the floor plans since 
Drawing Comparison was opened. Once circumstance where Refresh could be 
used was if a store planner was manually changing planograms in a floor plan so 
that it conformed to those in the prototype store. Refreshing at intervals would 
keep the list of current differences between the floor plans updated. 
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 Enable Docking can be toggled on and off. If docking is On, the Drawing 
Comparison dialog box will dock to the left of Planner, displacing Planner to the 
right to make room. If docking is Off, the Drawing Comparison dialog box can be 
positioned in any convenient location. 

Reports Menu 
The Reports menu allows users to toggle between one of three report modes: 
 Report on difference in placed Planograms between the two selected floor plans. 

 Report in differences in placed Categories between the two selected floor plans.  

 Report in differences in placed Fixtures between the two selected floor plans.  

Note: Reporting on differences between Categories is not 
currently operational. 

Toolbar 
The toolbar contains the following options 

Icon Description   

 

Select Drawings 
to Compare 

This option will open the Select Drawings to Compare dialog box. 
The use can then select the floors plans for comparison. 

 

Print Preview 
This option will bring up the Print Preview dialog box. Users can opt 
to print the information or exit the option. 

 

Display Tree 
View 

This option will cause information to be displayed in a tree (or 
hierarchical) view. 

 

Display List View This option will cause information to be displayed in a list (tabular 
form). 

 

Sort Column in 
Ascending Order 

This will sort the data into ascending order. It will be based on the 
column containing the currently highlighted cell.  

 

Sort Column in 
Descending 
Order 

This will sort the data into descending order. It will be based on the 
column containing the currently highlighted cell. 

 

Show All Values 
This will show all data from the two floor plans being compared. It 
will include data that is identical. 

 

Only Show 
Differences 

This will only show data that differs between the two floor plans 
being compared. 

Using Drawing Comparison 

Tree and List View 
The information may be view in one of two modes depending on user preference. These 
are Tree View (left in the screen shot below) and List View. 
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Users can toggle between the two views by using the appropriate icon in the toolbar. 

Note: in Tree view, the icons change if there are differences 
between the store and the template/prototype. In the screen 
shot above, the tooltip contains the ID of the Planogram 
Group, the last two digits of the planogram code and the 
form of the difference.   

Show All Values or Only Show Differences 
Users can select the amount of information displayed. This can be all items (left in the 
screen shot below) or only the items that differ. 

 

Possible Differences 
There are four types of potential differences between the two selected floor plans. These 
are: 

 Under: The quantity on the store is smaller than the quantity in the 
template/prototype. 

 Over: The quantity on the store is greater than the quantity in the 
template/prototype. 

 Missing: An object is present in the template/prototype that is not present in the 
store. 

 Illegal: An object is present in the store that is not present in the 
template/prototype. 

These differences can apply to: 

 Equipment Placed 
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 Planograms Placed 

 Categories Placed (not operational at present). 
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Validating Floor Plans 

Validating Floor Plans 
Prior to authorizing a floor plan, it should be validated to see if it is optimum.   

Reasons for Validating Floor Plans 

Merchandise Placement Errors 
Compliance is a key issue for retailers. Placing planograms on incompatible fixtures can 
lead to errors in product placement immediately the planogram is set. These placement 
errors can lead to the performance of the planogram being misinterpreted. For example, 
if there are few facings placed than designed for a product, its financial performance will 
be below that intended. An analyst looking at planogram performance might then be 
misled when the planogram is redesigned.  

Merchandise Optimization 
Planograms will generally be placed within a floor plan to meet an overall set of targets. 
An example would be the profitability of categories, aisles, departments and the overall 
floor plan. Forecast results could be calculated and compared to target. Any areas of the 
store falling short of target could then be replanned.  

Other Forms of Validation 
Retailers may have other reasons for validating floor plans meet the overall strategic 
plan. An example if this would be if the retailer was stocking a particular range of 
products as an image builder for the chain. Retailers might then want to validate that the 
placement of these image building products met requirements. 

Methods of Validating Floor Plans 
There are several methods of validating floor plans.  

Quick Reports 
Quick Reports (accessed from the View menu in both Planner and Merchandiser) enable 
the user to get specified results back from the floor plan. Macro Space Management 
comes with a set of pre-configured quick reports that can be used to check either for 
errors or for ways to further optimize the floor plan.  

 Example Quick Reports that can be used to check for errors are those for multi-
placed planograms or unpopulated fixtures. 

 Example Quick Reports that can be used to optimize floor plans include results 
for financial performance - for example planogram space measures. It is then 
possible to check forecast planogram performance against location in the floor 
plan. 

In addition to the pre-configured reports that are supplied, it would be possible to 
configure Quick Reports to meet retailer specific requirements. For example it would be 
possible to create a Quick Report identifying seasonal planograms and their expiry dates. 
It would then be possible to validate that there is a minimum period (say 4 weeks) 
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between the floor plan going into service and the first seasonal planogram requiring 
replacement.  

Key Performance Indicators 
KPIs can be used to visually indicate performance in the current floor plan. As with KPIs, 
MSM comes with a set of pre-configured KPIs that can be used to check either for errors 
or for ways to further optimize the floor plan.  

 Example KPIs that can be used to check for errors are those for planograms on 
fixtures of incorrect length, depth of height. 

 Example KPIs that can be used to optimize floor plans include results for 
financial performance - for example it is possible to show forecast profit and see 
if the high profit planograms are in physical locations that would justify those 
forecasts. 

In addition to the pre-configured KPIs that are supplied, it would be possible to 
configure KPIs to meet retailer specific requirements. For example it would be possible to 
create a KPI identifying all planograms with particular User Defined Attributes. An 
example of this would be UDAs identifying planograms that contain organic food 
products. It would then be possible to visually check the location of all organic products 
within the floor plan to see if they are logically placed in relation to each other. 

BI Publisher Reports 
BI Publisher reports are configured independently of MSM but could be used to give 
overview data on the floor plan. For example, historical data can be used to forecast the 
profitability of each planogram. It would be possible to use this forecast profitability to 
summarize profitability for the floor plan by category, aisle, department and overall. 
Each of these profit results could then be compared to pre-determined targets to see if the 
results are acceptable.  

Business Process for Validating Floor Plans 
The business process for validating floor plan will vary from retailer to retailer. One 
option is to put in a specific status (customizable in the Administration module) 
indicating the floor plan is awaiting validation. After the floor plan has been developed, 
it could be set to ready to validate status. If the floor plan meets requirements, the status 
could then be set to authorized and the floor plan set on the road to going into service.  
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Overview of Merchandiser 

Overview  
Merchandiser can be used to create, edit and review 3D Virtual Reality Stores. 

Merchandiser integrates with other modules in Macro Space Management to enable the 
user to control all aspects of operating a retail organization. 
 Fixtures and fittings can be created and edited in Fixture Studio. 

 Similarly products can be created and edited in Product Studio. 

 Planograms can be either imported or created in Merchandiser. 

Merchandiser can then be used to add, edit or delete equipment in a 3D Virtual Reality 
store. Similarly, Merchandiser can be used to add edit or delete merchandise in a 3D 
Virtual Reality store. 
The results of these activities are stored in the Macro Space Planning database. 

 

Note: The Macro Space Planning database is also used by the 
Planner (AutoCAD) module, which provides an alternative 
way to create and edit store layouts. Macro Space 
Management users may therefore work in which 
environment they find most convenient as the results of 
activities in either environment are stored in the central 
database and are available to the other environment. 

The Merchandiser Window 
The Merchandiser Window has six main parts. 
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The Menu Bar gives access to a series of drop down menus that control many of the 
operations in Merchandiser. 
The Toolbars give access to a further series of commands. 

The Object Browser controls fixturing and merchandising operations, together with the 
display of KPI’s. 

The Object Grid provides an alternative way to place equipment and merchandise. 

The Graphics Window displays a 3D plan of the selected store. 

The Status Bar gives information on current operations. 

Merchandiser Components 
The varying operations within Merchandiser are controlled in one of four ways: from the 
Object Browser and Object Grid, from the Menu Bar, from the toolbars, or using the 
mouse and keyboard. 
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Controls in Merchandiser 

Shortcut Keys 
Shortcut keys are available. These provide alternatives to calling the required function 
from pull down menus of toolbars. 

General Shortcuts 

Shortcut 
Keys 

Also available from: Function 

<Ctrl> + O File pull down Menu or 
Standard Toolbar 

Open Drawing (Via 
Store Manager) 

<Ctrl> + P Standard Toolbar Show Print Preview 

<Ctrl> + <Shift> 
+ C 

File pull down menu Show Configuration 
Module 

<Ctrl> + S File pull down menu Save Drawing 

<Ctrl> + Q File pull down menu Quit Application 

<Ctrl> + N File pull down menu Create New Planogram 

F8 View Menu Show/Hide Object 
Browser 

Delete N/A Delete all selected 
objects 

  

Display Shortcuts 

Shortcut 
Keys 

Also available from: Function 

<Ctrl> + F Edit pull down menu Display Find Dialogue 

<Ctrl> + L Directions and Product 
Text Toolbar 

Display Layers 
Dialogue 

F12 View Menu Take snapshot of 
Virtual Reality Store 

  

Editing Shortcuts 

Shortcut 
Keys 

Also available from: Function 

<Ctrl> + G Edit pull down menu Toggle Group On or 
Group Off 
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Shortcut 
Keys 

Also available from: Function 

<Ctrl> + A Edit pull down menu Select All 

<Ctrl> + E Edit pull down menu Empty selected 
fixture/shelf of 
products 

<Ctrl> + C Edit pull down menu Copy the Selected 
Products to the 
Clipboard 

<Ctrl> + X Edit pull down menu Cut the Selected 
Products and Paste on 
Clipboard 

<Ctrl> + V Edit pull down menu Paste the Selected 
Products onto the 
selected fixture/shelf 

<Ctrl> + Z Edit pull down menu Undo last action 

<Ctrl> + D Edit pull down menu Deselect all selected 
objects 

<Shift> + up or 
down cursor keys 

N/A Move selected shelf up 
or down on parent 
object 

Menu Options 

File Menu 
The File menu gives access to several options. The most important of these are the 
creating and editing of planogram definitions, accessing Store Manager, Printing and 
accessing the Configuration Module. 

 

Edit Menu 
The Edit down menu give access to a series of options mainly concerned with editing. 
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The Undo and Redo options allow the user to undo or redo recent actions. 

Cut, Copy and Paste allow the user to carry out those operations on objects in the 
drawing. 
Select all, De-select all, Empty and Delete enable the user to carry out bulk opera6tions 
on the drawing. 

Group On or Group Off determines how Families and Groups are selected. 

Size Rule allows the user to specify whether on not product size is to be taken into 
account when placing products on shelves. 

View Menu 
The View Options pull down menu allows the user to specify a number of options 
affecting the view on screen. 
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Find enables the user to find an object in the drawing. 

Record Path, Stop Record Path, Replay Path and Delete Path allow the user to configure 
a path specified though the drawing for the purpose of making a Virtual Reality movie of 
the store layout. 

Start Animation Recording, Stop Animation Recording and Replay Last Recorded 
Animation are options concerned with Virtual Reality movies of the store layout. 

Set 4 ViewPorts or Set 1 ViewPort determines how many views of the virtual store are 
available. 

Pivot Around Selected Object enables the user to select an object in the drawing to 
rotate around. 

Products Menu 
The Product pull down menu enables Product Dimensions to be updated. It also allows 
access to Product Studio. 

 

Lights Menu 
The Lights pull down menu calls up the Lights dialogue box 
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This allows the user to specify the lighting arrangements for the store. 

 

Calculate Menu 
The Calculate pull down menu gives access to calculations required for accurate 
reporting. 

 

Calculate Aisle Adjacencies 
This enables the user to determine which merchandise shares an aisle. 

Calculate Areas 
This gives determines how efficiently space in the store has been allocated. 

Calculate Face Planes 
Calculate Face Planes enables users to calculate the respective frontal area of products in 
planograms. 
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Calculate Fixture Adjacencies 
This is used to determine which fixtures are next to which. The information is used for 
calculation and reporting purposes. 

Calculate Product Adjacencies 
This is used to determine which fixtures are next to which. The information is used for 
calculation and reporting purposes. 

Calculate Space Measurements 

Calculate Space Measurements enables users to calculate the respective volumes of 
products in planograms. 

Tools Menu 
The Tools menu gives access to Planogram Substitution functionality. 

 

Window Menu 
The Window menu allows users to arrange multiple store plans (if open) and to select the 
store plan they wish to be active. 

 
The Help Options menu gives access to this help file. 

 
It also allows the version of the software to be checked. 

The Align Products Toolbar 
The Align Products toolbar allows shelves or products to be aligned. 

 

Icon Description 

 

 Align Left 

 

 Align Center 
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Icon Description 

 

 Align Right 

 

 Align Front 

 

 Align Middle 

 

 Align Back 

 

 Justify in X plane 

 

 Justify in Y plane 

 

 Justify in Z Plane 

  

Select shelf or product to 
justify (Icon toggles) 

The Animation Toolbar 
The Animation Toolbar enables the user to make define and store walk through paths 
for taking movies. It also allows users to record movies of the store layout in the Virtual 
Reality Environment. 

 

Icon Description 

 

 Start Recording AVI 

 

 Stop Recording AVI 

 

 Play Recorded AVI 

 

 Start Recording Path 

 

 Stop Recording Path 

 

 Replay Path 



Controls in Merchandiser 

The Directions and Product Text Toolbar  563 

Icon Description 

 

 Delete Path 

 

 Available Recorded Paths 

  

The varying Path options allow the user to set, edit or delete a path along which a 
recording will take place. 
The Recording options allow users to make movies of the Virtual Reality store, either by 
controlling the camera directly, or by setting it to follow a predefined path. 

The Directions and Product Text Toolbar 
The Directions and Product Text Toolbar is mainly concerned with views of selected 
objects. 

 

Icon Description 

 

 Front view of selected object 

 

 Back view of selected object 

 

 Top view of selected object 

 

 Bottom view of selected object 

 

 Left view of selected object 

 

 Right view of selected object 

 

 NW isometric view of selected object 

 

 NE isometric view of selected object 

 

 SE isometric view of selected object 

 

 SW isometric view of selected object 

 

Show product text 
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Icon Description 

 

 Show product text 

 

 Show grid lines form 

 

 Show zones form 

 

 Size rule (Toggle On or Off) 

 

 Layers 

 

 Undo 

 

 Redo 

 

 Explode 

 

 Implode 

  

After an object (or objects) have been selected it may viewed from any of six axes or four 
isometric directions. 

Other options specify whether zones, grid lines, etc., display. 

The Formatting Toolbar 
The Formatting Toolbar has a whole series of options concerning the appearance of 
annotation in the Virtual Reality store. 

 

Icon Description 

 

 Add Label 

 

 Edit Selected 

 

 Delete Selected 
Label 

 

 Bold Text 

 

 Italic Text 
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Icon Description 

 

 Left Justify Text 

 

 Center Justify 
Text 

 

 Right Justify 
Text 

 

 Top Justify Text 

 

 Middle Justify 
Text 

 

 Bottom Justify 
Text 

 

 Text Color 

 

 Background 
Color 

 

 Font Type 

 

 Font Size 

 

 List of Current 
Labels 

The Standard Toolbar 
The Standard toolbar enables the user to carry out a series of common actions. 

 

Icon Description 

 

 New Planogram 

 

 Open Store Manager 

 

 Save Drawing 

 

 Print Options 

 

 Cut 

 

 Copy 
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Icon Description 

 

 Paste 

 

 AutoFill 

  

Options include creating a new planogram, opening Store Manager, Saving and Printing 
the drawing, etc. 

The View Toolbar 
The View Toolbar enables the user to set varying options for viewing the Virtual Reality 
environment. 

 

Icon Description 

 

 Toggle between 1 and 4 ViewPorts 

 

 Synchronize 

 

 Next view 

 

 Clash detection 

 

 Pivot around selected object 

 

 Lock view position 

 

 Lock X axis movement 

 

 Lock Y axis movement 

 

 Lock Z axis movement 

 

 Set movement speed 

 

 Set texture quality 

 

 Set level of detail 
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Icon Description 

 

 Set front clipping plane 

 

 Set back clipping plane 

 

 Light Intensity 

 

  2D Label Viewing Distance 

Options include setting the number of ViewPorts, pivoting around selected objects, 
locking movement in various directions and setting the level and type of detail visible in 
the drawing. 

Note: There are no tooltips for the Movement Speed, Texture 
Quality, Level of Detail, Front Clipping Plane and Back 
Clipping Plane sliders. Instead, they show as prompts 
towards the right hand end of the status bar. 

The Status Bar 
The Status Bar contains a number of options and some useful information 

 

Camera Position 
This is on the left of the status bar. It gives the Cartesian coordinates of the current 
camera position, together with the angle the camera is pointing up or down and the 
horizontal direction it is pointing. 

Floor Plan Options 
These are in the middle position on the status bar. 

 Group On/Off 

Turning Grouping on or off determines the behavior when groups of fixtures (for 
example Gondola runs) are selected. If grouping is On, selecting a single fixture 
will select all associated fixtures - for example an entire gondola run. If Grouping 
is Off, fixtures can be selected one at a time without selecting the whole group. 

 Snap On/Off 

Turning Snap On or Off determines whether the currently selected fixtures will 
attach to the Snap Grid (Grid lines option - View menu) or not. 

 Edit Mode/Walk Mode 

Toggling between Edit Mode and Walk Mode determines whether the user can 
move in the floor plan. If Edit Mode is selected, the user will be fixed to one spot 
in the floor plan. This is convenient for editing shelves and merchandise. If Walk 
Mode is on, then the user can move in the floor plan via the mouse buttons and 
mouse wheel. 

 Connections On/Off 

If Connections are On, connection points will be displayed in the floor plan. If 
Connection Points are Off, then connection points are hidden. 
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Note: If Connection Point display is turned off (after being 
turned on), then the connection points can be hidden by 
pressing the Escape key. 

Selected Item of Equipment 
This is on the right of the status bar. It shows the position of the selected fixture, shelf or 
product. 

 If a fixture is selected, it will give the Fixture ID, together with the coordinates 
relative to the origin of the floor plan. 

 If a shelf is selected, it will give the Shelf ID, together with the coordinates 
relative to the origin of the parent fixture. 

 If a product is selected, it will give the Product ID, together with the coordinates 
relative to the origin of the parent shelf or fixture. 

Movement with the Mouse 
Note: to enable movement in the floor plan, Walk Mode in 
the status bar must be toggled on. If Edit Mode is selected, 
no movement will be possible. 

Movement Speed 
Movement speed in the floor plan is determined by the setting in the Movement speed 
slider control. 

 

Left Mouse Button 
The left mouse button enables users to move forward and back or rotate left and right in 
the floor plan. To do this position the mouse pointer at the appropriate position in the 
floor plan, then hold down the left mouse button. 
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Right Mouse Button 
The left mouse button enables users to move up, down, left or right in the floor plan. To 
do this position the mouse pointer at the appropriate position in the floor plan, then hold 
down the right mouse button. 
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Mouse Wheel 
How the mouse wheel operates depends on whether Walk or Edit mode has been 
selected in the status bar.  

 In Walk mode, rotating the mouse wheel forward or back rotates the viewpoint 
up of down. 

 In Edit mode, rolling the mouse wheel forward or back enables the user to move 
forward or back on the drawing along the currently selected axis of view. 

 Other Movement Options in the Floor Plan 

Pivoting about a Selected Object 
The Pivot About Selected Object option in the View toolbar enables the user to rotate 
about a specific point in the drawing. It is toggled On and Off by clicking on it.  

 

Pivot about Selected Object will only work if one or more objects have been selected in 
the floor plan. Once selected, the user can pivot about the selected objects by holding 
down the left mouse button. They can move forward or back from the selected objects by 
rolling the mouse wheel backwards or forwards. 

Viewing Objects from Specified Directions 
Objects can be viewed from specified directions by clicking on the appropriate icons on 
the Directions and Product Text toolbar.  

 

First, select the objects to be shown by left clicking on them. Next, click on an icon to 
show the specified viewpoint. 

Depending on the icon selected, the selected objects can be shown from the front or back, 
above or below, or left and right. They can also be shown from one of four isometric 
views. 

Locking Movement in Specified Planes 
The View Toolbar contains several controls for restricting the available movement in the 
drawing. 

 

Icon Meaning 

 

Lock View 
Position 

 

Lock X Axis 
Movement 

 

Lock Y Axis 
Movement 
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Icon Meaning 

 

Lock Z Axis 
Movement 

  

The options can be toggled on and off by clicking on them.  

 Lock View Position will freeze the drawing with no movement possible 
 Lock X Axis Movement will freeze the drawing with respect to left and right 

movement. 

 Lock Y Axis Movement will freeze the drawing with respect to forward and back 
movement. 

 Lock Z Axis Movement will freeze the drawing with respect to vertical 
movement. 

Plan View 
The Plan View Option can be activated from the Plan View option on the View pull 
down menu. 

 

This brings up the Plan View window.  
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This shows a plan view of the store and the current position of the camera within the 
store.  

The camera position can be repositioned by holding down the left mouse key and 
dragging it to its new position.  

Selecting and De-selecting Objects 
Objects are best selected when in Edit Mode (status bar). With the user 'fixed' at one 
specific point in the floor plan, objects can be selected by left clicking them. 

Standard Selection Set 
Standard Selection Sets occur when the objects are not in a Group or Family. The first 
object selected for a Standard Selection Set will be enclosed in a red frame. Subsequent 
objects selected for a set of objects will be enclosed in blue frames. 

  

 

Individual objects can be de-selected by left clicking on them with the mouse for a second 
time. All objects in the Standard Selection Set can be de-selected by clicking on the first 
selected object (red frame) for a second time. 
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Family and Group Selection Sets 
Objects that have been put into Families or Groups will be enclosed by yellow and green 
frames. 

 

If Grouping is Off it is also possible that cyan frames will be visible. 

 

If Grouping is On, then all objects in the set can be selected or de-selected by clicking on 
any member of the set. If Grouping is Off, individual objects can be de-selected by left 
clicking on them with the mouse for a second time. All objects in the set can be de-
selected by clicking on the first selected object (yellow frame) for a second time. 

General De-Selection 
All currently selected objects can be de-selected by <Ctrl + D>. 
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Floor Plan Display Options 

Overview of Single and Four ViewPorts 
Merchandiser can be viewed using single or multiple ViewPorts. 

A single ViewPort will just show one image of the floor plan. 

 

Changing to 4 ViewPorts will show four images of the floor plan. 
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These 4 ViewPorts can either be treated as separate entities or they can be synchronized. 

If used as separate entities, they can be used, for example, to move merchandise from one 
set of shelves to another. 

If used while synchronized they can be used, for example to show three different KPI’s 
(Key Performance Indicators), for the same part of the store. 

Setting Up and Switching Between ViewPorts 
When the drawing opens, it will show a single view of the store plan. 

(If 4 ViewPorts were enabled when the drawing was last saved and closed, the top left 
ViewPort will be displayed when the drawing is re-opened). 

Starting/returning to the 4 ViewPorts option can be achieved using the menus or 
toolbars. 
If using the View pull down menu, clicking on Set 4 ViewPorts will change the display 
from one to four viewpoints. 

If the user is already using four viewpoints, then the pull down menu will read Set 1 
view point, enabling the user to toggle back to a single view point. 
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Alternatively, the user can click on the appropriate icon in the toolbar. These will toggle 
between Show 4 ViewPorts and Show 1 viewport. 

The Next View icon toggles between the available views. 

 
  

 

Switch to 4 
ViewPorts 
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Switch to 1 
ViewPort 

 

Next view 

  
  
       

Saving and Restoring ViewPorts 
While working in a Virtual Reality store, it is possible to save ViewPorts for later 
restoration. To do this, the user should select the Windows > Views option from the View 
pull down menu. 

 
This will bring up the Views dialogue box. 
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This enables users either to save or restore specific ViewPorts 

Synchronizing ViewPorts 
The views in the 4 ViewPorts can be synchronized if required. This is achieved from the 
toolbar. 

 
Clicking on the Synchronize icon will immediately switch all four viewpoints to that they 
mirror the viewpoint in the currently active window. 

Clicking on the Synchronize icon again will desynchronize the four viewpoints to that 
they can be manipulated independently. 

Note: If the user has toggled from Show 1 Viewport to Show 
4 ViewPorts and 3 ViewPorts are blank, clicking on the 
synchronize icon is a quick way of populating the blank 
ViewPorts with views. 

Overview of Object Display 
The way objects display in a store plan can be changed in three ways in Merchandiser. 

The drawing is subdivided into layers and each class of object (fixture, fitting, product, 
etc), has its own specific layer. By changing the properties of the layer, the user can 
change how the objects on that layer display. 

Locking the Layer 
Locking the layer prevents objects on that layer being moved or deleted. 

Changing the Visibility 
It is possible to turn layers on or off. If a layer is turned on objects on it are visible. If a 
layer is turned off, they are hidden. 

Changing the Transparency 
The transparency values for a layer (and the objects on that layer) can be changed 
anywhere within a range of 0% - 100%. If the transparency is set to 0%, objects are 
completely opaque. If the transparency is set to 100% objects are completely transparent. 
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Overview of Locking Objects 
It is possible to lock objects so that they cannot be altered when in place in the 
Merchandiser environment. 

This is done by using the locking option in the Layers dialogue box, accessible from the 
View toolbar 

 

 

This shows the layers and whether they are locked or not. 

  

Icon Description 

 

Layer unlocked 

 

Layer locked. 

  

The lock for each layer can be toggled on or off by clicking on the appropriate icon. 
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Note: Depending on the system variable settings, some 
layers will be automatically locked depending on which 
Object Browser tab the user is in. 

If the system variable is enabled, when in the Fixturing Tab, all layers associated with 
merchandising are locked. Similarly, when in the Merchandising Tab, all layers 
associated with fixturing are locked. 

LOCK_OBJECTS_ON TAB_CHANGE System Variable 
The LOCK_OBJECTS_ON_TAB_CHANGE system variable is accessed from General 
Menu in the Administration Module. 

 

This brings up the System Variables dialogue box. 

 

LOCK_OBJECTS_ON_TAB_CHANGE can be set to 0 or 1. 

If set to 0, the layers will not be locked when changing from the Fixturing to the 
Merchandising Tabs and vice versa. 
If set to 1, the layers will be automatically locked. 

Note: Changing (and especially deleting) system variables 
can have a significant effect on the way Macro Space 
Management operates. It is recommended that Macro Space 
Management users consult their System Administrator or 
consult Oracle’s Technical Support Team. 
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Locking Objects 
Locking of specific classes of objects is achieved by locking the layers that those objects 
are placed on. 
The layer for the majority of objects, such as fixtures, fittings and shelves, will be 
determined when the object is created in Fixture Studio: 

 

Note: Layers selected for classes of objects should be 
consistent. If they are not then only some of the class of 
objects will be locked when a specific layer is turned off. 

Layers for zones will be determined by the Zone Type. 

Fixtures and fittings should be placed on specifically defined and consistent layers. 

Products are placed on their own specific layer. 
Locking layers is particularly useful for any object that is on the building layer, i.e. 
pillars, which should not be modified in the Merchandiser environment. 

Locked objects can still be selected, so that properties can be determined, etc. 

When locked objects are selected, a small warning will appear at the bottom of the 
screen. 
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Note: If objects are locked, then they cannot be deleted, 
moved, etc. If it is desired to do this, the layer must first be 
unlocked. 

Changing the Transparency and Visibility of Objects 
The transparency and visibility of objects can be changed in the floor plan. This is done 
by using the options in the Layers dialogue box, accessible from the View toolbar. 

 

 

Changing the Visibility of Objects 
When objects are placed in a Merchandiser floor plan they go onto a specific layer in that 
floor plan. For example fixtures go on the FIXTURES layer, Fixture Text on the FIXTURE-
TEXT layer. The layer can be turned on or off. If the layer is turned off, that layer and all 
the objects on it will no longer be visible in the floor plan. They can be restored to view 
by turning the layer back on.  

Icon Description 

 

Layer turned on 

 

Layer turned off 

If is desired to show fixtures without any accompanying text, the FIXTURES layer can be 
left turned on, while the FIXTURE-TEXT layer can be turned off. The fixture text can be 
returned to view at any time by turning the FIXTURE-TEXT layer back on. 

Changing the Transparency of Objects 
The transparency of objects can also be modified in the Layers dialog box. Each specific 
layer can have its transparency set to any value from 0 (completely opaque) to 100 
(completely transparent). In the example below, a fixture and its shelves and products 
are shown fully opaque and then 75% transparent. 
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54 
Styles in Merchandiser 

Overview of Styles 
Styles are used to define whether different types of objects fit together. They can be used 
to specify (for example) whether a shelf will fit on a fixture, or whether a product can be 
placed on a shelf. 
Using Styles in Merchandiser requires settings to be configured in the Administration, 
Fixture Studio and Product Studio Modules, as well as in Merchandiser. 

 

Each of these steps is discussed in more detail in the following topics. 
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Configuring Styles 

Configuring Styles 
Styles can be configured from within the Administration Module. 

Note: The Administration Module is only accessible to those 
with Administrator's privileges. 

To access Styles, select the Styles option from the Edit pull down menu. 

 

This will bring up the Styles dialogue box, which can be used to configure styles and the 
relationships between them. 

 

Styles Tab 
This allows Styles to be added or deleted from the list of available styles. 
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Style Relationships Tab 
This allows relationships to be set up between different types of styles. 

Test Tab 
This is used to test what product styles can be placed on equipment and what equipment 
specific products can be placed on. 

Adding and Deleting Styles 
Adding or Deleting Styles is done by using the Style tab in the Styles dialogue box 
accessed from the Administration Module. 

 

  

Icon Description 

 

Add style 

 

Delete style 

Adding a Style 
To add a style, click on the Add Style icon. A new line will be added in the styles table. 
The Style ID is a fixed, sequential number allocated when the style is created. 

The Name and Description will initially read Style11 and Description21, where the 
number is that of the style being created. These can be edited to the style name and 
description required. 

The Style type can be selected from a drop down list. 
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Tip: Fixture, Shelf and Product styles are in current use. 
Module style has yet to be implemented. 

Deleting a Style 
Styles can be deleted by highlighting a style and clicking on the Delete Style icon. 

If not in use, the style will be deleted. 
If in use, a warning will appear. 

 

Adding and Deleting Style Relationships 
Style Relationships can be added and deleted by using the Style Relationships tab in the 
Styles dialogue box accessed from the Administration Module. 
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Icon Description 

 

Add style 
relationship 

 

Delete style 
relationship 

Adding a Style Relationship 
To add a style relationship, first select the style types which it is desired to set up a 
relationship with. 

This can be done from the drop down lists – for example it might be required to associate 
a Shelf style with a Product style. 

Next, select the specific types of styles from the lists provided – for example it might be 
required to associate the Pallet Shelf Style with the Multipack product style. 

Finally, click on the Add Style Relationship icon to add the relationship. It will then 
appear in the list of current relationships. 

Deleting a Style Relationship 
Styles relationships can be deleted by highlighting a style and clicking on the Delete Style 
Relationship icon. 

Note: Style relationships in use can be deleted without any 
warning being given. 

This will not affect any objects placed before the relationship was deleted, but if further 
objects are to be placed using this relationship, it must be reinstated before they are. 

Adding and Deleting Joints 
Adding and Deleting Joints is done by using the Style Relationships tab in the Styles 
dialogue box. 



Assigning Fixture, Shelf and Product Styles 

Configuring Styles  589 

 
  

Icon Description 

 

Add joint relationship 

 

Delete joint 
relationship 

  

Adding a Joint 
To add a joint, first select the style types which it is desired to set up a relationship with. 

First select Fixture Style in the left hand drop down list. Next select Product Style in the 
central drop down list. Finally select Shelf Style in the right hand drop down list. Next 
highlight the required styles in each of the three lists. (For example Metal as a Fixture 
Style, Hung as a Display Style and Peg as a Shelf Style. Finally, click on the Add Joint 
Relationship icon to add the relationship. It will then appear in the list of current 
relationships. 

Deleting a Joint 
Joints can be deleted by highlighting a style and clicking on the Delete Style Relationship 
icon. 



Configuring Styles  

590 Oracle Retail Store Planner's User Guide 

Note: Joints in use can be deleted without any warning 
being given. This will not affect any objects placed before the 
relationship was deleted, but if further objects are to be 
placed using this relationship, it must be reinstated before 
they are. 

Testing Style Relationships 
Testing Style Relationships is done by using the Test tab in the Styles dialogue box. 

 

Equipment 
To see which product styles are associated with an item of equipment, click on that item 
of equipment in the list of available equipment. 

The list of associated product styles will then display. 

Note: The list of equipment can be sorted in ascending or 
descending order by clicking on the column headers. 

Products 
To see which equipment styles are associated with a product, click on that product in the 
list of available products. 

The list of associated equipment styles will then display. 

Products can be found by entering the product name or code and clicking on the search 
icon. 

Note: The list of products can be also sorted in ascending or 
descending order by clicking on the column headers. 
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Joints 
Joints can only be tested by trail placements on equipment. 
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Types of Styles 
There are three broad classes of style (although others can be defined). 

 Fixture styles 

 Shelf styles 

 Product styles 

In additions there are: 

 Joints 

 

FIXTURE 

Fixture style Shelf style Product style 

Fixtures must have one or 
more fixture styles. 

The Fixture Style 
Relationships determine 
what shelves and products 
it can accept.   

If shelving is to be placed 
on the fixture then a style 
relationship must exist 
between the assigned 
fixture style and the 
required shelf style. 

For products to be placed a 
fixture, a style relationship 
must exist between the 
assigned Fixture Style and 
the required Product Style. 

 

SHELF 

Fixture style Shelf style Product style 

For shelves to be placed on 
a fixture, a style 
relationship must exist 
between the assigned Shelf 
Style and the required 
Fixture Style. 

Shelves must have one or 
more Shelf Styles. 

The Shelf Style 
Relationships determine 
what equipment the shelf 
can be placed on and what 
products it can accept.   

For products to be placed 
on the shelf, a style 
relationship must exist 
between the assigned Shelf 
Style and the required 
Product Style. 

 

PRODUCT 

Fixture style Shelf style Product style 

For products to be placed a 
fixture, a style relationship 
must exist between the 
assigned Fixture Style and 
the required Product Style. 

For products to be placed 
on the shelf, a style 
relationship must exist 
between the assigned Shelf 
Style and the required 
Product Style. 

Products must have one or 
more product styles. 

The Product Style 
Relationships determine 
what equipment and 
shelves the product can be 
placed on.   
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Note: Products can only be assigned styles at the Display 
Level. They cannot be assigned styles at SKU level and 
above. 

 

JOINT 

Allows products to be placed directly on fixtures, placing at the same time the 
associated shelf object. 

Fixture style Product style Shelf style 

For products to be placed a 
fixture, a style relationship 
(using a joint) must exist 
between the assigned 
Fixture Style and the 
required Shelf style. 

For products to be placed 
on the shelf, a style 
relationship (using a joint) 
must exist between the 
assigned Shelf Style and 
the required Product Style. 

Products must have one or 
more product styles. 

  

The Product Style 
Relationships determine 
what equipment and 
shelves the product can be 
placed on.   

When creating a joint, if a fixture-shelf style relationship similar to the type being 
defined already exists it must be deleted before the joint (a combination of fixture, 
product and shelf styles) can be created.   

Example 
In the following Style Relationship (created in Administration) fixtures that have a 
Fixture Style of Metal assigned can accept shelves that have had an Open Shelf, Heavy 
Duty Shelf or Lateral Rod Shelf Style assigned. 
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Conversely, if a shelf has only had a Peg Slatted Style assigned it cannot be placed on a 
Fixture that has only has a Fixture Style of Metal assigned. 

Fixture Styles 
Each fixture should be associated with one or more Fixture Styles. 

An example of a fixture style might be ‘Metal’. This style might also be associated with 
fitting and shelves and can be used to indicate that particular items of equipment can be 
fitted together. 
If product is to be placed directly on any fixture, it also requires a shelf style. 

Shelf Styles 
Each shelf must be associated with one or more Fixture Styles and also one or more Shelf 
Styles. 

The Fixture Style is used to ensure the shelf fits onto a compatible fixture. 

The Shelf Style only allows products with compatible styles to be placed. 

Product Styles 
Each product must be associated with one or more product styles. These product styles 
will determine the compatible shelves the product can be placed on. 

For example shirts could be available in both Hung and Folded Product (Display) Styles. 

If a product is dragged into a shelf at item level then it will automatically select the 
correct Product Style. For example if shirts are dragged into an open shelf, they will be 
placed as Folded Shirts. If shirts are dragged onto a peg or bar, then they will be placed 
as Hung Shirts. 

If product is dragged onto a shelf at Display Level then it can only be placed on 
equipment compatible with that style. For example Folded shirts cannot be placed onto a 
bar. 

Adding Styles in Admin Module 
To add styles to the available list, open the Styles option in the Administration Module. 
Use the Style Tab and click on the Add Style Icon (circled). 
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This will add another line to the information grid (circled). 

 

Edit this line until it has the desired information. 
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Other styles can be added as required. Finally, exit to save the styles. 

Warning: There is a known issue with the Styles option at 
present. Information is temporarily lost if a second style is 
added immediately after the first. To overcome this close the 
Styles dialogue box after each style is added and then re-
open it to add the next. 

Setting up Style Relationships in Admin Module 
To Add Style Relationships to the available list, open the Styles option in the 
Administration Module. Click on the Style Relationship Tab. 
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Set the options as required. 

 

Set the first of the Style Types to Shelf Style and the other to Product Style. Next, select 
the Peg style from the list of the available Shelf styles and the Railed Product style from 
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the list of the available product styles. Finally, click on the Add Style Relationship icon. 
This will cause the Style to be added to the list of available Style relationships. 

 

This means we can put these Railed Product styles of product onto any shelf object 
assigned the Peg style. 

Note: If we need place products directly onto a fixture, a 
Style Relationship would be required between the Fixtures 
Style and the Product Style. 

An example of this would be putting products of Boxed Style onto fixtures of Pallet Style. 

Adding Style to Fixture in Fixture Studio Module 
To Add a Fixture Style to a fixture, open Fixture Studio. Select the required fixture and 
right click to bring up the pop-up menu. 
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Click on Edit Block. This will bring up the block details dialogue box. Select the 
Fixture/Styles Tab. 

 

To add a Fixture Style (or styles) select the required style(s) from the  list of available 
styles and move then over to the list of selected styles using the > arrow. 
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This means this fixture will now accept any shelves or products that have Style 
Relationships with the Fixture - Batteries Fixture Style. 

Adding Styles to Shelf in Fixture Studio Module 
To Add Fixture and Shelf Styles to a shelf, open Fixture Studio. Select the required shelf 
and right click to bring up the pop-up menu. 
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Click on Edit Block. This will bring up the block details dialogue box. Select the 
Fixture/Styles Tab. 

 

To add a Fixture Style (or styles) and a Shelf Style (or styles) select the required style(s) 
from the  list of available styles and move then over to the list of selected styles using the 
> arrow. 
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This means this shelf will now accept any fixtures or products that have style 
relationships with the Shelf - Batteries Shelf Style. 

Similarly, a Fixture style can be selected to determine what fixtures the shelf can be 
placed on.   

Testing Style Relationship 
Testing Style Relationships is done by using the Test tab in the Styles dialogue box. 
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Equipment 
To see which product styles are associated with an item of equipment, click on that item 
of equipment in the list of available equipment. 

The list of associated product styles will then display. 

Note: The list of equipment can be sorted in ascending or 
descending order by clicking on the column headers. 

Products 
Product can be found by entering the product name or code and clicking on the search 
icon. 

Note: Be as specific as possible in the search. The fewer 
items selected in the search, the faster the software will find 
the associated styles. 

To see which equipment styles are associated with a product, click on that product in the 
list of available products. 
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The list of associated equipment styles will then display in the highlighted box to the 
right. 

Note: The list of products can be also sorted in ascending or 
descending order by clicking on the column headers. 

Joints 
Joints cannot be tested in the Test Tab - they can only be verified by placing them on an 
item of equipment. 

Assigning Fixtures and Shelf Styles 
Styles can be assigned to fixtures and shelves from within Fixture Studio by highlighting 
them in the hierarchy and right clicking to bring up the pop up menu. 
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Clicking on Edit Block will bring up the Block Details dialogue box. The Styles/Ranges 
tab can then be used to specify the available styles for a particular object. 

 

Styles can then be assigned or removed using the < and > arrows. 

Note: A shelf object will require a fixture style to ensure it 
can be assigned to fixtures, and a shelf style to allow product 
to be assigned to it. 
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Adding Style to Product in Product Studio 
To Add a Product Style to a product, open Product Studio. Select the required product 
and right click to bring up the pop-up menu. 

Note: Products can only be assigned styles at the Display 
Level. They cannot be assigned styles at SKU level and 
above. 

 

Click on Edit. This will bring up the Product Display Style dialogue box. Select the Styles 
Tab. 
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To add a Product Style (or styles) select the required style(s) from the list of available 
styles and move then over to the list of selected styles using the appropriate icon. 

Assigning Product Styles 

Note: Products can only be assigned styles at the Display 
Level. They cannot be assigned styles at SKU level and 
above. 

Styles can be assigned to Products from within Product Studio by highlighting them in 
the hierarchy and right clicking to bring up the pop up menu. 

 
Clicking on Edit will bring up the Product Display Style dialogue box. The Styles tab can 
then be used to specify the available styles for a particular product. 
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Styles can then be assigned or removed using the appropriate icons.     
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55 
Using Styles in Merchandiser 

Placing Fixtures 
Primary Fixtures can be placed without reference to their assigned Styles. The only 
criteria for placing fixtures are that they have been assigned a primary object that places 
at floor level.    

Placing Shelf Objects 
Shelf Objects can only be placed if they meet two criteria. 

Connection 
Points 

The connections points assigned to the shelf must be compatible 
with the connection points assigned to the fixture it is to be placed 
on. 

Styles. The Fixture Style assigned to the shelf must be compatible with the 
Fixture Style assigned to the fixture it is to be placed on. 

Setting Preferred Styles 
Because some objects can be associated with multiple styles, specific instances of shelves 
within the drawing can be given preferred styles. 

For instance, a shelf could be associated with both a Stock shelf style as well as a 
Presentation shelf style; two display styles may then be defined for a particular product, 
a Display product style and a Boxed product style. 

The Stock shelf style would be linked with the Boxed product style, and the Presentation 
shelf style would be linked with the Display product style. This would allow both the 
Boxed and Display version of the product to be placed on the shelf. 
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However, the user would be able to indicate the preferred style for a particular instance 
of a shelf as being Presentation, which would force the Display product to be placed for 
that particular shelf. 

 

Using Preferred Styles 
Preferred styles can be specified for a specific shelf or shelves by selecting those 
required. This is done by holding down the <Ctrl> key and left clicking on the desired 
shelves. The first instance of a selected shelf will be highlighted in Red, subsequent ones 
in blue. 
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Holding down the <Ctrl> key and right clicking will then bring up the pop-up Menu. 
Clicking on the Edit option will bring up the Edit Shelves dialogue box. 

 

This can be used to set the preferences for that specific shelf or shelves. 

If different types of shelves have been included in a multiple shelf selection, only 
preference types common to the different types will be shown. 

If there are no common preference types, then the field in the preferences box will be 
blank. 

Using Styles 
The diagram below indicates how styles interrelate. 
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The fixture has been assigned a Metal Fixture Style. 

The Open Shelf, Peg Board and Hanging Rod shelf objects have all been assigned Metal 
Fixture styles. This means any of these three types of shelf object can be placed on the 
fixture. If another type of shelf object (for example a slatted back panel) had been 
assigned the Lozier fixture style, it would not have a fixture style compatible with that 
assigned to the fixture itself, and could not be assigned to that fixture. The Open Shelf, 
Peg Board and Hanging Rod shelf objects have also all been assigned appropriate shelf 
styles. 
The varying types of products have been assigned product styles. For example shirts 
have been assigned Boxed, Folded and Hung product styles. These styles determine what 
form of shelf object shift can be placed on. For example shirts with a Hung product style 
can only be placed on Hanging Rods. Conversely, the Open Shelf has been configured to 
accept both Boxed and Folded shirt styles. Ties only have Pegged product style and are 
restricted to the Peg Board. 

Note: Where an object has multiple styles they can set in 
order of preference using preferred styles. 
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56 
Planogram Printing 

Overview of Planogram Printing 
Planogram Printing allows users to select planograms in the currently active floor plan 
and print out information on the ones they have permissions to print. 

Note: Users wishing to Publish the planogram design plan 
(output it in electronic or hard copy form with permanent 
changes) should use the Immediate Planogram Publishing 
option from the File menu. 

Note: the default settings for this dialog box are derived 
from settings in the Planogram Publishing Configuration 
dialog box in the Administration module. 

 

The basic method of operation is as follows: 
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1. Administration Module 

Within the Administration Module: 

 The planogram users have permissions to print are assigned in the Data Security 
dialog box - Planograms Tab. 

 The fields that display in the Filtering Tab of the Print Planograms dialog box are 
configured in the Custom SQL dialog box. 

 Planograms can be printed using report templates specified in the Report 
Designer module. Permission to access this module is specified in the Functional 
Security dialog box. 

These settings determine what will appear in the Print Planograms dialog box (and the 
reports that will be available) when it is accessed in the Planner and Merchandiser 
modules. 

Note: In order to access the Administration Module, users 
must have permission to do so. 

2. Planner Module 

The Print Planograms dialog box may be accessed from the File Menu - a floor plan 
containing planograms must previously have been opened. Users with permissions 
to access the Planner module automatically have permission to use the functionality. 

3. Merchandiser Module 

The Print Planograms dialog box may be accessed from the File > Print Menu - a 
floor plan containing planograms must previously have been opened. Users with 
permissions to access the Merchandiser module automatically have permission to 
use the functionality. 

4. Report Designer 

The Report Designer module is used to design report templates that can be specified 
for use in the Print Planograms dialog box. Permissions to access this module are 
assigned in the Functional Security dialog box in the Administration module. 
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Using Planogram Printing 
The functionality is used as follows: 

3. A floor plan containing planograms is opened in the Planner or Merchandiser 
module. 

4. The Print Planogram option is selected from the File menu in the Planner or 
Merchandiser module. 

5. The appropriate planograms are selected in the Filtering tab of the Print Planograms 
dialog box. 

6. The report to use is specified in the Templates tab. 

7. The sequence the selected floor plans are to be printed in is specified in the Collation 
Tab. 

8. On clicking the Print button, the selected planogram reports will be printed on the 
default printer associated with the user's computer. 

Accessing the Print Planogram Functionality 
Note: before accessing the Print Planogram functionality, 
users should open a floor plan containing planograms. 

The Print Planogram functionality is accessed from the File Menu > Plot option. Users 
with permissions to access the Planner module will automatically have permission to use 
the functionality. 

 

Opening State of Functionality 
When the Print Planogram dialog box opens it will be populated with all planograms in 
the currently active floor plan. By default, they will be checked for selection. 
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Note: the columns that are displayed in the dialog box are 
configurable in the Custom SQL option available from the 
General Menu in the Administration module. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 

 

They are used as follows: 
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 Show All - this option shows all results. 

 Custom Filter - this option allows users to set filters using Boolean logic. The 
options are: 

– Equal to: will return rows that are an exact match for the entered text. 

– Not Equal to: will return rows that do not match the text string 

– Contains: will return rows where part of the data matches the text string. 
(Uses implied wild cards). 

– Does not contain: will return rows where no part of the data matches the 
text string. (Uses implied wild cards). 

– Begins with: will return rows where the text string is an exact match for the 
start of the data. 

– Ends with: will return rows where the text string is an exact match for the 
end of the data. 

– Does not begin with: will return rows where the text string is not an exact 
match for the start of the data. 

– Does not end with: will return rows where the text string is not an exact 
match for the end of the data. 

 Blanks - column will be filtered to only show rows with null values. 
 Non-Blanks - column will be filtered to only show rows containing a value 

 Results - column will be filtered to only show the selected result. 

The Templates Tab 
The Templates Tab allows users to specify the template format to be used when printing 
planogram designs. 

IMPORTANT NOTE: There is a known issue with 
planogram templates. The Planogram Publishing 
Configuration dialog box in the Macro Space Management 
Administration Module has an option to print associated 
planogram documents. At present this option is not 
available in the Print Planogram dialog box. Accordingly, 
the Template Tab in the Planogram Publishing 
Configuration dialog box should have the option set to Use 
Template. 
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The user can use a radio button to specify the form the report will take: an imported 
'associated planogram document' or a template that is configured in the Report Designer 
Module. 

1. Use Associated Planogram document - this option publishes the planogram design 
information using a pre-generated report using one of the following file formats: 
BMP, GIF, JPEG, JPG, PDF, PNG, TIFF or WMF. This report will be imported when a 
planogram is imported using Oracle Data Integrator (ODI). The Associated 
Document (if available) is specified in the Associated Document text box in the 
Details tab of the Planogram Design dialog box in the Merchandiser module. 



The Templates Tab  

618 Oracle Retail Store Planner's User Guide 

 

There are two options (selected using the radio button) for when the pre-generated 
report is missing. 

 Write an error to the AVTTB_PUBLISH_POG_LOG table. Information in this 
table can be read by means of a BI Publisher report or similar. 

 Use the default Report Designer template. 
2. Use Template - this option allows the user to define the way the template from the 

Report Designer module is selected. There are two options (selected using the radio 
button): 

 Use Planograms preferred template, if defined - this option is specified in the 
Preferred Template drop down list in the Details tab of the Planogram Design 
dialog box in the Merchandiser module. 

 Use Selected Template from List Below - this option can be set by checking items 
in the list of available templates. One or more templates may be selected. If 
multiple templates are selected, the name of the template will be added to the file 
name in brackets - for example 1_Bay_Mixed_Fizzy_Drinks (Basic Planogram 
Report).pdf 

If necessary, the list of templates can be searched by entering a text string into the 
drop down list, then clicking the Find button. (Actual or implied wild cards can be 
used). Each click of the Find button will cause the search engine to move forward 
through the matching results until no results are left. 

Note: the last 10 text searches can be selected using the drop 
down list in the text box. 
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The Filtering Tab 
The Filtering tab enables the user to select the Planograms to print. It will populate with 
all planograms in the currently active floor plan. 

Note: If there are multiple instances of a planogram in a 
floor plan, only a single entry will appear in the list of 
planograms. 

The Filtering tab returns a list of all planograms in the database. If only specific zones 
have been loaded into the floor plan when it was opened, the Filtering tab will also 
contain the planograms in the zones that were not loaded. 

Note: the option to only load specific zones is controlled by 
the Express Load option in the Merchandiser tab of the 
Configuration module. 

 

Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 
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Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in 
this position 

# Any number in this 
position 

If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*wine*' and will find I Bay Red Wine, 1 Bay White 
Wine, etc. 

Pick (Planner Only) 
Pick takes the user to the currently active floor plan. They can then use AutoCAD 
selection methods to select specific planograms. When the AutoCAD selection is 
completed with a right mouse click, the user will be returned to the Print Planogram 
dialog box and the dialog box will populate with the selected planograms. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 

 Select All will select (but not check) all rows of data 

 Clear All will deselect (but not uncheck) all rows of data 

 Check Selected will check all rows of selected data 
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 Uncheck Selected will uncheck all rows of selected data 

 Check All will check all rows of data 

 Uncheck All will uncheck all rows of data 

 Paste allows users to paste a carriage returned list of floor plan identifiers from 
the Windows clipboard. All rows in the dialog box that match the pasted 
information will be checked. 

Selecting Planograms to Print 
Planograms may be selected for printing by ticking the appropriate check box. 

The Collation Tab 
The Collation Tab allows users to specify the sequence the planogram designs will be 
published or printed in. Its main use is in printing hard copy versions of the designs 
where the sequence they are printed in makes it easier to sort and distribute them after 
printing. 

At least one collation option must be selected, or the tab will show as having an error. 

 

The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 

 Region is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 District is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 
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 Store Number is the Store Code in the Store dialog box in Store Manager. 

 Store Name is the Store Name in the Store dialog box in Store Manager. 

 

 Department is the department (zone) in the floor plan the planogram is 
associated with. 

 Aisle is the aisle the planogram is associated with. For this option to operate, 
aisles must first be drawn in the floor plan in the Planner module. In the example 
below, Aisle F-1 has been drawn between two runs of fixtures. 
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 Bay Number is the bay number associated with the fixtures the planogram is 
placed on. For this option to operate, the fixtures in the floor plan must 
previously have been bay numbered. 

 

 Bay Group is the Name assigned to a number of fixtures sharing a common 
characteristic. It is assigned in the Name field of the Bay Numbering dialog box 
in the Planner module. 

 

 Planogram Name is the name of the planogram. This is set in the Name field of 
the Planogram Design dialog box in Merchandiser. 
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 Planogram Code is the code for the planogram. This is set in the Client Code 
field of the Planogram Design dialog box in Merchandiser. 

 

Errors and Results 
If any settings in the Print Planograms dialog box will lead to errors during printing, an 
error symbol will be displayed on the tab containing the data with the problem. The Print 
button will also be grayed out and unavailable. 
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Users must correct the problems before the Print button will activate. 

The results from Floor Plan printing are stored in two tables within the database. These 
results can be viewed via reports generated from BI Publisher (or similar software). 
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Planogram Publishing 

Overview of Planogram Publishing 
Note: The way that planogram publishing performs in the 
Planner and Merchandiser modules is dependent of settings 
in other modules. This section is included so that users of the 
Planogram Publishing Functionality can discuss requested 
changes with the Administrators. 

Note: the default settings for the Planogram Publishing 
dialog box are derived from settings in the Planogram 
Publishing Configuration dialog box in the Administration 
module. 

The purpose of publishing a planogram is to disseminate information on the type, 
quantity and location of shelves and merchandise to those tasked with implementing the 
change. Publishing a planogram design can be done in hard copy or electronic format. 
The date at which this is executed depends on the Publish Date set in the Details tab of 
the Planogram Design dialog box in the Merchandiser module. 
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The Planogram Publishing functionality is used to disseminate planogram designs to 
specified printers or Windows folders to facilitate implementing those planogram 
designs. 

Note: a retail organization will still need a method of 
distributing the planogram designs from the printer or 
Windows folder to the end user. 

The basic method of operation is as follows: 

 

1. Administration Module 

The Administration module is used to configure access to the different parts of the 
functionality. It is also used to assign permissions to print or publish specific floor 
plans and planograms. Finally, it is used to configure how the batch processes for 
publishing floor plans will work. There are three options that affect publishing and 
printing of floor plans. 
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 The Functional Security option (Security menu) allows Administrators to control 
who can run Planogram Publishing as a batch process. It also controls who can 
access Immediate Planogram Publishing in the Planner Module. It also allows 
Administrators to control who can access Report Designer to create report 
templates for publishing planogram designs. 

 The Data Security option (Security menu) allows Administrators to control what 
planograms a user can print or publish from in the Planner and Merchandiser 
modules (and in In-Store Space Collaboration). 

 The Custom Query dialog box allows an Administrator to specify what fields 
will appear in the Immediate Planogram Publish dialog box in the Planner 
module. 

15. Configuring Outputs for Batch Process 

The outputs for the batch process output of Planograms are configured in the 
administration module using the Planogram Publishing Configuration dialog box. 

16. Running as a Batch Processes 

Planogram Publishing ban be run as a batch process - typically run overnight so that 
this processor hungry tasks can be executed without affecting the manual users of 
the system. The settings determining how this operates are set in the Planogram 
Publishing Configuration dialog box. 

The rights to do this are set in Functional Security in the Administration Module. 
17. Planner Module 

Within the Planner module, the Immediate Publishing of Floor Plans functionality 
can only be used by users for whom permissions have been granted in the 
Administration module. 

18. Merchandiser Module 

Within the Merchandiser module, the Immediate Publishing of Floor Plans 
functionality can only be used by users for whom permissions have been granted in 
the Administration module. 

19. Report Designer 

Report Designer can be used to create report templates that determine the format the 
planogram design is published in. 

20. Other Functionality 

There are three other items of functionality that affect planogram publishing. 

 Configuration Module - the Directories tab allows users to specify where the 
root folders holding published planograms are located. Sub-folders holding 
specific planograms will be created as children of this root folder. 

 Tables in the Macro Space Planning database hold the results of planogram 
publishing operations. 

 BI Publisher (or a similar application) can be used to generate reports based on 
the information held in the database - for example the names and results of 
planograms that have been published. 

Permissions to Run Immediate Planogram Publishing 
Before a user can run Immediate Planogram Publishing, they must first have been 
assigned the appropriate permissions in the Administration module. This is done using 
the Functional Security dialog box accessed from the Security menu. 
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Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 

 

Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In the example above, the 
Merchandise Planning Manager User Group has been assigned permission to use the 
Planogram Publishing functionality. 

The User Groups precise rights depend on settings in the Permissions dialog box. This is 
accessed from the right click menu in the Functional Security dialog box. 

 

This will bring up the Permissions dialog box. 
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1. If the User Group belongs to a Command Group higher in the Command Group 
hierarchy, by default it will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the selections 
made using the check boxes. 

2. If the User Group only exists at this level in the hierarchy, the Permissions dialog box 
will initially have all check boxes blank. The Administrator must then assign Allow 
of Deny permissions.   

Dates Planograms will be Published 
The purpose of publishing a planogram is to disseminate information on the type, 
quantity and location of shelves and merchandise to those tasked with implementing the 
change. Publishing a planogram design can be done in hard copy or electronic format. 
The date at which this is executed depends on the Publish Date set in the Details tab of 
the Planogram Design dialog box in the Merchandiser module. 

Note: the Publish Date operates purely on the date only and 
takes no account of the time of day. Publish Dates are stored 
in Date/Time format in the database, but the functionality 
only references the Date. 
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Another factor affecting the date at which at which planograms will be published is the 
Lead Time Tolerance (Hours) setting on the Output tab of the Planogram Publishing 
Configuration dialog box in the Administration Module. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 
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Batch processes can be set to start at any time of the day. For example, the batch process 
might initiate at 8 p.m. (20.00 hrs) in the evening to allow the maximum number of batch 
processes to be run before users come in for work again the following morning. 
However, the Publish date for the floor plan might be set for when the following day 
begins at midnight. The Lead Time Tolerance (Hours) setting allows for this. 

For example, if batch process is run on the 2nd June at 20.00 hrs in the evening and has 
no lead time tolerance, a planogram that has a Publish Date of 3rd June would be ignored 
for publishing purposes by this run of the batch process. If however, the Lead Time 
Tolerance (Hours) setting is set to 5 hours, this will be added onto the Date and Time for 
the batch process and cause the batch process to operate as if it were running at 01.00 hrs 
in the morning of 3rd June. All planograms with a Publish Date of 3rd June would then 
be published. 

Criteria for Publishing Planograms 
There are two criteria for publishing planograms: 

1. Publish Date has been exceeded 

If the Publish Date set in the Planogram Design dialog box in Merchandiser exceeds 
the current date (taking into account the Lead Time Tolerance (Hours) setting), the 
floor plan will be published. 

2. Planogram has been Updated since it was Published 

It is possible that the floor plan may have been modified after it was last published - 
for example of a later revision has been created. The condition for this is that the Last 
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Modified date is greater than the Last Published Date. These can be seen on the 
Properties tab of the Planogram Design dialog box in the Merchandiser module. 

 

Note: Planograms may also be republished if the Republish 
planogram if files are missing option has been checked in 
the Planogram Publishing Configuration dialog box. 

Locations Planogram Designs will be Published To 
The locations Planogram designs will published to and the file names that will be used 
are specified in the Output tab of the Planogram Publishing Configuration dialog box in 
the Administration module. 

Note: this dialog box will only be accessible to users with 
access rights to the Administration Module. 
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This dialog box allows Administrators to specify the directory structure, file format and 
file name that will be used when planogram designs are published. 
The starting point for the location planograms will published to in electronic form can be 
seen in the details for the Planogram Publish system directory specified in the Directories 
Tab of the Configuration module. 
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The Filtering Tab 
The Filtering Tab is used to select the planograms to publish. 
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Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next planogram matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 

Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in 
this position 

# Any number in this 
position 

  

If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*Wine*' and will find White Wine, Red Wine, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 

 Select All will select (but not check) all rows of data 

 Clear All will deselect (but not uncheck) all rows of data 

 Check Selected will check all rows of selected data 
 Uncheck Selected will uncheck all rows of selected data 

 Check All will check all rows of data 
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 Uncheck All will uncheck all rows of data 

 Paste allows users to paste a carriage returned list of planogram identifiers from 
the Windows clipboard. All rows in the dialog box that match the pasted 
information will be checked. 

Selecting Planograms to Process 
Planograms may be selected for printing by ticking the appropriate check box. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 

 

They are used as follows: 

 Show All - this option shows all results. 

 Custom Filter - this option allows users to set filters using Boolean logic. The 
options are: 

– Equal to: will return rows that are an exact match for the entered text. 

– Not Equal to: will return rows that do not match the text string 

– Contains: will return rows where part of the data matches the text string. 
(Uses implied wild cards). 

– Does not contain: will return rows where no part of the data matches the text 
string. (Uses implied wild cards). 

– Begins with: will return rows where the text string is an exact match for the 
start of the data. 
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– Ends with: will return rows where the text string is an exact match for the 
end of the data. 

– Does not begin with: will return rows there the text string is not an exact 
match for the start of the data. 

– Does not end with: will return rows there the text string is not an exact 
match for the end of the data. 

 Blanks - column will be filtered to only show rows with null values. 

 Non-Blanks - column will be filtered to only show rows containing a value 
 Results - column will be filtered to only show the selected result. 

The Template Tab 
The Template Tab is used so specify the type of report that will be used to output details 
of the planogram design. 

 

The user can use a radio button to specify the form the report will take: an imported 
'associated planogram document' or a template that is configured in the Report Designer 
Module. 

1. Use Associated Planogram document - this option publishes the planogram design 
information using a pre-generated report using one of the following file formats: 
BMP, GIF, JPEG, JPG, PDF, PNG, TIFF or WMF. This report will be imported when a 
planogram is imported using Oracle Data Integrator (ODI). The Associated 
Document (if available) is specified in the Associated Document text box in the 
Details tab of the Planogram Design dialog box in the Merchandiser module. 
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There are two options (selected using the radio button) for when the pre-generated 
report is missing. 

 Write an error to the AVTTB_PUBLISH_POG_LOG table. Information in this 
table can be read by means of a BI Publisher report or similar. 

 Use the default Report Designer template. 
Use Template - this option allows the user to define the way the template from the 
Report Designer module is selected. There are two options (selected using the radio 
button): 

2. Use Planograms preferred template, if defined - this option is specified in the 
Preferred Template drop down list in the Details tab of the Planogram Design dialog 
box in the Merchandiser module. 

3. Use Selected Template from List Below - this option can be set by checking items in 
the list of available templates. One or more templates may be selected. If multiple 
templates are selected, the name of the template will be added to the file name in 
brackets - for example 1_Bay_Mixed_Fizzy_Drinks (Basic Planogram Report).pdf 

If necessary, the list of templates can be searched by entering a text string into the 
drop down list, then clicking the Find button. (Actual or implied wild cards can be 
used). Each click of the Find button will cause the search engine to move forward 
through the matching results until no results are left. 

Note: the last 10 text strings can be selected using the drop 
down list in the text box. 
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The Collation Tab 
The Collation Tab allows users to specify the sequence the planogram designs will be 
published or printed in. Its main use is in printing hard copy versions of the designs 
where the sequence they are printed in makes it easier to sort and distribute them after 
printing. 

At least one collation option must be selected, or the tab will show as having an error. 

 

The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 

 Region is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 District is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 

 Store Number is the Store Code in the Store dialog box in Store Manager. 

 Store Name is the Store Name in the Store dialog box in Store Manager. 
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 Department is the department (zone) in the floor plan the planogram is 
associated with. 

 Aisle is the aisle the planogram is associated with. For this option to operate, 
aisles must first be drawn in the floor plan in the Planner module. In the example 
below, Aisle F-1 has been drawn between two runs of fixtures. 

 

 Bay Number is the bay number associated with the fixtures the planogram is 
placed on. For this option to operate, the fixtures in the floor plan must 
previously have been bay numbered. 
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 Bay Group is the Name assigned to a number of fixtures sharing a common 
characteristic. It is assigned in the Name field of the Bay Numbering dialog box 
in the Planner module. 

 

 Planogram Name is the name of the planogram. This is set in the Name field of 
the Planogram Design dialog box in Merchandiser. 

 Planogram Code is the code for the planogram. This is set in the Client Code 
field of the Planogram Design dialog box in Merchandiser. 
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The Validation Tab 
The Validation tab enables users to set a series of validation checks that must be satisfied 
before the planogram design is published. If any of the checks are failed, the details will 
be written to the AVTTB_PUBLISH_POG_LOG table. Information in this table can be 
read by means of a BI Publisher report or similar. 

 

1. Check for empty shelves - this option will check the parent fixture and associated 
shelf objects. It will raise an error report if: 

 The fixture and associated shelf objects can be populated with product 
placeholders, but no product placeholder has been placed. 

 The fixture and associated shelf objects can be populated with display styles, but 
no display styles have been placed. 

2. Check for products that have expired or are not yet effective - this option will check 
all products in the planogram against the effective date of the planogram. It will raise 
an error report if: 

 The Product Effective Date is after the Planogram Effective Date - i.e. the product 
is not yet available to place in the planogram. 

 The Product Expiry Date is before the Planogram Effective Date - i.e. the product 
will expire while the planogram is still in service. 

The check will be ignored if the product effective or expiry date is undefined. 

The Planogram Effective Date is set in the Details tab of the Planogram Design dialog 
box in Merchandiser. 
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The Product Effective and Expiry dates are set in the Details tab of the SKU dialog 
box in Product Studio. 
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3. Check for equipment that is obsolete or not yet available - this option will check all 
equipment in the planogram against the effective date of the planogram. It will raise 
an error report if: 

a. The Equipment Effective Date is after the Planogram Effective Date - i.e. the 
equipment is not yet available for the planogram. 

b. The Equipment Expiry Date is before the Planogram Effective Date - i.e. the 
equipment will be taken out of service while the planogram is still in use. 

The check will be ignored if the equipment effective or expiry date is undefined. 

The Equipment Effective and Expiry dates are set in the Category tab of the Block 
Details dialog box in Fixture Studio. 



The Validation Tab  

646 Oracle Retail Store Planner's User Guide 

 

4. Validation Scope - this controls when to apply the validation checks. There are three 
options - selectable by the radio button. 

 Apply to all planograms. 

 Apply to non-imported (manually created) planograms. 

 Apply to imported planograms. 
The application will automatically distinguish between imported and manually created 
planograms by means of the information held in the Macro Space Planning database. 
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Zones in Merchandiser 

Overview of Zones 
Important Note: Zones can only be added, edited and 
deleted in the Planner environment. Zones can be viewed 
but not altered in Merchandiser. Based on the floor layout 
specified by an architectural drawing; a Zone defines a 
section of floor that is used for a specific and clearly defined 
purpose. The Zone might define an area used for sales, it 
might define an area used for storing stock, or it might 
define areas used for non-sales purposes such as offices, 
corridors or toilets. 

From a technical standpoint, a Zone is a Macro Space Management block that allows 
additional information to be put into a Store Plan. This subsequently allows more 
structured Macro Space Management reports to be produced on the associated layout of 
fixtures, fittings and Planograms within that drawing. 

A Zone is defined by a Planner Polyline enclosing a specific section of floor. Further 
Polylines within the Zone can be used to define pillars or other obstructions. 

The designation of pillars and other obstacles allows them to be taken into account when 
calculating sales areas. This results in a more accurate calculation of the area of usable 
floor, enabling sales performance analysis to take into account the effect of obstructions. 

The Zone is used to assign a specified part of the total floor area to a specific function. 
Such functions include allocating to specific types of retail goods, (for example electrical 
goods), or designating the area as a non-sales area; for example a manager’s office or a 
corridor. 
Zones thus allow the total floor area in the store to be split into sales and non-sales areas 
and then further sub-divided as to purpose. 

This sub-division of the store allows Planograms and fixtures to be filtered by Zone, 
allowing the store planner to rapidly establish which goods and which fixtures are in a 
specific part of the store. 

Zones can also be designated as being excluded from certain types of reports. This allows 
fixtures and Planograms that have been placed in a storage area to be excluded from any 
calculations or reports on the performance of that part of the store. 

Many of the characteristics of Macro Space Management Zones can be configured within 
the Administration Module. 

Object Crossing Zone Boundaries 
If only some of the available zones are enabled, some fixtures and fittings from the non-
enabled zones may overlap the boundaries of the selected zones. 

The user will be able to see these overlapping fixtures and fittings, together with their 
associated shelves and products. 
These overlapping fixtures, fittings, shelves and products will not be locked, and the user 
will not be prevented from editing, moving or otherwise modifying these objects. 
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The Zones Toolbar 
The Zones Toolbar is found on the Object Browser. 

 

It contains two icons allowing operations to be carried relative to Zones. 

Icon Description 

 

Configuration 
Options 

 

Refresh 

  
Configuration Options invokes the Zones tab in the configuration module. 
Refresh refreshes the Zones Hierarchy to reflect any changes made in the Administration 
Module since Merchandiser was opened for the current session.   

The Zones Hierarchy Window 
The Zones Hierarchy Window is found immediately below the toolbar. 
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It contains a Hierarchical Tree giving a list of all the available Zone types. 

A zone selected in the drawing will be highlighted in the hierarchical tree. 

Note: Zone types and descriptions can be added, edited or 
deleted using the Administration module. 

The Properties Window 
The Properties Window gives information on the selected Zone Definition. 

 

The Zone Type and Area Properties are read only and cannot be edited. 

The Summary Window 
The Summary Window contains details of Zones within the drawing. 
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The information typically includes Zone Name, Zone Description, and Gross and Net 
Areas. 

(Information displayed can be customized by Oracle – contact Technical Support if 
necessary). 

Zone Names and Zone Descriptions can be sorted by clicking on the column headings. 

Overview of Express Loading 
Express Loading is used to load only some of the zones available in the drawing. 

This allows Macro Space Management users to load just the sections of the store plan that 
are of interest to them. 

This reduces the amount of detail in the drawing that the user has to view. 
It will also slightly speed up movement in the Virtual Reality environment as less data is 
being manipulated when the user's viewpoint moves. 

Drawings that are express loaded with only some of the available Zones will still be 
checked out to the user, preventing anyone from working on the Zones that have not 
been loaded. 

Activating Express Loading 
Express Loading is enabled in the Configuration Module.   

The Merchandiser Tab contains an Express Load checkbox.   
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If the checkbox is ticked, Express Loading will be enabled. 

The Express Loading dialogue box 
The Express Load dialogue box allows the user to select which Zones, Fixtures, Shelves 
and Products will be loaded. 
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The four radio buttons at the top of the dialogue box control what is loaded in the 
selected zones. 

 Load entire drawing results in every zone in the drawing being loaded. This will 
include any fixtures not included within a zone. 

 Select all Fixtures will select the fixtures in every zone in the drawing. 

 Select all Fixtures and Shelves will select the fixtures and shelves in every zone 
in the drawing. 

 Select all Fixtures, Shelves and Products will select the fixtures, shelves and 
products in every zone in the drawing. 

Note: Using the Select all Fixtures, Select all Fixtures and 
Shelves and Select all Fixtures, Shelves and Products options 
will not select from Fixtures, Shelves or Products that are not 
in a zone. 

Alternatively, the requirements for Individual Zones can be set by checking or 
unchecking the respective boxes for Fixtures, shelves and Products for those zones. 

Objects that are not at floor level (for example banners) are still associated with the zone 
they are within and will be displayed accordingly - i.e. the level of an object does not 
affect whether it is associated with a zone. 

The Include Groups and Families outside of the Zone checkbox (if selected) will result in 
all fixtures (and their associated shelves and products) belonging to a group or family 
that extend outside the selected zones being displayed. 

If this option is not checked, then only fixtures (and their associated shelves and 
products) that cross the boundary of the selected zones will be displayed. 
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Factors Affecting Equipment in 

Merchandiser 
Parameters Set in Fixture Studio 

Fixtures (and gondolas) often behave in a specific way in the Merchandiser module. 
Much of this behavior is determined by settings in Fixture Studio. Specifically, the 
behavior is governed by options set in the Block Details dialog box. 

 

Note: See the Fixture Studio Help File for more information. 

Gondola and Fixture Hierarchies 
Gondolas and Fixtures for use in Merchandiser are selected from a hierarchy in the 
Object Browser. 



Fixture Properties  

654 Oracle Retail Store Planner's User Guide 

 

There is one hierarchy for fixtures and another for gondolas. Users can switch between 
the two by clicking on the Blocks or Gondolas button while in the Fixturing Tab. They are 
made up of groups and fixtures (or gondolas). Groups are the equivalent of windows 
folders and serve to hold fixtures (or gondolas) of a specific type.  

The fixture and gondola hierarchies cannot be altered in Merchandiser, only in Fixture 
Studio. In Fixture Studio groups can be added, edited and deleted, as can fixture and 
gondola definitions. This allows the hierarchy to be customized to suit the user.    

Fixture Properties 
Fixture Properties are defined in the Block Details definition box in Fixture Studio. 
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It contains a series of tabs that allow intelligent properties to be assigned to the graphic 
that appears in the drawing. 

Tab Options 

Category Tab Basic parameters for the fixture including data on materials, 
manufacturer, how products fit onto the equipment, etc. 

Insertion Tab How the fixture is inserted into the drawing including the 
height above floor level and what direction the front of the 
fixture faces. 

Size Tab The dimensions of the fixture, including additional floor area 
assigned to allow for extra equipment to be placed on the 
fixture. 

Connections Tab Specifies which equipment can be connected to what other 
equipment. 

Parts Tab Specifies what a list of parts for the equipment; for example 
bolts and castors required. 

Fixture Tab  Specifies the product block used to represent products. 
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Tab Options 

UDA Tab Allows User Defined Attributes (text based information) to be 
assigned to the fixture. These UDA's can then be viewed in 
Merchandiser. 

Styles/Ranges Tab   

Merchandisable 
Areas Tab 

Defines the volume that merchandise is allowed to occupy.   

Shelf Tab Sets the default angle for any shelving to be attached to the 
equipment 

Preview Tab For use within Fixture Studio - it allows users to visually 
check connection points, merchandisable areas, etc. 

Gondola Definitions 
Gondolas are defined using the Gondola Definitions dialogue box in Fixture Studio. 

 

They allow gondolas to be defined from the available fixture blocks. Options include: 

Gondola Parts The list of parts that go to make up a gondola, including which 
are optional. 

Gondola 
Dimensions 

The permissible dimensions for the gondola. 

Specifying Insertion Points 
Insertion points can be specified within Fixture Studio. First select the block to be 
modified then select the Edit Block command. 
This will open the block Details dialogue box. The Insertion Tab allows the Insertion 
Position and Child Insertion Position to be specified. 
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Note: The Insertion Position is this dialogue box is a Macro 
Space Management insertion position. The original insertion 
position is an AutoCAD or 3D Studio graphics insertion 
position and the Macro Space Management Insertion 
Position is specified to match. 

If the Macro Space Management Insertion Position is changed, the AutoCAD or 3D 
Studio insertion position must also be modified by changing the graphic or vice versa. 

Failure to do this will result in differences between the AutoCAD/3D Studio insertion 
position and the Macro Space Management Insertion Position. This may result in 
misalignment when objects are placed in Macro Space Management. It will also result in 
errors when calculating adjacencies, etc. 

Child Insertion Points 
Child Insertion Points are used to provide a datum for product being inserted onto a 
fixture or shelf object. 

They are different from Insertion Points. 

Insertion points are used to specify the location of an object (fixture, shelf object, etc) 
within a Virtual Reality store. 
Child Insertion Points are used by Macro Space Planning to align product being placed 
on that fixture, shelf object, etc. 
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In the above diagram the shelf has an insertion point (red). This has been used to align 
the shelf relative to the back panel it has been placed on. 

Any moving or editing operations for the shelf will be carried out relative to this 
insertion point. 

The shelf also has a child insertion point (green). This will be used to align any product 
placed on the shelf. 

Any moving or editing operations for products placed will be carried out relative to this 
insertion point. 

Setting Child Insertion Points 
Child Insertion Points are set in Fixture Studio. 

 

The Child Insertion Position can be set to any one of nine positions in a specific X – Y 
plane, and to any of three positions in the Z axis. This gives 27 options for the child 
insertion position. 

Important: Wherever possible, child insertion positions 
should be standardized for particular classes of object. This 
will prevent misalignment problems. 
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Overview of Equipment Types 
Equipment is categorized under three types: 

Fixtures: Equipment that can be placed on the floor and can be populated with shelves 
and/or products. 

Fittings: Equipment that can be placed on the floor, but can’t be populated. 

Shelves: Equipment that is placed on a fixture and can optionally hold product. 

In addition, there is a fourth class of objects: 

Other: Any other item that is not equipment, e.g. an architectural column. 

Attachment Options 
The equipment used in building a store layout falls into three categories: Primary, 
Secondary and Tertiary. 

Primary Equipment indicates the most fundamental form of equipment. All Primary 
Equipment is capable of being placed directly on the floor. 

Examples of Primary Equipment include Metal Uprights, Back Panels, Pallets and 
Fittings, (such as legs). 

Some Primary Equipment is capable of accepting subsidiary equipment, (Secondary 
Equipment). 

Secondary Equipment indicates items of equipment that attach directly to Primary 
Equipment. Secondary equipment cannot be placed directly on the floor. 

Examples of Secondary Equipment include shelves, peg boards and slatted back panels 
Some Secondary Equipment is capable of accepting further subsidiary equipment, 
(Tertiary Equipment). 

Tertiary Equipment indicates equipment that is attached to Secondary Equipment. 

Examples of Tertiary Equipment include pegs, rods and dividers. 

Equipment can therefore be arranged in a hierarchy. 

 

All Secondary Equipment must have an item of Primary Equipment as a parent. 
Similarly, every item of Tertiary Equipment must have an item of Secondary Equipment 
as its respective parent. 

Depending on the design, some items of Primary, Secondary and Tertiary Equipment can 
accept merchandise. Others cannot. 
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Working and Stacking Axes 
Working and Stacking Axes define how product is placed onto fixtures and shelf objects. 

Fixtures and shelf objects that do not have at least one working and one stacking axis 
defined cannot accept product. 

Working Axis 
When products are placed onto a shelf object they have to be aligned with each other 
during placement. 

The working axes of an item of shelf equipment are the axis’s which product that is being 
sequentially placed is aligned along. 

 The X working axis is from left to right. 

 The Y working axis is from front to back. 

 The Z working axis is used for vertical placement. 
The working axis set should be appropriate for the type of fixture or shelf object. 

For example a shelf will normally have only an X working axis as product is normally 
placed along the length of a shelf. 

A freezer cabinet might have an X and a Y working axis as product is placed both along 
the length of the cabinet and from back to front 

 

The working axis set should be appropriate for the type of fixture or shelf object. 

Stacking Axis 
The stacking axis (or axis’s) is the direction(s) that products may be stacked on a fixture 
or shelf object. 

 The X stacking axis is from left to right. 

 The Y stacking axis is from front to back. 

 The Z stacking axis is used for vertical stacking. 
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The stacking axis set should be appropriate for the type of fixture or shelf object. 

Examples of the Working and Stacking Axis’s of Fixtures and Shelf Objects 
An open shelf will have objects placed along the length of the shelf (X working axis). 
It can have objects stacked next to each other (X axis) behind each other (Y axis) and on 
top of each other (Z axis). Accordingly an open shelf should have all three stacking axes 
checked. 

SHELF X Y Z 

Working      

Stacking    

  

A peg on the other hand can only have products placed along its length (Y working axis). 

A peg can only have products slid along its length – they are constrained so they can 
only move in that direction. Accordingly, a peg should only have its Y stacking axis 
enabled. 

PEG X Y Z 

Working     

Stacking    

  

 Working and Stacking Axes are set in Fixture Studio. 
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The rotation of products is theoretically allowed in any axis. In practice this is 
constrained by the Working/Stacking axes of the shelf objects. 

Aspects of Equipment 

Overview of Macro Space Management Equipment 
A Store in the Merchandiser environment is populated by equipment. This can include 
fixtures, fittings, shelves and many other items of store furniture. 
The way these items behave is affected by the properties they have been assigned, how 
they are grouped together for collective manipulation and by what the System variables 
are set to. 

Object Properties 
Each of these items of equipment has been initially created as a graphic (using for 
example AutoCAD). The graphic contains basic properties such as dimensions and an 
insertion point. 

The graphic has then been imported into Macro Space Management and turned into a 
Macro Space Management Block. During this process, the Macro Space Management 
Block is assigned additional properties that allow it to act in an ‘intelligent’ manner when 
in the Macro Space Management CAD and Virtual Reality Environments. 

Knowledge of how these ‘Intelligent Properties’ affect the behavior of equipment within 
Macro Space Management is important in understanding the behavior of the software. 
Some of these properties are: 

  

Characteristic Definition 

Insertion Points Determine the locations at which equipment 
and merchandise is placed in Merchandiser 

Child Insertion 
Points 

Determine the justification which products 
are placed on fixtures and shelf objects 

Connection 
options 

Determines how one item of equipment 
connects to another. 
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Characteristic Definition 

Placement 
Options 

Determines the alignment, etc, when 
product is placed onto open shelves, pegs 
and other shelf objects 

Styles Determines which items of equipment are 
compatible with another. Also determines 
which shelf objects products can be placed 
on. 

Alignments Determines how groups of products on 
shelf objects can be aligned (justified) 
relative to that shelf object. 

Product 
Orientations 

Individual product items can be placed in 
specified orientations, for example with the 
front, side or top of the packaging facing 
forward on the shelf object. 

  

Grouping of Objects 
Multiple objects (collections of either equipment or products) can be selected for 
collective operation. This is done by: 

 Selection sets: used for a single collective operation. 

 Groups: sets of objects in horizontal alignment that can repeatedly manipulated 

 Families: sets of objects in vertical alignment that can repeatedly manipulated 

System Variables 
In addition there are a number of System Variables that affect Macro Space Management. 
These may be set to different values – each of which will cause a modification to the 
behavior of the Macro Space Management environment. 

Overview of Equipment Types and Connection Points 
The equipment used in building a store layout falls into three categories: Primary, 
Secondary and Tertiary. 

Primary Equipment indicates the most fundamental form of equipment. All Primary 
Equipment is capable of being placed directly on the floor. Some Primary Equipment is 
capable of accepting subsidiary equipment, (Secondary Equipment). Only Primary 
Equipment has an Insertion Point that is directly placed in the floor plan of a store. 

Secondary Equipment indicates items of equipment that attach directly to Primary 
Equipment. Secondary equipment cannot be placed directly on the floor. Some 
Secondary Equipment is capable of accepting further subsidiary equipment, (Tertiary 
Equipment). Secondary Equipment has an insertion point relative to the insertion point 
of its parent Primary fixture. 
Tertiary Equipment indicates equipment that is attached to Secondary Equipment. 
Equipment can therefore be arranged in a hierarchy, as in the example below. 
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Within the Merchandiser environment, store furniture can be assembled in standard or 
custom configurations by joining together items of equipment. 

For example, a back panel could be placed directly on the floor. This back panel could 
then have runs of shelving attached, and the shelves in turn have dividers placed on 
them. 

Macro Space Management’s internal rules determine exactly how items of equipment can 
connect together. Within the Merchandiser environment, connection points give visual 
indications as to how individual items of equipment can be assembled. 

 

Overview of Location and Coordinate Systems 
The central Macro Space Management database holds information on the location (and 
dimensions) of all objects placed on the floor of the Virtual Reality store. These will 
normally be a limited number of fixtures and fittings such as legs, pallets, etc. 

Each object will be inserted at a specific Insertion Location with coordinates expressed in 
terms of X, Y and Z coordinates. 

Each object to be inserted has two Insertion Points; a Graphical Insertion Point and a 
Macro Space Management Insertion Point. The graphical insertion point is created when 
the graphic is drawn (in for example AutoCAD). When the graphic is imported into 
Macro Space Management, the coordinates of the graphical insertion point are manually 
entered into the object details held by Macro Space Management. This manually entered 
data must match the original graphical insertion point, or misalignments will occur in the 
Virtual Reality environment. 

All other objects, (equipment of merchandise) are connected to the fixtures and fittings 
that have been placed on the floor. These objects are known as children of their parent 
objects. 
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Children have their own insertion locations specified relative to the insertion location of 
their parent objects. They also have their own individual graphical and Macro Space 
Management insertion points. Again, these must match to prevent misalignments. 

Overview of Connection and Placement Options 
Objects in Macro Space Management can be split into several broad categories. 

Two of these categories are Equipment and Products. They connect together in slightly 
different ways. 

Equipment 
Equipment connects together using Connections. These may be either points (which 
simply snap two items of equipment together), lines (which allow equipment to be 
connected at intervals defined along a line), or planes (which allow equipment to be 
connected at intervals defined in a 2 dimensional grid). 

Products 
Products connect together using Placement Options. These may be either Continuous 
Placement (where products can be placed anywhere within a specified boundary, for 
example an open shelf), or Point Placement (where products can be placed in clearly 
specified places, for example on an array of pegs). 

Overview of Styles 
Styles are used to specify which items of equipment are compatible with another, and 
which types of product can be placed on which shelf. 

Equipment has Fixture Styles. Only equipment with compatible styles can be connected 
together. 

Shelves have both Fixture Styles and Shelf Styles. The Fixture style must be compatible 
with the equipment it is being placed on. The shelf style must be compatible with the 
product that can be placed on it. 

Product has a Product Style. The Product Style must be compatible with the shelf on 
which it is being placed or placement will not be allowed. 

Overview of Alignments 
When objects are placed on shelf objects, they may not be in the best possible alignment 
to display them, or there may be gaps between products leading to inefficient use of shelf 
space. 

Macro Space Management has a series of alignment options so that selected products on 
pre-determined shelves can be aligned (justified) to customer specified requirements 
such as the left of the shelf, the back of the shelf, etc. 

Overview of Product Orientations 
Products are normally placed with the front of the packaging facing the front of the shelf 
object. 

However, placing products in this orientation may not fill the shelf to its maximum 
capacity. 

Macro Space Management thus allows products to be placed in other orientations, for 
example on their side, so that the number of products placed on a particular shelf object 
can be maximized. 
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Product placed in orientations other than the main one are known as caps. 

Product Orientations 

Overview of Product Orientations 
Products are normally placed with the front of the packaging facing the front of the shelf 
object. However, placing products in this orientation may not fill the shelf to its 
maximum capacity. Macro Space Management thus allows products to be placed in other 
orientations, for example on their side, so that the number of products placed on a 
particular shelf object can be maximized. Product placed in orientations other than the 
main one are known as caps. 

Product Orientations 
Product is normally placed on the shelves with the front of the packaging facing the 
customer. However, this orientation can be changed; either during placement or when a 
product is edited. 

 

The nine possible orientations are as follows: 

 

(The red dot indicates the insertion point). 

Front is the default orientation. The other orientations are achieved by the following 
rotations from the default. 
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Orientation Rotation in X 
Axis 

Rotation in Y 
Axis 

Rotation in Z 
Axis 

Front None None None 

Front Side None 270o None 

Back None None 180o 

Left None None 90o 

Right None None 270o 

Left side None 270o 90o 

Top 90o None None 

Top side 90o 270o None 

Bottom 270o None None 

Effect of Rotations 
Then the object is rotated to change its orientation, it occupies the same relative position 
on its parent object. This is done by means of child insertion points. 

In the example of the box on a shelf, the child insertion point (the datum for the boxes’ 
position) is shown in blue. It is set at the front left of the shelf. 

 

When the box is rotated, it is still aligned relative to the child insertion point, although 
the boxes’ insertion point (shown in red) has moved 

A similar effect can be seen in the example of a box being rotated relative to its parent 
peg. 

 

The child insertion point (shown in blue) is at the front of the peg. When the box is 
rotated it remains in the same relative position to the child insertion point although its 
own insertion point has changed position. 
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Connection Points 

Overview of Connection Points 
Connections points are used to join items of equipment together. They can either be 
used singly, or aligned in lines, planes or boxes. 

Connection Points are used to attach items of equipment together. 
Connection Lines are used where items like crossbars have set positions along their 
length that can accommodate Tertiary Equipment such rods. 

The position of the arrow indicates the position of the connection point. 

The increments between set positions along a connection line are defined in Fixture 
Studio. 

The position of the connection arrow defines the leftmost position of the first point on the 
connection line. 

Connection Planes are used where Secondary Equipment such as peg boards or slotted 
back panels have a 2 dimensional array of possible connection points for Tertiary 
Equipment such as pegs. 

The increments between set positions in a connection plane are defined in Fixture Studio. 

The position of the connection arrow defines the bottom left position of the first point on 
the connection plane. 

 

In the above diagram, blue arrows (1) represent Connection Points; red arrows (2, 3, and 
4) represent Connection Lines and the green arrow (5) represents a Connection Plane. 
The arrow direction indicates the X axis and the arrow lies in the X, Y plane. 

Slatted back panels use a connection plane with the X spacing set to 0 so that rods can be 
slip to any position along the slot. The Y spacing is set to the distance between slots. 
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It is also possible to use more than one connection line, as for example with racking. 

 

The fixture could be defined as two uprights (front and back), plus the cross-bracing. 
This would allow beams (blue) to be added to either the front or the back. 
Macro Space Management will use the nearest connection arrow to the drop/pick point 
when deciding which to use. 

Connection points are used to define the exact point on the dropped object (shelf or peg 
or rod) that attaches to the notch position. The connection line/plane filters must match 
the connection point filters. If no connection point is defined for the dropped object, it 
will use the insertion point of the shelf/peg. 

The Connections Tab in Fixture Studio 
The Connections Tab in the Block Details dialogue box in Fixture Studio lets the user 
specify the connection options for Macro Space Management blocks. 
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A small Toolbar at the top lets users Add, Copy and Delete connections, while the 
Wizard on the toolbar allows the user to add three basic connections. 

The Connections List below the toolbar lists all current connections for the Macro Space 
Management Block. 

The defined connection points are the defaults for that fixture type and will be applied 
for every instance placed in the drawing. 

Note: See the Fixture Studio Help File for more information. 

The Connections Tab and the Configuration Module 
Settings in the Configuration Module can affect how connection points appear and 
behave. Settings are local and can be customized for the user. 

Access the Configuration Module by selecting the Configure Option in the file pull down 
menu. 
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Within the Configuration module, select the Fixturing Tab. The Connection Points frame 
can then be used to change their appearance. 

 

Pointer Size and Line Size affect the appearance of the connection points as displayed.  
Colors for Neutral, Male and Female connection points can also be set. 

A series of check boxes allow users to configure some aspects of how connection points 
operate: 

 Gender Filter determines whether connection genders are taken into account 
when deciding if connections are compatible. 

 Size Filter determines whether connection sizes are taken into account when 
deciding if connections are compatible. 
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 Shape filter options determine whether connection shapes are taken into account 
when deciding if connections are compatible. 

These settings are local and will not affect other users of Macro Space Management. 

Connection Details 
Each connection needs the following information to be specified for it in Fixture Studio. 

 Name 

 Type 

 Layer 

 Gender 
 Shape 

 Size 

 Whether it is the Default 

 Position, Array and Angle settings 

For one item of equipment to connect to another the following must be true. 

  Requirement Optional or Mandatory 

Gender The connection points must have 
compatible genders 

This requirement can be 
disabled in the 
Configuration Module 

Shape The connection points must have the 
same shape 

This requirement can be 
disabled in the 
Configuration Module 

Size The connection points must have 
compatible sizes 

This requirement can be 
disabled in the 
Configuration Module 

 If any of these criteria are not true, then a connection cannot be made. 

In addition, if the details of the connections are not correctly specified relative to each 
other, equipment may connect together in unintended alignments. 

Connection Point Parameters 

Setting Connection Point Parameters 
The Connection Point parameters are set using the Block Details dialogue box in Fixture 
Studio. 
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Brief details will be discussed in the following sections - see the Fixture studio help file 
for more detailed information. 

The Connections Toolbar 
The Connections Toolbar is found to the upper left of the Connections Tab in the Block 
Details dialogue box in Fixture Studio. 
It allows users to Add, Copy and Delete Connections. It also allows the user to invoke the 
Connections Wizard. 
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Icon Description 

 

Add a Connection 

 

Copy a Connection 

 

Delete a 
Connection 

 

Connection Point 
Wizard 

  

Add a Connection 
Clicking on the Add a Connection icon causes a line to be added to the Connections List 
ready for further details of the connection to be added. 

 

Copy a Connection 
Clicking on the Copy a Connection icon causes a line to be copied again to the 
Connections List mirroring details of the connection to be added. 

 

Before clicking the Copy icon, select the connection to be copied. Clicking on the icon will 
bring up the connection naming dialogue box. 
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Edit the name to one suitable for the new connection. In the example Left has been edited 
to Left - 2. 

On clicking OK, a duplicate connection will be added, save for the changed name. 

 

Delete a Connection 
To delete a connection, highlight the connection to be deleted and click on the Delete 
icon. 
The User will be asked to confirm deletion. 

 

Connection Wizard 
The Connection Wizard is discussed in its own section here 

The Connections Wizard 
The Connections Wizard can be invoked from the Wizard icon in the toolbar in the 
Connections Tab in the Block Details dialogue box in Fixture Studio. 

 

This will bring up the Connections Wizard dialogue box. 
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 Checking the Add connection on Left checkbox will add a Connection on the 
left. 

 Checking the Add connection on Right checkbox will add a Connection on the 
right. 

 Checking the Add connection at Back checkbox will add a Connection at the 
back. 

The left connection is male and the right female so that fixtures can only attach when 
they are facing the same way. The left connection is additionally set to be the default. 

The Back connection has no gender, so it will attach to any other connection. 
Checking the Clear Existing Blocks checkbox will remove any existing connections. 

On clicking OK on the Wizard, the selected default connections will be added. 

 

Other Connection Point Parameters 
Other connection point parameters can be set in the Connections Tab in the Block 
Details dialogue box in Fixture Studio. 
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These include Type, Position, Array Spacing, Gender, Shape, Size, Horizontal Angle and 
Vertical Angle. 

(See the Fixture Studio Help File for more information). 

Using Connection Points 

Overview of Using Connection Points 
Connection points can be used to attach one piece of equipment to another. 

For the equipment to connect, the connection points must be compatible. 

Some factors affecting compatibility are set in the Configuration Module. 
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Other fixture specific factors are set in the Configuration Tab of the Block Details 
dialogue box in Fixture Studio. 
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The combination of both sets of parameters will determine whether two connection 
points are compatible with each other. 

Turning Connection Display On and Off 
The Connection Display can be turned on and off for individual fixtures or a selection 
set of fixtures within the Merchandiser Module. 
Select one or more fixtures, then move the mouse pointer inside a fixture and use <Ctrl> 
plus right click to bring up the pop-up menu. 
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Clicking on the Connection points option in the pop-up menu allows connection display 
to be turned on and off. 

Hide parent will turn off connection point display the parent fixture when (for example) 
a child object such as a shelf is selected. 

Connection Point Appearance 
When visible, Connection Points are shown as triangles. 
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The color and size of the connection points can be specified in the Configuration Module. 

Their angle, gender, etc, for a specific fixture can be defined in Fixture Studio. 

Connection Points can appear in lines and arrays, as well as discrete points. The example 
below shows a Connection Line. 

  

Checklist for Compatibility 
For one item of equipment to connect to another the following must be true. 

  Requirement Optional or Mandatory 

Gender The connection points must have 
compatible genders 

This requirement can be 
disabled in the 
Configuration Module 

Shape The connection points must have the 
same shape 

This requirement can be 
disabled in the 
Configuration Module 

Size The connection points must have 
compatible sizes 

This requirement can be 
disabled in the 
Configuration Module 

Gender 
The gender of a connection determines whether that connection is compatible with 
another. There are three genders; male, female and neutral. They connect as follows: 

  Can connect with 

Male Female Neutral 

Female Male Neutral 
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  Can connect with 

Neutral Any other connection 

Shape 
The shape of a point connection can be specified from a list provided by Oracle. They 
connect as follows: 

  Can connect with 

None Any other connection 
shape 

Rectangle Rectangle None 

Circle Circle None 

Oval Oval None 

Triangle Triangle None 

Hexagonal None None 

  

The shape of a connection point is a theoretical concept used to make it easier to 
remember what connects to what - i.e. fixtures with 'Oval' connection points can only 
connect to other fixtures with 'Oval' connection points. 

(When displayed in Merchandiser, all connection points will appear visually as 
triangles). 

Size 
A maximum and minimum size for the connection can be set in Fixture studio 

A pair of connection points must have compatible sizes to connect together. 

If the Match check box is ticked, then the connections must have identical maximum and 
minimum sizes. If they are not identical, the connections will not mate. 

If the Match check box is not ticked, then the connections must have overlapping size 
ranges. If they are not overlapping, the connections will not mate. 

  Connection 
1 

Connection 
2 

Result 

Size Range 0 - 50 25 - 75 Compatible 

Size Range 0- 25 50 - 75 Incompatible 
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Connecting two objects in Edit Mode 

Swap to Edit Mode 
To connect two objects in edit mode, first ensure that edit mode has been selected by 
toggling from Walk Mode to edit mode on the status bar. 

 

Turn Connection Points On 

Next, ensure that the connection points have been toggled on by selecting a least two 
fixtures and use <Ctrl> plus right click to bring up the pop-up menu. 

 

1. Turn connection points on and they will appear as triangles in the drawing. 

2. Click First Connection Point and Follow Prompts 

3. Click on the first connection point. (Circled in red in the image below) 
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A prompt will then appear in the status bar asking the user to select the 

 

Select a connection point on the other fixture. (Circled in red in the image below). 

 

As soon as the second connection point is clicked, the first object will be connected to the 
second one. 



Using Connection Points 

Using Connection Points  685 

 

Note how the two connection points now meet: 
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Merchandise on the Object Browser 

Overview of Merchandising on the Object Browser 
Clicking on the Merchandising Tab on the Object Browser brings up a series of options 
for adding, editing and deleting Planograms. 

 

The Toolbar gives access to varying options concerning Planograms. 

Buttons allow users to swap between product or planogram operations. 
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The Hierarchy Window allows users to see the list of available planograms. (The 
hierarchy showing will depend on which button is selected). 

The Properties Window gives details of the currently selected object. 

The Summary Window gives details of how many of the selected objects have been 
placed in the drawing. 

The Preview Window gives a preview of the selected product or planogram (if 
available). 

Highlight Selected Item from Tree 
The Highlight Selected Item from Tree option enables products or planograms selected 
from the appropriate hierarchical tree to be highlighted when they are selected in the 
drawing. 

 

  

This is a feature that can be toggled On or Off. To toggle the option on, click on the icon. 
This will show as depressed on the toolbar. To toggled the option off, click on the icon 
again. It will no longer be depressed. 

Note: It is recommended this option be only selected when 
required. When activated, (toggled on), it takes up 
processing capacity. Leaving this option toggled on when 
not required will slow other operations. 

To highlight a product or planogram find the required item in the drawing and click on 
it. The item will then be highlighted in the hierarchical tree – the exact method of 
highlighting depending in the options selected in the Configuration Module. 

Highlight Where Used in Store 
The Highlight where used in Store icon enables products or planograms selected from 
the appropriate hierarchical tree to be highlighted on the drawing. 

 

This is a feature that can be toggled On or Off. To toggle the option on, click on the icon. 
This will show as depressed on the toolbar. To toggled the option off, click on the icon 
again. It will no longer be depressed. 
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Note: It is recommended this option be only selected when 
required. When activated, (toggled on), it takes up 
processing capacity. Leaving this option toggled on when 
not required will slow other operations. 

To highlight a product or planogram, find the required item in the hierarchical tree and 
click on it. The item will then be highlighted in the drawing – the exact method of 
highlighting depending in the options selected in the Configuration Module. 

Editing Product Definitions 
Clicking on the Edit Definitions Icon in the Products toolbar opens Product Studio. 

 

(If Product Studio is already open, it will be made the active window). The currently 
selected product will then be presented for editing. 
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Note: The Product Studio dialogue box that opens will 
depend on what level in the product hierarchy has been 
selected. 

Once changes have been made and saved, they can be used within Merchandising after 
the Refresh option has been used on the Object Browser. 

Editing Planogram Definitions 
To Edit a Planogram, highlight the required planogram in the hierarchy and right click to 
bring up the pop-up menu. 

 

 (If the merchandiser module is already open, it will be made the active window). The 
currently selected Planogram will then be presented for editing. 
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Once changes have been made and saved, they can be used within Merchandising after 
the Refresh option has been used on the Object Browser. 

Find Product or Planogram 
The Find Product or Planogram function is invoked by clicking on the Search icon in the 
Merchandising toolbar. 

 

This will bring up the Find Product (or Find Planogram) dialog box. 
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This is used by typing the required search string into the Find box and clicking the 
Search icon to the right of it. 

 

This will bring up a list of any blocks matching the search string. 

Left clicking on any result will return the user to the Merchandising Products Window, 
where the selected Product or Planogram will be highlighted in the hierarchy tree. 

The Refresh Option 
The Refresh Icon refreshes the both Planogram and Product information in the 
hierarchical tree. 

 

Using Refresh ensures that the information is brought up to date with any changes made 
in Merchandiser or Product Studio, both to the hierarchical tree and to any products or 
planograms added to, edited, or deleted from it. 

Configuration Options 
The Merchandising Tab in the Configuration Module can be called by clicking on the 
Configuration icon on the Merchandising toolbar. The options in this Tab are more fully 
explained in the section in the Configuration Module. 
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This will bring up the Merchandising Tab from the Configuration Module. 
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Adding Product items 

Overview of Adding Products 

Preliminary Actions 
To add products in Merchandiser, a series of preparatory parameters must be set in the 
Administration Module, Fixture Studio and Product Studio.   

The process is as follows: 

 

These parameters are generally set up on a 'one-off' basis when Macro Space Planning is 
implemented. They will not generally need significant change after that point. 

Adding Products 
Products can be placed with two levels of detail; placeholders and display styles. 
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In the above screen shot the upper two shelves are populated with placeholders, the 
lower two with display styles. 

 Placeholders are used to indicate that a particular type of merchandise is on the 
shelf or fixture but give no information on product dimensions, quantities or 
orientation. 

 Display Styles give full information on the SKU's place on the shelf or fixture 
including product dimensions, quantities or orientation. 

Display styles can be placed in Merchandiser. They can then be added, edited and 
deleted in Front Graphical view in In-Store Space Collaboration. Display styles cannot be 
displayed (or seen) in the Planner module. 
Products are added by dragging them from the window in the Merchandising tab on the 
Object Browser onto the fixture or shelf that they are intended to populate. Placeholders 
will be placed without taking into account the available dimensions. Display Styles can 
only be placed if the dimensions of the receiving fixture and fitting are of sufficient size 
and if the styles of the fixture or shelf are compatible with the product being placed on it. 

If Display Styles can be placed then the Add Products Dialogue box will appear. 

 

This enables the Quantity, Alignment, Detail, Orientation and Properties to be specified. 

Product quantities and alignments can either be placed manually or calculated 
automatically. The latter option is particularly useful when using caps. 

 



Adding Product Items 

Preliminary Actions required in the Admin Module  695 

The above example has back and end caps. These could be placed manually, but this 
would be time consuming. They can be placed in a single operation when the quantity is 
calculated automatically.   

Note: prior to placing products on shelves or pegs, certain 
one-off configuration actions are required in the 
Administration Module, Fixture Studio and Product Studio. 

Preliminary Actions required in the Admin Module 
Prior to adding products onto shelves or pegs, some preliminary configuration may be 
required in the Administration module using the Styles dialog box accessed from the 
Styles option on the Merchandising Menu. These are one off actions - once completed 
during implementation of the application; they will not generally need to be repeated. 

Ranges 
Ranges are set in the Ranges dialog box accessed from the Ranges option on the 
Merchandising Menu. 

 

Styles 
Styles are set up using the Styles dialog box accessed from the Styles option on the 
Merchandising Menu. 
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First, Styles for the fixtures the pegs will go onto, the pegs themselves and the products 
that will go onto the pegs must be set up in the Style tab. Next, Style Relationships must 
be set up between the fixture the peg will go on and the Peg themselves. Finally, Style 
Relationships must be set up between the products and the pegs they will be hung from. 
Without these actions, product placement cannot take place in Merchandiser. 

Note: For more detailed information see the Administration 
Module Help File. 

  

Preliminary Actions required in Fixture Studio 
As preparation for placing products on shelves or pegs, certain preliminary actions may 
be required in Fixture Studio. These are normally set up during implementation of the 
software and will generally not need changing after that. 

1. The shelves or pegs and their parent fixtures must have compatible connection 
points. This enables them to fit together. 

2. The parent fixtures, shelves or pegs must have appropriate styles assigned. 
3. The parent fixtures, shelves or pegs should have a range assigned. 

4. The merchandisable area for the fixture, shelf or peg must be compatible with the 
product being placed. 

Connection Points 
Connection points are assigned in the Connections tab of the Block Details dialog box in 
Fixture Studio. 
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Fixture and Shelf Styles/Temperature Ranges 
Fixture and Shelf styles are assigned in the Styles/Ranges tab of the Block Details dialog 
box in Fixture Studio. A Temperature range should also be assigned in this tab. 
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Note: Fixtures must have a Fixture Style assigned; shelves 
and pegs must have both a Fixture Style and a Shelf Style 
assigned. 

Merchandisable Areas 
Merchandisable Areas are assigned in the Merchandisable Areas tab of the Block Details 
dialog box in Fixture Studio. 
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Note: For more detailed information see the Fixture Studio 
Help File. 

Preliminary Actions required in Product Studio 
Before a product can be added onto a fixture, product or shelf at Display Style level, 
certain preliminary actions may be required in Product Studio. These are normally set up 
during implementation of the software and will generally not need changing after that. 

1. The products should have been assigned a temperature range. 

2. The products must have been assigned a Product Style 

3. If the product is a hung product, it must have been assigned a Peg Position 

Temperature Range 
Temperature Ranges are assigned to display styles in Physical tab of the SKU dialog box 
for their parent SKU. 
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Product Styles 
Product Styles are assigned in the Styles tab of the Display Style dialog box. 
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Peg Positions 
Peg positions are assigned in the Peg Holes tab of the display style dialog box. 

 

Note: For more detailed information see the Product Studio 
Help File. 

Common Problems Experienced When Adding Products 
Some common problems experiences when adding products include: 

Insufficient Space 
If the dimension of the display style product is larger than the available space on the 
parent fixture, shelf or peg, a warning will result. 
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If the error is minor, the problem can be overcome by reducing the space assigned to 
other display styles on the parent fixture, shelf or peg. If there is a serious mismatch of 
dimensions, an alternative item of equipment may be indicated. 

Incompatible Styles 
If the Styles assigned to the parent fixture, shelf or peg is incompatible with the Style 
assigned to the display style product, an error will result and the Display Style cannot be 
placed. 

 

This can be corrected by ensuring that: 

1. The correct style has been assigned to the parent fixture, shelf or peg in Fixture 
Studio. 

2. The correct style has been assigned to the Display Style in Product Studio. 

3. A Style Relationship exists between the parent fixture, shelf or peg and the display 
style that will be placed. This can be verified in the Administration Module. 

Incompatible Ranges 
If the Temperature Range assigned to the parent fixture, shelf or peg is incompatible with 
the Temperature Range assigned to the display style product, an error will result and the 
Display Style cannot be placed. 

 

This can be corrected by ensuring that: 

1. The correct temperature range has been assigned to the parent fixture, shelf or peg in 
Fixture Studio. 

2. The correct temperature range has been assigned to the parent SKU for the display 
style in Product Studio. 
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The Add Product Dialog Box 

The Quantity Tab - Setting by User 
The Quantity Tab allows the user to specify the number of instances a product can be 
placed at display Style level. 

Note: Two radio buttons allow the user to specify whether 
quantities are set manually by the user or set automatically 
by the program. This section of help discussed manually 
setting, automatic setting are discussed later on. 

 

If the top radio button is selected (as in the above screen shot) then the user can manually 
select the product quantities. 

Note: The product quantities may be affected by settings in 
the Orientation tab. 

The user may specify values for the number of facings, depth and stack for the product. 

Option Definition 

Facings The number of times the product can be placed along the shelf (the X 
direction). 

Depth The number of times the product can be placed relative to the depth of 
the shelf (the Y direction). 

Stack The number off times product can be stacked on top of each other (the Z 
direction). 

  

These quantities are constrained by the dimensions of the shelf or fixture. The minimum 
possible value in each direction is one, while the maximum number is determined by the 
dimensions of the product. 
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Note: the minimum and maximum values for facings, depth 
and stack can be limited by settings in the Size and Shape 
tab of the Display Style dialog box in Product Studio. 

For each of the directions products can be placed, there are three options; initially 
specified by the pertinent radio buttons: 
 One: a single instance of the product 

 Fill: the shelf or fixture will be filled to its maximum capacity 

 Other: the user can use the spin controls to se the quantity of any value between 
one to the maximum capacity of the shelf or fixture. 

Note: Automatic setting by the program does not place caps, 
but only places the product in the primary orientation. If the 
user wants to place products with side, rear or top caps, it is 
recommended they select the Calculate option by clicking on 
the appropriate radio button - (2) in the annotated diagram 
above. 

The Grouped check box determines whether products are placed as product groups, or 
as a stack of ungrouped items. 

Note: It is recommended that products are placed as 
grouped items as they can then be manipulated as a single 
object. If they are placed as a stack of ungrouped items, then 
each item in the stack has to be manipulated individually. 
This increases the amount of time required from the user, 
the amount of information stored in the database and the 
amount of processor time required to display the products 
on screen. 

The Alignment Tab 
The Alignment Tab allows alignment of the initial product placement to be adjusted 
horizontally, i.e. in the X, Y plane. 

 

In the example below, the products on the left hand shelf have been placed with a Left 
Front alignment, and the products on the right hand shelf have been placed with a Back 
Right alignment. 
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The Detail Tab 
The Detail Tab gives information on dimensions and quantities. 

 

Size is the size of one instance of the Product. 

Gap is the gap between instances of the product. The gap is preset when the product is 
designed in Product Studio and may be necessary where merchandise like glass or 
crockery is concerned. 

Min stack is the minimum quantity that can be placed. 

Max Stack is the calculated maximum quantity that can be placed. 

Shelf Capacity is the dimension of the shelf on which the products are being placed. 

The Orientation Tab 
The Orientation Tab allows the orientation of the product to be defined when it is placed 
on the shelf. It will by default be placed with the front of the product facing the front of 
the shelf or the fixture, but other orientations are possible. For example, the product 
could be placed with the right hand side facing the front of the shelf or the fixture. 
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The maximum amount placeable for each orientation will be shown, while non available 
orientations will be greyed out. 

 

In the above example the product group on the left has been placed with the Front 
orientation. A second example of the same product group has then been placed to its 
right in the Top Side orientation. 

Note: Changing orientation will also change the quantity on 
the Quantities Tab to the maximum possible in that 
orientation. This is to allow the user to see if changing the 
orientation will increase the quantities that can be placed on 
the shelf. 
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The Properties Tab 
The Properties tab displays a customisable list of properties associated with the products 
being placed - the exact list of information displayed being dependent on information in 
the AVTTB_CUSTOM_SQL table. (This information can only be edited by 
Administrators with access to the database). 

 

The information is intended to be of use to merchandisers populating the floor plan. 

Overview of Calculation Option Method 
This section of help details how the calculate option can be used to simplify maximizing 
the number of products placed on a shelf. 

There are two options for adding products in Merchandiser; by manually adding then 
and by automatically adding them by using the calculate option. 

To maximize the number of products on a shelf it is sometimes necessary to use end caps, 
as in the example below. 

 

It is possible to achieve this manually by placing the main body of product, then placing 
the rear end cap and then the size end cap. This may require some time to achieve. 
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It is also possible to achieve this in a single operation using the Calculate option. This can 
result in considerable savings in time when populating shelves. 

Size Rule 
When placing product it is recommended the Size Rule is turned on, either from the edit 
menu or the icon on the toolbar. 

 
This will restrict the number of products added to those permitted by the confines of the 
shelf. 
If this option is not enabled, it is possible that product will overlap shelves to the left, 
right or above. 

Using the Calculation Option 
The Add Products dialogue box allows the user to control the calculated quantity and 
orientation of the product being placed. 

 

To calculate a quantity: 

1. Select the Calculate option by means of the appropriate radio button. 

2. Use the spin control to set the total quantity to that above the total number of 
products the shelf (or fixture) can accommodate. 



Using the Calculation Option  

710 Oracle Retail Store Planner's User Guide 

3. The Calculate Button can then be used to open the calculation screen. 

After the calculate button is clicked, the calculation screen will appear. 

 

4. The Required Quantity is that set in the preceding Add Products dialogue box. If 
necessary this can be edited to a different value while in the screen. 

5. The Quantity Tolerance allows the user to set the permissible variation in quantity. 

 If set to 0, Macro Space Management will try and calculate an exact solution. If 
set to >0 Macro Space Management will accept the first calculated solution that 
comes inside the permissible range. 

 For example, if set to 60 ± 5, the first calculated solution that falls in the range 55 
– 65 will be accepted. 

6. The Main Orientation of the product can be set from the drop down list. 

 

This determines which part of the products’ packaging faces the front of the shelf. 

7. The Priority for the working axes can be set by clicking on the appropriate axis to 
highlight it then using the + and – buttons to change the order of priority. 

8. Macro Space Management will calculate the quantities in the order the axes have 
been selected. For example, if the X axis has been chosen, the software will stack the 
maximum number of products along that axis then take the dimensions of those 
placed products in account when calculating how many products can be placed 
along the second priority axis. 
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9. If the Fill check box is selected, then Macro Space Management will place the 
maximum number of products in that direction. If the Fill checkbox is not selected, 
then a Fixed Quantity can be entered in the appropriate box. If a Fixed Quantity is 
entered, this will also disable the Allow Caps option as the fixed quantity only 
applies to products placed in the Main Orientation.  If a quantity greater than the 
maximum number that will fit is entered then the number will default to the largest 
value possible.  

10. End Caps can be allowed or prevented by selecting or un-selecting the check box as 
appropriate. 

11. The results will show in the Proposed Solution frame. (A warning will appear if the 
number of products that can be placed is below that in the Required Number 
setting). 

12. If the details are correct, click on the OK button to place the products. 

Adding Products using Pegs 
Adding Products using Pegs is similar to adding products to a shelf - the product is 
dragged and dropped onto an existing peg. 

Note: if Joints have been set up in the Administration 
Module, products can be dragged onto a parent fixture (such 
as a slatwall or pegboard) and the peg will be added at the 
same time. 

 

In the example above products have been placed on pegboard using pegs to hang them 
from. 
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Additional Ways of Placing Products 
There are a number of additional ways of placing products - they reflect ways that might 
be used in real life within stores. These ways are: 

Placing on Product on top of Another 
To place on product on top of another drag the required product from the options in the 
merchandising tab over to the product on top of which you wish to place it. Ensure the 
mouse cursor is just inside the object to be placed on top of, and release the mouse key. 
The desired products will them be placed on top. This might be used to place a 'display' 
version of a product on top of boxed versions of the same product. 

Note: If the mouse cursor is just above the object to be 
placed on top of when the key is released, then the object 
being placed will be inserted to one side, rather than on top. 

 

The depth and number of facings of the object being placed on top cannot exceed those 
determined by the length and depth of the object of which it has been placed on top. 

Caps 
Caps are when the same product is placed over another product, using a different 
orientation, in order to fill space. This can be achieved manually, by placing several 
instances of the same product next to each in different orientations. 
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It can also be achieved automatically by making use of the Calculate option on the Add 
Products dialog box. 

 

Nesting 
Nesting allows you to take into account how products could be stacked inside each other. 
In the example below, the Pyrex bowls on the left are nested inside each other, the ones 
on the right are not. Nesting allows a more accurate determination of the number of 
products than can fit inside a specified volume. 

 

Nesting can be specified in the Size and Shape tab of the Display Style dialog box in 
Product Studio. Alternatively, nesting can be manually set in the Merchandiser module. 
This can be done by taking two layers of products one product high and then selecting 
the Edit Article Nesting option from the right click menu. 
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Alignment 

Overview of Alignment 
Alignment defines the relative positions of product (and sometimes equipment) to each 
other. 

In previous implementations of Macro Space Management alignment was automatically 
determined by the parent object on which the products were placed. In the current 
implementation of Macro Space Management, alignment is no longer automatic and the 
user can customize position using the various options available. 

Products can be aligned with each other, or with their parent fixture or shelf, depending 
on what is selected. The alignment will work with equipment, as well as products. There 
are 9 options for alignment: 

Aligning along length of shelf 

 

Align to Left 

 

Align to Center 

 

Align to Right 

Aligning across depth of shelf 

 

Align to Front 

 

Align to Middle 

 

Align to Back 

Distributing across volume of shelf 

 

Distribute Left/Right 

 

Distribute Front/Back 

 

Distribute Top/Bottom 

Buttons for aligning along or across the shelf will only be enabled if at least one object is 
selected and the drawing is not read-only. 

Buttons for distributing across the shelf will be enabled if at least 3 objects are selected 
and the drawing is not read-only. 

Clash Detection 
Clash Detection should be turned on when aligning; else products could overwrite each 
other. 

 If Clash Detection is turned on, products will move until they are in contact. 

 If Clash Detection is turned off, products can be moved so they occupy the same 
physical space. 

Clash detection is toggled On or Off by clicking on the clash Detection Icon in the Views 
toolbar 



Align to Left  

716 Oracle Retail Store Planner's User Guide 

 

Sequential Operations 
Each alignment operation only works on one plane at a time; i.e. it only works in the X, Y 
or Z plane for that particular operation. 

It is thus possible to use sequential alignment operations to achieve the desired effect. For 
example it is possible to use the Align to Left operation (X axis) followed by the Align to 
Back operation (Y axis). 
This will result in all selected products being aligned to the left and rear of the selected 
shelf. 

Align to Left 

Align to Left 
If one or more shelves/fixtures are selected before clicking the Align to Left button, then 
all child products will be aligned to the left. Alignment towards the front or back of the 
shelf will not be affected. 
Products will first be sorted in order of position along the length of the shelf. The first 
product will then be placed at the left hand end of the shelf. The next product will be 
placed adjoining the first such that it is adjacent, but does not overlap. Successive 
products will be placed in a similar manner until all have been placed in a left justified 
alignment. 

The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected. 

Products Selected 
If only products are selected, then they will be aligned so that left-hand side of each 
product matches the right-hand side of the preceding product in the selection set. 

 

Shelf/Fixture and Products Selected 
If the shelf/fixture, plus some of its child products are selected, then only those products 
will be aligned with the shelf, rather than all the products on the shelf. 
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Shelf/Fixture Selected 
If the shelf is selected (and no products) and the alignment button is pressed, then it will 
assume all child objects are selected and align them to the shelf. 

 

Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment. 

Align to Center 

Align to Center 
If one or more shelves/fixtures are selected before clicking the Align to Center button, 
then all child products will be aligned to the center. Alignment towards the front or back 
of the shelf will not be affected. 

When all products have been aligned to center, there will be an equal unoccupied space 
to either side. 

The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected. 

Products Selected 
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If only products are selected, then they will be aligned so that centre-hand side of each 
product matches the centre-hand side of the first product in the selection set. 

 

Shelf/Fixture and Products Selected 
If the shelf/fixture, plus some of its child products are selected, then only those products 
will be aligned with the shelf, rather than all the products on the shelf. 

 

Shelf/Fixture Selected 
If the shelf is selected (and no products) and the alignment button is pressed, then it will 
assume all child objects are selected and align them to the shelf. 
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Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment. 

Align to Right 

Align to Right 
If one or more shelves/fixtures are selected before clicking the Align to Right button, 
then all child products will be aligned to the right. Alignment towards the front or back 
of the shelf will not be affected. 

Products will first be sorted in order of position along the length of the shelf. The first 
product will then be placed at the right hand end of the shelf. The next product will be 
placed adjoining the first such that it is adjacent, but does not overlap. Successive 
products will be placed in a similar manner until all have been placed in a right justified 
alignment. 

The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected. 

Products Selected 
If only products are selected, then they will be aligned so that right-hand side of each 
product matches the right-hand side of the first product in the selection set. 
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Shelf/Fixture and Products Selected 
If the shelf/fixture, plus some of its child products are selected, then only those products 
will be aligned with the shelf, rather than all the products on the shelf. 

 

Shelf/Fixture Selected 
If the shelf is selected (and no products) and the alignment button is pressed, then it will 
assume all child objects are selected and align them to the shelf. 
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Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment. 

Align to Front 

Align to Front 
If one or more shelves/fixtures are selected before clicking the Align to Front button, 
then all child products will be aligned to the front. Alignment towards the left or right of 
the shelf will not be affected. 

Products will first be sorted in order of position along the depth of the shelf. The first 
product will then be placed at the front edge of the shelf. The next product will be placed 
adjoining the first such that it is adjacent, but does not overlap. Successive products will 
be placed in a similar manner until all have been placed in a front justified alignment. 

The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected. 

Products Selected 
If only products are selected, then each selected product will be aligned so that front edge 
of each matches the front edge of the shelf. 

 

Shelf/Fixture and Products Selected 
If the shelf/fixture, plus some of its child products are selected, then only those selected 
products will be aligned with the front of the shelf, rather than all the products on the 
shelf. 
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Shelf/Fixture Selected 
If the shelf is selected (and no products) and the alignment button is pressed, then it will 
assume all child objects are selected and align them to the front of the shelf. 

 

Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment. 

Align to Back 

Align to Back 
If one or more shelves/fixtures are selected before clicking the Align to Back button, then 
all child products will be aligned to the back. Alignment towards the left or right of the 
shelf will not be affected. 

Products will first be sorted in order of position along the depth of the shelf. The first 
product will then be placed at the back edge of the shelf. The next product will be placed 
adjoining the first such that it is adjacent, but does not overlap. Successive products will 
be placed in a similar manner until all have been placed in a back justified alignment. 
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The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected. 

Products Selected 
If only products are selected, then each selected product will be aligned so that back of 
each matches the back of the shelf. 

 

Shelf/Fixture and Products Selected 
If the shelf/fixture, plus some of its child products are selected, then only those selected 
products will be aligned with the back of the shelf, rather than all the products on the 
shelf. 

 

Shelf/Fixture Selected 
If the shelf is selected (and no products) and the alignment button is pressed, then it will 
assume all child objects are selected and align them to the back of the shelf. 
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Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment. 

Align to Middle 

Align to Middle 
If one or more shelves/fixtures are selected before clicking the Align to Middle button, 
then all child products will be aligned to the middle. Alignment towards the left or right 
of the shelf will not be affected. 

When all products have been aligned to the middle, there will be an equal unoccupied 
space to the front and rear. 
The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected. 

Products Selected 
If only products are selected, then each selected product will be aligned so that middle of 
each matches the middle of the shelf. 
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Shelf/Fixture and Products Selected 
If the shelf/fixture, plus some of its child products are selected, then only those selected 
products will be aligned with the middle of the shelf, rather than all the products on the 
shelf. 

 

Shelf/Fixture Selected 
If the shelf is selected (and no products) and the alignment button is pressed, then it will 
assume all child objects are selected and align them to the middle of the shelf. 
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Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment. 

Distribute Left/Right 

Distribute Left/Right 
Distribution ensures that the spaces (or overlaps) between objects are equal. 

Products 
If only products are selected, then Distribute Left/Right will establish the total distance 
between the left edge of the leftmost product and the right edge of the right most 
product. It will then establish the combined length of all the products within that 
distance. 

After comparing the total distance and the combined length, Distribute Left/Right will 
then move all selected products so that the gaps (or overlaps) between the selected 
products are equal. 
If products are selected, the left hand and right hand products in the selection will not 
move, but all intermediate products may have their positions adjusted. 

Parent Fixture/Shelf 
If the parent fixture/shelf is also selected, then it will assume that all child products are 
selected; this will distribute products between the left hand edge and right hand edge of 
the merchandisable areas. 

This means that unlike a Products selection, the left hand and right hand products in the 
selection will move to the respective left hand and right hand extents of the shelf 
respectively. 
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Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment. 

Distribute Front/Back 

Distribute Front/Back 
Distribution ensures that the spaces (or overlaps) between objects are equal. 

Products 
If only products are selected, then Distribute Front/Back will establish the total distance 
between the front edge of the foremost product and the back edge of the rear most 
product. It will then establish the combined depth of all the products within that 
distance. 

After comparing the total distance and the combined depth, Distribute Front/Back will 
then move all selected products so that the gaps (or overlaps) between the selected 
products are equal. 
If products are selected, the front and back products in the selection will not move, but 
all intermediate products may have their positions adjusted. 

Parent Fixture/Shelf 
If the parent fixture/shelf is also selected, then it will assume that all child products are 
selected; this will distribute products between the front edge and rear edge of the 
merchandisable areas. 

This means that unlike a Products selection, the front and rear products in the selection 
will move to the respective front and rear extents of the shelf respectively. 
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Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment. 

Distribute Top/Bottom 

Distribute Top/Bottom 
Distribution ensures that the spaces (or overlaps) between objects are equal. 

Products 
If only products are selected, then Distribute Top/Bottom will establish the total distance 
between the top edge of the lowermost product and the maximum height available. It 
will then establish the combined heights of all the products within that distance. 

After comparing the total distance and the combined heights, Distribute Top/Bottom 
will then move all selected products so that the gaps (or overlaps) between the selected 
products are equal. 

If products are selected, the top and bottom products in the selection will not move, but 
all intermediate products may have their positions adjusted. 

Parent Fixture/Shelf 
If the parent fixture/shelf is also selected, then it will assume that all child products are 
selected; this will distribute products between the front edge and rear edge of the 
merchandisable areas. 

This means that unlike a Products selection, the top and bottom products in the selection 
will move to the respective top and bottom extents of the shelf respectively. 
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Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment. 

Aligning to Non-Rectangular Objects 
Macro Space Planning allows alignment to non rectangular objects such as semi-circular 
fixtures or corner shelves in Merchandiser. 

The shape of the non-rectangular shelf is defined in Fixture Studio - all products placed 
on the shelf will be confined to the bounds of the non-rectangular area. 

Note: See the Fixture studio 

Shelves 
Alignment on non-rectangular objects should be carried out using the Shelf alignment 
options and with clash detection on. 

 

Products 
Non-rectangular products will be treated as boxes for alignment purposes. 
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Aligning to Snap Grid 
It is possible to align objects to a regular grid. This can be toggled On or Off by clicking 
on the Snap option on the Status bar. 

 

It is also possible to toggle it On or Off using the Edit menu. 

 

The grid itself can be set to be displayed using the Grid Lines Option in the View pull 
down menu. 
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This brings up the Grid Lines dialogue box which can be used to set the parameters of 
the grid. 

 

The grid will then appear in the Virtual Reality Environment. 
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To turn the grid off, go to the layers dialogue box and turn off the Grid-Line layer. 
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The Planogram Hierarchy 

Overview of the Planogram Hierarchy 
The Planogram Hierarchy is found towards the top of the Object Browser. 

 

It is active when the planogram button is selected in the merchandising toolbar. 

The hierarchy can be modified in one of two ways: groups and planograms. 

Groups 
Groups hold collections of planograms. They can be set up in a hierarchical structure - for 
example Summer Promotion is a child of Promotional Items. 

Planograms 
Planograms can be assigned to groups. Each Group holds a collection of planograms of 
similar purpose.   

Adding a Group 
To add a group, highlight the node in the hierarchy the group is to be a child of. 
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In this case the  Tinned Goods Group has been selected. 

Use <Ctrl> and Right click to bring up the pop-up menu. 

 

Select Add Group to bring up the Group dialogue box. 
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The Name and description can be typed in, and the pertinent icon selected from a drop 
down list. On clicking on OK, the group will be added to the hierarchy. 

Editing a Group 
To edit the details of the Planogram Group, highlight the required group in the hierarchy 
and use <Ctrl> plus right click to bring up the pop-up menu. 

 

Select the Edit Group option. This will bring up the Edit Group dialogue box. Modify it 
as required. 
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In this instance 'Example Planogram Group' has been changed to Modified Planogram 
Group'. 
Click on OK and the details will be modified in the hierarchy. 

Deleting a Group 
To delete a Planogram Group, highlight it in the hierarchy, then bring up the right click 
menu. 

 

Click on Delete Group and the group will be deleted. If the Planogram group has 
planograms associated with it, these will be deleted as well. Before this can occur, a 
confirmatory dialog box will appear.   
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Adding Planograms 
Planograms are added by selecting a parent group and highlighting it. 

 

In this case we wish to add a Planogram to the 3D Samples Group. 
Once the group is highlighted, there are two ways to add a planogram; from the menu 
bar and from the pop-up menu. 

 Planograms can be added from the File pull down menu: 
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Clicking on New Planogram will cause a blank Planogram dialogue box to appear, ready 
for the details of the planogram to be entered. 
 Planograms can also be added by using <Ctrl> plus right click to bring up the 

pop-up menu. 
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The add planogram option will then cause a blank Planogram dialogue box to appear, 
ready for the details of the planogram to be entered. 

 

On saving of the Planogram dialogue, the new planogram will appear in the hierarchy. 
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Editing Planograms 
Planograms are edited by selecting a planogram and highlighting it. 

 

Planograms can be opened for editing in one of two ways: from the menu bar and from 
the pop-up menu. 

 Planograms can be opened for editing from the File pull down menu: 

 

 Planograms can also be edited by using <Ctrl> plus right click to bring up the 
pop-up menu. 
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In both cases the Planogram dialogue box will open to allow the properties of the 
planogram to be edited. 
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Purge Planograms Option 
Purge options are available using the Purge option on the Tools pull down menu in the 
Administration Module. 

 

Note: The Administration module is only available to users 
with Administrator's privileges. 

The planograms will not be permanently deleted from the database until the Planograms 
option is checked on the Purge dialogue and the OK button clicked. 

 

Results will be reported in the Purge Results dialogue box. 

 

Setting Access Permissions for Planogram Design 
The ability for users to modify the planogram hierarchy and individual planograms is set 
in the Administration module. These permissions can be used to: 

1. Allow users to add, edit or delete Planogram groups in the Planogram Hierarchy 

2. Allow users to add, edit or delete individual planograms 
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Overview of Planogram Creation 
There are two basic ways of creating planograms. 

 By designing a planogram in the planogram design dialog box. 

 By selecting merchandised fixtures in the store and using them to create a 
planogram. 

The first method is used for creating a planogram from scratch, including selecting the 
fixtures, shelves and products from those available. 

The second method is used to turn an existing arrangement of fixtures, shelves and 
products in a floor plan into a planogram. 

Both methods use a similar logic, and which one is used at a specific time will depend on 
the circumstances. 

 

Special Forms of Planograms 
There are two forms of planograms that can be used to supplement fully detailed, 
finished planogram designs. 
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Equipment Planograms 
If a store plan is being developed, but planograming is still at an early stage, it is possible 
to create equipment planograms. These can be used to lay out the shelves, etc, in the floor 
plan so that a bill of materials can be generated. 

 

Note: it is also possible to place the shelves, etc, directly in 
the floor plan without using equipment planograms. 

Placeholder Planograms 
Planograms can be saved with product placeholders in place of display styles. 
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The usual purpose of this sort of planogram is to allow store planning to start before 
planogram design. The placeholder planogram is saved as Revision 1. When the design is 
finalized, it is saved as Revision 2. 

If Planogram Substitution is carried out in a floor plan containing Revision 1 
(placeholder), that planogram will automatically updated to Revision 2 (full detail). 

  

  



 

746 

67 
Planogram Design Display Window and 

Toolbar 
Overview of Merchandising on the Object Browser 

Clicking on the Merchandising Tab on the Object Browser brings up a series of options 
for adding, editing and deleting Planograms. 

 

The Toolbar gives access to varying options concerning Planograms. 
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Buttons allow users to swap between product or planogram operations. 

The Hierarchy Window allows users to see the list of available planograms. (The 
hierarchy showing will depend on which button is selected). 

The Properties Window gives details of the currently selected object. 
The Summary Window gives details of how many of the selected objects have been 
placed in the drawing. 

The Preview Window gives a preview of the selected product or planogram (if 
available). 

The Planogram Toolbar 
The Planogram toolbar is found on the Merchandising Tab of the Object Browser. It is 
active when the Planogram button is selected. 

 

It contains a series of icons allowing various operations to be carried out on Planograms. 

Icon Description Comment 

 

  

Add to Selected Fixture 

  

(Not enabled in 
Merchandiser) 

 

  

Edit Planogram Definition 

  

 

  

Remove from Fixture 

  

(Not enabled in 
Merchandiser) 

 

  

Reverse Planogram 

  

(Not enabled in 
Merchandiser) 

 

  

Highlight where used in 
store 

  

 

  

Highlight Selected Item in 
Tree 

  

 

  

Find Product or Planogram 

  

 

  
Show Merchandising 
Options 

  

 

  
Refresh 
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Some of these options are only available in the Planner environment - alternative 
methods being available in the Merchandiser module. 

The Merchandising Hierarchy Window 
The Merchandising window shows a hierarchical tree of all the available products or 
planograms. 

 

The tree can be expanded or contracted by clicking on the + or – icons. 

The Merchandising window can be minimized by clicking on the splitter bar. 

 

The Products or Planograms buttons immediately below the splitter bar determine 
whether the hierarchical tree shows products or planograms. 
The Products hierarchical tree can be configured in Product Studio using the Add 
Product, Edit and Delete options on the menu available by right clicking. 

 

The Planograms hierarchical tree can be configured in Merchandiser using the Add, Edit 
and Delete options on the menu available by right clicking. 



Planogram Design Display Window and Toolbars 
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The Group or Planogram options will be available or greyed out depending on whether a 
group or a planogram has been highlighted in the hierarchy. 

The Properties Window 
The Properties Window will show the properties for the currently selected product or 
planogram. 

 

The Properties window can be minimized by clicking on the splitter bar. 

 

The Summary Window 
The Summary Window will show a user defined list of products or planograms placed 
in the drawing. 
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Clicking on a column heading will re-order that column. Clicking again will reverse the 
sort order. 
The Summary window can be minimized by clicking on the splitter bar. 

 

The information that appears in the summary window is customizable and is selected by 
means of a SQL statement.    

The Preview Window 
The Preview Window will be blank if a planogram is selected. 

 

The Preview window can be minimized by clicking on the splitter bar. 
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Planogram Creation in Store 

Overview of Planogram Creation in the Store 
Planogram Creation within the Store requires the following stages: 

 

Select Fixtures 
This determines which fixtures (and associated products) will become the planogram. 

Right click and Select Make Planogram 

This starts the planogram definition process. 

Specify Planogram Details 
This allows the user to specify the Planogram Details, Store Dependency, Season 
Dependency, Fixture Styles, and User Defined Attributes, (UDA's). 

It also allows the user to modify the fixtures and products originally selected for the 
planogram design. 

Select Node in Planogram Hierarchy 
This determines where the planogram will be saved in the hierarchy one it has been 
defined. 

Save Planogram 
This saves the defined planogram to the specified point in the planogram hierarchy in the 
Object Browser. 
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Select Fixtures 
One or more fixtures (together with their associated merchandise) can be selected by 
holding down <Ctrl> and right clicking on the required fixtures. The fixtures will then be 
enclosed by a selection box. 

 

  
In this example, the first selected fixture is enclosed by a red selection box, and the 
second in a blue selection box. Other selection box colors may occur depending on 
whether multiple fixtures have been selected, or whether the fixtures belong to a group 
or family.    

All selected fixtures will be included in the planogram. 

Right click and select Make Planogram 
Once the fixture(s) have been selected, position the mouse pointer over them and right 
click to bring up the pop-up menu. 

Note: The Make Planogram option will only be available if 
fixtures are selected. If product or shelves are selected, it will 
not be available. 
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Selecting the Make Planogram Option will bring up a new Planogram dialogue box. 

 



Specify Planogram Details  
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This requires completion and saving. 

Specify Planogram Details 
The Planogram dialogue box allows users to specify full details for the planogram. 

 

The Details Tab allows the planogram name, effective date, etc, to be specified. 
The Stores Tab allows users to select which stores the planogram is intended for. 

The Seasons Tab allows users to select which time periods the planogram is intended 
for. 

The Fixture Styles Tab allows users to specify which types of fixtures the planogram can 
be placed on. 

The Design Tab allows the planogram design to be modified relative to the fixtures and 
merchandise selected in the store. 

The Financial Tab allows financial performance data to be assigned to the planogram. 

The UDA Tab allows User Designed Attributes to be set for the Planogram.   

Select Node in Hierarchy 
Selecting the node in the hierarchy determines where the planogram will be saved once 
it has been created. 
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Save Planogram  755 

 

Here, the Carbonated Drinks Planogram Group has been highlighted, and the planogram 
will be saved under this node. 

Save Planogram 
Clicking on the OK button will save details of the planogram to the Macro Space 
Planning database. 
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Note: The Save As button is used to save a different version 
of an existing planogram. It is not normally used when 
creating a planogram from new. 
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Overview of New Planogram Design 
Planogram Creation from new requires the following stages: 

 

Select New Planogram from File pull down menu 
This starts the planogram definition process. 

Specify Planogram Details 
This allows the user to specify the Planogram Details, Store Dependency, Season 
Dependency, Fixture Styles, and User Defined Attributes, (UDAs). 

It also allows the user to modify the fixtures and products originally selected for the 
planogram design. 

Select Node in Planogram Hierarchy 
This determines where the planogram will be saved in the hierarchy one it has been 
defined. 

Save Planogram 
This saves the defined planogram to the specified point in the planogram hierarchy in the 
Object Browser. 

Select New Planogram from File pull down menu 
The New Planogram Option is selected from the File Pull down menu. (Alternatively, 
the Add Planogram option can be selected from the right click menu). 



Specify Planogram Details  

758 Oracle Retail Store Planner's User Guide 

 

This will bring up a blank Planogram definition dialogue to allow the details of the 
planogram to be specified. 

 

Specify Planogram Details 
The Planogram dialogue box allows users to specify full details for the planogram. 
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The Details Tab allows the planogram name, effective date, etc, to be specified. 

The Stores Tab allows users to select which stores the planogram is intended for. 

The Seasons Tab allows users to select which time periods the planogram is intended 
for. 

The Fixture Styles Tab allows users to specify which types of fixtures the planogram can 
be placed on. 

The Design Tab allows the planogram design to be created from the available fixtures 
and merchandise. 

The Financial Tab allows financial performance data to be assigned to the planogram. 

The UDA Tab allows User Designed Attributes to be set for the Planogram.   

Select Node in Hierarchy 
Selecting the node in the hierarchy determines where the planogram will be saved once it 
has been created. 
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In this example, only a simple hierarchy has been created, but considerably more 
complex hierarchies can exist in large retail organizations. 

Here, the Clothing Planogram group has been highlighted, and the planogram will be 
saved under this node. 

Save Planogram 
Clicking on the Save button will save details of the planogram to the central Macro Space 
Management database. 
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Note: The Save As button is used to save a different version 
of an existing planogram. It is not normally used when 
creating a planogram from new. 
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Overview of Planogram Design Options 
The Planogram dialogue box allows users to specify full details for the planogram. 

 

The Details Tab allows the planogram name, effective date, etc, to be specified. 

The Stores Tab allows users to select which stores the planogram is intended for. 

The Seasons Tab allows users to select which time periods the planogram is intended 
for. 

The Fixture Styles Tab allows users to specify which types of fixtures the planogram can 
be placed on. 

The Design Tab allows the planogram design to be modified relative to the fixtures and 
merchandise selected in the store. 

The Financial Tab contains performance data for the planogram. 
The UDA Tab allows User Designed Attributes to be set for the Planogram. 



The Details Tab  

764 Oracle Retail Store Planner's User Guide 

The Details Tab 

Overview of the Details Tab 
The Details Tab is used for to set up the description of the planogram, together with 
other parameters concerning its operation. 

 

Name, Description and Revision 
The Name, Description and Revision allow users to enter information pertinent to the 
planogram. 

 

Name is the filename by which the planogram will be referenced in the database. 

Description is a longer and more informative version of the name. 

Revision is the number of the initial revision of the planogram. The revision will be auto-
incremented each time a new version of the planogram is saved. 

Size Description is used to describe the nominal dimensions of the planogram. 
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Planogram Status and Dates 
The planogram status and dates define when the planogram will come into service. 

 

Status 
Status is set from the Status drop down list in the Details tab. 

 

Status can be set to one of three options: 

• Proposed - the planogram is still in the process of being deigned and approved. 
Planograms at Proposed status can be placed in floor plans - for example to allow 
floor plans to be developed before planogram designs are complete. 

Note: it may be necessary to develop a report or KPI that 
shows planograms of Proposed status so they can be 
reviewed before a floor plan is authorized to go into service. 

• Current - the planogram is in service and available for placement 

• Superseded - the planogram is obsolete and has been taken out of service. 
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Note: additional statuses may be added using the Status 
option available from the General menu in the 
Administration module. 

Publish Date 
This date is a flag that can be used to indicate the data at which equipment and 
merchandiser required to implement the planogram can be ordered. 

Effective Date 
This is the date planograms come into service. 

If the MERCH_TREE_EFFECTIVE_DATE system variable is turned on (Administration 
module) the effective date of the planogram will be compared to the Active Date of the 
current floor plan (set at the top of the Object Browser). If the Planogram Effective Date is 
after the Active Date for the floor plan, the planogram will not be available for 
placement. This prevents planograms that will only be available after a specific date 
being placed 

Expiry Date 
The Expiry date is the date at which the planogram will be taken out of service. When a 
planogram is created, the date will be set to a default of 31st Dec 2999. 

Planogram Information 

Planogram information 
This section contains information on the planogram 
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Note: Name, Description, Size Description, Revision, Status, 
Publish Date, Effective Date, Expiry Date are discussed 
elsewhere in this section. 

Family Code indicates the Family the planogram belongs to. There might be a 1 bay 
planogram for printer cartridges for small stores and a 2 bay planogram with larger 
quantities of the same cartridges for a larger store. The Family Code can be used in 
reports of KPI's to check that only one instance of a printer cartridge planogram has been 
placed in a store. 

Assortment Code gives further information on the purpose of the planogram. Codes are 
often client specific - for example HSL might indicate that the planogram was designed 
for stores with a Hispanic demographic, for stores of small size and does not have a large 
movement of products associated with it. 
Temperature Range is the temperature that the products in the planogram will be 
displayed at. It is set using the drop down list. The selected temperature range must 
match the temperature range on the fixtures the planogram will be placed on in the floor 
plan. Temperature ranges are configured using the Ranges option in the Merchandising 
menu in the Administration module. 

Weight Range indicates the total weight of the products in the planogram. This 
functionality is not yet in use. 

Stock Type is not in use in this version of the software. 

AutoFill Rule indicates the AutoFill rule that has been selected if the AutoFill 
functionality has been configured in the Merchandiser module. 
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Can be Split is a flag indicating whether the planogram must be placed on adjacent 
fixtures, or whether the selected fixtures can be separated from each other. 

Client Code is a code assigned by the client to identify the planogram. The code will 
vary from retailer to retailer. 
Buddy Family Code indicates the Family code of a planogram that should be associated 
with this planogram. For example, if the family code of a planogram is that of printer 
cartridges, the Buddy Family code might be that of printer paper. The Buddy Family 
Code can be used in reports or KPI's to check that the right pairing of planograms has 
been placed. 

Units are the units of measure for the planogram dimensions. The list of available units 
can be configured using the Units option accessed from the General menu in the 
Administration Module. 

Time Units are the units of measure for the set and dismantle times. The list of available 
units can be configured using the Units option accessed from the General menu in the 
Administration Module. 

Manpower Set Time is the time it will take to add any shelving and place the products. 
The units are set in the Time units drop down list. 

Manpower Dismantle Time is the time it will take to clear all shelving and products in 
preparation for placing the next planogram. 

Category Role is the reason the retailer believes customers purchase products from that 
planogram. 

Inventory Model indicates the Inventory Model used to provide the data for the 
planogram design. 

Rank is an arbitrary number that can be assigned to indicate order 

Traffic Flow indicates whether the planogram is designed to be viewed by people 
walking left to right or right to left. 

Requires Power is a flag specifying whether the planogram requires electrical power or 
not. An example would be a planogram for televisions where the televisions in display 
are on. 
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The Properties Tab 

Overview of the Properties Tab 
The Properties tab (which is read only) gives information on the planogram. 

 

Source is the source of the design of the planogram. MSM indicates that the planogram 
was created using Macro Space Management. Alternatively, this could be the name of the 
third party source of the planogram design. This information is read from the 
AVTTB_POG_SOURCE table in the database. 

Import Identifier is assigned to identify the specific import that brought in the 
information. 

Imported Name identifies the source of the import. This could be the name assigned to 
the planogram in the third party software, a cluster holding a series of planograms or a 
flat file holding a number of planograms. 

Last Imported is the date of the last import. (Information may be imported a number of 
time to update - for example - financial data. 

Parent Product is the name of the node in the hierarchy that is the common link between 
all of the products in the planogram. It can either be calculated by Macro Space 
Management or assigned during import. 

Created is the date the planogram was first created or imported 

Created By is the identifier of the user if the planogram was manually created. If the 
planogram was imported, this will be indicated instead.   
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Last Modified is the date the planogram was last saved or information was last 
imported. 

Last Modified By is the identifier of the user if the planogram was manually updated. If 
the information was imported, this will be indicated instead.   
Last Published is the date the planogram design was last printed in electronic or hard 
copy form. 

Size is the calculated size of the planogram. 

Number of Bays is the number of profiles (bays) in the planogram. 

Total Number of Facings is the number of facings in the planogram. 

The Stores Tab 

Overview of the Stores Tab 
The Stores Tab is used to select the Stores the planogram is valid for. 

 

This information is for reporting purposes only and does not put any constraints on 
planogram placement. 

Configuring the List of Stores 
The list of stores can be configured by means of the Store Manager module. This is 
invoked by clicking the Store Manager Icon in the toolbar. 
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Store Manager allows the hierarchy of clusters and stores to be added to, edited and 
deleted from. 

 

Adding or Removing Stores 
To Add or Remove Stores check the Store Dependent box. 
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This will enable the Stores toolbar. 

Icon Description 

 

Add Store 

 

Remove Store 

 

Remove all Stores 

  

Individual Stores can be added or removed by using the Add Season or Remove Season 
icons. 

Remove all Stores will remove all selected stores from the right of the display. 

The Seasons Tab 

Overview of the Seasons Tab 
The Seasons Tab allows users to specify which seasons (if any) the planogram is valid 
for. 
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This information is for reporting purposes only and does not put any constraints on 
planogram placement. 

Configuring the List of Seasons 
The list of seasons is configured in the Administration Module. Select the Seasons 
option from the Merchandising Menu. 

 

This will bring up the Seasons dialogue box. 

 

This allows seasons to be added, edited or deleted. 

Adding or Removing Seasons 
To Add or Remove seasons check the Season Dependent box. 
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This will enable the season toolbar 

Icon Description 

 

Add Season 

 

Remove Season 

 

Remove all Seasons 

  

All available seasons can be added to the planogram by selecting all seasons on the left of 
the display, then clicking on the Add Season icon. 

Individual seasons can be added or removed by using the Add Season or Remove Season 
icons. 
Remove all seasons will remove all selected Seasons from the right of the display. 
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The Fixture Styles Tab 

Overview of the Fixture Styles Tab 
The Fixture Styles tab allows users to specify which fixture styles the planogram can be 
placed on.  

 

Planograms can only be placed on fixtures that have been assigned those styles. 

In the example above, the planogram can only be placed on fixtures that have been 
assigned the Standard Fixture style.   

Selecting styles can be done by means of the toolbar. 

Icon Description 

 

Add Style 

 

Remove Style 

 

Remove all Styles 

Adding or Removing Styles 
Styles can be added or removed by means of the toolbar. 
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To add or remove a style, simple highlight it and click on the relevant icon. 

Icon Description 

 

Add Style 

 

Remove Style 

 

Remove all Styles 

  

Remove all Styles will remove all selected Styles from the right of the display. 

Configuring the List of Styles 
The list of available styles is configured in the Administration Module. 

Note: Users will require the appropriate privileges to use the 
Administration Module 

Select Styles from the Administration Module Merchandising Menu. 
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This will bring up the Styles dialogue box. This allows Styles to be defined, Style 
Relationships to be set and those style relationships to be tested. 

 

The Design Tab 

Overview of the Design Tab 
The Design Tab is used to design the planogram. 
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Selecting the Fixtures and Shelf Objects for the Planogram 
When working in the Design tab, only fixtures and shelf objects can be added. It is not 
possible to using gondolas. 
The fixtures required for the planogram can be selected from the hierarchy on the Object 
Browser and 'dragged and dropped' into the planogram design. 
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As fixtures are 'dragged and dropped' into the design window, they will align facing the 
user and ordered from left to right. 
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Similarly, shelf objects can be added by selecting the required parent fixtures and adding 
as necessary. 

Selection details work in a similar manner to in a floor plan, as do Walk Mode and Edit 
Mode. 

Selecting the Products for the Planogram 
Products can then be placed using those available from the hierarchy in the Object 
Browser. 
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If objects are selected at SKU level or above, they will be placed as placeholders - 
indicating that type of merchandise is on that fixture or shelf, but giving no indication of 
position, size or quantity. If objects are selected at display style level, position, size and 
quantity are specified. 
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The screen shot above shows products being added to a planogram at display style level. 

2D and 3D Views 
There are two forms the planogram can be viewed in: 2D and 3D. The option in use is 
selected from the toolbar in the Design tab of the Planogram Design dialog box. 

 

2D 
The 2D option shows a flat 'Read Only' image of the planogram. It is a preview of the 
image that can be set to appear on the front of planograms when they are imploded into 
2D form in Merchandiser floor plans. 
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3D 
The 3D option shows a fully editable view of the planogram. It shows the planogram as it 
would appear when placed in a floor plan in the merchandiser module. It also allows 
equipment and merchandise to be added, edited and deleted. 

 

User Defined Attributes 
As well as the User Defined Attributes assignable to the planogram in general on the 
UDA tab, it is also possible to assign UDA information to individual profiles (bays), as to 
specific shelves and products. 

UDA's associated with Planogram Profiles (bays) in the planogram design 
UDA's associated with a specific profile (bay) in a planogram can be seen by highlighting 
that bay in the Design tab. 
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 Clicking the Object Properties icon on the toolbar will bring up the Profile User Defined 
Attributes dialog box. 

 

This will bring up the Profile User Defined Attributes dialog box. 
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Note: the number after the parent fixture for the profile (23 
in the above example) is the PRD_ID from the 
AVTTB_PROFILE table. It is a unique identifier for the 
profile/bay the UDA refers to. 

UDA's associated with specific items of equipment in the planogram design 
UDA's associated with a specific item of equipment in a planogram can be seen by 
highlighting that item of equipment in the Planogram Design window in the 
Merchandiser module and clicking the Object Properties icon on the toolbar. 

 

This will bring up the Equipment User Defined Attributes dialog box. 

 

Note: the number after the item of equipment (62 in the 
above example) is the FXL_ID from the AVTTB_POG_FIXEL 
table. It is a unique identifier for the item of equipment the 
UDA refers to. 

UDA's associated with specific products in the planogram design 
UDA's associated with a specific product in a planogram can be seen by highlighting that 
item of merchandise in the Planogram Design window in the Merchandiser module and 
clicking the Object Properties icon on the toolbar. 
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This will bring up the Product User Defined Attributes dialog box. 

 

Note: the number after the item of merchandise (67 in the 
above example) is the PPR_ID from the 
AVTTB_POG_PRODUCT table. It is a unique identifier for 
the item of merchandise the UDA refers to. 

The Financial Tab 

Overview of the Financial Tab 
The Financial Tab contains information of the performance of the planogram. This 
information can either be manually entered or imported as part of a planogram import. 
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Financial Tab - Basic Details 

 

Currency 
The currency for the financial data is set from a drop down list. The data in this list is 
specified in the Units dialog box, accessed from the General Menu in the administration 
module. 

Calculate other fields after editing 
If checked, this forces all data associated with specific fields to be recalculated when data 
is changed elsewhere. 
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Use Planogram Size for Dimensions 
This substitutes the planogram size held in the database for the imported planogram size. 

Linear 
This field holds the base linear measurement of the planogram. 

Square 
This field holds the footprint of the planogram: the base linear multiplied by the depth 

Cubic 
This field holds the volume of the planogram: the base linear multiplied by the depth 
multiplied by the height. 

Linear Units 
This field holds the unit of measure for the length. 

Square Units 
This field holds the unit of measure for the area. 

Cubic Units 
This field holds the unit of measure for the volume. 

Demand Transference 
This is the probability that if a specific product is out of stock in a store, a customer will 
buy an alternative product. This probability could be very high - for example for baked 
beans. It could be very low for specific products - for example recently released computer 
software games. 

Target Capacity 
This is the minimum percentage of the merchandisable capacity of the parent fixtures 
that should be filled with product. 

Target Service Level 
This is the level of stock that will result in the specified percentage of merchandise being 
present in the stores across the retail chain. High Target Service Levels result in stock 
being increasingly available for customers, but also increase inventory costs. 

Historical Service Level 
This is the service level resulting from the historical levels of stock. 

Target Number of Facings 
This is the designed number of product facings in the planogram 

Return on Inventory Investment 
This is the Gross Margin Return on Investment. 

Note: the calculation method may vary from retail 
organization to retail organization. 
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Financial Tab - Actual Data 
The actual data is based on EPOS data collected by the retailer and imported into Macro 
Space Planning as updates to the planogram specific data during planogram imports. 

 

Note: the currency unit for the financial data is set using the 
Currency drop down list in the upper part of this dialog box. 

Sales 
This is the sales for this planogram. The time period is client dependent and may be daily 
average, weekly total, monthly total, etc. 

Sales/Linear 
This is the sales figure divided by the Linear figure for the planogram. 

Sales/Square 
This is the sales figure divided by the Square (footprint) value for the planogram. 

Sales/Cubic 
This is the sales figure divided by the Cubic (volume) value for the planogram. 

Profit 
This is the profit for this planogram. The time period is client dependent and may be 
daily average, weekly total, monthly total, etc. 
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Profit/Linear 
This is the profit figure divided by the Linear figure for the planogram. 

Profit/Square 
This is the profit figure divided by the Square (footprint) value for the planogram. 

Profit/Cubic 
This is the profit figure divided by the Cubic (volume) value for the planogram. 

Gross Margin 
This is the gross margin for this planogram. Gross Margin is calculated by the formula 
Gross Margin = (Profit/Sales) x 100% 
The time period is client dependent and may be daily average, weekly total, monthly 
total, etc. 

Gross Margin/Linear 
This is the gross margin divided by the Linear figure for the planogram. 

Gross Margin/Square 
This is the gross margin divided by the Square (footprint) value for the planogram. 

Gross Margin/Cubic 
This is the gross margin divided by the Cubic (volume) value for the planogram. 

Movement 
Movement is the number of times the planogram will be replenished in a specific time 
period. 

Movement/Linear 
This is the movement divided by the Linear figure for the planogram. 

Movement/Square 
This is the movement divided by the Square (footprint) value for the planogram. 

Movement/Cubic 
This is the movement divided by the Cubic (volume) value for the planogram. 

Financial Tab - Forecast Data 
This tab contains forecast data for the performance of the planogram. It can be 
superseded by actual data as the planogram comes into service. 
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Note: the currency unit for the financial data is set using the 
Currency drop down list in the upper part of this dialog box. 

Forecast Sales 
This is the forecast sales for this planogram. The time period is client dependent and may 
be daily average, weekly total, monthly total, etc. 

Forecast Sales/Linear 
This is the forecast sales figure divided by the Linear figure for the planogram. 

Forecast Sales/Square 
This is the forecast sales figure divided by the Square (footprint) value for the planogram. 

Forecast Sales/Cubic 
This is the forecast sales figure divided by the Cubic (volume) value for the planogram. 

Forecast Profit 
This is the forecast profit for this planogram. The time period is client dependent and 
may be daily average, weekly total, monthly total, etc. 

Forecast Profit/Linear 
This is the forecast profit figure divided by the Linear figure for the planogram. 
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Forecast Profit/Square 
This is the forecast profit figure divided by the Square (footprint) value for the 
planogram. 

Forecast Profit/Cubic 
This is the forecast profit figure divided by the Cubic (volume) value for the planogram. 

Forecast Gross Margin 
This is the forecast gross margin for this planogram. Gross Margin is calculated by the 
formula Gross Margin = (Profit/Sales) x 100% 

The time period is client dependent and may be daily average, weekly total, monthly 
total, etc. 

Forecast Gross Margin/Linear 
This is the forecast gross margin divided by the Linear figure for the planogram. 

Forecast Gross Margin/Square 
This is the forecast gross margin divided by the Square (footprint) value for the 
planogram. 

Forecast Gross Margin/Cubic 
This is the forecast gross margin divided by the Cubic (volume) value for the planogram. 

Forecast Movement 
Forecast movement is the number of times the planogram will be replenished in a 
specific time period. 

Forecast Movement/Linear 
This is the forecast movement divided by the Linear figure for the planogram. 

Forecast Movement/Square 
This is the forecast movement divided by the Square (footprint) value for the planogram. 

Forecast Movement/Cubic 
This is the forecast movement divided by the Cubic (volume) value for the planogram. 

Financial Data and Planogram Weighting 
The data from the Financial tab is used in the Financial Weighing dialog box accessed 
from the Merchandising menu in the Administration module. 
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This option allows users to set up a system for calculating the relative performance of 
planograms from the imported or manually entered financial performance data. 

The UDA Tab 

Overview of the UDA Tab 
The UDA Tab is used to add User Defined Attributes (UDA's) to the Planogram. 

 
UDA's are implementation specific and can be customized according to customer 
requirements. 
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Configuring the Fields for the UDAs 
The fields for the UDAs are configured in the Administration Module. Select the User 
Defined Attributes option from the Merchandising Menu. 

 

This will bring up the User Defined Attribute dialogue box. 

 

This allows the fields for the UDAs to be added, edited or deleted. 

Adding, Editing or Deleting UDA Information 
The UDA fields themselves are configured in the Administration Module. The title used 
for each UDA field is shown in the Property column. This information cannot be edited 
in the Planogram Design dialog box. 
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The information in the Value field can be added, edited or deleted by the user. Data can 
be one of the following types: 

 Type Description 

Text A text field, for example a name 

Whole 
Number 

An integer, such as 1, 2 or 3 

Decimal A number with values after the decimal 
point, for example 1.234 

Date A date - for example a review date 

Boolean A Yes/No field. This appears as a 
checkbox. 

Currency Currency: a financial value. 
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72 
Saving Planograms 

Saving Planograms as New Designs and New Revisions 
Once a planogram has been designed, that design can be updated at a later date. 
Changing the Revision Number of a planogram is straightforward. 

 

The Planogram Revision (1) can be seen at the top right of the dialogue box. 

To change the revision, click on the Save As button (2). This will bring up the Save As 
dialogue. 
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Select the Save as New Revision radio button and enter the Revision Number. Click on 
OK to save the new revision. 

Overview of Planogram Versions 
Planogram designs can be updated. For example, a more up to date design of packaging 
could become available and the planogram updated accordingly. 
The updated planogram is known as a new version. 

When a planogram is revised in such a manner, the older version of the planogram has 
its status changed to 'superseded',   

Overview of Planogram Import 
As an alternative to creating planograms within Merchandiser, Macro Space 
Management users have the option of importing existing planograms from third party 
software. 

This requires a customized import routine - planograms being imported into the central 
Macro Space Management database where they become available for placement into 
store plans. 

Contact Oracle's Technical Support Team for further information. 
The Preview Window 
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KPIs and Time Dependent Data 

Overview of Time Dependent Data 
Macro Space Management data can come from two main sources: the program itself and 
data imported from external software. 

This data is stored in the central Macro Space Management database. 
The data can then be analyzed in two ways: using Reporting Tools and using KPI’s (Key 
Performance Indicators). 

Key Performance Indicators present data visually in the form of color coded objects 
within the Virtual Reality store. This enables an overview of performance to be seen at a 
glance. 

Reporting Tools present data in the form of ordered lists. This enables data to be 
analyzed in detail. 

Note: Macro Space Management has an internal reporting 
tool called Report Studio. Alternatively, reporting tools from 
Oracle can be used - an example is BI Publisher. 

The two methods are complementary; enabling the user to see information in two 
different ways. 

As data changes with time, Macro Space Management allows data to be analyzed for 
specific periods of time. Such information is known as Time Dependent Data. 

It is possible to review Time Dependent Data for a specific day, week, month, quarter or 
year. It is also possible to review the data for seasons or any other specified criteria. 

Data Import 
Data can be imported from external programs using Macro Space Management’s Data 
Import module. 

This data is then stored in tables within Macro Space Management’s central database. 

Such data might include sales values, product volumes, etc. 

Imported data can then be analyzed using Report Studio or KPI’s, (Key Performance 
Indicators). 

Setting Effective Dates in Store Manager 
The Effective Date for a drawing within in Store Manager can be manually set by 
selecting the required drawing by highlighting it. Right clicking will bring up a menu of 
options. 

Selecting Properties will bring up the Properties dialogue box. 

Publish and effective dates can then be set by clicking on the down arrows by the Publish 
and Effective Date drop down menus. This will cause a Standard Date control to be 
displayed. This can be used to set the Publish and Effective data for the drawing. 

Note: Publish and Effective dates can only be set when a 
drawing has Authorized status. 
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Status and Effective Dates 

Status 
Each store within a retail organization is subdivided into floors. Each floor in turn can 
have a number of revisions, and each revision can contain a number of drawings. 

Only one drawing at a time can be current (active) for a store. The current position of a 
drawing is indicated by its Status. Although these there will be some variation from 
customer to customer, statuses tend to follow the same general sequence. 

 Proposed drawings are tentative layouts for stores. 

 Authorized drawings are layouts that have been accepted for future 
implementation. 

 Current drawings are the layouts that are presently in use. 

 Historical drawings are drawings of layouts that have been superseded. 
A specific store may only have one current drawing (the layout presently in use) and one 
authorized drawing (the layout due to come into use) at any one time. 

Drawings can be viewed with any status, but the amount of information available for 
KPI’s and reports may vary depending on the status of the drawing. 

For example drawings with Proposed status may not have sales data associated with 
them, while drawings with Current status probably will. 

Publish and Effective Dates 
When a drawing reaches Authorized status it may have Publish and Effective dates 
assigned to it. 
The Publish Date is the date at which an authorized drawing is sent to the affected stores 
so that they may begin preparations for implementing it. 

The Effective Date is the date at which the drawing becomes the active version of the 
layout within the affected stores. 

Note: Publish and Effective dates can only be set when a 
drawing has Authorized status. 

Effect of Effective Date on Status 
When an Authorized drawing is given an Effective date, this indicates the date at which 
it is to come into use. 

At the date at which the drawing becomes Effective, its status is changed from 
Authorized to Current. Simultaneously, the drawing it replaces has its status changed 
from Current to Historical. 

Overview of using KPI's 
KPI’s can be produced using data from on the store associated with the current drawing, 
or from a user specified store. 
Macro Space Management enables the user to select both the date and time period for the 
data to be displayed. This enables users to monitor performance with specified time 
periods. 

KPI’s can be selected from the Object Browser by clicking on the KPI tab. 

Clicking on a particular KPI will then bring up the Key Performance Indicator Dialogue 
Box. 
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This lets the user specify the Details, Stores involved and Date Ranges required. 

It also lets the user specify which ViewPort(s) to use. 

When these have been selected, the pertinent KPI will be displayed. 

Selecting Stores and Date Ranges 

Selecting Stores 
Stores for which KPI’s can be displayed can be selected using the Stores Tab in the Key 
Performance Indicator dialogue box. 

If the Current Store check box is selected, then KPI’s will be displayed for the store 
associated with the currently active drawing. 

If the Current Store check box is not ticked, then the store may be selected from the list of 
all available stores. These may be sorted by Store Code or Store Name by clicking on the 
column header. 

Selecting Dates 
Date Ranges for which KPI’s can be displayed can be selected using the Date Tab in the 
Key Performance Indicator dialogue box. 
Radio buttons enable the user to specify whether the date on which the KPI should be 
based is the Effective Date (the date on which the drawing became current), the Current 
Date (today’s date), or a user specified date. 

Dates can be set using the Date Control Display that will appear as soon as the Date drop 
down list is activated. 

The Date range can also be selected from the drop down list that appears when Data 
Type is activated. 

This will specify the time period relative to the selected date. 

All date ranges are after the selected date. 

For example, selecting a current date of 11/10/06 and a date range of a Month will select 
all data for October 2006. 

KPI's and ViewPorts 
Each KPI can be associated with one or more ViewPorts. 

This is specified in the Details Tab of the Key Performance Indicator dialogue box when 
the KPI is first opened. 

In the above example, the KPI has been selected to show in ViewPort 1. 

KPI's and using Multiple ViewPorts 
It is possible to use ViewPorts to display a single KPI reporting on data over different 
date ranges. It is also possible to use ViewPorts to display performance data from 
different stores sharing the same layout. 

Each instance of the KPI can be set to show in a different ViewPort window, allowing the 
Macro Space Management user to see compare how performance changes over time or 
how performance varies from store to store. 

In the above example the Weekly Sales KPI has been set to show in four different 
ViewPorts, each showing date for a different week. 
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Renaming KPI’s 
Each instance of similar KPI’s open in multiple ViewPorts has to be renamed. This is 
because each KPI must have a unique name. If duplicate names occur, Macro Space 
Management will put a warning at the bottom of the Key Performance Indicator dialogue 
box. 
In the example below the SubClass Forecast Sales (Fixture) KPI has been renamed to each 
instance has a unique name. 

Selecting Stores 
Stores can be selected from the list on the Stores Tab of the Key Performance Indicator 
dialogue box. 

Date Ranges 
Start dates and Date Ranges can be set from the Date Tab of the Key Performance 
Indicator dialogue box. 
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